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1 Getting Started

Introduction
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Welcome to MADRIX - the professional LED lighting control software solution for architecture and
entertainment environments including clubs, nightclubs, stages, art installations, exhibition stands,

interior and building illumination.

This manual is designed both as a course in using MADRIX and as an ongoing reference.

How To Use This Help And Manual

You can always call up the MADRIX Help and Manual by pressing "F1" while working with the
application.

© 2011 inoage GmbH



7 MADRIX Help and Manual

LINKS are displayed in orange. Simply click through and you will be taken to the according chapter

within this user guide or an external website will be launched.

MADRIX and this user guide are only available in English.

1.1 What Is DM X?
About DMX

DMX512, often abridged to DMX (Digital MultipleX), is a communication protocol used mainly to
control stage lighting. It is a type of the RS-485 architecture. Developed by the Engineering
Commission of USITT, the standard took off in 1986 with subsequent revisions in 1990 leading to
USITT DMX512/1990. ESTA took control of the standard in 1998 and started an additional revision
process. The new standard, officially known as "Entertainment Technology - USITT DMX512-A -
Asynchronous Serial Digital Data Transmission Standard for Controlling Lighting Equipment and

Accessories", was approved by ANSI in November, 2004.

DMX was originally intended as a replacement for 0-10V lighting control for usage in linking
controllers and dimmers of different manufacturers; a protocol to be used as a last choice after
trying more proprietary methods. However, it soon became the primary method for not only linking
controllers and dimmers, but also linking more advanced fixtures and special effects devices, such
as fog machines and moving lights. DMX512 is unidirectional and does not allow for a response.
Therefore, it must not be used for any type of utilization involving one's safety, such as controlling

pyrotechnics. MIDI is sometimes used for this very task.

A DMX512 controller is connected to fixtures or devices in a so-called daisy-chain linkage. Each
device has a DMX-IN and usually a DMX-OUT connector-sometimes labeled as DMX thru. The
DMX-OUT port of the controller is linked via a DMX512 cable to the DMX-IN of the first fixture. A
second cable then links the DMX-OUT of the first fixture to the next device, and so forth. In
general, the last DMX-OUT connector, which is not connected, should have a DMX512 terminating
plug attached to it. This simply is a 1200 resistor joining together pin 2 and 3 of the connector.
Many modern devices neglect this requirement because they are capable of auto-terminating the
link.

© 2011 inoage GmbH
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The connectors themselves should be five-pin XLRs. Nevertheless, only three pins of the five are
used. Many manufacturers use three-pin XLR connectors, in violation of the Standard. Additionally,
with the approval of the DMX512-A standard Cat5-cabling is also an acceptable wiring topology if

used in a permanent installation.

Only cables designed for utilization with DMX512 should be used. Testing by ESTA has shown that
CATS5 cables may be used without any compromise of signal quality. However, due to the common
usage of three-pin XLR connectors, microphone cables are often used for DMX512 purposes and

this is certainly not a recommended practice.

Data Plus (pin 3) and Data Minus (pin 2) are reversed in comparison to sound cables. Hence, the
signal travels in the opposite direction to the pins (female is out, male is in). The pin layout of a

female connector is the following:

Pin Layout

#1 Shield/Ground

#2 Data -

#3 Data +

#4 Spare (or Data2 Minus)

#5 Spare (or Data2 Plus)

© 2011 inoage GmbH
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1.2 What Are LEDs?
About LEDs

+._

E
+— 34— -
v A light emitting diode (LED in short) is an electronic semiconductor unit. If a voltage is

applied to the diode in a flow pattern, it emits light.

With the help of specific choices of semiconductor materials and doping, a large variety of light
and color shades can be produced. Most importantly, the spectral range and the efficiency of the

diodes can be influenced.

Due to an increased efficiency and the development of white LEDs, the area of light emitting
diodes varies widely. Nowadays, the use of LED technology is not restricted to the illumination of

rooms and buildings only, but has many more fields of application.

Economic Advantages Of LEDs

High degree of effectiveness combined with a low energy consumption

Nominal heat development
e Almost unlimited life span of lamps

e Minimized cost compared to common light systems

Design Advantages Of LEDs

e Small design and shape
e Size and format of common lights
e Dimming is possible without change of light temperature

e Color of light is adjustable (if differently colored LEDs are used)

© 2011 inoage GmbH
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1.3 System Requirements

Minimum Requirements

At least a 2GHz dual-core processor, 1,024 MB RAM, 200MB free disk space, screen resolution of
1024 x 768, 24-bit color rendering, and at least DirectX 9.0c. One free USB port for the USB
dongle (USB Software Protection Key). A sound card is optional (required for Sound2Light and
Music2Light).

Recommended Requirements For Large Installations

Dual-core or quad-core processor with 3GHz, 4 GB RAM, 1GB free disc space, screen resolution of
1280 x 1024, 32-bit color rendering, and at least DirectX 9.0c. One free USB port for the USB
dongle (USB Software Protection Key). A sound card is optional (required for Sound2Light and
Music2Light).

Optimal Configuration

Optimal computer specifications may vary greatly and depend mainly on these factors:

¢ Pixel resolution

Type of output

Effects in use

e Number of layers in use

The more pixels, effects, and layers asre used, the more computer performance is required. The

MADRIX demo version can help to test the software prior to purchase.

© 2011 inoage GmbH
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Supported Operating Systems

Microsoft® Windows® XP, Windows® Vista, and Windows® 7.

Compatible with 32 bit and 64 bit.

Windows XP requires Service Pack 1 (SP1).

Compatible with

~

Wmdows*?

1.4 The MADRIX KEY
USB Software Protection Dongle

You can download MADRIX at http://www.madrix.com for free. But a full
license requires a special USB software protection key, which is used for the software
protection. It is a copy and license management system, which is encoded based on hardware.

Without this MADRIX KEY, the demo mode will be activated.

In demo mode MADRIX sends DMX512, Art-Net, DVI, KiNet, T9, Insta and ROBE
protocol data even without the MADRIX KEY (USB dongle) for 1 hour, always

interrupting transmission after one minute for a short duration.

© 2011 inoage GmbH
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When you purchase the software, you will receive your personal MADRIX USB dongle. The MADRIX

USB software protection key fully activates data output.

Several MADRIX KEYs can be combined and used with one single computer. The product features
will add up and their combined possibilities will be offered. Often, this will mean that the available
DMX output increases. For example, MADRIX NEO and MADRIX KEY start used together would offer
2x DMX512 output.

But a MADRIX KEY is not bound to one computer and can be used with each of your computers.

Which MADRIX Version Do I Own?

You can check your MADRIX version and MADRIX KEY serial number here:
Menu "Help" -> "About MADRIX".

®

= MADRIX
e NUSIC MAKES THE T
0:55

(c)inoage trade GbR

Irte
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MADRIX NEO And MADRIX PLEXUS

Regarding the MADRIX NEO or the MADRIX PLEXUS, the software protection is already included in
the USB DMX512 interfaces.

The MADRIX KEY is not necessary for the MADRIX NEO or PLEXUS.

Why Is Software Protection Necessary?

This software is protected against piracy via legal, technical measures. The MADRIX USB
software protection key offers the highest level of security of any software protection item

(dongle) owing to genuine, hardware-based encryption. Thank you for your understanding!

Upgrades

MADRIX, and therefore the MADRIX KEY, comes in several versions:

MADRIX start, dvi start, basic, dvi, professional, and ultimate.

MADRIX start, dvi start, basic, dvi, and professional may be upgraded at any time due to the
software protection dongle. The MADRIX KEY simply needs to be updated. Upgrades are possible

at any time. Please contact your MADRIX dealer if you would like to upgrade your MADRIX version.

Upgrading your MADRIX KEY is now possible within MADRIX.

Please navigate to the Help menu and select "Update MADRIX KEY".

© 2011 inoage GmbH
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[Help
Help... F1
Help Online

FAQ
Forum

Website

Update MADRIX KEY...
Update MADRIX Version...

About MADRIX...

A new dialog will open.

A

Before using these functions, please make sure that exactly one MADRIX KEY is

connected to your PC.

1) Use the button "Create RTC File" in order to create a new file that needs to be sent in (by e-
mail).
2) After receiving your new RTU file from your dealer, press "Update MADRIX KEY" in order to

start the upgrade procedure. Go ahead by selecting the new RTU file you received.

© 2011 inoage GmbH
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This is the whole procedure in short:

1. Create the RTC file.

2.Send the file to your dealer (by e-mail).

3. Receive a new RTU file from your dealer (by e-mail).
4. Update your MADRIX KEY.

15 Installation Of MADRIX

Important Notes

(Purchased Product, Demo Version, Updates)

Please note that the MADRIX software can be downloaded from www.madrix.com. Regular updates
of the software are also available online. Our demo version of the software is fully functional and
includes the software with every single feature, but it restricts output. The full version will be
activated once you connect the USB software protection dongle to your PC/notebook. For more
details, please read the chapter The MADRIX KEY.

It is highly recommended to always use the latest software update.

Using A MADRIX CD-ROM

When using a MADRIX CD-ROM for the installation process, please insert the CD into the CD-ROM
drive of your computer. The MADRIX setup will start automatically using an Auto Installer. Please

wait until the setup has fully loaded. Then, proceed with the setup process as described below.

© 2011 inoage GmbH
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Downloading The Software Online

After downloading the MADRIX_Full_Install.exe, please double-click this file in order to start the
setup process. Please wait while the Auto Installer is loading the setup. Afterwards, proceed with

the setup process as described below.

MADRIX Version Update

WMADRIY Updat

O Inform

MADRIX can automaticially search for new software versions. Enable this setting in the Start

Options. Or check for updates manually using the "Help" menu.

Setup Process

© 2011 inoage GmbH



17 MADRIX Help and Manual

Welcome to the MADRIX Setup
Wizard

This wizard will guide you through the installation of MADRIX

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Next to continue.

S MADRIX Setup [P

License Agreement

Please review the license terms before installing MADRIX .

MADRIX

Press Page Down to see the rest of the agreement.

END-USER LICENSE AGREEMENT FOR INOAGE SOFTWARE
Licence agreement

IMPORTANT NOTE

Flease read this license agreement before using this software. By continuing the
installation and by using this software you commit yourself respecting all the terms and
conditions of the license agreement without reservation. If you do not accept these
terms and conditions, please stop the installation process.

RIGHTS OF THE LICENSE AGREEMENT

If you accept the terms of the agreement, didc I Agree to continue. You must accept the
agreement to install MADRIX .

< Back |[ I Agree ] | Cancel

Choose Components
MADRIX )
PAUSAT MAKES THE LIGHT Choose which features of MADRIX you want to install.

Check the compenents you want to install and uncheck the compenents you don't want to
install. Click Next to continue.

Description

Installs the MADRIX
Desktop shortcut application and all

Examples necessary files.
MADRIX KEY Driver
Interface Driver
Visualizer Driver
WinPcap Driver

Select compenents to install:

Space required: 91.7MB

MNext > ] | Cancel

Step 1)

You can always quit the setup by choosing

"Cancel".

Click "Back" in order to return to a previous

step during the setup process.

Now, please click "Next" to start the

installation.

Step 2)

The "License Agreement" will appear. It
outlines the terms you are agreeing to by
installing the software. You must accept

these terms in order to continue.

Please click "I Agree".

Step 3)

This window offers the chance to select
which components and which drivers you
want to install. A description is given for

every item.

It is always required to install "MADRIX". This

component includes the drivers for the
MADRIX NEO and PLEXUS interfaces.

© 2011 inoage GmbH



Getting Started 18

Select "Desktop Shortcut” if you wish to
create a shortcut to the MADRIX software on

your Windows desktop.

Select "Examples" if you wish to install
examples including setups, effects, scripts,

etc. (For more info, see the chapter Examples

).

Select "MADRIX KEY Driver" if you wish to
use MADRIX start, dvi start, basic, dvi,
professional, or ultimate. This installs the

driver for the USB software protection dongle.

Select "Interface Driver" in order to copy
drivers for various DMX interfaces. The drivers
can be found in the MADRIX installation
directory of MADRIX then. This component is
not necessary if you only want to use the
MADRIX NEO or PLEXUS interface.

Select "Visualizer Driver" if you wish to
install the WYSIWYG driver in order to use the
Visualizer software WYSIWYG together with
MADRIX. »WYSIWYG Visualizer

Select "WinPcap Driver" if you wish to use

the EuroLite T9 or ColourSmart Link protocol.

Click "Next" after choosing the components.

© 2011 inoage GmbH



19 MADRIX Help and Manual

Step 4)

Choose Install Location

M&Pnlx Choose the folder in which to install MADRIX .

Afterwards, please choose an installation
directory on your hard disk where the
software will be installed. A standard

destination folder will automatically be

Destination Folder

R — provided by the setup.

oL LT Click "Browse" to change the folder.

Space avaizble: 43.2GE

<gack || mstal ] [ Concel Then, click "Install" to start the installation

process.

Step 5)

Installation Complete
Setup was completed successfully,

MADRIX

When the setup displays "Installation

o Complete", please click "Next".
R —
Delete file: C:\Usersthertel\AppDataiLocal Temp WMADRIX-WYG-Driver\Madrix\yglns... =
Output folder: C:\Program Files {x86) \MADRLX
Remove folder: C:\Users\hertel\AppDataLocal Temp MADRIN-WYG-Driver),
Output folder: C:\Usersthertel\AppDataLocal\Temp\WinPcaplnstal
Extract: WinPcap_4_1_l.exe... 100%
Execute: "C:\Usersthertel\AppDataiLocaliTempiWinPcapInstall WinPcap_4_1_1.exe”
Delete file: C:\Usersthertel\AppData | ocal Temp \WinPcapInstal\WinPcap_4_1_1.exe
Output folder: C:\Program Files {x86) \MADRIX
Remove folder: C:\Users\hertel\appData'LocalTempiWinPcapInstall,
Completed

Step 6)
Completing the MADRIX Setup .
Wizard If you do not wish to start the software now,
MADRIX has been installed on your computer. please deselect "Run MADRIX“.

Click "Finish" to quit the setup.
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Upgrading From NEO Or PLEXUS To A Higher MADRIX Version

The NEO Quick Start Guide describes which elements should be installed when you wish to use the
MADRIX NEO interface. If you want to upgrade to higher version of MADRIX (e.g. MADRIX basic),
please re-install the software and choose the necessary components. You will need to install at
least the "MADRIX KEY Driver". Other components may be necessary according to your

requirements. Please see above for more details.

1.6 Do | Need Audio Input?

Using Audio Input

A sound card is a computer expansion card that can input and output
audio signals controlled by computer programs. Normally, a sound card provides the audio
component for multimedia applications and is used for music composition, video or audio editing,
presentation/education, and entertainment (games). Many computers have an integrated sound

card, while others need these expansion cards to be installed if audio capability is desired.

MADRIX works with and without an audio signal.

Static Color effects (SCE) are working without an audio signal.
Similarly, MADRIX offers Sound2Light (S2L) and Music2Light (M2L) effects. Both require an audio
signal in order to be functioning.
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You can use audio sources, such as Winamp®, Windows Media
Player®, Apple iTunes, Apple QuickTime Player®, Real Player®, Ultramixer®, etc. Audio input for

sound cards, e.g. microphone or Line-IN input, is supported as well.

Apart from that, you can also play any music from your CD-player, DVD-player, MP3-player,
cassette recorder, DAT-player, radio, etc. Please use the Line-IN port of your sound card in this

instance.

Why A Professional Sound Card?

We advise to use a professional/semi-professional sound card to obtain best performance of the

audio analysis.

Why ASIO?

Sound cards that provide an ASIO driver can deliver excellent results. The MADRIX audio analysis
will very fast and precise. Sound2Light and Music2Light effects will look better. It is highly
recommended using a sound card with native ASIO support.

MADRIX also natively supports the Windows Audio Session API (WASAPI) which delivers very good

results under Windows Vista and Windows 7, even without ASIO.
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1.7  Audio Input Configuration & ASIO

Introduction

MADRIX offers incredible Sound2Light and Music2Light effects. The music is being analyzed after
tone theoretical parameters. MADRIX analyzes the height of tones, the volume, single tones,
intervals, keys, and tonalities. Audio sources may be external signals (e.g. Line-IN, Mic-IN), as
well as internal audio signals played with the help of the PC.

The general case is that MADRIX automatically finds a primary audio device and is able to

work properly right from the first start.

So, basically you do not need to configure it. But if audio input does not work or if you want to
configure ASIO, please read the sections below.

e How To Set Up Audio Input (Without ASIO)

e How To Set Up ASIO

How To Set Up Audio Input (Without ASIO)

Please check the audio configuration in the "Audio Input" tab. Please go to "Preferences” ->
"Device Manager" -> "Audio Input" or press "F4" and then select the tab.

et DeETault
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[

This button is activated by default and enables the standard Windows audio

drivers.

Furthermore, MADRIX allows you to select a particular "Audio Device". The software scans your
system and the Windows Audio Mixer Control to capture devices available for audio input. That
means you can properly assign your Line-IN, microphone, or other specific devices in this menu.
Just select the device you want to analyze from the drop-down list. Labels vary according to
manufacturers and sound cards but often include "CD-Player", "Microphone", "Wave", etc.

"Stereomix" is the accumulation of all channels and often is used as default.

You may select the "Frame Time" according to your requirements as well. The standard value of
20 ms (50 FPS) should be sufficient for a normal user.

If problems occur, simply use the button "Set Default" to restore the default settings.

Then, press "Apply".

You can also choose if the audio input is used for the S2L - Sound2Light Effects and M2L -
Music2Light Effects implemented in MADRIX. Both options for this, "Use For S2L Effects" and

"Use For M2L Effects" are activated by default as this is highly recommended.

How To Set Up Audio-IN Windows Vista & Windows 7

LY - E |

& Windows Vista . ‘
Windows 7

If MADRIX should analyze music from your Windows Media Player, Winamp, or others, you have

to define the proper audio source in the Windows control panel first.
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Please close all running applications. Afterwards, navigate to the windows control panel. Search

for the entry called "Sound" and open it. Depending on the operating system, the entries

described below may have been named differently.

. 3y Sound

Change sound card settings
Change system scunds
Adjust system volume
Manage audic devices

#w Fase nf Arress Center

Now you will see a new
window with your hardware
audio devices. Next, right-
click inside this window to

open the context menu.

Select "Show Disabled
Devices" in the context

menu.

Playbadk | Recording |5cunds | Communiﬁtinns|

Select a recording device below to modify its settings:

.,

Headset Microphone
Logitech USE Headset
Default Communications Device

Microphone
Realtek High Definition Audio
Mot plugged in

Line In
Realtek High Definition Audio
Mot plugged in

Stereo Mix
Realtek High Definition Audio
Default Device

Configure

Set Default |"' Properties

QK I[ Cancel ] Apply

v | Show Disabled Devices

v Show Disconnected Devices
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Please activate the device Enable

"Stereo Mix" using right click et o= Default Device

and "Enable". Afterwards, Set as Default Communication Device
you will need to click "Set as v Show Dicabled Devices

Default Device". v Show Disconnected Devices

Properties

Finally, you will have an

activated "Stereo Mix" audio

Playback | Recording |50unds |Cnmmuni:3tiuns|

Select a recording device below to modify its settings:

device set as recording

source. MADRIX can now

; Headset Microphone
analyze your music from 9 Logitech USE Headset
software applications, like @ Default Communications Device

Microphone
Realtek High Definition Audio
Mot plugged in

Windows Media Player or

Winamp.
Line In
Realtek High Definition Audio

>
P @ Mot plugged in

Press "OK".

Stereo Mix
Realtek High Definition Audio
Default Device

Configure [get Default IV] [ Properties

Ok ][ Cancel ] Apply

Since MADRIX 2.12., the native Windows WASAPI interface is implemented in MADRIX. Due to the
implementation, audio capturing is done faster and more precisely in Windows Vista and Windows
7. If you are using one of these operating systems, the "Frame Time" will not be visible or

adjustable. It is being set automatically by MADRIX.
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PRIMAR'Y

In addition, please make sure that the audio configuration in MADRIX is configured properly. Please
see the description above (How To Set Up Audio Input).

How To Set Up ASIO

Introduction

ASIO (Audio Stream Input/Output) is a widely known
audio standard. ASIO is a registered trademark of Steinberg Media Technologies GmbH. Above all,
the standard provides low latency, a feature often requested by professionals. Using ASIO the

MADRIX audio analysis will be faster and more precise.
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Important Notes

Before using ASIO with MADRIX, please make sure that the ASIO drivers are installed on your
computer. If the drivers are not installed, MADRIX will not be able to find the ASIO audio

hardware.

It is recommended to connect external ASIO hardware (a USB sound card, for example) directly to
a USB controller of your PC. It is not recommended to use a USB hub or the front-USB. Please use
USB 2.0.

Configuration

Please go to "Preferences" -> "Device Manager" -> "Audio Input” or press "F4" and select
the tab.

Set Detault

Activate the "ASIO" button to activate the ASIO sound drivers. The audio configuration dialog will

change.
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Confiouration

Ef

Uze For M2L Effects B2 not connected or in use

et Cefatlt

You can choose if the audio input is used for the S2L - Sound2Light Effects and M2L - Music2Light
Effects. This is highly recommended. Therefore, both options for this, "Use For S2L Effects” and
"Use For M2L Effects" are activated by default.

In the next step, select your interface or sound card in the drop-down list called "Audio Device".
Afterwards, please select the appropriate device for the left audio channel "L" as well as the right
audio channel "R". You may select any channel you want. If you wish, it is also possible to select
the same channel for left and right. If you are seeing the message "not connected or in use"
(like shown in the picture), please connect your ASIO device and/or make sure to select a channel

for "L" and "R". Please press "Apply" after changing the settings.

Cormguraton

You can configure your ASIO device by pressing the "Configuration” button.
The ASIO drivers that come with your interface will be launched. Please make sure that your ASIO

hardware is connected. Or else, it is possible that no configuration dialog will be launched.

In this configuration dialog you can set various settings. The music analysis will be more precise if
the latency / amount of samples is as low as possible. Sometimes, this setting is called 'Buffersize’.
You can achieve milliseconds with ASIO. 1000 frames represent 1 ms. 500 frames represent 2 ms.

250 frames represent 4 ms, and so on. You will be able to see the number of frames that is

captured in the Task Watcher.

If you are encountering problems, please change the latency settings. For example, effects might

freeze or single frequencies might over modulate. A higher latency can solve the problem.
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1.8 Using The Audio Analysis

Real-Time Audio Analysis For Synchronized Effects

With a sound card and the unique Music2Light real-time effects, MADRIX will deliver a light show
that is 100% synchronic to the music. MADRIX analyzes audio signals in real time and plays LIVE
shows. In contrast to lighting consoles and other software solutions, the MADRIX light show runs
automatically and synchronously to the music. You can use the real-time audio analysis with any

audio source, e.g. audio-CD, record player, tape, MP3, WMA, microphone, etc.

Getting Started

If you want to use the Sound2Light (S2L) or Music2Light (M2L) effects, the audio
analysis needs to be activated. MADRIX automatically activates the "Audio" button, and hence

the audio analysis, if you select a S2L or M2L effect.

An activated "Audio" button in green color indicates that the MADRIX audio analysis is running.
Otherwise the audio analysis is stopped and not activated. If you want to use only static effects

(e.g. SCE Color, SCE Color Ramp, ...), you do not have to start the audio analysis.

Next, please adjust/control the volume with the volume fader. The visualization shows the
input level of your music. Just move the fader upwards if you want a higher audio input level.

Move the fader downwards if you want a lower audio input level.
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To achieve maximum results with the MADRIX audio analysis, an optimal volume of the music is
required. No matter which music source you are using, please always set up the audio level
beforehand. Keep in mind the right order of the set-up: Please set up the level with the Windows
Mixer first and then proceed with MADRIX.

You will get the best results if the maximum level of the audio signal is in the green to orange
area. You will only get a perfect output if the red LEDs at the top light up at no time. If the input

signal is too low, it affects the quality of the analysis as well.

If you do not see any output in the previews while using a reliable audio signal and having
activated the audio analysis, the volume might be too low. If you do not have any level at all,
please check Audio Input Configuration & ASIO.

The Audio button can be activated every time you start MADRIX if you select this option in the
Start Options. The entry is called "Activate 'Audio’'-button". To access options of MADRIX,
please press "Ctrl+Alt+0" or go to the menu "Preferences" -> "Options".
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Performance Adjustments

The speed of your computer, audio performance settings, and the level of the audio signal are

very important for perfect results of the music analysis. Fine tuning of your audio and computer

performance can be arranged very simply. Please click at the entry "Audio Performance" (or

"Ctrl+AIlt+A") inside the menu "Preferences".

[ Preferences

Matrix Generator.., F2
Patch... F3
Device Manager... F4
Audio Performance.., Ctrl+Alt+ A
Rermote Control »
Backup System...

Options.. Ctri+Alt+0

A new window will open and you will be able to adjust parameters for the music analysis.

MZL Performance

|1 | [ EEEEEm
- |

T . e RN RT I

Sl e . T O I i D RN
MZL Sensibility '
I . e . | |

Cetaut

If you are using a computer with less then 1GHz, please move the fader to the far left.

Computers with 2.4GHz or higher can manage higher values; you can pull the fader to the far

right. The numerical values that you can enter in the input field can range from1 to 6, or 0 to 7.

If you set the "S2L M2L Performance" to 6, you will reach a maximum precision of the music

analysis. Because of the high precision, a small delay in displaying the effects is normal. You might

be able to see a delay when a musical tone is played but displayed by MADRIX a bit later. If you

think that the delay is too big, simply move the fader one step to the left.
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The "M2L Cleaner" allows to use a cleaner music analysis for M2L effects. Small numerical
numbers correspond to a slight cleaning. With that also wrong results in the audio analysis are

shown. Move the fader to the right or put in high numerical values and you will see clean results.

"M2L Sensibility" controls the sensitivity of the music analysis for M2L effects. It works like an
audio filter. The more you move the fader to the right, the less will be displayed. The sensitivity
will increase and only the most important analytical data will be used. The numerical values for

Sensibility have to be in the area from 0 — 100.

A fast computer will deliver better results than a slow computer regarding the audio analysis.
Please pay attention to the system requirements of MADRIX and to the processor load while

running the software. A sound card with ASIO is a big improvement as well.

Please note: With some effects in MADRIX, and with some types of music as well, it is

sometimes useful to move the fader a little bit to the left, even if your PC is fast enough.

1.9 Supported Sound Cards

The selected audio signal is being scanned and analyzed using functions
of Microsoft DirectX®. If your sound card does not process and deliver requested data fast
enough, problems with the sound analysis are likely to occur.

If you are having problems with the audio analysis, we suggest:
e Check if you have clicked the "Audio" button, and if the "Audio" button is activated.
e Check the Windows recording settings using the mixer control for your recording device.

e Check the installation of drivers of your sound card as well as the installation of the Microsoft
DirectX®-version.
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e Buy one of the latest sound cards with high quality.

In order to make sure that your sound card works properly, we suggest testing it with
MADRIX:

e Start the MADRIX demo version.

e Activate the via the Audio button while playing some music on your PC, for
example.
e Open the (Menu "Tools" -> "Task Watcher" or press "F5").

e Check the entries "Audio Capture Frames (Is/Tar.)". The left side shows the current value,

while the right box shows the target value.

1.10 PC Power Management

Microsoft® Windows® operating systems offer a wide variety of power management options. In
most cases, PCs, laptops, notebooks, and netbooks benefit from a longer battery life if a good

power management is in use.

But certain problems might occur nevertheless. If after a while your MADRIX KEY cannot be

identified by the software anymore or if your interfaces are suddenly deactivated, we advise:

If such problems occur, we strongly recommend to deactivate all power options in Windows®
in order to guaranty an interruption-free operation of MADRIX.

You can access the 'Power Options' of Windows® in the 'Control Panel'.

Navigate to "Change power-saving settings".
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-
t -y [53 » Control Panel » All Control Panel ltems » energy X

\[g Power Options

Change power-saving settings

Change what the power buttons do
Change when the computer sleeps

@ Search Windows Help and Support for "energy”

Make sure to click "Change advanced power settings".

Change settings for the plan: High performance

Choose the sleep and display settings that you want your computer to use.

| L&' Turn off the display: [Never Y]

% Put the computer to sleep: [I‘\Iever ']

Change advanced power settings

Bestore default settings for this plan

Save changes H Cancel

Especially the "USB settings" are important. Disable the suspend settings.

34
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Advanced settings

\[ l Select the power plan that you want to customnize, and

then choose settings that reflect how you want your
computer to manage power,

’High performance [Active]

Setting: Never
Desktop background settings
Wireless Adapter Settings
Sleep
=) USE settings
[=] USEB selective suspend setting
Setting: Disabled
Power buttons and lid
PCI Express
Processor power management

1B EHH

Micrmlanr

[ Restore plan defaults

| [ camcel || zeot ||

And do not forget to change also other settings that might interrupt the operation.
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2 Graphical User Interface (GUI)
Introduction

A graphical user interface (abbr.: GUI), is a particular type of user interface for interacting with
a computer. It makes use of graphical images and widgets in addition to text to represent the
information and actions available to the user. Usually the actions are performed via direct
manipulation of graphical elements. GUI design is a very important adjunct to our application

programming.

The goal of MADRIX is to enhance the usability of lighting control with an intuitive and
logical design. The visible graphical interface includes a number of graphical elements, which

allow for a prolific interaction with the program.
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Overview

The graphical user interface of MADRIX is divided into different sections. The following image

shows a good overview.

I|- h |'
IJ.-"rI"EI!fi_Lw J:lultp.lt | e

Storage: Area: A : : B K Storage Area:

7/ e e ] B

Effect Area A L ST Effect Area B

Pulse/ Stroboscope Flazma Drops | Crops

Master Fader Audio Level

Learn More

Cayer

38

In the following chapters every section will be introduced. Moreover, every chapter will provide

links to learn the software in more detail.

The Menu
This chapter introduces the menu bar of the application.

Preview Windows
Preview A, Preview B, and Preview Output will be explained in detail here.

Fade Area (Crossfader)
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Learn how to use the Crossfader, fade types, and the color filter.

Storage Areas A & B
The brief overview will introduce the buttons in Storage Area A and Storage Area B.

Effect Areas A & B
How can I use effects? Effect Area A and B will be explained here.

Cue List Section
These buttons are used to control the implemented Cue List function of MADRIX.

Master Fader & Audio Level
How do these two buttons and faders work? It is explained briefly in this chapter.

Touch Screen
An additional touch screen interface is built right into MADRIX. This interface can be opened using

the MADRIX logo! Learn more about it in this chapter.
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2.1 The Menu

You can find the menu in the upper section of the software including "File", "Edit",

"Preferences", "Window", "Tools", "Previews", and "Help".

File Menu

Mew Ctrl+M
Open Setup... Ctrl+0
Save Setup Ctrl+5
Save Setup As... Ctrl+Alt+5

Import 3
Export 3
1 MaobileDJ

2 Martin

3 DiscoSample

4 Bastl
5 Bart

Exit

Click on the menu item "New" (or "Ctrd+N")and you will get a new, blank and clear setup with

clean Storages.

Furthermore, you can use "Open Setup” (or "Ctr+0") (i.e. loading), "Save Setup" (or "Ctrl+S"),

and "Save Setup As..." (or "+Alt+S") for managing your setups.
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Mew

Open Setup...
Save Setup
Save Setup As..

Import
Export

1 MobileDJ

2 Martin

3 DiscoSample
4 Bastl

5 Bart

Exit

Ctrl+M
Ctrl+0
Ctrl+5
Ctrl+Alt+5

Storage
Storage Place

Patch...

Device Settings...

Use the menu entry "Import" to import (load) a complete Storage (all Storage Places of one

single Storage Area), a Storage Place, the Patch, and Device Settings. Use the menu entry

"Export" to export (save) a complete Storage (all Storage Places of one single Storage Area), a

single Storage Place or all Storage Places but separately ("Storage All..."), the Patch, and all

defined Device Settings.

The menu also displays a number of setups that were used last.

Click on the menu item "Exit" to close MADRIX.

Learn more in the chapter
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Edit Menu

Clear All Storages...

Clear All Storages A...

Clear All Storages B...

Copy Storages Places...

Cue All Occupied Storage Places

Storage Place & »
Storage Place B »
Layer A »
Layer B 2

In the Edit menu you can "Clear All Storages”, "Clear All Storages A", and "Clear All Storages

B". This actions will clear all settings on selected Storages.

With the item "Copy Storage Places" you can copy one, multiple, or all Storage Places from
Storage A to B or from Storage B to A. A new window will open. Read the chapter Storage Places,

Submaster, and Cue for more information.

The option "Cue All Occupied Storage Places™ adds all Storage Places to the Cue List if they

are not empty.

The two items "Storage Place A" and "Storage Place B" represent the context menus of the

Storage Places of Storage Area A or Storage Area B, respectively.
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Clear All Storages...

Clear All Storages A,

Clear All Storages B...

Copy Storages Places...

Cue All Occupied Storage Places

Storage Place &
Storage Place B

Layer &
Layer B

Cue

Open...

Save..,

Copy
Cut

Paste

Clear

In these menus, use "Cue" in order to add the currently selected Storage Place to the Cue List.

Use "Open" to load a Storage Place or "Save" the currently selected Storage Place (in *.mef

format). Use "Copy", "Cut", and "Paste" to perform the analog actions. The "Clear" function

will reset the currently selected Storage Place, i.e. all changes will be deleted. Learn more in the

chapter Storage Places, Submaster, and Cue.

The two items "Layer A" and "Layer B" represent the context menus of the effect layers of

Storage Place A or Storage Place B, respectively.
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Clear All Storages...

Clear All Storages A,

Clear All Storages B...

Copy Storages Places...

Cue All Occupied Storage Places

Storage Place & k

Storage Place B 2

Layer & k Mew

Layer B 2 Duplicate
Copy
Paste
Insert
Rename
Delete

In these menus, use "New" to create a new layer with default settings. Use "Duplicate" to
reproduce the selected layer, which will add a copy next to it. Use "Copy" to store the settings
of the selected layer to the clipboard. Then, use "Paste" to apply the stored settings to the layer
you have currently selected. This does not create a new layer, but overwrites the settings. Click
"Insert" to create a new layer using the settings stored in the clipboard. "Rename" allows you
to change the description of the layer tab. Use "Delete" in order to remove the layer in use from

the effect. Learn more in the chapter Layers.
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Preferences Menu

Preferences

Matrix Generator... F2
Patch... F3
Device Manager... F4
Audio Performance... Ctrl+Alt+ A
Remote Control »

Backup System...

Options... Ctrl+Alt+0

The Preferences menu contains various items for settings: the "Matrix Generator", the "Patch",
"Device Manager" and "Audio Performance", "Remote Controls", the "Backup - System", and "Start
Options".

The "Matrix Generator" (or "F2") is the easiest way to set up your light matrix (chapter). After
creating your matrix with the help of the Matrix Generator you can use the "Patch" (or "F3") for

further configuration (chapter).

The "Device Manager" (or "F4") is the main tool to configure your devices. You can set up your
DMX (DMX-0OUT and DMX-IN) or DVI devices, Art-Net or MIDI hardware, audio input settings, and
visualizers, like WYSIWY G from Cast Software.

Click on "Audio Performance™ (or "Ctrl+Alt+A") to open the dialog for setting up the audio

performance and audio optimization.

You can use "Remote Control" with MADRIX by using DMX-IN, Art-Net Remote, MIDI-IN, and
Remote HTTP.

MADRIX comes with an integrated web server and can be controlled remotely via an internet
browser. You can activate this feature by clicking on the menu item "Remote Control" ->
"HTTP". MADRIX includes an integrated DMX-IN and MIDI-IN feature as well and can be controlled
remotely with your lighting desk or DJ/V] MIDI console. You can activate this feature by clicking
on the menu item "Remote Control” -> "DMX" or "MIDI". For more information, please have a
look at the chapter INPUT & Remote Control.
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Preferences

Matrix Generator... F2
Patch... F3
Device Manager.., F4
Audio Performance... Ctri+Alt+4
Remote Control 2 HTTP...
Backup System... DMX...
Options... Ctrl+Alt+0 MIDL...

For more information regarding the integrated backup solution, have a look at the chapter Backup

System.

You can access MADRIX options by clicking "Options" (or "Ctrl+Alt+0") in the preferences menu.

Please read the corresponding chapter to get more details.

Window Menu

Cue List... F7
Recording... Ctrl+Alt+R
Touch... F&

The window menu includes options for the "Cue List" window, the "Recording" window, and the

"Touch" Screen window.

"Cue List" (or "F7") opens the implemented MADRIX Cue List. Read the chapter Cue List for more

information.

To use the record function with a DMX standalone interface, click "Recording" (or "Ctrl+Alt+R").

You can read more about the recording function in the Chapter Recording.

"Touch" (or "F8") opens the extra Touch Screen Window to control MADRIX via a touch screen

panel. Read the chapter Touch Screen for more info.
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Tools Menu
Task Watcher... F5
Lagfile... Fé
DMK Watcher... Ctrl+Alt+D
MIDI Watcher... Ctrl+Alt+M
DMK Fader Tool... Ctrl+AR+F
PLEXUS Configuration... Ctrl+Alt+P

The "Task Watcher" (or "F5") provides detailed operational information.

The "Logfile" (or "F6") keeps track of all warnings and system information.

The "DMX Watcher" (or "Ctrl+Alt+D") allows you to monitor your DMX output or Input while using
MADRIX.

The "MIDI Watcher" (or "Ctrl4+Alt+M") allows you to check your MIDI connection.

The "DMX Fader Tool" (or "Ctrl4+Alt+F") can help to check whether single LED fixtures are working
correctly or not.

The "PLEXUS Configuration" is the tool to configure and manage your MADRIX PLEXUS devices.

You can read more in the chapter Tools or in the chapter MADRIX PLEXUS, respectively.
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Previews Menu

Preview 4 *
Preview B r
Preview Output [
Preview DVI1 2
Preview DVI 2 [

The output windows of the software can be adjusted using the Previews menu. Those settings are

explained in more detail in the next chapter Preview Windows.

Help Menu

Help... F1
Help Online

FAQ
Forum

Website

Update MADRIX KEY...
Update MADRIX Version...

About MADRIX...

The Help menu offers access to the MADRIX "Help..." (or "F1"), the "Online Help", and it
includes additional web links to the online "FAQ", the online MADRIX "Forum" as well as the
MADRIX "Website".

Upgrading your MADRIX KEY is now possible within MADRIX ("Update MADRIX KEY..."). See the
chapter The MADRIX KEY for more details.
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Use "Update MADRIX Version" if you wish to update the MADRIX manually. The software will

then check if newer versions are available for downloading.

And you can see details "About MADRIX...". Latter, gives you information about your MADRIX

license and the MADRIX version.

2.2 Preview Windows

Introduction

Preferences  Window Tools Previews

MUSIC MAKES THE LIGHT

14:28:15

This chapter explains the three preview windows (Preview A, Preview B, and Preview Output).

"Preview A" and "Preview B" represent the two preview windows for the two MADRIX effect
pipelines. The centered "Preview Output"” window is a preview of the DMX output. With the help
of the preview windows you are able to have a look at the effects before they are displayed on

your installation.

DVI previews are explained at the end of this chapter.
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Context Menu

Overview

All preview windows have a context menu. In order to show it, please click the right mouse
button inside a preview window.
You can choose from "Grid", "Stretch Pixels", "Show Status Information", "Show Clock",

"Use Background Image" and "Disable Preview".

You can also access this menu using the menu "Previews".

Previews

Preview 4 2 Grid

Preview B * Stretch Pixels

Preview Output [ Show Status Information
Preview DVI1 b | v Show Clock

Preview DVI 2 r

Use Background Image...

Dizable Preview

Grid

This option activates an optical raster display showing separating the single pixels. If the

resolution is too high, the grid will not be visible anymore.

Stretch Pixels

Use this option to extend the preview windows to the full frame. If activated, the content will be

stretched as well in the previews.

Show Status Information

The name of the preview, the current matrix size, and the current frames per second of this

preview will be displayed at the top of a preview window, when this option is activated.

Show Clock
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If you activate "Show Clock", you will see the system time in the preview. In the example above
it is 14:28:159, German time (GMT +01), or 03:18:39 pm.

Background Image

If you click "Use Background Image" a dialog will open to select a file. You may load *.bmp, *.

gif, *.jpg, *.png, *.tif, or *.tiff files as background images for your previews.

Open
Lookn: [ [0 [ - emaE
= = output
el [ preview-a
Recont FIaces | reviews b
Desidop
=
Libraries
L™
Computer
.
w
Network
File pame: [ =] Open
Flesoftyps:  [Allsupported files (bmp:gf.jpg-prg-tf-ti <] Cancel |
[~ Open as read-ony

An example is given below.

MAD

e NMUSIC MAKES THE LIGHT

G Kl

I,y | avauil|
BLLLLLLA T

=)
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The recommended resolution for background images and Preview A or B is:

Preview A & B

MYLOGO

364x213

The recommended resolution for background images for Preview Output is:

Preview Output

MYLOGO

239x213

52
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Patch Mask

Only the Preview Output offers this option. Learn more:

Clear Message

Only the Preview Output offers this option. If necessary, MADRIX displays errors and warnings in
this preview. Choose "Clear Message" to discard the message. It will not be displayed anymore.

Such a message could look like this:
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Disable Preview

If you want to deactivate a preview window, choose this option. This might be helpful to save

resources and increase performance.

The Mask Mode - Previews With Darker Areas

Part 1 - Too Many Channels Used

4 - | —
et 0 lem -
"= MADRIX - C\User =

File Edit Preferences Window Tools Previews Help

' S MADRIX
e MUSIC MAKES THE LIGHT

| F—1 B
T IF i G
|III|||..r*T“-|.|||III| g

If a darker area is displayed in the preview windows, the size of your matrix is larger (the set-up
has more DMX channels) than your MADRIX version supports. In the example above, you can see a
darker area because this MADRIX set-up has more than 512 channels and the version is valid only
up to 512 channels. As a result, all fixtures beyond 512 channels will be displayed darker than the

first 512 channels.

You can check your MADRIX version here: "Help" -> "About MADRIX".
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Part 2 - Creating An Individual Patch

ELls el e T
[INN T 1 sovnntll
T T

=)

THE | Calar | () 1 FADE

There is another possibility that you will see a darker area in the previews apart from the issue
with the version. This will be the case if you have created a Patch with areas where no fixtures
are located. These areas without any fixtures will automatically be displayed darker to indicate
that this area is not in use. In the picture given above, a dark area is shown in the middle of all
previews. The corresponding patch would look like this:
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Activating or Deactivating Mask Mode

As was described above, the internal preview windows will reflect the Patch you have created.
Every pattern will be visible. LEDs that will be used are displayed brighter than pixels without LED
fixtures. In MADRIX you can select two different modes for this regarding Preview A, B, and
Output.

Activating Mask Mode (Transparent Pixels)

If you would like to see all pixels of your overall LED matrix, perform a right-click in the

Preview Output, navigate to "Patch Mask" and select "Transparent".

This will influence all three Previews.
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A

Grid
Stretch Pixels

¥ Show Status information

Show Clock

Use Background Image...

Patch Mask

Clear Message

Disable Preview

Transparent

Opaque

Deactivating Mask Mode (Opaque Pixels)

If you would like to show only the grid that includes the pixels in use, perform a right-click in

the Preview Output. Then, navigate to "Patch Mask" and select "Opaque".

This will influence all three Previews.
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Stretch Pixels
Show Status information

Show Clock

Use Background Image...

Patch Mask 4 Transparent
Clear Message Opaque
Dizable Preview
Further Configuration
To change the settings of the Previews, please read the chapters and

DVI Previews And DVI Output

With MADRIX dvi start, MADRIX dvi, MADRIX professional, and MADRIX ultimate you are
provided with DVI output.

With the DVI output you can easily control LED pixel walls or use screen-capturing, for example.

Learn more about this in the chapter
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2.3 Fade Area (Crossfader)

Introduction

sl I 1L B

B

1 FADE

MADRIX features a useful Crossfader that sets the source of the final output. In other words, you
can use an effect from Storage Area A or B, a mix of both, or switch seamlessly between them

(fade). The Preview Output will show you the results.

How To Use The Crossfader

The position of the fader decides which of the effects (A or B) is displayed in the Preview Output
window. Set the fader to the far left to show the effect of preview A. Set the fader to the far

right and the effect of preview B will be shown. Any position in between is also possible.

By using the input field "Time" (represented by a clock) you can determine the fade duration.
Enter the time using seconds and tenths of second like this: "2.5" for a fade duration of 2.5
seconds. A click on the "FADE" button starts the fading procedure. If the fader is positioned on
the right side, it will automatically move to the left side. If the fader starts on the left side, it will

move to the right side.

addition, you can move the Crossfader with the help of your mouse.

Click "A" or "B" once and the Crossfader will instantly jump to either A or B. In

Please note: If you use a double-click (with the left mouse button) on the Crossfader slider,

it will be reset to 50%, i.e. to the exact middle position between A and B.
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The output will be influenced by one of the four fade types and a color filter. It could also be

manipulated by a macro or freeze.

Fade Types

The button in the upper left corner says which fade type will be used. If you click it, a drop-down
list will appear.

B R

-|I||||II B

FADE

You can choose from "XF" (Cross-fade), "WF" (White-fade), "BF" (Black-fade), and "CF" (Color-
fade).

The fade types will influence how effect A is mixed with effect B or vice versa. You can
specifically control the result. In the following, it is described how the different modes work. Let's
assume that effect A is currently playing and that you would want effect B to be displayed

next. So we will fade from Preview A to Preview B.
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— Preview A — Preview B
Cross-Fade
100%
0%
A Output B
Preview A: 255.0.0 Preview A: 127.00 Praview A: 0.0.0
Preview B: 0.0.0 Preview B: 0.0.127 Praview B: 0.0.255
Preview Output: 265.0.0 Preview Output: 127.0127 Preview Output 0.0.255

A cross-fade starts by dimming effect A linearly from 100% to 0% during the fade

time. But at the same time, effect B starts to fade in until it is fully shown at the end of the

fade. As a result an interpolation of the colors of A and B will be used during the fade.

At the beginning of the whole fade procedure, effect A stands at 100%, while effect B is not

displayed (0%). Halfway through, both effects are dimmed to 50% as you can see in the
picture. Neither effect A nor effect B are displayed with 100%. That is why the cross-fade

appears to be darker. At the end of the fading procedure, effect A stands at 0%, while effect B
is shown with 100%.
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— Preview A — Preview B
White-Fade
100%
0%
A Output B
Preview A: 255.0.0 Preview A: 255.0.0 Praview A: 0.0.0
Preview B: 0.0.0 Preview B: 0.0.255 Praview B: 0.0.255
Preview Output: 265.0.0 Preview Output: 2665.0.2565 Preview Output 0.0.255

A white-fade is the opposite of a black-fade. It starts with effect A being shown
at 100% for the first half of the fade time. At the same time, effect B fades in during the first
half until it is also shown with 100%. Afterwards, effect B remains at 100% for the rest of the
fade procedure, while effect A is dimmed from 100% to 0%.

Halfway through, both effects are shown with 100%. Because of that, a white-fade does not
necessarily display a white color in middle position. Instead, this fade type uses addition of all
color values. For example, if your are using a SCE Color in pure red on effect A (255, 0, 0) and
SCE Color in turquoise/cyan on effect B (0, 255, 255), the result will indeed be a pure white
halfway trough as it adds up to 255, 255, 255. But using a SCE Color in pure red on effect A
(255, 0, 0) and SCE Color in pure green (0, 255, 0), this results in pure yellow in the middle of
the fade procedure (255, 255, 0), for example.
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= Preview A = Preview B

Black-Fade
100%

0%

A Output B

Preview A: 255.0.0 Preview A: 0.0.0 Praview A: 0.0.0
Preview B: 0.0.0 Preview B: 0.0.0 Praview B: 0.0.255
Preview Output: 2565.0.0 Preview Output: 0.0.0 Preview Output 0.0.255

A black-fade starts with dimming effect A from 100% to 0% for the first half of

the fade time. Effect B remains at 0% during this time. Then, halfway through the fade

procedure, effect B starts to increase until 100% shown. Effect A was already at 0% and
remains at this level for the rest of the fade.

Since both effects are shown with 0% in the middle of the fade, this always results in a black

output, and therefore the name.
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— Preview A — Preview B Color C
Color-Fade
100%
0%
A Output B
Preview A: 255.0.0 Preview A: 0.0.0 Praview A: 0.0.0
Preview B: 0.0.0 Preview B: 0.0.0 Praview B: 0.0.255
Preview Output: 265.0.0 Color C: 0.265.0 Preview Output 0.0.255
Preview Output: 0.255,0

Tt
L
Essentially, a color-fade in MADRIX does imitate a black-fade (see above). Effect
A is dimmed to 0% first and afterwards effect B increases linearly from 0% to 100%.

But on top of that, a color is added. While effect A is reduced in intensity, the color C gains
intensity. In the middle of the fade effect A and effect B stand at 0%, but color C stands at
100%. When effect B reaches 100%, color C is reduced to 0% again.

In the middle position you will not see effect A or B, but only the color you picked. The

"FaderBox" button or the Color Picker enable you to choose the color for the color-fade.
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Color Filter

You can also choose to activate a Color Filter. Such a filter filters the colors

used in the effects of Storage Area A or B. Simply select the color using the Color Picker or the

Color FaderBox in the upper right corner of the Fade Area, and a color filter is activated. The color

"white" is the default setting and means that no filter is active.

The color filter works in multiply mode. That means that the colors of the effects are multiplied

with the colors of the filter (Effect x Color Filter). Both, effect and filter, are represented through
RGB or RGBW mode (RGB(W) x RGB(W). Moreover, every single color of the effect will be multiplied

with the corresponding color of the filter (Rx R, Gx G, Bx B, W x W). You will see the relation in

the following table.

Effect X Color Filter The colors of the effects are multiplied with the
colors of the filter.
results in
RGB(W) X RGB(W) Effect and filter are represented through RGB or
RGBW mode.
results in
R X R Every single color of the effect will be multiplied with
G X G the corresponding color of the filter.
B X B
(W) X (W)
Example 1 in RGB Mode
SCE Color X Color Filter = Result
Yellow Green Green
255 X 0 - 0
255 X 255 _ 255
0 X 0 - 0
Example 2 in RGB Mode
SCE Color X Color Filter = Result
Red Green Black
255 X 0 - 0
0 X 255 - 0
0 X 0 - 0
Example 3 in RGB Mode
SCE Color X Color Filter = Result
Turquoise Pink Blue
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255
255

x

255

255

Other Functions

By activating the "Freeze" button you can put the output on hold (freeze). Click it and

hold the mouse button. Double-click it to freeze it permanently.

The Fade Area also includes a macro button. This button activates the "Main Output

Macro", a macro generally comparable to macros for effects. But in contrast, this macro affects

the entire main output. You can find more details in the chapter Macros & Scripts.
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24 Storage Areas A& B

Overview

Storage Area A and Storage Area B are located below Preview A and Preview B. Those two areas
contain 60 Storage Places each and a number of other elements. Storage Area A and Storage

Area B are sometimes referred to simply as Storage A and Storage B.

Storage Places

E Every single number form 1 - 60 represents one single Storage
Place. Storage Places are used to store your effects. If you hover
with your mouse over a Storage Place, you will see a preview of the

effect shown as thumbnail.

Working with Storage Places is described in more detail in the

chapter Storage Places, Submaster, and Cue.
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Other Elements

Submaster

The "Sub" button can be used to adjust the intensity of a Storage

Place. Learn more in the chapter Storage Places, Submaster, and Cue.

Cue

e Using the "Cue™ button will automatically add the activated Storage
Place to the Cue List. Learn more in the chapter Cue List.

Description Field

ETEEE Usc this field to enter a description for your effect. This is is

very useful if you are going to use the Cue List, Thumbnails, or if

you wish to copy Storage Places or save them.

Storage Place Macro

This button opens the Storage Place Macro Editor. Storage Place
macros affect an entire Storage Place including its effect and all of its
layers. You could change the opacity of three different layers of this
effect at the same time, for example. You can find more details in the

chapter Macros & Scripts.

Speed Master A And B
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The so-called Speed Master is a fader that is positioned on every
Storage Area. The fader allows you to speed up and slow down effects.

Below such a fader you can find a "Pause" button. Learn more in the
chapter Speed Master.

25 Effect Areas A & B

Overview

The MADRIX interface is equipped with two effect areas (Effect Area A and Effect Area B). By
default, it will look like this:

SCE  Color
=ubr farmal Lk

Calar
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Standard Buttons And Controls

Selecting An Effect

SCE Color Via a drop-down list in the upper left corner of such an Effect
Area, you can select one of the various effects. Read more
information on how to work with effects in the chapter Effects.

Learn more about the different effects in the chapter MADRIX
Effects.

Layer Opacity

Regulate the intensity of a single layer with the help of this

slider or input field. The chapter Layers will give you more
information.

Blind And Solo Mode

E H These are the "Blind" button and the "Solo" button. The chapter
Layers will give you more information.

Submaster
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Mapping

Mix Modes

Link Mode

i

To adjust the intensity of an effect or layer, please click and hold the
"Sub" button. Make adjustments by moving your mouse up or down.
An activated Submaster will turn green. More details can be found in

the chapter Storage Places, Submaster, and Cue.

The Submaster allows you to solely adjust the intensity of the
running effect or layer. To adjust the intensity of all running effects
you have to use the Master Fader.

If you want to map, tile, or rotate an effect, please click the "Map"
button. A new window will open. The features are described more
precisely in the chapter Map, Tile, And Rotation.

This button sets the mix mode and functions as a drop-down list. Just
like in image-editing software, you can use different mix modes to mix
layers with each other. The button is labeled "Normal" by default.

You can find more information in the chapter Layers.

This "Link" button activates the option to link layers. Linking layers is
very useful to create new effects. Please read the next chapter

Layers for more information about this topic.
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Storage Place Macro

Reset

Frame Fade

e

Layer Tab

4 Color Change *

Layer Button

This button opens the Storage Place Macro Editor. Storage Place
macros affect an entire Storage Place including its effect and all of its
layers. Fore example, you could change the opacity of three different
layers of this effect at the same time. You can find more details in the
chapter Macros & Scripts.

All effects have a reset button "R". This button restores default
settings of the single layer and thus the effect.

Several effects have an additional "Frame Fade" button. This feature
creates a very smooth effect; especially when slow movements are

involved. It renders the output more softly. An activated button will
turn green.

Every layer has its own tab at the bottom of an Effect Area. Learn
more in the chapter Layers.

© 2011 inoage GmbH



73 MADRIX Help and Manual

This button provides several options to work with layers. A context

menu will appear. Learn more in the chapter Layers.

Tips
Perform a double-click on sliders, faders, etc. and they will be reset to their default value.

Use the spacebar on your keyboard to perform various actions. If the selected control is a
button, the button will be clicked. If the selected control is a check box, this toggles the check
box. If the current control is an option, this selects the option. If an edit field (Color Edits) is

selected, you can switch between the values 0 and 255.
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Individual Buttons And Controls

Each effect has its own buttons and controls. Have a look at the three examples below and you
will see that the standard controls (which are described above) are always there, while the middle

part changes with every effect.

SCE Bounce
1| 4l ) ] farmal Link

Colar Table
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Frequency Flash W

=) Mormal Link
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hap Mormal

Calar
Time Slot

hdowe

Fuasition

2.6 Cue List Section

Overview

Cuetist

The MADRIX GUI offers 4 buttons to control the Cue List. Before they can be
used, a Cue List needs to be created and configured. Learn more about the Cue List.

© 2011 inoage GmbH



Graphical User Interface (GUI) 76

Buttons

[P

cue st

Press "Go" to skip to the next Cue List entry.

Press "Back" to go back to the previous Cue List entry.

Use this button to play or stop the Cue List.

This button opens a new window, which is the Cue List itself. More options
will be available to you then.
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2.7 Master Fader & Audio Level

Master Fader

The user interface is equipped with a "Master Fader". This fader sets the overall
brightness of the output and your fixtures. You will see the result in the Preview Output. It will not

affect the two other previews. But of course, it will affect the intensity of your LEDs.

Use the input field to directly set a certain value with a range from 0 to 255. When

using the Master Fader, you will see that this field displays the currently used value.

The "Black™ button forces an immediate blackout on the output. Click it once to
render the output completely black. It does not affect the Master Fader. Click again to deactivate

the function. Using this feature should be an exception.
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Audio Level

IIIII::I:l::I

230
L JU
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AU

The MADRIX GUI includes a level control too see the incoming audio signal. The fader

allows to adjust the input level.

Use the input field to directly set a certain level ranging from 0 to 255. When using

the fader, you will see that this field displays the currently used value.

The "Audio" button needs to be activated to see the incoming audio signal.

Learn more in the chapter Using the Audio Analysis.

2.8 Touch Screen
Overview
General

The touch screen interface was especially designed to provide you with an intuitive and easy to
use interface.
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Go to the menu "Window" -> "Touch..." (or press "F8") to open the touch screen.

If it is enabled in the settings, you can open/close the touch screen window by pressing the

MADRIX logo.

SMADRIX

= MUSIC MAKES THE LIGHT

e ey
H} |
Flwe B CF

L

\*f"u‘“lll.. ..|I|||||

Important Notes

In order to ensure performance of MADRIX, all three previews will switch from the main

MADRIX window to the touch screen interface when it is selected.

_all
Please note: If you have installed a second, third, etc. monitor, you can

easily move this touch window to the first, second, third, ... computer display by pressing

the Tabulator key on your keyboard.
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Number Of Storage Places

MADRIX allows you to choose the number of Storage Places that will be displayed. The buttons
will be scaled automatically to the resolution of your screen. Simply change the settings according
to your needs (please read below how to change them). You can use 3, 12, 24, 40, or 60 Storage

Places. Please note that this is the number of Storage Places per Storage Area/ per side.

3 Buttons Per Side 12 Buttons Per Side

SMADRIX

bl 1111 o
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Settings

To access options of the touch screen, please press "Ctrl+Alt+0" or go to the menu
"Preferences" -> "Options". A new window will open. Then, navigate to the tab "User

Interface".

The option "Use Automatic Fade™" can be a helpful support tool. Use it if you wish MADRIX to
perform an automatic fade when switching from one effect to another effect in the opposite
Storage Area (for example from effect 1 in Storage Area A to effect 1 in Storage Area B). You can
define the length of the fade using the input field "Max. Fade Time" (in seconds).

Enable "Open/Close With Touch On MADRIX Logo" if you want to be able to close the Touch
Screen Window by pressing the MADRIX logo. Likewise, you can open the window by clicking the
the MADRIX logo on the graphical user interface.

"Storage Button Count" sets the number of Storage Places per side. It sets how many Storage

Places will be displayed. You can use 3, 12, 24, 40, or 60 Storage Places.
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3 Using The Software
Introduction

MADRIX already is an easy to use, user-friendly, and reliable Windows® software for the creation

of complex lighting scenes and entire shows with matrix control.

In order to make you more comfortable in handling the software, in this chapter you will
learn how to use MADRIX.

3.1 Matrix Generator

Overview

FProtocal :
Fizture :
Ratatian s | Crigina

Count = :

Start Corner: | Top Left

hlain Orientation : | Horizontal
Snake Mode : T Wiith Fixture Rotation ')

. Stat Channel :

tart Universe :

After starting the application, it is required to configure your light matrix in MADRIX. To do so,
please open the "Matrix Generator" ("F2" or "Preferences" -> "Matrix Generator"). A new

window will open. Now, please configure your light matrix according to the next steps:
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Protocol

Please choose which kind of LED fixture you are using. You can choose between "DMX" and "DVI"

. If you wish to used both types, please use the Patch.

Please note: If a DVI fixture is selected, all controls that are only relevant to DMX512 fixtures will

be disabled.

Fixture

According to your selection of the "Protocol" (please see above), you can now select your lighting

fixture in the drop-down list called "Fixture".

If your fixture is not yet implemented, please have a look at the chapter Fixture Editor or ask for

support.

Fixture Rotation

MADRIX offers the possibility to set the rotation of a fixture. Please mind that a change will affect

the whole matrix. All fixtures will be rotated! Rotation is currently not possible for DVI fixtures.

© 2011 inoage GmbH



85 MADRIX Help and Manual

Count X, Count Y

More importantly, you need to define the number of LED fixtures that
are installed in your set-up. "X" sets the quantity of horizontally mounted fixtures, while "Y" sets
the number of lighting fixtures with vertical alignment. Both values make up the whole matrix. In

our example you will get a matrix with 100 pixels (10x10 pixels).

Please pay attention to how your fixture is patched. Some fixtures are already implemented with

their specific number of pixels, for example 32x48 pixels.

Please enter the number of fixtures you are using and not the total number of pixels.

"Merge Fixtures" becomes available when using the protocol type "DVI".

Deactivate the option if you wish to create an individual DVI Patch.

When using DVI or related protocols, please pay attention to the maximum number of supported
DVI pixels according to your MADRIX version and according to the performance of your PC.
When using DMX or related protocols, please pay attention to the maximum number of DMX

channels according to your MADRIX version and according to the performance of your PC.

DMX Start Corner

Top Right
Bottom Left
Battom Righit

With the help of the "DMX Start Corner" it is possible to specify
where DMX addressing starts.
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Main Orientation

The option "Main Orientation" defines the (horizontal or vertical) orientation of the set-up. A

helpful picture in the Matrix Generator dialog will show you how your set-up is configured:

DMX Start Corner Main Orientation: Horizontal Main Orientation: Vertical

Top Left

Top Right

Bottom Left

Bottom Right

Snake Mode

- ]

Activate "Snake Mode" if you are handling DMX addressing as shown
in the picture, for example. You can use snake mode in addition to the fixture rotation. A helpful

picture in the Matrix Generator dialog will show you how your set-up is configured.

Hint: If you have snake mode and fixture rotation activated, every fixture in your second line will
be rotated by 180°.
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Example:

In this example we configured a light matrix of 4 x 5 pixels using snake mode. The Matrix Generator

would look like this:

Fizture © g
Fixture Rotation :
Count X :
C art Camer: | Top Left

Main Orientation : | Horizontal

& 'E' Wiith Fixture Rotation '™

In theory, the LEDs are arranged as follows: 3 pixels per LED (due to RGB), 4 fixtures per row, and

5 rows. Please see the picture below.
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DMX Start Channel/DMX Start Universe

In a final step, you have to select the "DMX Start Channel" as well as the "DMX Start

Universe", which is the start universe. If fixture addressing is greater than the number of

channels of one universe, the corresponding fixtures will be added to a new universe

automatically. For example: Per 512 DMX channels, 170 RGB fixtures can be controlled. That

means, calculating 170 fixtures * 3 channels results in 510 DMX channels. Therefore, channel 511

and 512 will be left empty. And if your are using more then 170 fixtures, those will be assigned to

a hew universe.

Please check your LED installation for linear addressing of the lighting units in horizontal and

vertical direction.

Important Notes

LED Fixtures

Comments
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EUROLITE LSD The fixtures are pre-patched and included with their
amount of pixels. Please only define how many fixtures

you are using and not the total number of pixels.

Color Kinetics eW Flex SLX, If your are using a PDS-150, a sPDS-480ca, or a PDS-

Color Kinetics iColor Flex SLX 60ca with one or two strings per controller, please select

the correct fixture.

Further Configuration

If you want to patch the addresses of your fixtures manually or if you want insert more lighting
fixtures, please click inside the menu "Preferences" -> "Patch". More information is given in the

next chapter Patch.

If you would like to configure your LED fixtures, please have a look at the chapter Fixture Editor.

Further Tips

Please make sure to save your MADRIX Setup after the configuration process.

3.2 Patch

Introduction

After starting up MADRIX, it is necessary to configure your light matrix.

You can either use the "Matrix Generator" for this task or the "Patch". Please see the chapter
Matrix Generator for simple tasks. The Patch described in this chapter offers many more options
and allows to configure your virtual matrix in great detail. The Patch allows you to configure DMX

and DVI fixtures freely and individually.
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If you are working with DMX, please read this chapter. If you are working with DVI fixtures,

please read this chapter and the chapter DVI Patch.

Patch and DVI Patch are one and the same tool in MADRIX. The term DVI Patch specifically

refers to using DVI fixtures.

To open the Patch, go to the menu and click "Preferences" -> "Patch" or simply press the key
llF3ll.

The Patch dialog is a separate window. Hence, you will be able to control MADRIX while working
with the Patch.
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Overview

Layout

The patch is divided into different main sections. In addition to the menu and the toolbar, you will

find three large columns.

EE—

Patch Size | Add Delete

luuz
+

ighlight Owverlap  Link  ( 1Maps  Auto Address

Frtre

The first column on the left side is a list, which contains the different fixtures and their assigned
start channel. A drop box above this list allows you to select the DMX universe or the DVI

category. If the DVI category is displayed, the DVI Mapping status is shown.
The second column represents a graphical version of your virtual matrix.

The third column includes the information regarding the "Fixture Settings", "DVI Mapping", and the

"Fixture Description".

You can rearrange the width of each column by dragging the column edges. Moreover, you can
hide the columns if you drag them to the border of the window. They will snap back into view if
you drag the border back far enough.

If you wish to reset the layout of the Patch dialog, please navigate to the menu "View" ->
"Reset Layout".

Visualization
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DMX Channel :
DMX Universe :
Position X -

Position ' :

r DVI Mapping
Flipping
Rotation :
Position X :

Position ¥ :

1 Fidure Description

The workspace is represented with the help of a dark grey grid. The virtual matrix or patch is

represented with the help of a light grey grid.

oo uood
coo1 Co04 Ccoo07

uoa uoo uoa
C016 Co13 co10

DVI fixtures are displayed in dark yellow. Selected DVI fixtures are displayed in yellow. DMX

fixtures are displayed in dark green. Selected DMX fixtures are displayed in green.
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The Patch Menu

You can find the menu in the upper section of the Patch including File, Edit, Select, Preferences

, and View.

File Menu

| File

Mew Chrl+M
Open Patch... Ctrl+C
Save Patch Ctrl+5
Save Patch As... Ctrl+Alt+5
Close F3

The File Menu includes "New" (or "Ctrl+N"), "Open Patch..." (or "Ctrl+O"), "Save Patch" (or
"Ctrl4+S"), "Save Patch As..." (or "Ctrl+Alt+S"), or "Close™" (or "F3"). These functions are self-

explanatory.
Edit Menu
Edit

Undo Ctri+Z
Redo Ctrl+Y
Patch Size...
Add Fidures... Ins
Delete Selected Fixtures Del
Reset Selected DVI Maps Ctrl+R
Rotate Selection by 90° Page Down
Rotate Selection by 180°
Rotate Selection by 270° Page Up
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Use "Undo" (or "Ctrl+Z") in order to restore the previous state of the Patch. "Redo" (or "Ctrl+Y")

can be used to recreate the state after having performed an undo.

The menu entry "Patch Size" will call up a small dialog to change the major settings of your

virtual matrix (size and color depth).

"Add Fixtures..." (or "Ins") will call up a dialog similar to the Matrix Generator. Here you can set
up the fixture or set of fixtures you want to add to your virtual matrix. Please always remember
that there is a specific function called "Allow Overapping" in the preferences menu. If overlapping
is allowed, fixtures will be placed on top of existing fixtures in the Patch. If it is deactivated, you
cannot place any fixture to a position that is occupied by another fixture in the Patch. Likewise,

you may simply "Delete Selected Fixtures" (or "Del").

"Reset Selected DVI Maps" is only relevant when working with DVI fixtures. Please read the

chapter DVI Patch for more information.

"Rotate Selection by 90°" (or "Page Down"), "Rotate Selection by 180°" and "Rotate
Selection by 270°" (or "Page Up") can be used to quickly change the rotation of a single fixture
or even multiple fixtures. If you select multiple fixtures and use these functions, the entire block of
fixtures will be rotated. They will be literally rotated using the central point of all fixtures. Hence,
the position of the fixtures change automatically. In contrast, if you select several fixtures and
adjust the "Rotation" in the "Fixture Settings" in the third column of the Patch dialog, each fixture

will be rotated individually. Their positions will not change.

Select Menu

Select All Ctrl+ A
Deselect All Ctrl+D
Invert Selection Ctrl+I

"Select All" (or "Ctrl+A") can be used to select every single fixture in the Patch. Simultaneously,

the fixtures will be highlighted and selected in the left column, which is the list of fixtures.

Use "Deselect All" (or "Ctrl+D") to drop your current selection.
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"Invert Selection” (or "Ctrl+I") will select every fixture except the ones you have currently

selected.

Preferences Menu

Preferences

Highlight Selected Fidures
Allow Overlapping

v Link DVI Maps And Fistures Ctrl+L
Copy DVI Maps With Fixtures

v Auto Address Copied DM Fidures

Options... Ctrl+Alt+0

"Highlight Selected Fixtures" will make corresponding fixtures flash for a better identification.

This makes it easier to see them on stage.

"Allow Overlapping" allows fixtures as well as DVI Maps to be arranged on top of each other in
the virtual matrix. If overlapping is allowed, fixtures or DVI Maps will be placed on top of existing
fixtures or DVI Maps in the Patch. If it is deactivated, you cannot place any fixture or DVI Map to

a position that is occupied by another fixture or DVI Map in the Patch.

"Link DVI Maps And Fixtures" (or "Ctrl+L") is only relevant for the DVI Patch. It links DVI fixtures

and their corresponding DVI Maps together when applying a transformation (position, rotation, or

flipping).

"Copy DVI Maps With Fixtures" is only relevant for the DVI Patch. It allows you to copy
corresponding DVI Maps along with their DVI fixtures without resetting the settings of the DVI
Maps.

"Auto Address Copied DMX Fixtures" enables auto addressing for DMX fixtures only. Auto

addressing is explained below.

"Options..." (or "Ctrl+Alt+0") will call up the options dialog of the Patch.

View Menu
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View
VI Map Mode Ctrl+M
Zoom In Ctrl+Plus
Zoom Out Ctrl+Minus
Focus All Ctrl+0
Focus Selection Ctrl+F

v File Toolbar

v Edit Toolbar

v Select Toolbar

v Preferences Toolbar

v View Toolbar

Reset Layout

You can show or hide the various elements of the toolbar. The "File Toolbar" refers to options
regarding the Patch files. The "Edit Toolbar" refers to options regarding working with the Patch
itself. The "Select Toolbar" includes options to select fixtures. The "Preferences Toolbar"
includes options for various settings. The "View Toolbar" includes options referring to the layout
of the Patch.

The next features will influence the appearance of the second column, the graphical patch itself:

"Zoom In" (or "Ctrl+Plus"™) or "Zoom Out" (or "Ctrl+Minus") will determine the level of detail.

Zoom in to see single fixtures, their assigned universe, channel, and rotation.

The option "Focus All" (or "Ctrl+0") will display all fixtures (and their DVI Maps) you have patched
in their full size to fit the width of the column. In contrast, "Focus Selection" (or "Ctr+F") will
zoom in to the highest level containing the selected fixtures (and their DVI Maps) in order to have
a detailed view of it.

"DVI Map Mode" is only relevant when working with DVI fixtures. Please read the chapter DVI

Patch for more information.

If you wish to reset the layout of the Patch dialog to its original settings, use the option "Reset

Layout".
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The Toolbar

The toolbar provides shortcuts for the most convenient tasks and includes the majority of options,

which are also included in the menus.

Working With The Patch

Navigation

Press Space and use a left-click in order to drag the graphical patch.

Or you can use the scroll bars to navigate in detailed view.

Zooming

In addition, to the functions you can find in the menu (with their keyboard shortcuts), you can
use the mouse wheel to zoom in and out. Please note that the description text and the icons on

the fixtures do not scale, that means that they will only be visible in high zoom levels.

Selecting Fixtures

You can select fixtures in the list to the left and they will be automatically selected in the
graphical patch. This also works when you select several fixtures in the list using the "Shift" or
"Ctrl" button.

The graphical Patch itself offers various other possibilities to select fixtures:

Simply move your mouse, "left-click" a single fixture, and you will have selected this fixture. If you

want to deselect a single fixture, hold "Ctrl" while clicking it again.
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If you want to select several fixtures, simply hold the "Ctrl" button while using a "left mouse-

click".

There is also a selection box to select multiple fixtures. To use the selection box hold "Shift" first.
Then, hold your left mouse button and drag your mouse. A selection mask will become visible. It is
displayed with the help of a dotted line. Additionally, hold the "Ctrl" button and you will be able to

select different areas of the patch which will be added to your selection.

Additionally, hold the "Shift" button, "left-click" the first fixture, then "left-click" the last fixture,
and applying a rectangular selection mode, every single fixture between the first and the last
fixture will be selected. Hold the "Ctrl" and the "Shift" button at the same time and you can select

different fixtures each time, while the previously selected fixtures remain selected.

Use "Ctrl+A" to select every single fixture in the Patch (select all). Simultaneously, the fixtures will
be highlighted and selected in the left column. Use "Ctrl+D" to drop your current selection
(deselect all). "Ctrl+I" will select every fixture except the ones you have currently selected (invert

selection). These options are also available in the menu and the toolbar.

Interaction

You can apply drag & drop to a single fixture. Simply select it and hold the mouse button. Then,
move your cursor. Your selection will stand out from the rest of the patch. Drop it on the new
position and it will automatically snap to this position according to the grid.

This also works with multiple fixtures.

Use drag & drop together with the "Ctr" button to copy fixtures and the DMX universe and DMX
channel will be automatically adjusted if this option is activated. For more details, please see

below (Copying Fixtures).

Select one or several fixtures and use the arrow keys on your keyboard to move themto a

different position.
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If you select multiple fixtures and use "Page Up" or "Page Down" on your keyboard, the entire
block of fixtures will be rotated. They will be literally rotated using the central point of all fixtures.
Hence, the position will be changed automatically.

In contrast, if you select several fixtures and adjust the "Rotation"” in the "Fixture settings”,

each fixture will be rotated individually. Their positions will not change.

Undo And Redo

Use "Undo" (or "Ctrl+Z") in order to restore the previous state of the Patch. "Redo" (or "Ctrl+Y")

can be used to recreate the state after having performed an undo.

By default, the Patch allows 500 steps to be reversed. You can change the so-called "History
Size" in the Options. Go to the menu "Preferences" -> "Options" or press "Ctrl+Alt+0".

[

Worcspace

iidth :

Height : 12 =
_T

Undo Hista -3 500 =
| SE————|

pitaslp Heln

Using The Workspace

The workspace allows you to freely work with fixtures in the Patch. It is shown via a dark grey

grid. By default, the size is set to 512x512 pixels.

You can change the size of your workspace in the Options. Go to the menu "Preferences" - >

"Options" or press "Ctrl+Alt+0".
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Height :

Undo Historny Size :

Changing The Size Of The Virtual Matrix

The virtual matrix defines the actual Patch area. It represents your LED fixtures and therefore the
area on which the MADRIX effects are rendered and displayed.

Go to the menu "Edit" - > "Patch Size" to change the main settings of your virtual matrix.

Dimension X :

Dimension " :

Colar Depth :

"Dimension X" determines the number of pixels in x. "Dimension
Y" sets the number of pixels in y. "Color Depth" represents the number of colors your LED
fixtures support. A color depth of 3 resembles RGB mode, while a value of 4 represents RGBW

mode. If you operate an one-channel lighting fixture installation, set the color depth to 3.

Please remember to change the Color Depth if you added 4 color LED fixtures.
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Adding New Fixtures

If you go to the menu "Edit" -> "Add Fixtures..." a dialog comparable to the Matrix Generator
will open. Or, you could simply press "Ins" on your keyboard. According to the settings, one or

more fixtures will be added to the patch at the specified position.

Please note: You can add fixtures from different manufacturers and you can also add
fixtures that are of different types, i.e. DMX or DVI. In this way, you can create your own

individual Patch according to your requirements.

Fizture s I

Ratation = Criginal

Count ¥ : - N 1 — 'B' erge Fidures

Start Camer: | Top Left

Main Orientation : H

Detalt

Press "Default" if you wish to reset this window to its original settings.

Please pay attention to "Start Position X" and "Start Position Y" as those values define where
exactly the fixture or fixtures will be added to the workspace. If a fixture is already patched to
this area, you will get a notification that the fixture positions overlap. Please choose a different

start position then or activate "Overlap" if you really want the fixtures to overlap.
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"Merge Fixtures" becomes available when using the protocol "DVI".
Deactivate this option if you wish to patch DVI fixtures individually. If the option is activated, all

fixtures will be merged to one, single DVI fixture.

Please remember to change the Color Depth if you added 4 color LED fixtures in the option "Patch

Size".

For more information about this dialog, please read the chapter Matrix Generator.

Deleting Fixtures

You can easily delete fixtures. Select the fixtures you want to remove and use the "Delete" icon in

the toolbar or press "Del" on your keyboard.

Copying DVI Fixtures

Single Fixtures

Copying a DVI fixture is simple. Select a single DVI fixture by holding down the "Ctrl" key and the
left mouse button at the same time. Then, drag your mouse and a copy of the DVI fixture will be

created as a result. Finally, drop the fixture at its new position.
Multiple Fixtures

Select multiple DVI fixtures and hold down the "Ctrl" key. Now hold down the left mouse button at
the same time. Then, drag your mouse and copies of the DVI fixtures in a corresponding pattern

will be created as a result. Finally, drop the fixtures at their new position.
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Copying DMX Fixtures / Auto Addressing

Copying DMX fixtures has been improved by adding auto addressing. If auto addressing is
enabled, MADRIX will automatically increase the DMX channel (and DMX universe) of the copied
fixture. You can enable the feature in the Patch menu "Preferences" -> "Auto Address Copied
DMX Fixtures". Disable this feature and the copied fixtures will have the same DMX channel and

universe as their sources.

Please pay attention when using auto addressing and double-check if each fixture is

addressed correctly!

Single Fixtures

Select a single DMX fixture by holding down the "Ctrl" key and the left mouse button at the same
time. Then, drag your mouse and a copy of the fixture will be created as a result. Finally, drop the
fixture at its new position. The DMX channel and the DMX universe will be automatically adjusted
if "Auto Address Copied DMX Fixtures" is enabled.

Example:

The original fixture at position 1,1 is mapped to DMX universe 1 and channel 1. It requires 3 DMX

channels. Therefore the first copy, fixture number 2, is automatically set to channel 4, and so on.

Lood Lo Lo oo

Coo1 Co04 CooF Co10 L

Co13

A A A A A
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Multiple Fixtures

If you select several DMX fixtures, auto addressing also works. The intelligent function calculates
the next free DMX address for each of the copied DMX fixtures and automatically adjusts the DMX

channel and the DMX universe for each fixture.
Example 1:

A row of four linearly addressed fixtures shall be copied at once (6 DMX channels per fixture).
Result: Each fixture will be addressed to the next free DMX address in comparison to the previous

fixture.

uoo1 uoo1 uaod uaod
cool Coo7 Co13 Co19

uoo1 uoo4 uaod uaod
025 C031 co37 Cco43

Example 2:

A row of four linearly addressed fixtures shall be copied at once, while fixture number 3 has a
higher address than fixture number 4 (6 DMX channels per fixture). Result: Fixture number 7 has

also a higher DMX address than fixture number 8.

oo uoo uoo1 uoo1
Coo1 o007 co18 C013

oo uoo uoo1 uoo1
C025 C031 Co43 Co37

Example 3:
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A row of three linearly addressed fixtures should be copied at once, while spacing and an offset is

added to fixture number 3 (6 DMX channels per fixture). Result: Fixture number 6 continues with

the next free addressing of fixture number 5 and does not have an additional offset, while keeping

the spacing.

uoo1
Coo1

uoa
co19

uoo1
coo7

uoo1
co2s

Highlight Selected Fixtures

uoo1
co13

uoo1
Co31

Activating this option will make corresponding fixtures flash for better identification. This makes it

easier to see them on stage/in your LED installation. That means, if you select one or several

fixtures within the Patch dialog, the corresponding devices in your installation will light up.

Allow Overlapping Fixtures

This feature allows fixtures in your virtual matrix to overlap. In order to rearrange the virtual

matrix, a fixture may be dragged/repositioned to the position of another fixture.

© 2011 inoage GmbH



Using The Software 106

Error And Information Messages

The Patch comes with an integrated message system. Depending on the issue, an information box
will be displayed at the bottom of the second column. The following image is an example of a
message. If overlapping fixtures are not allowed and you would want to relocate a fixture to an

occupied position, the following message appears:

The fixtures' poztions overlap! Please change the settings or allow overlapping explicitly.

Fixture Settings, DVI Mapping & Fixture Description For Single

Fixtures

Overview
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Fodure Settings
Short Name :
Fipping
Rotation @ «
DMX Channel :
DMX Universe :
Position X :
Pasition ¥ :

DVl Mapping
Flippi
Rotation
Posit
Posttion Y :

Fodure Description

To configure a fixture within the Patch dialog
window, just select it in the list to the left or via your virtual matrix. You may use the mouse or
the arrow keys on your keyboard to navigate through the list. The according information will be
displayed in the third column.

Every single fixture has its own "Fixture Settings". You can edit the short name, flipping, rotation,
DMX channel, DMX universe, and its position in the virtual matrix. Moreover, values can be
adjusted using an offset, which can simplify the set up process. Please apply every single change

by pressing "Ok". "Reset" can be used to restore original settings.

The section "DVI Mapping" is only relevant for DVI fixtures. Please read the chapter DVI Patch for

more information.

A detailed "Fixture Description" of the fixture will be given as well.
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Fixture Rotation

Fixture rotation is shown for both DMX and DVI fixtures with the help of a solid arrow.

(A small baseline indicates the opposite direction of the direction the arrow shows)

0° 90° 180° 270°

Fixture Flipping

Fixture flipping is shown for both DMX and DVI fixtures with the help of a double arrow/Two-way

symbol. (If a fixture is not flipped, no symbol will be shown)

Flipping is applied to the original fixture position, before rotation.

None Flip H FlipV Flip HV
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Fixture Settings, DVI Mapping & Fixture Description For Multiple

Fixtures

Fodure Settings
Short Mame

Flipping : D Mone

Ratation = Original v (SCifset

DM Channel - 1 2. Offset

DM Universe - 1 5. Offset

Position X 15 Offset

Position Y 1 5 Offset

DVl Mapping

Flipping v o Mone e

Pasition Y :

Fodure Description

Limit values

I_ini\a erses - 001

To configure multiple fixtures within the Patch
window, you can simply select them in the fixture list to the left side of the screen by using and

holding "Ctrl" or "Shift" while clicking in order to select several devices.

The according information will be displayed in the third column. The usual "OK" and "Reset" buttons
below the settings will vanish and several new "Ok" buttons will emerge. Simply change the

specific settings and apply the changes by pressing "Ok".

For example if you select several fixtures and adjust the "Rotation" in the "Fixture Settings", each

fixture will be rotated.

A detailed "Fixture Description" will provide a summary about the selected fixtures as well.

© 2011 inoage GmbH



Using The Software 110

Exporting Fixtures From The Patch

—ave FixIlre A

If you wish to save a fixture directly from the Patch, without using the
Fixture Editor first, select the fixture and use the button "Save Fixture As". MADRIX will save it

on your hard disk as an MADRIX Fixture in *.mfx file format. Simply choose a name.

How The Patch Affects The Internal Previews

Preview A, Preview B, and Preview Output will be influenced by the individual Patch you are
creating. If you create a pattern, these Previews will reflect your LED installation. Learn how to

use this feature in the chapter Preview Windows.

Further Tips

Please make sure to save your MADRIX Setup after the configuration process.

You may also save and/or export the Patch file (*.mpf) separately.

3.3 DVI Patch

Introduction

This chapter is an addition to the chapter Patch. Please read the chapter Patch in order to learn

more about the Patch in general. This chapter DVI Patch focuses on working with DVI fixtures.

Patch and DVI Patch are one and the same tool in MADRIX. The chapter DVI Patch

specifically refers to using DVI fixtures.
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To open the Patch, go to the menu and click "Preferences" -> "Patch" or simply press the key
IIF3II-

Usage

Working with DMX-based fixtures is relatively easy and can be managed with the help of the
MADRIX Patch without much difficulty. You can simply add rotated fixtures or add space between
fixtures, for example. Without the MADRIX DVI Patch it would not be possible to add rotation or

spacing to DVI-based fixtures, because of how DVI hardware controllers work.
The DVI Patch allows you to add

e rotation

e flipping

e spacing

to your DVI-based installations.

How DVI Hardware Controllers Work

DVI controllers receive a signal (input) and map it to the LED fixtures (output). But due to their
construction, DVI controllers need to receive the input images in a linear way, in one whole block
of information (often like a rectangle) - no matter how the actual LED installation looks like.

You could also say that DVI controllers expect DVI fixtures to be installed in a predefined way. If

you install them differently, you need to change the input, too.

In other words, when your LED installation looks like this for example:

n

Then your DVI controller will probably need the input signal to look comparable to this:

© 2011 inoage GmbH



Using The Software 112

MADRIX will transform the signal for your DVI controller according to your Patch configuration.

While the DVI fixtures represent your LED installation in MADRIX and its Preview Windows, so-
called DVI Maps represent how the controller should receive the signal. As shown above, DVI
fixture and DVI map often are two different things if you add rotation, flipping, or spacing. That is
why in MADRIX you will have to configure both DVI fixture and DVI map separately. The DVI Patch
provides a normal view and a view called "DVI Map Mode", which makes it possible to configure
both.

Basic Workflow (Step By Step)

In order to work with DVI fixtures, please follow the instructions below:

Step 1) Position your DVI fixtures in the workspace of the Patch according to your LED

installation.
Step 2) Set the size of your virtual matrix. (It normally includes all of your DVI fixtures.)
Step 3) Activate the DVI Map Mode (Ctrl+M) in the Patch.

Step 4) Position the DVI Map of every DVI fixture according to the requirements of your DVI

hardware controller. (The first DVI Map normally starts at position x:1, y:1.)

Step 5) Activate the DVI Map Mode of the external DVI Output window(s).

Step 1 and 2 are explained in more detail in the chapter Patch.

Step 3, 4, and 5 will be explained below.
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Step 3, 4, and 5 are only necessary, if you wish to add spacing, rotation, or flipping to

your DVI fixtures.

DVI Maps & DVI Map Mode

Overview

DVI Map Mode
DVI Maps represent the fixture configuration for the DVI hardware controller. DVI Maps have the
same size as the fixture, but they have their own position, rotation, and flipping settings.

In order to work with DVI Maps, you need to activate DVI Map Mode. You can activate DVI Map
Mode in the Patch menu "View" -> "DVI Map Mode" or by using the shortcut "Ctrl+M".

You only need the DVI Map Mode if you are using DVI fixtures in a different way than

what the DVI controller expects.

Comparison of Normal Mode and DVI Map Mode

DVI Maps in Normal Mode DVI Maps in DVI Map Mode
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DVI Maps are inactive in Normal Mode. They
are shown in grey with a grid.

(Column 1 shows a selected fixture and map.
Column 2 shows a non-selected fixture and

map.)

DVI Maps are active in DVI Map Mode. They are
shown in yellow with a grid.

(Column 1 shows a selected fixture and map.
Column 2 shows a non-selected fixture and

map.)

When DVI fixture and DVI map have the same

position, the DVI fixture is shown.

When DVI fixture and DVI Map have the same
position, the DVI Map is shown.
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By default, DVI fixture and DVI Map
are linked together. If a setting, such as
rotation, is set for the fixture or the DVI Map,
the opposite element (which then is the DVI
Map or the fixture) will receive the same
setting or a corresponding offset. Deactivate
the feature in the menu "Preferences" ->
"Link DVI Maps and Fixtures" or "Ctrl+L". If

activated, the icon glows green in the toolbar.

By default, DVI fixture and DVI Map
are not linked together and can be set up
separately. If a setting, such as rotation, is set
for the fixture or the DVI Map, the opposite
element (which then is the DVI Map or the
fixture) will not receive the same setting or a
corresponding offset. Activate the feature in
the menu "Preferences" -> "Link DVI Maps

and Fixtures" or "Ctrl+L". If activated, the

icon glows green in the toolbar.

(ET
DVI fixtures can overlap, that means

they can be positioned over another. You need
to activate "Allow Overlapping” from the

menu "Preferences". If activated, the icon

glows green in the toolbar.

(ET
DVI Maps can overlap, that means

they can be positioned over another. You need
to activate "Allow Overlapping” from the
menu "Preferences". If activated, the icon

glows green in the toolbar.

Copy DVI Maps

DVI fixtures can be easily
copied. Enable or disable "Copy DVI Maps
With Fixtures" in the Patch menu
"Preferences" to decide how DVI Maps are

handled when copying a DVI fixture.

DVI Maps cannot be copied like DVI fixtures in
DVI Map Mode. Please switch back to normal

mode.
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1) Disabled: If a DVI fixture is copied, the
copied DVI Map is reset to its default settings,
that means to the position of the newly copied
DVI fixtures. In fact, a new DVI Map will be
created for the copied DVI fixture.

2) Enabled: If a DVI fixture is copied, the
copied DVI Map matches the settings of the

source DVI Map or a corresponding offset.

If activated, the icon glows green in the

toolbar.

Reset DVI Maps

Reset one or several selected
DVI Maps by choosing "Reset Selected DVI
Maps" from the "Edit" menu. If pressed, the

icon flashes shortly green in the toolbar.

Reset DVI Maps

Reset one or several selected
DVI Maps by choosing "Reset Selected DVI
Maps" from the "Edit" menu. If pressed, the

icon flashes shortly green in the toolbar.
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DVI Mapping (Interaction & Settings)

DVl Mapping

Hipping : | Cricinal ™ Offset ;| Mone

Rotation : | Criginal | Offset :

Position X :

Position Y :

DVI Maps can be used in the Patch just as any other fixture. In other words, they can be
positioned with the mouse or keyboard, for example. Please have a look at the chapter Patch for

more information on how to work with fixtures and thus DVI Maps.

You may also edit the properties of a selected DVI Map with the help of the section "DVI
Mapping"” to the right. You may change the flipping, rotation, or position of the DVI Map. You can

also use an "Offset" for each of these items.

At the same time, the section DVI Mapping shows all necessary information for the DVI Map.
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Activating DVI Map Mode For The External DVI Output Windows

118

screen-capturing.

Please activate DVI Map Mode for your external DVI Preview window.

Activating DVI Map Mode for the external DVI Preview window is only necessary for

5‘( DVI Map Mode

v | Grid

Stretch Pixels

Show Status Information
Show Clock

DVI Window Settings...
Lock Position

v Always On Top
Use Background Image...

v DVI
Window

Fullscreen

Flip Vertically
Flip Horizontally

Close

Please note: More information about using DVI output can be found in the chapter DVI.

Example

How To Configure Two Rotated EUROLITE LSD 37.5

Normal Setup

The normal setup of two EUROLITE LSD 37.5 fixtures looks like this (schematic):
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Cabling

LAN [N

32x64 32x64 L oun

Power

Example Setup

In this example we will configure the two fixtures to be installed like this (schematic):

P9XeE
4
1

32x64

1. Adding DVI Fixtures
First, we create a new Patch. Please go to the menu "File" -> "New" or use "Ctrl+N".

Second, we add the two fixtures. Please go to the menu "Edit" - > "Add Fixtures..." or use "Ins".

Make sure to not select "Merge Fixtures".
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The Patch will look like this:

DMX Channel :
DMX Universe :
Position X :

Position ' -

VI Mapping
Flipping :
Rotation :
Position X :

Position ¥ :

Ficture Description

Now, we need to rotate both fixtures to match the LED installation:

120
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(If you receive the error message "The DVI mapped positions are out of the valid range! Please

change the settings", then move your fixture or DVI Map towards a free space on your workspace.

)

ooo
All Deselect A

Highlight Owerlap Link C

2. Size Of The Virtual Matrix

Now, go to the menu "Edit" -> "Patch Size". Enter 128 for Dimension X and 32 for Dimension Y. The

virtual matrix now matches the size of both fixtures in total.
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3. Activating DVI Map Mode

Activate DVI Map Mode via the menu "View" -> "DVI Map Mode" or via "Ctrl+M".

AL

tch Size | Add  Delete

ghlight Overlap Link

4. Configuration Of The DVI Maps

Select the first DVI Map and position it at the center of your workspace. Change the "Rotation" to

"Original" in the section "DVI Mapping". Press "OK".

Select the first DVI Map and position it at the center of your workspace. Change the "Rotation" to

"Original" in the section "DVI Mapping". Press "OK".

Then, arrange both DVI Maps next to each other in the upper left corner. DVI Map 1 is positioned

at x:1, y:1 and DVI Map 2 is positioned at x:33, y:1.
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Deactivate DVI Map Mode.

DMX Channel :
DMX Universe :
Position X -
Postion ' :

DVI Mapping

Flipping :
Rotation :
Position X :

Position
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5. Result

Your final Patch should look like this:

GEEE=

Patch Size | Add Delete

As you can see, all DVI fixtures and DVI Maps are visible. The DVI fixtures and therefore the three

internal Previews will represent your LED installation:

The DVI Map needed to be patched separately because the DVI hardware controller expects to

receive the input signal like this (also shown above in the Normal Setup).
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The EUROLITE LSD 37.5 works with the EuroLite T9 protocol. No screen-capturing is needed and

therefore DVI Map Mode does not need to be activated for the external DVI output window.
Tips
Make sure that DVI Maps and DVI fixtures are not linked in DVI Map Mode (Disable Link mode).

If you receive the error message "The DVI mapped positions are out of the valid range! Please

change the settings", then move your fixture or DVI Map towards a free space on your workspace.

Further Tips

Please make sure to save your MADRIX Setup after the configuration process.

You may also save and/or export the Patch file (*.mpf) separately.

34 Tools

Introduction

MADRIX provides several helpful monitoring tools.

Please navigate to the menu "Tools" and select the tool you which to use. Every tool has a
keyboard shortcut as well.

Here is an overview:

e Task Watcher
e Lodfile

e DMX Watcher
e DMX Fader Tool
e MIDI Watcher
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Task Watcher

Color

I

Time in ms) LWl Output Frame

a0 il

H I -'1 -'1

The Task Watcher ("F5") is an important monitoring tool that provides detailed technical

information, mainly about the performance.

126
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Explanation
The window has three parts to it:

Part 1 shows information for the two currently selected effects (on A and B).

Cayer

Bitrap
requency Flash
Color Ramp

Each layer of the effect is shown with its description in the column "Layer". The column "Is"
displays the actual frame rate of the layer. The column "Target" displays the target frame rate of

the layer - the frame rate that should be reached. Both figures should be around the same value.

Part 2 shows eight items.

Ol Output Frames 1, 2

. Contraller Frames (OUT/IN)

LWl Controller Frames (OUT)

Aorailable Memony
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"Mixer Frames" represents the actual frame rate of the main mixer (left side) as well as the
processing time in milliseconds (right side). The frame rate to the left should show 50 frames. The
processing time to the right should show less than 20 milliseconds. If other values occur,

performance problems are likely to occur.

"Audio Capture Frames" displays the actual frame rate of the audio capturing (audio analysis)
as well as its target frame rate. You can configure the target frame rate in the "Device Manager"
under the tab "Audio Input". The standard target frame rate is 50 or 100. The actual frame rate
should be higher than 30. Or else, S2L and M2L effects might judder. A value of -1, says that the
audio analysis is currently deactivated. For ASIO, higher values are normal. »Audio Input
Configuration & ASIO

"DMX Devices Connected" shows how many DMX devices are connected to your PC and found
by MADRIX (right side). It also shows if these devices are enabled in MADRIX (left side). In the
picture above, you can see that only 1 device is enabled, but a total of 3 devices is connected. »
DMX512 (DMX-OUT)

"GDI Objects" tells you the number of GDI objects created for the graphical user interface.
Windows allows a maximum of 10,000 GDI objects per software application. If this figure
constantly increases and does not decrease while using the program, please contact inoage
GmbH.

"DVI Output Frames" displays the frame rate of Preview DVI 1 (left side) and Preview DVI 2
(right side). This value should be 50 if a DVI window is activated. If no DVI window is activated,
the value should be -1. »DVI

"DMX Controller Frames" represents the frame rate of the DMX controller, which sends data to
all DMX devices. Hereby, DMX-OUT and DMX-IN can be monitored. DMX-OUT (left side) should
have a value of 50. The value for DMX-IN (right side) is set by the DMX-IN interface. Like in the

picture above, a value of -1 on the right side says that DMX-IN is currently deactivated.

"DVI Controller Frames" represents the frame rate of the DVI controller regarding proprietary
DVI devices, such as the EuroLite T9. This value should show 50 frames. Or else, the DVI output
might flicker. A value of -1, like in the picture above, says that no proprietary DVI device is

currently activated. (»Proprietary DVI Devices)
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"Available Memory" shows how much free system memory (physical RAM) is available. If the

value falles below 100 or stands near 0, performance problems are likely to occur.

Part 3 lists all connected interfaces that are enabled.

nx MADRIX
¥ MADRIX
nx MADRIX
¢ MADRIX

a La

L L La La L Ea
Ca 0d Co Ca Co ga i
Ltn LN oLl oen Loen

L L
Ca G
L4 =)

nx MADRI
¥ MADRIX US
¢ MADRI
¢ MADRIX
¥ MADRIX US
MADRIX |_.|'.'_
dmx MADRIX

[FURT)
(%] |_:_|_1

3
5

33.5
33.5

L La
Ca
i oen

Sen ||:||r||:|
nding
sending

il

il
=3
Qr
=
]

sending
nding
sending
nding
ge ||:||r||:|

il

m

o
=3
E—
=
=]

SEN u:||ru:|

il
=3
Q—
=
=]

sen u:||ru:|
nding
sending

il

(P T T P R ¥ S ¥ R ¥ B ¥ I[...i:! (P T T P R ¥ S ¥ R 7 B ¥
]

m

The column "Type" says whether the connected device is of the type DMX or DVI. "Device"

shows the description and information about the device.

"Frequency" displays the frequency (Frame rate, Frames/s) of the device with which it currently

sends or receives. When using DMX-OUT this figure should reach the value that is configured in
the "Device Manager" under the tab "DMX devices" ("Frames/s"). »DMX512 (DMX-0OUT)

"State" tells if a device sends data ("sending") or receives data ("receiving"). The entry "???"

says that the status is currently unknown. Examples for this situation are: 1) DMX-IN is enabled

but no data is being sent. 2) While sending data via an interface, the interface is being

disconnected from the PC.
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Window Size

Having connected a lot of interfaces to a PC, the current window size of the Task Watcher might
be too small. If this is the case, please resize the window by dragging the window border. If you
did scale the window wide enough (to the right), part 3 of the window will be repositioned and

displayed not below part 1 and 2. It will be displayed to the right side as shown below.
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Logfile

ermanently

The Logfile ("F6") keeps track of all warnings and system information.

Use "Save Permanently” to keep track of entries until MADRIX is closed. Otherwise, the file will
only contain entries up to the creation point of the logfile ("Save To File..."). Press "Clear" to

delete all entries of the current lodfile.

"Level” determines which kind of information is shown including only information, warnings, and
errors. Use the "Filter" to see information belonging only to certain topics, such as DMX or Art-
Net.

"Logsize" limits the number of entries to the given value.
Use the "Search" box to enter the keywords you are looking for.

"Close" closes the Logfile window.

If you search for an error and are unable to locate the problem, please check the logfile

first. This Lodfile is also needed for every support request.
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DMX Watcher

The DMX Watcher ("Ctrl+Alt+D") allows you to monitor your DMX output while using MADRIX.

Modes

Use the 512 channel mode for normal fixtures that use 512 DMX channels per

universe. This is the standard mode.

Blank™ “Lines
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Use the 1024 channel mode for fixtures that require more than 512 channels per
universe. The manufacturer specified these settings. Examples are Insta Light 2022 panels, ROBE
StageQubes 324, and GLP ion.tubes. MADRIX supports this and is able to display 1024 channels
per universe. The DMX Watcher allows you to monitor it. After pressing the button, the DMX

Watcher in 1024 channel mode will look like this:

Explanation
You have several options to choose from.

"Virtual OUT" will activate monitoring of the data output, which is the data that is created by
MADRIX in order to be sent to your hardware. It is the point in time before the data is actually
delivered to the DMX hardware.

A box next to it determines the DMX universe you are currently looking at. Adjust the number to

your requirements.

Display data with the help of DMX values, percentage values, using HEX, or a visual bar chart.
Data that is going to be sent will have a white color. If the data is 3 seconds "old", the color fades

to grey.
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At all times, you can use different backgrounds for a better reading. They include simple black,
lines between rows and columns, shading only rows, or shading only columns, or applying a chess

pattern.

Use the Freeze button in order to hold the image. Click the button once and the picture will

freeze.

To show the data output, you can use "1Hz" which translates to 1 FPS, while "10Hz" and
"BOHz" will use 10 FPS or 50 FPS, respectively.

Likewise, DMX input data can be monitored. Simply activate "Input". Data that is received at that

very moment will have a green color. If the data is 3 seconds "old", the color fades to grey.

Important Note

Per 512 DMX channels, 170 RGB fixtures can be controlled. That means, calculating 170 fixtures *
3 color channels results in 510 DMX channels. Therefore, channel 511 and 512 will be left empty,

because they are simply not in use.
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DMX Fader Tool

(=)

| B B on L B Oon B on B on B0 2 on (o B on [y B on

Channel
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The DMX Fader Tool ("Ctrd+Alt+F") provides access to twelve different DMX channels, which you
can choose individually. The DMX Fader Tool can be used to overwrite output signals of these

DMX channels. This feature can be very useful if you want to test single fixtures individually.

Simply activate a channel using the "On" switch and select the DMX "Universe" and "Channel".
The fader allows you to set a specific DMX value for such a channel. You can also use the input
field below the fader to specify a certain value. Click (and hold) the "Flash™ button to set the

value instantly to 255, the maximum value.

Use the "Select All" button to activate all 12 channels with one mouse click.

Use the "Deselect All" button to deactivate all 12 channels with one click.
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MIDI Watcher

The MIDI Watcher ("Ctrl+Alt+M") allows you to check your MIDI connection when you are using
MIDI sound analysis or a DJ/V] console to control MADRIX remotely.

The MIDI Watcher is a useful tool in order to start your search if problems occur with your MIDI
connection.
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3.5 Storage Places, Submaster, And Cue

Introduction

b e et o i

CLE Color

The chapter Storage Areas already introduced the controls you can find in Storage Area A and
Storage Area B. This chapter focuses on how to work with Storage Places. It will also provide

more details regarding Submaster and cue function.

Working With Storage Places

Overview

MADRIX provides 2 x 60 Storage Places to save your effects. They are located in Storage A and
Storage B, which are positioned below the preview windows. The Storage Places are consecutively

numbered from 1 to 60.

Click the desired Storage Place number, choose an effect from the list of effects, and
customize the effect according to your needs. You can learn more about how to set up an effect

in the chapter Effects.

After setting up your effect, the effect itself and all corresponding settings will be saved
automatically in this Storage Place. You will see a green arrow displayed in the lower right corner
of a Storage Place if you have chosen and modified an effect. This corner light indicates that this

Storage Place is not empty.
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e

If you click a Storage Place, you activate it. After you did select it this way, the button
will light up and change into a green-colored button. In this way you know, which Storage Place is

currently used.

Equalizer

You can have a small preview of your effects if you hover with your

mouse over a Storage Place. A thumbnail will show your effect.

Also, remember to give your effect a name with the help of the

description field.

Please note that Storage Places on the other hand are saved in MADRIX setup files. Learn more in

the chapter
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Context Menu

Cue

Open...

The Storage Places are equipped with a context menu. Simply perform a right-click

on a single Storage Place and the menu will appear. You may "Cue”, "Open", "Save", "Copy",

"Cut", "Paste"”, and "Clear" a Storage.

The same context menu is available in the menu:

Clear All Storages...

Clear All Storages A,

Clear All Storages B...

Copy Storages Places...

Cue All Occupied Storage Places

Storage Place &
Storage Place B

Layer &
Layer B

Cue

Open...

Save...

Copy
Cut

Paste

Clear
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Cue
Cue will add the currently selected Storage Place to the Cue List.
Open Or Save

Single Storage Places can be saved. This means that you can save individual effects. They will be
stored in the *.mef file format. Likewise, you can load a Storage Place you once stored by

choosing "Open". Learn more about files in the chapter File Types.
Copy, Cut, And Paste

In total, 120 Storage Places are available to you. If you would like to duplicate or rearrange your
setup of Storage Places, use these functions. Be also sure to read the section "Drag & Drop"

below.

Here is an example: Select a Storage Place that contains an effect. Then, press copy, and select
another Storage Place. Click paste. Now, your original effect will be copied from the original

Storage to the target Storage. Both Storage Places will show the same effect.
Clear

If you would like to delete an effect and restore the blank Storage Place, choose the option

"Clear".

Drag & Drop
The options "Copy and Paste" and "Cut and Paste" are also available using drag & drop.

Select a Storage Place and while holding the mouse button, drag it to another Storage Place. This
performs a "Copy and Paste". Additionally, hold the "Shift" key during this procedure and a "Cut
and Paste" will be performed. Both actions do work within one Storage Area or between both

Storage Areas.

In addition, you can select a *.mef file in Windows and drag it to a Storage Place of your choice in
MADRIX. Such a file is created when you save a Storage Place. Learn more about files in the

chapter File Types.
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Options From The Edit Menu

Clear All Storages...

Clear All Storages A...

Clear All Storages B...

Copy Storages Places...

Cue All Occupied Storage Places

Storage Place A 2
Storage Place B »
Layer A »
Layer B 2

Clear

In the Edit menu you can "Clear all Storages", "Clear all Storages A", and "Clear all Storages
B". This actions will clear all settings on selected Storages. This means that all Storage Places will

be deleted and restored to their default state. You will have to confirm your selection with "Yes".

Copy

With the item "Copy Storage Places" you can copy one, multiple, or all Storage Places from A to

B or from B to A. You will see the following dialog open, when you select it.
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Copy Storages

LCalar

Storage A is shown in the left part and the Storage B in the right part.

Use the "Select All" button to select all entries in the list of Storage A or B,

respectively.

Use the button "Deselect” to undo your selection. No Storage Place will be

selected anymore.
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In general, you should first select all Storages you want to copy. Navigate to the other list and
choose the Storage Places where your selected Storages should be saved. Then, use one of the

buttons described below.

Please use the "Ctrl" or "Shift" keys for multiple selection. Especially, in the case of copying images
and videos it may take a while to copy all Storage Places. The two progress bars at the bottom of

the window will show you the progress.

Please select the Storages you want to copy and then click on the right arrow to copy

them from A to B. In this process, the Storages will be assigned their previous numbering. In other
words, Storages 1 to 8 of Storage A will be copied to 1 to 8 in Storage B.

Please select the Storages you want to copy and then click on the right arrow to copy

them from B to A. In this process, the Storages will be assigned their previous nhumbering. In other

words, Storages 10 to 15 of Storage B will be copied to 10 to 15 in Storage A.

With an activated Map button you can copy selected Storages defining their exact
spot in the lists. Hence, you can copy one Storage Place to a different Storage Place in the other
Storage. In this way, you can change the numbering. For example, you want to copy Storage
Place Al to Storage Place B50. Using only the arrow keys, as described above, this is not possible.

Using the "Map" function makes it possible. When activated, the button will glow green.

Use this button to copy one single Storage Place from Storage A to several Storage

Places in Storage B. Simply select the effect in the list of Storage A and select multiple Storage

Places in the right list. Then press this button.
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Use this button to copy one single Storage Place from Storage B to several Storage

Places in Storage A. Simply select the effect in the list of Storage B and select multiple Storage

Places in the left list. Then press this button.

Select one single Storage Place in the left or right list and then press this button. The

selected Storage Place will be copied to all other 119 Storage Places.

Cue

You can add all Storage Places that contain an effect to the Cue List with the item "Cue All

Occupied Storage Places" .

Options From The File Menu

Similar to saving a single Storage Place, you can save or load an entire Storage Area. If 120

Storage Places are not enough, this might be a good possibility.

This options available from the File menu.
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Mew Ctrl+M
Open Setup... Ctrl+0D
Save Setup Ctrl+5
Save Setup As.. Ctrl+Alt+5

Import 3

Export 3 Storage 3
Storage Place L
Patch...

1 MobileD)
2 Martin

3 DiscoSample Device Settings...
4 Bastl

5 Bart

Exit

To save a Storage Area, go to "Export" -> "Storage" -> "Storage A" or "Storage B". The file
will be a MADRIX Storage Setup File (*.mss). To load a Storage Area, go to "Import" ->
"Storage" -> "Storage A" or "Storage B".
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Submaster And Cue

The Submaster can be found at the bottom of a Storage Area. The Submaster can be
used to control the intensity of a selected Storage Place. It only works for the Storage Place that
you did select. It does not control the main output. If you want to adjust the overall intensity,

you need to use the Master Fader.

Upon clicking, the "Sub™" button extends to a fader. Please make sure to press and hold the
button at the same time. Afterwards, you can easily move the fader with your mouse. A range of
0 to 255 provides a precise adjustment of the intensity. A value of 0 renders the effect completely
black.

e

Using the "Cue" button will automatically add the selected Storage Place to the Cue
List. The newly created Cue List entry will include all the applied parameters, like the description

of the Storage Place or the fade duration and fade type of the crossfader in the Fade Area.

Using A Storage Place Macro

Storage Place macros affect an entire Storage Place including all layers. You can find

more details in the chapter Macros & Scripts.
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3.6 Speed Master

The so-called Speed Master is a fader that is positioned on the right
side of each Storage Area. The fader allows you to speed up and slow down effects. Thereby,
every effect of Storage A or B will be affected. In this way, the Speed Master increases or

decreases the speed of the whole Storage Area.

Move the fader upwards to increase the speed of the running effect(s). Move the fader
downwards to decrease the velocity. A label on the fader indicates the current value. The Speed
Master offers a speed range from "+10" to "-10", which says if you have set a positive or negative
acceleration. The value "1.0" indicates normal speed. It is the default value. As a result, effects
will play with the BPM speed that is selected in the Effect Area. A value of 0.0 means that all the
effects are stopped. Values higher than 1.0 accelerate the speed of effects. Values lower than

1.0 but higher than 0.0 slow down effects. Negative values will reverse the direction of effects.

Perform a double-click on the slider and the Speed Master will be reset to its default value of
1.0.

TR
i

Below such a Speed Master you can find a "Pause™ button. This button is to halt the

effect.

Click and hold the button to pause the effect as long as you hold the mouse button. Perform a
double-click in order to halt the effect permanently. A single click deactivates the permanent stop

again.
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3.7 Effects
Selecting An Effect

MADRIX includes two areas (Effect Area A and Effect Area B). A drop-down list allows you to
select an effect.

or
Bitmagp
Baune

E
E
E
E
E
E
E
E
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Variety Of Effects

MADRIX offers a large variety of effects as you can see from the list in the screenshot.

They are arranged into four categories: Static Color Effects (SCE), Sound2Light Effects (S2L),
Music2Light Effects (M2L) and the MAS Script Effect. These categories and their effects are
explained in detail in the chapter MADRIX Effects.

Configuration Of Effects & Layers

Effect Area A and B provide a number of buttons and controls to configure your effects. Please
have a look at the chapter Effect Areas A & B to learn more.

Moreover, you can choose one effect per layer from the drop-down lists. Working with Layers is
described in the next chapter.

Using Several Effects And Saving Effects

The selected effect will be automatically saved in the selected Storage Place. MADRIX offers 60
Storage Places in each Storage Area. Hence, you will be able to create a lot of effects and storing
is automatically handled by the software. Learn more in the chapter Storage Places, Submaster,
and Cue. Please note that Storage Places on the other hand are saved in MADRIX setup files.

Learn more in the chapter File Types.

3.8 Layers

Introduction

Color EG Dropz | Drops | Metaballs BNGEEE]
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If you want to use layers, you have to set up an effect first. This effect will automatically
be handled as one, single layer. That means that each effect is also a layer at the same

time.

While the usage of one layer allows for the selection of only one effect, the utilization of multiple
layers, which are stacked on top of each other, can alter the displayed effects and images
massively. In this way, you can use layers in MADRIX to compose your own original effects. A
layer can be modified in various ways, such as setting the opacity or using the link or mix modes.

Layers dramatically increase the usability and flexibility of an experienced user.

The layer section can be found at the bottom of each Effect Area. Layers are illustrated in
MADRIX with the help of tabs. Layer 1 will always be located to the left of an Effect Area. If you
are using more than one layer, you will see several tabs. MADRIX supports an unlimited number of
layers. (The actual number of layers available for use depends on your computer performance and

matrix size.)

General Options

Buttons And Controls

The order of layers can be easily changed. You can move a layer to the
left and to the right by simply clicking on the arrows of an active layer
tab. Then, the layer will change its position an move in the according

direction.
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Plasma

=

j "

Context Menu

Use the Blind button in order to hide the currently selected layer. It
instantly sets the opacity of the layer to 0. The layer will not be visible
anymore in the Previews and output, but you will still be able to adjust its
settings. In this way, you may have a look at your created effect
excluding certain layers. A layer tab will pulsate in red if blind mode is
active.

Blind mode also affects link mode. A layer with an activated link mode will
also be set to blind mode if blind mode is activated for the layer it is linked

to.

Use the Solo button in order to hide every layer except the currently
selected. Hence, the layer is the only one that will be displayed. The layer
tab will pulsate in green if solo mode is active. Solo mode overrides blind

mode.

This button opens the Effect Macro Editor. You can find more details in

the chapter Macros & Scripts.
Use the Reset button to restore the default settings of the currently
selected layer.

"Double-click” a layer tab and you will be able to rename the description

of this layer tab. Hit "Enter" to accept the changes.
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Duplicate

The context menu for layers can be accessed in three different ways. You can call

it up via the "Layer" button at the bottom or you can perform a "right-click" on a single layer tab

. You could also use the Edit Menu.

Clear All Storages...

Clear All Storages A...

Clear All Storages B...

Copy Storages Places...

Cue All Dccupied Storage Places

Storage Place A
Storage Place B

Layer &
Layer B

Mew

Duplicate

Copy
Paste

Insert
Rename

Delete

Afterwards, you can choose to from several actions.
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Use "New" to create a new layer with default settings. Use "Duplicate" to reproduce the
selected layer, which will add a copy/a new layer with the same setup next to it. Use "Copy" to
store the settings of the selected layer to the clipboard. Then, use "Paste" to apply the stored
settings to the layer you have currently selected. This does not create a new layer, but
overwrites the settings. Click "Insert" to create a new layer using the settings stored in the
clipboard. "Rename" can be used to change the description of a layer tab. Then, hit "Enter" to

accept the changes. Use "Delete" in order to remove the layer in use from the effect.

Layer Opacity

167 [ IIIIIIIIIII

You can use opacity to create overlapping layers. The opacity
fader determines the opacity of the currently selected layer. You will get 100% coloring by pulling
the layer to the far right. A value of 127, i.e. the middle position, sets the opacity to 50%.

You can also use the input field to enter a certain value. The values range from 0 to

255, the highest value with zero opacity.

Tip: If you double-click the fader area (using the left mouse button), the slider will position

itself at 50% opacity.
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Using The Submaster

Use the Submaster to adjust the intensity of the current layer. A value of 255
represents full opacity and a value of 0 hides the layer. It will be rendered black, then. The

Submaster overrides Link mode.

Layer Mix Modes

Layers can blend into each other using one of several modes. Just like in image-editing software,
you can use different mix modes to mix layers with each other.This results in diverse color

combinations and completely new effects.

[ hloemal
Mormal

If you want to use layer mixing modes please click the button between the Map
and the Link button. It is labeled "Normal". This button sets the mix mode and functions as a drop-

down list. In the example shown here you can see that the mix mode "Color Burn" is now selected.
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You can choose fromover 20 different layer mixing modes. These options make it possible to
change how layers are graphically merged with each other, i.e. with an underlying layer. Keep in

mind that a layer’s opacity and mixing mode interact with the opacity and mode of the layers

underneath.

You can select the following mixing modes:

Normal, Darken, Multiply, Color Burn, Linear Burn, Lighten, Screen, Color Dodge, Linear
Dodge, Overlay, Soft Light, Hard Light, Vivid Light, Linear Light, Pin Light, Hard Mix,
Difference, Exclusion, AND, OR, XOR, NAND, NOR, and Mask.

Link Mode

The "Link" button simply links two layers. Linking layers is very useful if your are
working with several layers. In fact, MADRIX will render both layers simultaneously handling it like
one layer. If you activate Link mode, the currently selected layer layer will be linked to the layer
underneath. It means the that it will be linked to the layer left to it.

Example
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We have created an effect with two layers. Layer 1 is the SCE Ticker effect and layer 2 is SCE

Plasma.

E  Plasma

- = Thap Mormal Link
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L |
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r|_|1 ove D .

Ticker - Scralling Text m

As a first result, you will get the following preview. Because of the two layers and standard

settings the top layer is the only layer that is displayed.

.
Without Link Mode

Now, let us activate Link mode. Note that the Link Mode button glows green.
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As a result, both layers will be merged and the preview looks totally different. The text will be

filled with the plasma effect and in this way, both layers are used to create a new effect.

With Link Mode
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Using The Map And Tile Functions

Please have a look at the chapter Map, Tile, And Rotation in order to get to know the background

to the "Map" button.
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Using A Macro

You can find more details in the chapter Macros & Scripts.
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39 Color Selection

Introduction

While using MADRIX, you will encounter various ways to choose a color set-up, mostly for effects
or fades. This section describes them in more detail. Please keep in mind that MADRIX mainly
works with the RGB color model. Each channel, red, green, and blue, can be defined using a value

between 0 and 255, ie. using 'no color' to 'maximum extent'.

Simple Color Selection

Often, you will find 4 input fields representing the 4 color channels: Red, Green, Blue, and White.
The white channel only applies if RGBW fixtures are used. If you are only 1-channel fixtures, all

channels except the first channel will be disabled.
Simply enter a particular value between 0 and 255 in the fields displayed.

Use the spacebar once to set a value instantly to 0 or 255. Perform a left-click into a value field
and continue to hold the mouse button. Then, move your mouse up or down to adjust the value

as well.
Here are some examples:

White - 255, 255, 255
Black - 0, 0, O

Red - 255, 0, 0

Green - 0, 255, 0
Blue - 0, 0, 255
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The Color Picker

The intelligent Color Picker built right into MADRIX is simply controlled with the help of the mouse.

Just click inside the color field, which in most cases is black or white by default. Be sure to hold
the mouse button! While holding it, you can easily navigate inside the color field and pick your

favorite color. If you have decided for one, just let go of the button. It is as simple as that.
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The Color FaderBox

- FaderBaox

H

1849 44 1449

The Color FaderBox is a helpful addition to the Color Picker.

L1kl
Use this button to call up the FaderBox. The dialog that will be shown contains four
sliders to assign a color value to each of the channels (red, green, blue, and white, if applicable).
The white channel only applies if RGBW fixtures are used. If only 1-channel fixtures are used, the

all channels except the first channel will be disabled.

You could also enter a value between 0 and 255 in the field displayed below each slider. Use the
spacebar once to set a value instantly to 0 or 255. Perform a left-click into a value field and

continue to hold the mouse button. Then, move your mouse up or down to adjust the value.

The result of your choices will be shown in the large field at the bottom of the window. This is the

color you have chosen. Press "Close" to exit the dialog.
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The Color Table

[
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The Color Table contains a list with different colors; each used in the effect. You can enter
numerical values from 0 to 255 for red, green, blue, white, and the alpha channel via input fields
at the top. The alpha channel sets the opacity of a single color. Then, it becomes transparent and

blends with the background.

The white channel only applies if RGBW fixtures are used. If only 1-channel fixtures are used, the

all channels except the first channel will be disabled.

You can extend your list with a new color value by pressing the "+" button. Existing entries can
be deleted from the list by marking it and pressing the "-" button. The order of your entries
(colors) may be changed, too. In order to do so, simply select the color and press the upward

arrow or the downward arrow.

If you select an entry, you can choose your color with the help of entering values directly or by
using the Color Picker, which is implemented here as well (see above).

The list you created as well as presets can be saved and loaded. The number of entries in the list
can be seen in the lower part of the window. In our example shown above, six entries are

currently included in the list (#6). To close the window, click "Close".

Drag the upper or lower border of the color table window to resize the whole dialog.
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The Color Ramp

large color contral
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Using the color ramp: Select and hold a color (using the small square button) and move the
mouse if you want to relocate a color. Click the small x-button at the bottom of a color to remove
it.

Click inside the large colored area to create a new color at this particular position with the

particular color you picked. Simply drag and drop it afterwards to change its position.

Use the input field "Position" to adjust it more precisely. The picture below shows how position

and color have the same position values.

Use "Fade" to fade smoothly between colors. This option is activated by default.

r|_|1 owe

Delete G5

Position 0.2 | "B Fade
|
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If it is not enabled, the transition between colors will be hard as is shown in the picture below.

Additionally, the "Alpha value" sets the opacity of a single color. Then, it becomes

transparent and blends with the background.
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Music2Light Color Setup

After pressing the button "M2L Colors"”, a separate window will be opened. This dialog offers you

the possibility to match colors to specific keys. All existing keys are displayed in this window.

Major keys are listed in the left part of the window. The right hand side contains all minor keys.
In the example above the "C" (written in capital letters) in the upper left part represents C-major
and has a pure yellow as its color value (RGB: 255, 255, 0). C-minor, located across on the other
side of the list, has a darker yellow assigned (RGB: 153, 153, 0).

You may "Load" and "Save" your color tables, too. Five color presets are already included and
can be accessed by using the buttons "C1", "C2", "R", "G", and "B". The "Close" button closes

the window.
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3.10 Map, Tile, And Rotation

Introduction
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You can assign/map effects to a certain area of your matrix, i.e. relocate them. In order to do so,

please use the "Map" button in the effect area. A new window will open.
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By clicking the "%" button, percentage/relative values will be used.

By clicking the "PX" button, absolute values (in pixels) will be used.
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The section "Map (Position/Size)" includes
parameters to define the position and size of the selected layer/effect. "Pos X" sets the position
in X. "Pos Y" defines the position in y. "Size X" and "Size Y" are to set the size in x and vy,
respectively. In this way, you are allowed to display the effect in a larger or smaller size than the

virtual matrix size.

Several presets, such as "Full Size", "Double Size", "Half Size", "Top", "Bottom", "Left" ,"Right", etc.

are already included and available via the quick select button below.

"Mirror" is an option to mirror effects horizontally ("Mirror H"), vertically ("Mirror V"), and in a

horizontal-vertical direction ("Mirror HV") or not ("No Mirror").

Negative values may be used, too. In this way, you can map an effect to an outer area. Equally
helpful is the option to "grab" and move the colored map square directly with your mouse or to use

the faders.

If you have mapped several layers, a colored square will be displayed for each layer in addition to

the currently mapped layer.
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For example, it could look like this:
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The "Tile" section allows you to apply tiling to
the selected layer/effect. In other words, you are able to divide the virtual matrix into sections.
"Scale" influences the size. A factor of 4 means that you will get 1/4 of the original size and the
mode is automatically set to "Repeat Mode". "Pos X" defines the position in x, whereas "Pos Y"
defines the position in y. "Size X" and "Size Y" were implemented to be able to modify the size of
the layer/effect. Hence, you can render an effect larger or smaller than the virtual matrix size.

"Offset X" and "Offset Y" define the spacing between repeated or mirrored sections.

Several presets, such as "Full Size", "Double Size", "Half Size", "Top", "Bottom", "Left" ,"Right", etc.

are already included and available via the quick select button below.

"Mirror" is an option to tile effects horizontally ("Mirror H"), vertically ("Mirror V"), and in a
horizontal-vertical direction ("Mirror HV") or not ("No Tile"). You can also choose to repeat the
effect ("Repeat").
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Rotate

Rotate

Cegree:

MADRIX is able to "Rotate" layers. Move the

fader to the left to rotate clockwise. Move the fader right to rotate counter-clockwise. Activate a

permanent rotation by clicking the animation button.

3.11 Backup System

Introduction

The MADRIX Backup System (Master/Slave) is a type of communication protocol between two or

more MADRIX computers in order to set up a professional backup solution.

'Keep alive messages' are sent by one MADRIX computer to other computers to check if the
connection between the computers is working properly. If the Master fails, i.e. if the Master does
not send 'keep-alive-messages' in a certain time interval (in seconds) as defined by the "Keep
Alive Time", the Slave is automatically activated and sends the DMX512 data. In like manner,

the Slave is sending 'keep alive messages'.
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How Does It Work? - Instructions

To configure the MADRIX Backup System, please navigate to the menu "Preferences" ->

"Backup System". This will open a new window.

Backup System Configurs

1.1  Bob-Baumeister
| I |

mmand From

Activating the switch "On" in the top left corner enables the backup solution. If your computer or
laptop is equipped with more than one network card, you will be able to choose the appropriate

network in the large drop-down list.

By activating the "Check KEY" switch, you can automatically monitor if the MADRIX software
protection key is is plugged into that remote computer. Additionally, you will be able to identify

the MADRIX version since it is shown in the list how many DMX universes are supported.

You can set up the "Keep Alive Time" with a time range of 0.1 to 25.6 seconds. This is the

duration between two keep-alive transmissions.

If you activate "Receive Sync Command From Master", this computer will receive

synchronization data from another computer (Master).

You can select another computer from the list and click at the "Change Master" button to set
this computer as your Master. You are not allowed to select your local computer as Master. You

will have to choose a remote computer.
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How To Connect Master And Slave

Switch
NS
:}. 182.168.0.1 182.168.0.2
) Ethernet
MADRIX MADRIX
Master Slave

You can utilize your network card with an Ethernet port to connect two ore more computers using
a network switch. Set up the IP addresses from the computers like in the picture above. Both

computers have to be in the same network area (e.g. 192.168.0.1 to 192.168.0.254).

Usage

"Receive Sync Command From Master" is a useful feature to play cue lists synchronously.

Learn more about the Cue List.
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Example 1: How To Use The Backup System And Art-Net

LED Matrix

#EEEET i

DMX512

ArtNet Device
2.0.0.10

0

Ethernet

2.0.0.1 N 2.0.0.2
Switch
192.168.0.1 % 192.168.0.2
Switch
MADRIX MADRIX
Master Slave

We recommend to always use two separate networks with two network cards if you want to sync

Master & Slave and use Art-Net at the same time.

Minimum requirements for this set-up are two computers, two Ethernet switches, one Art-Net

device, Ethernet cables, and DMX cables.

Apart from that, both computers need to have two network cards installed. The set-up for the
first network card is 192.168.0.x and the second is 2.0.0.x. The former will be used as the backup

system, the latter is transferring Art-Net data.
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Example 2: How To Use The Backup System And Art-Net (Low-
Budget Alternative)

LED Matrix
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2.0.0.1 N 2.0.0.2
@ Switch
MADRIX MADRIX
Master Slave

In addition, you may use a variation of the example above. Depending on your installation, it can
be possible to do the setup without the second network. It is a smaller budget alternative and in
this case only the Art-Net network will be used. At the same time this means that traffic from
both Art-Net and the backup system will be transferred over this single network. In larger

installations this might cause network problems due to high data traffic!

Connecting this backup system to the internet is not recommended because problems with the
internet connection are likely to occur (such as connection errors, dropouts, etc.). WiFi-nodes are
also not recommended. The Art-Net data will simply interfere with the internet data in the 2.0.0.x

network.
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If your Art-Net interfaces support the 10.0.0.x network, you may establish an internet connection
since the Art-Net data will be blocked by your router and does not interfere with the internet

connection.

Such an installation is at your own risk.

Example 3: How To Use The Backup System And USB DMX512
Interfaces

LED Matrix

m |

DMX512

DOMX512 DMX512

DMX Merger

% 192.168.0.1 % 192.168.0.2

Switch
MADRIX MADRIX
Mastenr Slave

If you are going to use an USB DMX512 interface, PCI cards, or PCMCIA devices, you can work
with one network card to sync Master and Slave.

Minimum requirements for this set-up are two computers, one Ethernet switch, one DMX merger,
two DMX512 devices, Ethernet cables, and DMX cables.

Apart from that, both computers need to have a network card installed. The set-up for this

network is 192.168.0.x. Only this card/network will be used for the backup system.
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3.12 File Types

Introduction

While working with MADRIX, you will come across several types of files. This chapter explains
which file type belongs to which function or which part of the software.

List Of File Types

*.ms2 MADRIX Setup File
Your whole show will be saved. It stores relevant data in one single file including
but not limited to patch, effects, settings, Cue List, etc. Please note that videos

will not be included in this file.

* . mpf MADRIX Patch File

Stores your patch. »Patch

* . mfl MADRIX Fixture Library File
Stores the whole Fixture Library. »Fixture Editor

Please note: The madrix.mfl is being overwritten with an updated version every
time a new MADRIX update is installed.

* . mfx MADRIX Fixture

Stores one single fixture. »Fixture Editor

*.mss MADRIX Storage Setup File
Stores a complete Storage Area including all Storage Places (and effects). »
Storage Areas A & B

* . mef MADRIX Storage Place File
Stores one single Storage Place, and thereby one effect you created. »Storage

Places, Submaster, and Cue

* . mdf MADRIX Device File

Stores all relevant settings for your (connected) devices. »OUTPUT
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* . vdf Visualizer Device File
Stores all relevant settings for a configured visualizer. »WYSIWY G Visualizer
*.mmrc MADRIX MIDI Remote Configuration File
Stores a MIDI remote control configuration (MIDI map) for a MIDI console. »MIDI-
IN
*.mdrc MADRIX DMX Remote Configuration File
Stores a remote control configuration for DMX-IN. »DMX-IN & Art-Net Remote
*.mrec MADRIX Record File
Stores recorded shows. »Recording
*.dxd MADRIX PLEXUS Scene File
Stores DMX data for the PLEXUS hardware interface. »Recording
*.mpl MADRIX Cue List File
Stores the Cue List and its entries and settings. »MADRIX Cue List
* . mit MADRIX Image Table File
Stores an image table for the SCE Bitmap effect. »SCE Bitmap
*.mct MADRIX Color Table File
Stores a color table for various effects, such as the SCE Bounce. »MADRIX
Effects
*.m2l M2L Color Setup File
Stores a M2L color table for Music2Light effects. »Music2Light Effects (M2L)
*.log Log File
A log file created with the MADRIX Logfile tool or the MIDI Watcher. »Tools
*.csv Comma-Separated Values File
A file format that can be used for the MADRIX Cue List. »File Watcher
*.mas MADRIX Script File
A script for the MAS Script Effect. »MAS Script Effect
*.macs Encrypted MADRIX Script File
A compiled and encrypted script for the MAS Script Effect. »MAS Script Effect
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* . mms MADRIX Effect Macro File

A macro for an effect, a Storage Place Macro, or a Main Output Macro. »Macros
& Scripts

*.mcm MADRIX Crypted Effect Macro File
A compiled and encrypted macro for an effect, a Storage Place Macro, or a Main
Output Macro. »Macros & Scripts

*.rtc MADRIX KEY File
Required if the MADRIX KEY needs to be updated. »The MADRIX KEY

*.rtu MADRIX KEY Update File
Required to update the MADRIX KEY. »The MADRIX KEY

Images And Videos

Furthermore, MADRIX supports every image and video type that is supported by your Windows PC.
This could be for example:

e Images: *.bmp, *.gif, *.jpg, *.jpeg, *.png, *.tif, *.tiff, etc. (»SCE Bitmap)

e Videos: *.avi;*.mpg;*.mov;*.wmv;*.asf;*.divx;*.vob;*.flv, etc. (»SCE Video)

If you are encountering problems using such files, please install the required video codec on

your PC.

Loading A Setup

As described above, a MADRIX Setup stores a lot of information. When loading a setup, you have

different choices to make:
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Select "Load Patch" and the pre-defined virtual matrix and Patch settings will be loaded from this
Setup. This overwrites your current Patch. If you deselect this option, your current Patch will be

used.

Select "Load DMX Device Settings" and all settings regarding DMX devices will be loaded from
this Setup. This can overwrite your current settings. Deselect this option if you have configured

your own DMX settings.

Select "Load DVI Device Settings" and all settings regarding DVI devices will be loaded from this
Setup. This can overwrite your current settings. Deselect this option if you have configured your
own DVI devices settings.

Select "Load Audio Settings" and all settings regarding audio will be loaded from this Setup. This
can overwrite your current settings. Deselect this option, if you wish to keep your own audio
settings.

3.13 Fixture Editor

LED fixtures are implemented using the MADRIX Fixture Editor. The fixtures are stored in the
MADRIX Fixture Library (madrix.mfl).

The Fixture Editor is automatically installed together with MADRIX. You can access the tool or its
documentation by calling up the shortcut in the Windows Start Menu or in the MADRIX installation
directory.
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T Focuretdior - Clbs
File Fixtures p

Fixture:

Channel #

Nam

Ok Epply

Cancel

With the help of the Fixture Editor you can

e see how fixtures are integrated in MADRIX,
e see how many and which fixtures are already included,
e adjust settings to your requirements,

e implement fixtures by yourself.

Please note: Always make a backup of the madrix.mfl before and after applying any

changes.
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4 MADRIX Options
Overview

To access the options of MADRIX, please press "Ctrl+AlIt+0" or go to the menu "Preferences" -
> "Options".

MADRIX Options include the following topics:
e Start Options

e File Watcher

e Devices (USB/PCI)

e Devices (Network)

e User Interface

e Performance

4.1  Start Options

Overview

To access options of MADRIX, please press "Ctrl+Alt+0" or go to the menu "Preferences" ->
"Options". Now got to the tab "Start Options".
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Al cancel Help

MADRIX provides various possibilities to decide which feature(s) should be enabled if the software

or your computer starts ("Start Options").

In the case of "Run MADRIX, When Windows Starts" MADRIX will be initiated automatically if

you log in into Windows.

Additionally, "Set Timeout To Start Software" allows you to define a time frame in seconds in
which MADRIX will not fully start. Instead, a loading screen with a countdown will be displayed. If
you still want to start the software immediately, use the "Start Now" button. If you want to
abort the start procedure, press "Cancel Startup". MADRIX will not be started then. The feature
is particularly helpful with network devices. Windows needs some time to initialize such devices
after the start-up. But MADRIX might be already loaded completely and may not detect the

devices as a result. This option prevents that case.
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S MADRIX

e MUSIC MAKES THE LIGHT

Start MADRLK

Start Mo Cancel Startup

Set "Start Touch At Startup” to launch the touch screen window when MADRIX starts.

If you activate the feature "Check For Updates" MADRIX automatically searches online for newer

versions. "Check for BETA Updates" will include the latest beta versions in the search.

"Activate 'Audio’'-Button" is only necessary if you wish to use Sound2Light and/or Music2Light
effects or have them already included in your Cue List. This automatically starts the sound

analysis.

If you want to load a custom setup right from the beginning, please activate "Load This Setup
On Start"” and choose a setup file. In addition, a pre-programmed Cue List can be commenced

simultaneously by using "Start Cue List After Loading The Start Setup".

You can set the Master Fader to a specific value if you activate the switch "Set Master Fader

On Value". Just type in the value you require into the input box.

If you have created your own particular fixture set-up using the Fixture Editor, you will be able to
load this fixture library via the switch "Load A Special Fixture Library" at the MADRIX start-up.

(With the help of the MADRIX Fixture Editor you can create your own fixtures. This tool is included
in the MADRIX installation. Learn more in the chapter )
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Select "Initialize QuickTime At Startup" to initiate QuickTime support already when MADRIX
starts. This improves the launching time when QuickTime movie files are loaded within the SCE
Video effect.

Important Notes

All Start Options will be saved locally on your computer. The settings here will not be saved in
your MADRIX Setup file.

4.2 File Watcher

Overview

To access options of MADRIX, please press "Ctrl+Alt+0" or go to the menu "Preferences" ->
"Options". Now got to the tab "File Watcher".

Automatic Cue List Reloading

MADRIX can automatically reload a Cue List within a pre-defined refresh time. To activate this
feature, call up MADRIX Options by pressing "Ctrl+Alt+0" or go to the menu "Preferences" ->
"Options".

After switching to the "File Watcher" tab, please activate "Watch This Cue List File And
Reload If Changed", select the Cue List file, and set a refresh time.
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Usage

The File Watcher with its Automatic Cue List Reloading feature is very useful if you are using an
external program that creates a Cue List in the *.csv file format. If this Cue List is changed, you

are easily able to access the new Cue List without modifying settings within MADRIX.

In order to work with this feature, simply create a new Cue List, save it using the *.csv file format
and open the file with a text editor or other appropriate software. Here is an example with two

Cue List entries:

CUE; DESCRI PTI ON; DATE; TI MECODE; DURATI ON; FCUE; STORACE; PLACE; FADETYPE; FADETI ME; R, G B; W
1;"Radial ";"daily";-1; 600000; 0;0;0; 1; 1. 00; 0; 0; 0; O
2;"Color Scroll";"daily";-1;600000;0;0;1;1;1.00;0;0;0;0

Read more on the Cue List topic in the chapter: MADRIX Cue List.

Important Notes

All options of the tab File Watcher will be saved locally on your computer. The settings here will

not be saved in your MADRIX Setup file.
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4.3 Devices (USB/PCI)

Overview

To access options of MADRIX, please press "Ctrl+Alt+0" or go to the menu "Preferences” ->
"Options". Now got to the tab "Devices (USB/PCI)".

Use Device Driver

MADRIX can be configured to search automatically for all known and supported devices using USB,
PCI, PCMCIA, DMX512, etc. at the software start-up. Activate a check-box in order to enable the

use of a certain interface driver.

Please note: If you only activate drivers for devices which you are effectively going to use,

e you can speed up the loading/starting time of MADRIX.

e you can avoid problems with other interfaces.
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e you can avoid problems with other software running on your computer which also controls
such DMX interfaces.

More Information

This user guide provides further information: Supported DMX512 & Art-Net Interfaces.

Further Configuration

For more information about the configuration of your DMX devices, please see the chapter DMX512
(DMX-0UT).

Important Notes

All options of the tab Devices (USB/PCI) will be saved locally on your computer. The settings here

will not be saved in your MADRIX Setup file.
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4.4  Devices (Network)
Overview

To access options of MADRIX, please press "Ctrl+Alt+0" or go to the menu

"Preferences” ->
"Options". Now go to the tab "Devices (Network)".

Configuration
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If you enable the drivers in this menu, MADRIX automatically starts searching for known and

supported network devices at startup.
You can enable four particular network drivers here:

e e:Ccue - e:net,

e Robe StageQube324 / Insta Light2022,
e Philips Color Kinetics - KiNet,

e ESTA - Streaming ACN.

e inoage - MADRIX

Please always make sure that you have selected the correct network.

Tips

You can speed up the loading/starting time of MADRIX. Please only activate drivers for devices

which you are going to use.

More Information

Please read the corresponding chapter to configure MADRIX further:

e e:net from e:cue

ROBE StageQube 324

e Insta Light 2022 - LED-Panel RGB 324

e Philips Color Kinetics - KiNet

e ESTA - Streaming ACN

e MADRIX PLEXUS
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Important Notes

All options of Devices (Network) will be saved locally on your computer. The settings here will not
be saved in your MADRIX Setup file.

4.5 User Interface

Overview

To access options of MADRIX, please press "Ctrl+Alt+0" or go to the menu "Preferences” ->

"Options". Now got to the tab "User Interface".

General

MADRIX provides an option to maximize the window. "Keep Aspect Ratio For MADRIX GUI" will

keep the aspect ratio of the user interface if you maximize MADRIX, i.e. the window will be scaled

properly.

Aspect Ratio On
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MADRIX features an special Touch Screen Window to control MADRIX via a touch screen panel.

Here you can define certain settings for this additional touch screen window.

The option "Use Automatic Fade™" can be a helpful support tool. Use it if you wish MADRIX to
perform an automatic fade when switching from one effect to another effect in the opposite
Storage Area (for example from effect 1 in Storage Area A to effect 1 in Storage Area B). You can

define the length of the fade using the input field "Max. Fade Time" (in seconds).

Enable "Open/Close With Touch On MADRIX Logo" if you want to be able to close the Touch
Screen Window by pressing the MADRIX logo. Likewise, you can open the window by clicking the
the MADRIX logo on the graphical user interface.

"Storage Button Count" sets the number of Storage Places per side. It sets how many Storage

Places will be displayed. You can use 3, 12, 24, 40, or 60 Storage Places.

You can read more about the Touch in the chapter Touch Screen.

Important Notes

All options of the tab User Interface will be saved locally on your computer. The settings here will

not be saved in your MADRIX Setup file.
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4.6 Performance

Overview

To access options of MADRIX, please press "Ctrl+Alt+0" or go to the menu "Preferences” ->
"Options". Now got to the tab "Performance"”.

a0.0

T R (]

II'|IIIIIIII

'||i||||||||
-u

Main Mix

MADRIX renders all outputs separately. Only when needed, use this slider to adjust the frame rate

of the actual data output (in frames per second). Normally you don't need to change this setting.

Only change this value if it is really necessary!

Use the "Reset" button to restore the default settings. The default frame rate is 50.0
FPS.

Virtual DMX Universes

Output
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Change this value if you need to use more virtual universes than actual DMX universes in your
Patch.

Please use this slider to increase or decrease the number of virtual universes which MADRIX will
address. (It is possible to use more virtual DMX universes than actual DMX universes by using less

than 512 DMX channels per universe.)

Please remember that your MADRIX KEY (MADRIX version) limits the number of

actual DMX universes.

Use the "Reset" button to restore the default settings. The default value is 256 virtual

DMX universes.
Input

Change this value if you need to use more DMX universes for input. Please use the slider or input
field to set the required number.
Learn more about this feature in the chapter DMX-IN & Art-Net Remote.

=
Use the "Reset" button to restore the default settings. The default value is 8 virtual

DMX-IN universes.

Previews

If you activate "Use Direct3D Previews", all previews will be rendered using Microsoft DirectX
and Direct3D, a hardware acceleration of graphical images based on your graphics card. If you
encounter problems with Direct3D Previews you can deselect this option. If you deselect it,

standard DirectDraw Previews will be initialized. The rendering may take a few seconds. Please

always use the button "Apply" to apply your changes.

MADRIX supports DirectX 9 and DirectX 10 graphic cards and drivers. Please check which DirectX

drivers you have installed by typing 'dxdiag' into the Windows command line.
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We recommend to enable Direct3D output.

This option is a great performance improvement for MADRIX.

"Use V-Sync" activates the Vertical Synchronization function of your graphics card for your
display monitor or output device. V-Sync can only be used with Direct3D-Previews. Please always

use the button "Apply" to apply your changes.

"FPS" allows you to manually set the frame rate (frames per second) of the five Preview Windows
(Preview A, Preview B, Preview Output, Preview DVI 1, Preview DVI 2). A higher number of frames
generates smoother results, but requires more computer performance. The "FPS" option can be set
independently of V-Sync. But if V-Sync is activated, the maximum frame rate will be set by the

highest possible V-Sync frame rate of your monitor or output device, even if you entered a higher

number.

a
Use the "Reset" button to restore the default settings. The default value for
DirectDraw Previews is 30.3 FPS. The default value for Direct3D Previews is 50.0 FPS.

Restart Previews

Press the button "Restart Previews" if you think refreshing your Preview
Windows is necessary. Then, all MADRIX previews will be initialized again. The rendering may take

a few seconds.
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5 MADRIX Effects
Overview Over Effects

e SCE - Static Color Effects
SCE - Static Color Effects are pure color effects. The first category of MADRIX effects is easily

capable of delivering impressive light effects! No additional input is necessary.
e S2L - Sound2Light Effects

S2L - Sound2Light Effects require an audio input signal. As a result, amazing light effects that are

synchronized to the music will be generated!
e M2L - Music2Light Effects

As a special highlight, MADRIX offers you Music2Light effects. These effects incorporate advanced
analytical methods to analyze music for tone theoretical parameters. MADRIX analyzes the height

of tones, volume, and also single tones, intervals, keys, and tonalities to name but a few.
e MAS - <PRODUCTNAME%> Script Effect

The powerful Script Editor, which is included in the software, gives you the possibility to program
your own effects. With the script language allows you to easily realize ideas for effects on your

own.

Overview Over GUI Elements

Various buttons and interface elements are available in order to configure your effects. For more

information, see the chapter Effect Areas A & B.

5.1 Static Color Effects (SCE)

SCE - Static Color Effects are pure color effects. The first category of MADRIX effects is easily

capable of delivering impressive light effects! No additional input is necessary.
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5.1.1 SCE Bitmap

SCE Bitmap

). Mormal

Filter -

BF M a0n
L

Animation 1

Speed

The SCE Bitmap effect provides the
possibility to load one or more bitmaps at the same time. You can open the following image file
formats: JPG, GIF, PGN, TIF and BMP using the "Image Table" button or the "Open File"
button. MADRIX also supports the animated GIF format.

With the help of a wide selection of arrows, it can be decided in which direction the image should
be moved. You can display the image in a grey color scale; just click the "Greyscale" switch.
"Stretch" resizes the loaded image to the matrix size. With the help of a filter color you can

change the appearance of your image. It manipulates the color values of the image.
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The "Tile" switch is for tiling/duplicating the image on the matrix size. "BPM" defines how fast the
image moves, whereas "Animation Speed" (animation speed) determines how fast images change
with reference to the image table. The higher the value, the fast they are animated. Values

smaller than 1 may be used as well. An animation speed of 0.5 cuts it by half, for example.

If you have a RGBW installation and you want to use the white channel, you
have to activate the "RGB to RGBW" mode. Television screens and computer displays work with
pixels (picture elements) using values for red, green, and blue (RGB). Likewise, computer bitmaps/

images are saved in RGB mode.
MADRIX features an integrated color space conversion from RGB to RGBW.

To load an image, click on the "Open File" button or the "Image Table" button.
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I Image_01.jpg 1
L A=W

"HI Image_[01.jpg

H == v Irmage_02.jpg

= Image_03.jpg

waas | |mage [04.jpg

Irmage_05.jpg

Export

The newly opened window contains a list
with added images. You can can load one or more images. The "Time" value determines how long
a bitmap will be shown. If the time frame of the last picture has ended, the first picture will

automatically be shown again. It is a loop. In this example the time is set to 1 second.
Double-click a picture and the loop will restart from the picture you just selected.

The list you created can be saved and loaded, too. Choose "Export" to export files in the *.bmp
file format (Bitmap).

If you wish to rotate a picture, use this button and select a rotation of 0°, 90°, 180°,
or 270°.
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i
If you want to swap images to change their order, please select both images first. Next,

simply press the "Swap" button. Click "Close" to exit this dialog.

Important Notes

Please do use a picture resolution according to the size of your LED matrix. It is not useful to use
a resolution of 30002000 pixels if your LED matrix has a size of 192x128, for example. Please
resize your pictures before using them in MADRIX. Please do also use 72 DPI. Both means will

improve performance considerably.

Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.
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51.2 SCE Bounce

SCE Bounce
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The SCE Bounce effect renders bouncing lines. As
set-up possibilities you have got parameters for
"BPM" (Speed), number of "Objects" and
"Points", "Fade Out" time, and "Size". With the
help of the Color Table you can define the colors of

bouncing objects.

If a value of 1 is selected for "Points", various
modes, such as rectangle, circle, and cross, are

available.

You can either enter values directly over the keyboard or use the fader box with your mouse. With

the "Reset" button you can set this effect back to default values.

Using the Tap Button for Manual BPM Input
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The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this

button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will
calculate the BPM value subsequently.

51.3 SCE Color

SCE Colar

)3, Marmal

Calar

The SCE Color effect renders a plain color. It
delivers one color on your complete light
installation. Settings include adjustable values for
red, green, and blue. (And white if you have a
RGBW fixture.)
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You can either enter values directly over the

keyboard or use the fader box with your mouse.
With the "Reset" button you can set this effect

back to default values.

5.1.4 SCE Color Change

SCE Color Change

Map Maremal

ColorTable

|' I I I O O W AR
o | |

The SCE Color Change Effect is an
effect to primarily create a color like
the SCE Color Effect. But in addition,

you can program a color change.

You can simply choose from a color
table to select favored colors.
Likewise, you can enter a time (in
seconds) in an input field to define
how long a color will be shown. A
fade option offers a nifty transition

between colors.

Tap

206
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To set up the "Color Table", please click
the button. A new window containing a list will appear. You can enter numerical values from 0 to
255 for red, green, blue, and white via input fields. You can extend your list with a new color
value by pressing the "+" button. Existing entries can be deleted from the list by marking it and
pressing the "-" button. The order of your entries (colors) may be changed, too. In order to do

so, simply select the color and press the upward arrow or the downward arrow.

The list you created as well as presets can be saved and loaded. The number of entries in the list
can be seen in the lower part of the window. In our example shown above, six entries are

currently included in the list (#6). To close the window, click "Close".

Please note: The last color will automatically cross-fade to the first color in the list.

Using the Tap Button for Manual BPM Input
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The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this

button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will
calculate the BPM value subsequently.

5.15 SCE Color Fill

The SCE Color Fill effect offers you six different filling effects: Random, Drops, Snake, Flat,
Collapse, and Tetris.

"Fill Time" specifies how many seconds will pass until the matrix is filled completely. "Duration”
determines the delay before the effect starts again.

SCE Color Fill - Random Mode

SCE  Calor Fill
=) Mormal

color Takle T Wi Caolar
hdade | Random W

Fill Time i — L e e N
 —— | |

Duration | 1 | <HPALI L LILLIITI
L o I I
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The SCE Color Fill in random mode
randomly fills the matrix with one or

more colors.

To set up the color scheme, press
the "Color Table" button. If you
activate "Mix Color", all colors in
your color table will be used to render

a colorful picture on the output.

SCE Color Fill - Drops Mode
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The SCE Color Fill effect set to Drops

mode fills the matrix with colored

drops (as if it rains). B E_:_:-_.:.;:_ = -::.:___ LT E. ] - "
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activate "Mix Color", all colors in . %— _" -'—-_.: s

your color table will be used to render

a colorful picture on the output.

To set up the direction of the effect,
use the arrow buttons on the right

side of the effect area.

SCE Color Fill - Snake Mode
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This mode fills the matrix in a snake-
like mode. e SCE Color Fill in Snake

mode fills the matrix with colors.

To set up the color scheme, press
the "Color Table" button. If you
activate "Mix Color", all colors in
your color table will be used to render

a colorful picture on the output.

Especially useful features are the
options to influence the starting

point, direction, orientation, and

several modes, like mirrored,

centered, circled output.

SCE Color Fill - Flat Mode

SCE  Color Fill
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Hereby, the matrix is filled very
plainly. The picture shows the cross-

mode ("X") and a diagonal rotation.

To set up the color scheme, press
the "Color Table" button. If you

activate "Mix Color", all colors in
your color table will be used to render

a colorful picture on the output.

To set up the direction of the effect,
use the arrow buttons on the right

side of the effect area.

SCE Color Fill - Collapse Mode

Colar Fill
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The SCE Color Fill in Collapse mode
fills the matrix with colors in Tetris

style.

To set up the color scheme, press
the "Color Table" button. If you

activate "Mix Color", all colors in

your color table will be used to render

a colorful picture on the output.

In addition, the "Width" and
"Height" can be adjusted in
percent.

To set up the direction of the effect,
use the arrow buttons on the right

side of the effect area.

SCE Color Fill - Tetris Mode

Color Fill
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Randomly selected Tetris bricks are

used to fill the screen in this mode.

To set up the color scheme, press
the "Color Table" button. If you

activate "Mix Color", all colors in

a colorful picture on the output.

You may set up the starting point,
direction, and orientation of the

effect as well.

5.1.6 SCE Color Ramp
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The SCE Color Ramp effect renders a
color gradient. Settings include
adjustable values for red, green, blue,

and white.

You can either enter values directly
over the keyboard or use the fader
box with your mouse. With the

"Reset" button you can set this

effect back to default values.

large calor contral

[ | i [ | [ |
& i * o o

Using the color control: Select and hold a

color (using the small square button) and move the mouse if you want to relocate a color. Click
the small x-button at the bottom of a color to remove it. Click inside the large colored area to
create a new color at this particular position with the particular color you picked. Simply drag and

drop it afterwards to change its position. Use the input field "Position" to adjust it more precisely.

The "Alpha value" sets the opacity of a single color. It becomes transparent and

blends with the background.

Furthermore, you can define the direction of the gradient by simply clicking onto the direction
buttons.

Selecting a mode is also possible.
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If you select "Radial Ramp", the slider called "Angle" becomes available. Use this slider to rotate

the Radial Ramp according to your wishes. A range of 0 to 359 degrees is available.

5.1.7 SCE Color Scroll
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The SCE Color Scroll Effect delivers a

moving color gradient.

Speed and direction can be easily
modified.

Press "Fade" to get a smooth
gradient from color to color.

"Offset" determines the size of the color bars, i.e. it sets the distance between colors of the

gradient. Activate "Rnd" (random) to receive a random broadness of the gradients. Two input

fields below "Offset" define the value of the minimum and maximum width.

To set up the "Color Table", please click
the button. A new window containing a list will appear. You can enter numerical values from 0 to
255 for red, green, blue, and white via input fields. You can extend your list with a new color
value by pressing the "+" button. Existing entries can be deleted from the list by marking it and
pressing the "-" button. The order of your entries (colors) may be changed, too. In order to do

so, simply select the color and press the upward arrow or the downward arrow.
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The list you created as well as presets can be saved and loaded. The number of entries in the list
can be seen in the lower part of the window. In our example shown above, six entries are

currently included in the list (#6). To close the window, click "Close".

These arrow buttons define the direction and starting point of an effect. Press the
downward arrow if you want the gradient to move from top to bottom. Press the upward arrow if
you want the gradient to move from bottom to top. The cross in the middle activates a movement
from two, opposite directions. The gradient may also move inside out or vice versa. Additionally,
several other options (horizontal, vertical, rectangle, square, ellipse, circle, in implode or explode

mode) are available.

If you want to have smooth gradients, press the Fade button.

Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.
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5.1.8 SCE Drops

SCE Drops
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The SCE Drops effect displays falling

objects, just like rain drops.

As always, the input field "BPM" sets
the speed of the effect. You may

enter a value between 1 and 9999.

"Step" can be used to stretch the drops. For example, a step value of 2 will render drops every
second pixel. With "Length" you can choose the length of the single objects. Adjust the number
of objects by using "Count". "Width" sets the width of each object, while "Pitch" determines

the spacing between objects.
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Four arrow buttons allow you to decide in which direction the effect should move.
In addition, you can choose from different shapes. Click the button labeled "Line" by default.

Use the "Color Table" to set up the colors of the effect. In addition, those colors can be used in

chronological order or shuffle mode. Entirely random colors can be used, too.

P2
LT

To set up the Color Table, please click the
button. A new window containing a list of colors will appear. You can enter numerical values from
0 to 255 for red, green, blue, and white via input fields. You can extend your list with a new color
value by pressing the "+" button. Existing entries can be deleted from the list by marking it and
pressing the "-" button. The order of your entries (colors) may be changed, too. In order to do

so, simply select the color and press the upward arrow or the downward arrow.

The list you created as well as presets can be saved and loaded. The number of entries in the list
can be seen in the lower part of the window. In our example shown above, six entries are

currently included in the list (#6). To close the window, click "Close".

Using the Tap Button for Manual BPM Input

© 2011 inoage GmbH



221 MADRIX Help and Manual

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this

button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will
calculate the BPM value subsequently.

5.1.9 SCE Explosions
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Explosions

The SCE Explosions effect can display

all kinds of explosions and fireworks.
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The Color Table defines the colors used by the effect.

"BPM" defines the speed of the effect.

"Size" defines how big the whole explosion will be.

"Shape Size" defines how big single objects are.

"Explosions" defines how many explosions are displayed by the effect at the same time.
"Shapes" defines the number of single objects a single explosion includes.

"Fade Out" defines if objects get a visual tail and fade out over time.

"Gravity" defines how strong objects are dragged to the bottom.

"Sparkle" defines which color is added to single and small parts of the explosion.

==l .
= Blur

You can choose from two different modes: Explosions and Fireworks. If Fireworks
is selected, you may also define a direction will the help of the four arrow keys. You can also
choose from different types of explosions (Sphere, Sphere Glow, Spiral, Radial, Diamond, Star, or
Random). You can also choose from different shapes for the objects (Rectangle, Rectangle Filled,

Circle, Circle Filled, Cross, Star, Diamond, Diamond Filled, or Random).
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5.1.10 SCE Fire
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The SCE Fire effect renders a colored

fire.

The effect has two
modes "Fire" and "Flames". Use this

button to select which mode you

want to use.

As always, the input field "BPM" sets the speed of the fire. You may enter a value between 1 and
9999. With "Height" you can choose the height of the fire. The flames height can be adjusted
from 1 to 32.

© 2011 inoage GmbH



MADRIX Effects 224

Four arrow buttons allow you to decide where the fire should have its starting
point. If you want the fire effect's direction to be from bottom to top, press the upward arrow, for

example.
Fire Mode

The effect area includes several presets for this effect. Different color variations are set by using
the buttons "RG", "RB", "GR", "GB", "BR", and "BG". Single colors arise from additive color
mixtures via RGB. In this way, flames are displayed shades of red - green (RG), red - blue (RB),
green - red (GR), green - blue (GB), blue - red (BR), and blue - green (BG).

Flames Mode

Use the "Size" slider to adjust the width and height of an individual flame. "Intensity" regulates

the size of the fire further.

Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.
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5.1.11 SCE Metaballs
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The SCE Metaballs effect displays
objects that morph into each other

creating a liquid animation.

Tap

R

|— .:ir'l::lEe Fi...

=

e s | =1

ircle

frledhom

The Color Table defines the number and type of colors used by the effect. You can use more

than one color for the effect.

"BPM" defines the speed of the effect.

"Count" defines the number of objects (metaballs).

"Max. Size" affects the maximum magnitude of the metaballs.

"Outer Glow" determines the outer shimmer of objects.
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"Inner Glow" determines the inner gleam of objects which are not filled.

"Border" adjusts the border size of non-filled objects.

Next to the "Max. Size" slider, a drop-down button provides several modes on how the

size of the metaballs is calculated.

Uniform - Each metaball has the same size.

Linear - A linear distribution is used to increase the size regularly.
Quadratic - The majority of metaballs will be smaller than the rest.

SQRT - Using a square root function the majority of metaballs will be larger.
Cubic - Uses a cubic distribution with mixed sizes.

Random - Sizes will be generated randomly.

The "Rnd" button (random mode) can be tapped to generate new random sizes
each time. This automatically activates "Random" mode. Use the "Scale" slider for resizing. This

slider is only available in random mode.

Circle

Medicm

In addition, you can choose from different shapes (Rectangle, Rectangle Filled,
Circle, Circle Filled, Diamond, Diamond Filled). A second button allows you to choose a second set
of metaballs in cirlce, rectangle, or diamond shape. A third button defines how much the colors
are mixed within the morphing objects (Very Blurry, Blurry, Slightly Blurry, Medium, Slightly Clear,
Clear, or Very Clear).

Using the Tap Button for Manual BPM Input
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The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will
calculate the BPM value subsequently.

5.1.12 SCE Plasma
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The SCE Plasma effect is used to
show a liquid and moving color

gradient.

Set up the "BPM" speed and various

colors to influence the outcome.
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Using the color control: Select and hold a
color (using the small square button) and move the mouse if you want to relocate a color. Click
the small x-button at the bottom of a color to remove it. Click inside the large colored area to
create a new color at this particular position with the particular color you picked. Simply drag and

drop it afterwards to change its position. Use the input field "Position" to adjust it more precisely.

The "Alpha value" sets the opacity of a single color. The color becomes transparent

and blends with the background.

Furthermore, you can define the direction of the gradient by simply clicking onto the direction

buttons.

If you want the gradient to be rendered more smoothly, press the "Fade" button ("Set Frame
Fade").

Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.
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5.1.13 SCE Pulse/Stroboscope
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The SCE Pulse/Stroboscope produces a stroboscope or pulsating effect.

Enable this effect to generate regular flashes. Strobe lights are often used in nightclubs and

raves, and are available at home for special effects or in the entertainment area.

"Frequency" (frequency) determines the flash interval in "Pulse" mode. Sequences can vary

from very slow speed (a value of 1) to a very high velocity (a value of 25).

In "Strobe" mode you can select the time, the effect switches "On" and "Off".

If you want the effect to be rendered more smoothly, press the "Fade" button ("Set frame

fade").
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5.1.14 SCE Radial
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The SCE Radial offers moving colors in

three different radial modes.

Set up the "BPM" speed and various
colors to influence the outcome.
Values for red, green, blue, and white
may be used.

230

You can either enter values directly over the keyboard or use the fader box with your mouse.

Use the input field "Length" to define the extent of the shapes. Change X and Y coordinates to

modify the "Center" of a radial effect.
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This drop-down button allows to select different modes. You can choose from
three different types of effect: "Circle", "Radar", and "Helix". Select a mode after clicking the

button to activate the particular mode.

With the sinus buttons you can define the color mode (one color or multi-color
mode.) Direction buttons allow to set up the motion direction. Additionally, you will find two

moving mode buttons to define inside-out or outside-in mode.

"Factor" and "Amplitude" are available when "Circle" or "Helix" is selected. "Factor" influences
the way the function is drawn. It increases the number of waves. "Amplitude" increases the

intensity of those waves.

Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.
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5.1.15 SCE Shapes

1)1 Mormal Link

Colar Takle W R

T EE e 1 I I O N W R AR

BFM 1200 | = |

Fade (BFNY, 150
| EE—— |

I e [ e A AR AR NININT
! T

|' I I I O O I W A AT

Count 1
Wi dth 10 P | T O O I I AR

Border, 4| ML UL ULULELTnm
[ . | |

The SCE Shapes effect randomly
renders objects with different shapes

in a color you have selected.

There are different modes for colors,
speed, fade times, number of objects
(Count), Width, Border, and different
types of shapes.
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mand Implode
indd Filled
‘ Diamaond Fille

The picture shows available modes/shapes for this effect. You have to
play with the parameters BPM, Fade, Count, Width, and Border to see the possibilities you have
with this effect. Be creative and try to combine this effect with others by using layers and

different mix modes.

Using the Tap Button for Manual BPM Input
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The effect includes a special function for setting BPM manually. If you want to attain

synchronous movements of effects to the beat of the music, press the "Tap" button. Press this

button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.

5.1.16 SCE Starfield
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SCE Starfield mainly simulates a field
of stars streaming towards the viewer
from the center of the effect. This

creates a depth effect.

The Color Table defines the colors used by the effect.
"BPM" defines the speed of the effect.

"Rotation Amount" defines how much the single objects rotate around the center. You can
rotate the effect to the left and to the right. If the slider is positioned in the middle, it will not
rotate (0).

"Length" defines how long the tail of the objects is, how much depth effect is applied.
"Width" defines how big the flying objects are.

"Depth" further influences the depth effect and how near or far the objects seem to be.

You can choose from different shapes (Rectangle, Rectangle Filled, Circle, Circle
Filled, Cross, Star, Diamond, Diamond Filled, or Random). You can also change if objects fly

outwards (from far to near) or inwards (from near to far).
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5.1.17 SCE Ticker - Scrolling Text
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Ticker - Scralling Text

With the SCE Ticker effect you can easily
write text messages. Use the "Text" field

to set up the message content. A different

color can be chosen similarly.

The "Offset" area is used to configure the position of the text with the help of the x-axis (left
input field) and the y-axis (right input field). Positive values for x will locate the text more to the
right. Negative values move the text to the left. Positive y-values relocate the text downward.

Negative values set it upwards. Use the spacebar to reset values to 0.

Choose the desired typeface by pressing the "Font" button. Microsoft® operating

systems already include optimal fonts. Load for example the font "Small Fonts” and adjust the
type size.

Attention: The color, which you can set up inside this "Font Selection" dialog, is going to be
ignored! MADRIX will use the color selected in the effect dialog instead.
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Activate "Reverse Sentence" to display the whole text in reverse. Activate "Reverse Word", if
you want to change the word order in a sentence. The last word of the sentence is going to be

the first one in the output.

The buttons "S", "W", and "C" stand for sentence, word and character. Activate the sentence
button ("S") when you want to interpret the text as a sentence. Activate the word button ("W")
when you want to have the text interpreted in the single words (with line breaks). Activate the
character button ("C"), when the text should be displayed in single characters (with line breaks).
The differences will be especially visible when scrolling the text from top to bottom or reverse, for

example.

The arrows section offers the possibility to define the direction of the movement. For a text
running from bottom to top, press the upward arrow. The square in the middle fixes the text at
default position.

Important Notes For Smoother Movements

If you activate the "Smooth" switch, the movement of the text will be rendered more softly. We
suggest to use this feature if your matrix has a lot of pixels in x and y or if you think the text

movement is not fluent enough.

Please also activate the "Frame Fade" button if you wish to have smoother text.

Typefaces

Typefaces can be grouped into two main categories: serif and sans-serif. Serifs contain small

features at the end of strokes within letters.

AaBbCc

Sans-Serif font
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AaBbCc

Serif font

Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.

5.1.18 SCE Video
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With the SCE video effect you can play
videos or grab a video signal from a
WebCam, for examply. Click "Open" to load

a video.

All video codecs that are installed on your computer are being supported automatically by MADRIX.
If you want to have all the features of the SCE Video effect, use Apple Quicktime videos. With
Apple Quicktime videos (*.mov, *.qt) you get support to play videos backward and forward-

backward looping. Please ensure that Apple QuickTime 6.0 or above is installed.

The SCE Video effect is also able to play MADRIX Record Files (*.mrec). Learn how to create your

own record files in the chapter Recording.

Capturing

Video signals of capture devices, such as an installed webcam or TV-

card, can be used, too. The button will glow in green, when capturing is activated.

CAptUre

Click "Capture" and choose your video capture device.

With MADRIX several capture devices can be easily be used. For every single layer and each
different effect pipeline a different capture device can be utilized. It is also possible to use the

same capture device multiple times.
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Playing Video Files

I Cpen

Use the "Open" button to select the video file you wish to play.

Start | 00:01:0%5 End | O0:02:04
| M | L |

"Start" and "End" set the start/end position at which
the video starts/stops playing. The Start/End fields support the following inputs for the time:

For an input of one hour you can use 0100000, 01:00:00, 01,00,00, 01.00.00,
01/00/00, 1h, or 01h0OOMOOs.

For an input of ten minutes you can use 001000, 00:10:00, 00,10,00, 00.10.00,
00/10/00, 10m, or 00h10mO0Os.

For an input of ten seconds you can use 000010, 00:00:10, 00,00,10, 00.00.10,
00/00/10, 10s, 00hOOM10s.

The space bar resets the field to the default value.

A bar of commonly used buttons allows you to easily control the video

playback.

Additionally, a time scale and a time window show the current playback position.

ek

The integrated video player offers even more options. "AS" (Autostart) will
automatically start the video after the loading process, or even in pause modus when changing
the Storage space. You can also enable various playback modes: an endless repetition of the

video by activating the Loop button.
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Video play modes:
None: in this mode the video stops playing after it reaches the time entered in the end position
field and will jump back to the start position.
Loop: in this mode you will activate an endless repetition of the video.
Loop backward-forward: when the video reaches the start or the end position, it will change the

play back direction.

The video itself can be moved across the matrix. Use the arrows to decide for a
direction fix the output.
If you want to display the loaded video in gray color mode, activate "Greyscale".
By marking "Stretch" the loaded video will be automatically adjusted to your matrix size. The

switch "Tile" is for tiling the loaded video on the matrix size.

"BPM" defines how fast the video is moved across the screen/matrix.
This value and fader are for moving videos horizontally, vertically, etc. Move the fader to the left

to slow down the movement and move the fader to the right to speed it up.
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With the help of the rotation function you can rotate videso and live video signals
by 90°, 180°, and 270°.

The output can be set to matrix, original, 4:3, or 16:9 mode in addition to
the stretch feature to use a correct display mode for your loaded video. A 16:9 video is viewed

best in 16:9, for example.

I =5 RSB

If you have RGBW fixtures and you want to use the white channel, please
activate "RGB to RGBW" mode. Television screens and computer displays work with pixels
(picture elements) using values for red, green, and blue (RGB). Also computer video files are saved

in RGB mode. MADRIX features an integrated color space conversion from RGB to RGBW.

A colored video can be converted to monochrome colors by using the "Greyscale" mode.

Setting The Speed
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The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.
You can also use the "BPM" slider to adjust the beats per minute.

In contrast, "Speed" defines the playback speed of the selected video.

If you have opened a video and it is not possible to change the speed, this feature
simply is not supported by the loaded video codec! Please use the Apple QuickTime

codec instead (*.mov file format).

Deinterlace Modes

Often digital cameras, digital broadcasting, or digital filming is done via interlacing. In order to get
25 frames per seconds, 50 pictures are shot and merged/mixed with one another. You receive 25
odd frames (frame set 1) and 25 even frames (frame set 2) that contain different picture

information (alternating pixel lines). In order to get an undisturbed picture, proper deinterlacing is

necessary.

=)

By clicking the Deinterlace button ("DI"), you can activate the deinterlace mode.

A new window with "Deinterlace Settings" will open. Now, you can choose from 5 different

modes:

None Use this option to deactivate deinterlacing.
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Bob

Bob Linear

Blend

Discard

This mode uses one set of 25 frames (even or odd) and copies missing
information from the pictures provided. Pixel lines are copied to create a full
image.

Activate "Top Field First" in order to choose odd frames to be processed.

This is the recommended deinterlace mode.
Bob Linear uses one set of 25 frames, but builds an average for the missing
pixel lines.

Activate "Top Field First" in order to choose odd frames to be processed.

This mode renders an average image from frame set 1 and frame set 2.

Discard simply dismisses missing information. Thereby, pixel lines are
excluded. This results in half of the original resolution for the final image.

Activate "Top Field First" in order to choose odd frames to be processed.

Important Notes

Apple QuickTime Codec

Please download and install Apple Quicktime for free if you want to use Apple Quicktime videos.

This codec package is highly recommended for using video file swith MADRIX. (If you are only

using Apple Quicktime, please disregard the following codec pack).

Having Codec Problems? - Install the K-LITE Codec Pack
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Please install the "K-Lite Codec Pack" if you encounter problems when playing a video file or when
a codec is missing. This codec pack is a collection of VFW/ACM codecs, DirectShow filters, and
tools. Codecs and DirectShow filters are needed for encoding and decoding (playing) audio and
video formats. The K-Lite Codec Pack is designed as a user-friendly solution for playing all your

movie files.

Using Videos In Your MADRIX Setup

When using video files in your setup, MADRIX will locate these files on your harddisk. But MADRIX
will not save the videos in your MADRIX setup file. In order to play the setup on a different

computer, you will need to copy your videos, too.

5.1.19 SCE Wave
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With the SCE Wave effect displays a

moving wave with a particular color.

Adjust the speed with the "BPM"

slider.

"Length" sets the wave's width. You
can influence the outcome further by

using various directions and modes.

This mode uses a sine wave with absolute values. Activating it, will turn the

"Mode" directly influences how the
wave is drawn. Do not hesitate to
experiment with the settings. A

description is given below.

button green.

This mode represents a sine wave. Activating it, will turn the button green.

-|'|'T| Select this button to activate sawtooth mode, which has its peak to the left.

Activating it, will turn the button green.

Select this button to activate sawtooth mode, which has its peak to the right.

Activating it, will turn the button green.

© 2011 inoage GmbH



247 MADRIX Help and Manual

ﬁ This button activates triangle wave. Furthermore, you can adjust the slider
"Peak". By default, this slider is set to 50, which is the middle position. If you
set it to the far left, a sawtooth with a peak to the left will be shown. If you
set it to the far right, a sawtooth with a peak to the right will be shown. In this
way, you can create your individual wave with values inbetween. Activating the

button will turn it green.

Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.

5.2 Sound2Light Effects (S2L)

S2L - Sound2Light Effects require an audio input signal. As a result,
amazing light effects that are synchronized to the music will be generated!
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5.2.1 S2L Equalizer

Equalizer
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The S2L Equalizer provides a real-time equalization

and visualization of the audio signal.

By default low frequencies will be displayed to the
left and high frequencies to the right. Color and
speed functions will be available to you in the

menu.

The "BPM" (speed) function determines how fast

the equalizer is updated.

Addtionally, the "Drop" rate specifies how fast shown frequencies drop to make room for new

ones.

You can use the "Amplify" function as a visual amplifier of the audio signal. Values will be
displayed more intensely as a result. The more you move the fader to the right, the stronger will
be the visual amplification of the single signals.

You can use the input field "Bands" to define the amount of frequency bands you want to
display. A maximum value of 511 is supported by MADRIX allowing for a spectacular 511-band
equalizer effect.
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You can define the colors for the equalizer by clicking at the "Colors"
button. By activating the "Monochrome" button the equalizer will be displayed in white color. If

you activate the "Band" mode button you will get a gradient per band with selected colors.

LGS —E—

"View Log" switches to logarithmic rendering of the signals. "Push
HF" (push higher frequencies) modifies the height of higher tonalities, i.e. amplifies their outline.

Depending on the kind of music as well as its volume, we suggest to try what fits best.

]

Alter the starting point of the equalizer by using the direction arrows. If the
arrow key "Up" is used, low frequencies are display to the left and high frequencies are displayed
to the right.

There are several other modes included, such as "Invert" and "Mirror", to be able to modify the

appearance of the effect further.

These two mode buttons allow you to control the direction of the effect from

outside to center or vice versa. They activate a doubled equalizer at the same time.

Use this button to select one of five different modes: "Bar" is selected by
default. It is the common way of displaying an equalizer. "Radial" transforms the equalizer graph
into a radial shape, which is outlined. "Radial Line" does not include this outline, while "Radial

Outline™ displays nothing but this outline. "Radial Dot" uses dots to outline the radial equalizer.

Using the Tap Button for Manual BPM Input
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The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.

522 S2L EQDrops
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The S2L EQ Drops effect renders
equalizer drops falling

synchronously to the music.

As usual, the intelligent Color Picker
allows to easily select the color of

the drops.
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"BPM" sets up the speed with which the drops are being displayed and updated. If you would like
to have slow movements (updates) move the fader to the left, or put in low numerical values.
Values in a range from 1 to 9999 are supported. If you move the fade to the right, the update

speed increases and drops move faster.

"Length" defines the drop's length. Move the fader to the right and the drops will be displayed

longer. The numerical values for the length have to be in the area from 1 - 100.

"Bands" determines the number of equalizer bands shown. If you have a matrix size with 50 x 50
pixels for example, you can make use of a 50-band equalizer at maximum. Additionally, you may

"Invert" or "Mirror" the equalizer.

"Sens" controls the sensitivity of the audio analysis. It works like an audio filter. The more you
move the fader to the right, the less drops will be displayed. The sensitivity will increase and only
the most important analytical data will be used. The numerical values for Sens have to be in the
area from 0 - 100.

=
e
oy

Four arrow keys allow you to determine the direction and starting point of the
effect. Press the downward arrow to display falling drops. Likewise, drops can be send from
bottom to the top, for example. In both cases, lower tones are displayed on the left and high

tones on the right.

If you have activated "Use Level (db)", this effect illustrates the (volume) level
of the music and its frequencies. MADRIX uses the color that has been selected by you, when a
certain level in the music has been reached. If this feature is activated, it is not possible to adjust

"Length" because the length of the drops now represents the level of the music.

Using the Tap Button for Manual BPM Input
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The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.

5.2.3 S2L EQ Shapes

Mormat

Color Table = Fnd
I EEEEEETmm

|1 LU L
Trrrl.

Fada (BFMY, 150
e

 TTTTTTITI
G a————————

Pitch 20 + | | O I W R RN

Border| 1| ™ "I
o ——

|' I O O O Y A AT ' Uze Level (ch)

Amplify 0
el

The S2L EQ Shapes are a real-time
equalization of the audio signal using
a variation of shapes to display tones
of the music. By default low
frequencies will be displayed at the
bottom of the matrix and high tones

at the top.
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There are different parameters to set
up different colors, BPM/fade, width
of the objects, spacing between
objects (pitch), size of their border,

and various types of shapes.
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The picture shows available modes/shapes for this effect. You have to
play with the parameters BPM, Fade, Count, Width, and Border to see the possibilities you have

with this effect. Be creative and try to combine this effect with others by using layers and

different mix modes.
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524 S2L EQ Tubes
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The S2L EQ Tubes effect delivers an
equalizer-like effect displayed as

horizontal or vertical lines.

You can simply choose a color by

using your mouse or keyboard.

"BPM" sets up the speed with which the drops are being displayed and updated. If you would like
to have slow movements (updates) move the fader to the left, or put in low numerical values.
Values in a range from 1 to 9999 are supported. If you move the fade to the right, the update

speed increases and drops move faster.

"Fade (BPM)" determines the fade-out time of lines. The higher the value, the faster lines will

vanish.
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wi =

These two buttons decide if lines should be displayed in horizontal or vertical order.

This button enables horizontal and vertical lines to be shown at the same time, i.e.

crossed.

You can use the "Amplify" function as a visual amplifier of the audio signal. Values will be
displayed more intensely as a result. The more you move the fader to the right, the stronger will

be the visual amplification of single signals.

"Bands" determines the number of equalizer bands shown. If you have a matrix size with 50 x 50
pixels for example, you can make use of a 50-band equalizer at maximum. Additionally, you may

"Invert" or "Mirror" the effect.

If you have activated "Use Level (db)", this effect illustrates the (volume) level
of the music and its frequencies. MADRIX uses the color that has been selected by you, when a

certain level in the music has been reached.

Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.
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5.25 S2L Frequency Flash
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The SCE Frequency Flash effect
generates a pulse effect which is

running synchronously to the audio

frequencies.

The effect shows a color when a high level between the two selected frequencies is reached.
Afterwards, the selected color will be dimmed with a certain "Fade" duration. When a high level is
reached once more, the color will be set to 100% again.
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Ezand | 5 Hz 102 Hz

In order to be able to specify how the effect should work,

MADRIX offers the user to set a frequency "Band". In this way, the software analyzes the music

with regard to certain areas/frequencies (in Herz). The left box represents the lowest frequency,

the right one the highest. In the example shown above, the frequency spectrum includes

everything between 8Hz and 102Hz. Bass tones (usually 8Hz - 135Hz) are especially suited for this

effect.

"Sensitivity" controls the sensitivity of the audio analysis. It works like an audio filter. The more

you move the fader to the right, the less drops will be displayed. The sensitivity will increase and

only the most important analytical data will be used. The numerical values for Sens have to be in

the area from 0 - 100.

5.2.6

S2L Level Color
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The S2L Level Color effect refers to
the level of music. It puts out the
color that has been selected by you
when a certain level in the music has

been reached.

After that the color is being dimmed
with the "Fade" duration that has

been set. A high level sets the color
to 100%.

The speed value ("BPM") let's you determine how close the audio analysis correlates to the
music. Higher speeds are suitable for electronic, beat-intense music, while classical music benefits

from lower values.

If you activate the "Mono" switch, you will have a mono audio analysis using only 1 audio

channel.

Four arrow buttons allow you to alter the direction and starting point of the
effect. Press the downward arrow if you want the effect to be displayed from top to bottom, for

example.

Using the Tap Button for Manual BPM Input
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The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.

52.7 S2L Level Meter
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The S2L Level Meter refers to the
stereo level of music input and

renders by default a 2-band level.

The left audio channel will be
displayed left and the right audio
channel will be displayed on the right
side.
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For setting up colors simply press the "Color Table" button.

"BPM" sets up the speed with which the effect is displayed and updated. If you would like to
have slow movements (updates) move the fader to the left, or put in low numerical values. Values
in a range from 1 to 9999 are supported. If you move the fade to the right, the update speed

increases and the band moves faster.

You can use the "Amplify" function as a visual amplifier of the audio signal. Values will be
displayed more intensely as a result. The more you move the fader to the right, the stronger will

be the visual amplification of single signals.

The "View Log" button switches to logarithmic rendering of the signals. Depending on the kind of

music as well as its volume, we suggest to try what fits best.

In the "Bands" area you can set the number of the bands for this effect. Maximum is 2 since only

the left and right audio channel are included.

Alter the starting point of the equalizer by using the direction arrows. There are several other

modes included, such as inversion, to be able to modify the appearance of the effect further.

Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.
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5.2.8 S2L Level Ring

Level Ring
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The S2L Level Ring again uses the
stereo level of the music. It
generates a colored two-band level
output in a form that has been
selected by you (retangle, circle,

cross, star).

The left and right audio channel will

be displayed as a deflection of the

level ring form.

For setting up colors simply press the "Color Table" button.

"BPM" sets up the speed with which the effect is displayed and updated. If you would like to
have slow movements (updates) move the fader to the left, or put in low numerical values. Values
in a range from 1 to 9999 are supported. If you move the fade to the right, the update speed

increases and the band moves faster.
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You can use the "Amplify" function as a visual amplifier of the audio signal. Values will be
displayed more intensely as a result. The more you move the fader to the right, the stronger will

be the visual amplification of single signals.

The "View Log" button switches to logarithmic rendering of the signals. Depending on the kind of

music as well as its volume, we suggest to try what fits best.

Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.

5.29 S2L Waveform
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The S2L Waveform refers to the
stereo or mono level of the music and

produces a moving waveform.

Use the "Time Slot" to change the

movement speed. Move the fader to
the right, the update rate decreases
and the effect will run slower. Values

lower than 1 are also possible.
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Using the color control: Select and hold a

color (using the small square button) and move the mouse if you want to relocate a color. Click
the small x-button at the bottom of a color to remove it. Click inside the large colored area to
create a new color at this particular position with the particular color you picked. Simply drag and

drop it afterwards to change its position. Use the input field "Position" to adjust it more precisely.

The "Alpha value" sets the opacity of a single color. The color becomes transparent

and blends with the background.

This control box allows you to set up the audio analysis mode. You can select

between mono, stereo, left and right audio channel. If you select stereo, you will see two

graphs. One graph will only be displayed using one of the other three modes.
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Four arrow buttons allow you to alter the direction and starting point of the

effect. Press the downward arrow if you want the effect to be displayed from top to bottom, for

example.

These two mode buttons allow you to control the direction of the waveform from

outside to center or vice versa.

Experimenting with the parameters can deliver amazing results!

5.2.10 S2L Wavegraph
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The S2L Wavegraph refers to the
stereo or mono level of the music and

renders a moving wavegraph.

Set up the various colors to influence
the outcome. You can either use the
mouse or enter values easily via your

keyboard.

Use the "Time Slot" to change the movement speed. Move the fader to the right, the update

rate decreases and the effect will run slower. Values lower than 1 are also possible.

This control box allows you to set up the audio analysis mode. You can select
between mono, stereo, left and right audio channel. If you select stereo, you will see two

graphs. One graph will only be displayed using one of the other three modes.

e
e

Four arrow buttons allow you to alter the direction and starting point of the

effect. Press the downward arrow if you want the effect to be displayed from top to bottom, for

example.
iy oy

These two mode buttons allow you to control the direction of the waveform from

outside to center or vice versa.

Depending on the type of music as well as the volume of the music, we suggest to just play
with the functions.
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5.3 Music2Light Effects (M2L)
Introduction
As a special highlight, MADRIX offers you Music2Light effects. These effects incorporate advanced

analytical methods to analyze music for tone theoretical parameters. MADRIX analyzes the height

of tones, volume, and also single tones, intervals, keys, and tonalities to name but a few.

b dis gis
as
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The music is being analyzed in real time by the MADRIX music
analysis. With the analysis of the tonality connections, the software relies on the "Instructions in
Level of Sound” by Paul Hindemith. Paul Hindemith (16 November 1895 - 28 December 1963) was a
German composer, violinist, teacher, theorist, and conductor. He established the theoretical
principals of the level of sound in modern music.

Possibilities
Moment analysis - The currently played music (at this instant) is being analyzed.

Time analysis - The tone theoretical parameter is being observed over a certain period of time
and statically appraised. For example: The key that was dominant during the last second will be

displayed, or intervals are being shown, which were re-adapted during the last half second.
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Techniques Of The Tone Analysis

Basic tone analysis (Tonality).
Scale analysis to the accepted tonality (Major, Minor).

Analysis of intervals relatively to the accepted tonality.

Analysis of the absolute interval (distances between adjacent tones).

Single tones.
Number of single tones (max. 128).

Volume of single tones.

5.3.1 Notions Of Music Theory

Overview

MADRIX offers incredible Music2Light (M2L) effects. The music is being analyzed with tone

theoretical parameters.

*3
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This section will provide you with more details regarding single tones, tonality, scale, key, and

intervals.
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5.3.1.1 Single Tones

Tones are the basic elements of music. With the
term "tone", one, single tone is meant. You have to distinguish tones from sounds, which are
composed of more than one tone. The basis of all tones is, via a frequency, an exactly defined
sinus tone. An instrumental tone, e.g. from a violin, is a complicated mixture of the (playing and
sounding) basic tone and a couple of simultaneously occurring over tones. This fact, among

others, is responsible for the typical sound of the instrument.

5.3.1.2 Tonality

For defining a certain tonality of a chord, all intervals
have to be included. In most cases, the tonality of the chord is corresponds to the basic tone of

the strongest interval.

5.3.1.3 Scale
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In the musical field, the adjectives 'major' and 'minor'
can describe a scale, key, chord, or interval. For intervals, the terms refer to a difference in their
relative width, major referring to notes somewhat further apart; the other terms are classifications

based on the use of certain intervals, especially the major or minor third.
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Major and minor are frequently referred to the titles of compositions in their foreign language form,

especially in reference to the key of a piece of musik.

A key is a hierarchy of tones (scale), which is based
on a basic tone (tonic). Examples for keys: C-minor: minor-scale with the basic tone C (comprising
the tones C, D, Es F, G, As, B, C), Fis-major: major-scale with the basic tone Fis (comprising the

tones Fis, Gis, Ais, H, Cis, Dis, Eis, Fis).

5.3.1.5 Intervals
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In music theory, an interval is the relationship between two notes or pitches, the lower and higher
members of the interval. It often directly refers to those two notes (otherwise known as a dyad).

Larger intervals are described as wide and smaller ones as narrow (for example, a sixth is wider

than a third). But these are only relative terms.
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To be able to define the tonality of a chord, it is necessary to check for the included intervals.

5.3.2 Standard Color Setup For M2L Effects

For choosing the colors for the MADRIX Standard Color Setup,
the Circle of Fifths from music education is being used. Starting with C, this notion describes a

circle. Because of that, the relationship of the keys is visible from the arrangement.

Adjacent keys are named 'parallel keys'. The greater the distance between two keys, the less

related they are. To support this fact, complementary colors are used in MADRIX.

The outer ring of the circle describes the major keys, the inner ring the minor keys. While
colors describe the tonality, the scale of the color is being expressed with the help of the

brightness.
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By assigning yellow to the tonality C and due to the fact that the colors are assembled clockwise,

all other colors emerge. Consequently, Fis gets assigned blue, the complementary color of yellow.

Any other color for the keys between C and Fis arises from the spectrum of colors between yellow

and blue of the RGB color model.
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53.3 M2L Color Fade
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This Music2Light Color-fade effect offers a suitable

light mood in unison with the music.

The MADRIX music analysis works in this effect
according to the following criteria: existing keys

and tonalities.

You may select different colors for different

tonalities. In this way, if the sound changes, the
color will fade, too.

The "Base" color defines the default background color of the effect. RGB values (from 0 to 255)
can be entered directly into the input fields via mouse or keyboard. Additionally, a fader box

button provides you with four sliders to adjust the color value.
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MZL Color Setup
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After pressing the button "M2L Colors"”, a separate window will be opened. This dialog offers you

the possibility to match colors to specific keys. All existing keys are displayed in this window.

Major keys are listed in the left part of the window. The right hand side contains all minor keys.
In the example above the "C" (written in capital letters) in the upper left part represents C-major
and has a pure yellow as its color value (RGB: 255, 255, 0). C-minor, located across on the other
side of the list, has a darker yellow assigned (RGB: 153, 153, 0).

You may "Load" and "Save" your color tables, too. Five color presets are already included and
can be accessed by using the buttons "C1", "C2", "R", "G", and "B". The "Close" button closes

the window.

Conclusion:

Regarding this effect, you decide which color is assigned to which key.

© 2011 inoage GmbH



MADRIX Effects 274

5.34 M2L Color Rings
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The Music2Light Color Ring effect delivers matching
gradients synchronously to the music, in form of

inward or outward oriented rings.

The music analyses work with the following criteria

in this effect: existing tones and tonalities.

You may select different colors for different
tonalities. In this way, if the sound changes, the

color will fade, too.

The "Base" color defines the default background color of the effect. RGB values (from 0 to 255)
can be entered directly into the input fields via mouse or keyboard. Additionally, a fader box

button provides you with four sliders to adjust the color value.

"BPM" sets up the speed with which the effect is displayed and updated. If you would like to
have slow movements (updates) move the fader to the left, or put in low numerical values. Values
in a range from 1 to 9999 are supported. If you move the fade to the right, the update speed
increases and the effect moves faster.
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MZL Color Setup

After pressing the button "M2L Colors"”, a separate window will be opened. This dialog offers you

the possibility to match colors to specific keys. All existing keys are displayed in this window.

Major keys are listed in the left part of the window. The right hand side contains all minor keys.
In the example above the "C" (written in capital letters) in the upper left part represents C-major
and has a pure yellow as its color value (RGB: 255, 255, 0). C-minor, located across on the other
side of the list, has a darker yellow assigned (RGB: 153, 153, 0).

You may "Load" and "Save" your color tables, too. Five color presets are already included and
can be accessed by using the buttons "C1", "C2", "R", "G", and "B". The "Close" button closes

the window.

With BPM you set the speed in which the effect is being displayed. If you would like to have slow
movements (updates) move the fader to the left, or put in low numerical values. If you move the

fade to the right, the up-date speed increases and the effect becomes faster.

Conclusion: You decide which tones will match with which colors.
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Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.

5.3.5 MZ2L Color Scroll
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The Music2Light Color Scroll effect offers a color

gradient moving synchronously to the music.

The MADRIX analyzes the following criteria:

existing key intervals and tonalities.

You may select different colors for different

tonalities. In this way, if the sound changes, the

color will fade, too.
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The "Base" color defines the default background color of the effect. RGB values (from 0 to 255)
can be entered directly into the input fields via mouse or keyboard. Additionally, a fader box

button provides you with four sliders to adjust the color value.

M2ZL Colar Setup

After pressing the button "M2L Colors", a separate window will be opened. This dialog offers you

the possibility to match colors to specific keys. All existing keys are displayed in this window.

Major keys are listed in the left part of the window. The right hand side contains all minor keys.
In the example above the "C" (written in capital letters) in the upper left part represents C-major
and has a pure yellow as its color value (RGB: 255, 255, 0). C-minor, located across on the other
side of the list, has a darker yellow assigned (RGB: 153, 153, 0).

You may "Load" and "Save" your color tables, too. Five color presets are already included and
can be accessed by using the buttons "C1", "C2", "R", "G", and "B". The "Close" button closes

the window.
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These arrow buttons define the direction and starting point of an effect. Press the
downward arrow if you want the gradient to move from top to bottom. Press the upward arrow if
you want the gradient to move from bottom to top. The cross in the middle activates a movement
from two, opposite directions. The gradient may also move inside out or vice versa. Additionally,
several other options (horizontal, vertical, rectangle, square, ellipse, circle, in implode or explode

mode) are available.

"BPM" sets up the speed with which the effect is displayed and updated. If you would like to
have slow movements (updates) move the fader to the left, or put in low numerical values. Values
in a range from 1 to 9999 are supported. If you move the fade to the right, the update speed

increases and the effect moves faster.

Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.
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5.3.6 M2L Interval Drops
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Music2Light Interval Drops analyzes intervals within
the music and displays them in form of moving
drops.

The MADRIX music analysis works with the

following criteria in this effect: included intervals.

Simply set up a color in which the drops should be

rendered.

"BPM" sets up the speed with which the effect is displayed and updated. If you would like to
have slow movements (updates) move the fader to the left, or put in low numerical values. Values
in a range from 1 to 9999 are supported. If you move the fade to the right, the update speed

increases and the effect moves faster.

"Length" sets the drop's length. The more you move the fader to the right, the longer the drops

will be. You could also enter a numerical value of up to 100.
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Four arrow buttons allow you to determine the direction and starting point of the
effect. Press the downward arrow to display falling drops. Likewise, drops can be send from
bottom to the top, for example. In both cases, lower tones are displayed on the left and high

tones on the right.

Conclusion: As soon as it is possible to analyze one or more intervals, they will be displayed

as drops in the specified color.

Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.
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5.3.7 M2L Interval Tubes
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Interval Tubes

The Music2Light interval tube effect renders

intervals included in the music in form of tubes.

The MADRIX music analysis works with the

following criteria in this effect: included intervals.

As set up possibilities you have the color values for the color of the tubes. The value from 0 to
255 can be entered. With the help of the fader box you can also enter the colors with your

mouse.

"BPM" sets up the speed with which the effect is displayed and updated. If you would like to
have slow movements (updates) move the fader to the left, or put in low numerical values. Values
in a range from 1 to 9999 are supported. If you move the fade to the right, the update speed
increases and the effect moves faster.

"Fade" determines the fade-out time of tubes. The higher the value, the faster tubes will vanish.

© 2011 inoage GmbH



MADRIX Effects 282

"Width" defines the width of tubes. An input value of 1 corresponds to 1 pixel for one tube.

Larger numbers mean more pixels per tube.

These option buttons decide if tubes are displayed horizontally, vertically, or both.

Conclusion: As soon as it is possible to analyze one or more intervals, they will be displayed

as tubes in the color you set up.

Using the Tap Button for Manual BPM Input

The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this
button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will

calculate the BPM value subsequently.

5.3.8 MZ2L Single Tone Shapes
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This Music2Light single tone effect impressively

shows single tones of the track.

The MADRIX music analysis uses the following

criteria: number of single tones and tone pitch.

Simply set up a color in which the drops should be

rendered. You can also generate random colors or

use them in shuffle mode.

"Fade (BPM)" sets up the speed with which the effect is displayed and updated. If you would like
to have slow movements (updates) move the fader to the left, or put in low numerical values.
Values in a range from 1 to 9999 are supported. If you move the fade to the right, the update

speed increases and the effect moves faster.

"Sensitivity" controls the sensitivity of the audio analysis. It works like an audio filter. The more
you move the fader to the right, the less drops will be displayed. The sensitivity will increase and
only the most important analytical data will be used. The numerical values for Sens have to be in
the area from 0 - 100.

"Width" decides over the width of objects. An input value of 1 corresponds to 1 pixel for one

tube. Larger numbers mean more larger objects for a single tone.

"Pitch" allows to adjust the spacing between objects. "Border" defines if objects are rendered

with an additional border, which makes them appear bigger.
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At the right hand side you can find a button/list to set up the mode of

the effect. Various object shapes and modes can be selected.

Conclusion: As soon as it is possible to analyze one or more intervals, they will be displayed

the color you set up.

54 MAS Script Effect

Introduction
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MADRIX offers numerous effects to create a light show.The "MAS Script Effect"” offers the

feature to program your own effects.

With the so-called script language MADRIX Script it is possible to put all your wishes and ideas
into practice. The entire MADRIX script language is fully described in the MADRIX Script Help.

The Script Help (user manual) is for all those who want to develop light effects with MADRIX
Script. However, this does not require much knowledge of programming. The different parts of this
language will be explained with various examples. We recommend for your first steps into this area
to work through these examples. In a second step you might want to try to alter the settings of
those examples. In this way you will get a feeling for the programming language and the syntax. It
is the same in real life: Practice makes perfect!

You can find the documentation in the Windows Start Menu -> All Programs -> MADRIX - >
Documentation -> MADRIX Script Help.

Interface
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Selecting the "MAS Script Effect" will display the associated interface in the
effect area. You are able to open a MADRIX script by clicking the left button "Load". The right

button will open the Script Editor and show the underlying script.

"= Lirmit Script Execution

"Limit Script Execution" can be a helpful option if you run a script
with a very long execution time. MADRIX will stop the execution of a script and runs it from the
beginning if it takes up too much processing time or is stuck in a loop. This will ensure the stability
and performance of MADRIX.

Using The Tap Button For Manual BPM Input

ap|

ap
The effect includes a special function for setting BPM manually. If you want to attain
synchronous movements of effects to the beat of the music, press the "Tap" button. Press this

button at least four times in a row according to the beat of the music (1/4 notes). MADRIX will
calculate the BPM value subsequently.

5.5 Macros & Scripts

Introduction

MADRIX features its own scripting language. With this programming language you can create
scripts or macros for MADRIX. You may use it to create your own light effects, as was described

in the previous chapter. In addition, it may be used to control and manipulate running effects.

Usage
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This button points towards the option to use macros or scripts.
The term Scripts refers to the MAS Script Effect. Macros are used on top of effects or the output.

Currently, there are four possibilities to use <%PRODUCTNAME_SCRIPT %>.

The first one is to create a new effect from scratch (MAS Script Effect).

The second involves modifying the settings of a running effect (Macros for Effects).

The third possibility controls the main output directly (Main Output Macro).

e Fourth, you can use storage place macros to control every single storage place individually (

Storage Place Macro).

On the one hand, macros can be used to manipulate the outcome of an effect. Examples include
rendering parts of effects transparent or changing the color via a grey filter. On the other hand,
macros can be used to change settings of an effect. A macro can set the text of the SCE Ticker
effect to current time, for example. Each effect is equipped with a "Macro" button. Simply click it
to call up the Macro Editor. Use the window to write, load, and edit existing macros. Each Storage
Area has one macro button, and the Fade Area includes the button to the Main Output Macro.

The MAS Script Effect does have one button for scripts and a standard button for a macro.

The complete MADRIX Script Language is described in the MADRIX Script Help. You can find
this documentation in the Windows Start Menu -> All Programs -> MADRIX -> Documentation

-> MADRIX Script Help. For further information please read this documentation.
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6 MADRIX Cue List
Overview

With MADRIX you can easily create a Cue List in just a few steps. The Cue List offers the

possibility to precisely manage the playback of effects.

You can access the feature in three ways: Go to the menu "Window" -> "Cue List", press "F7",
or click the "Cue List" button included in the MADRIX interface.

Back

al

cuelist

The Cue List window will open.

00:00:00:00 e 'E External 25FPS
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Working With Cues And Entries

These buttons are located at the left side of the Cue List window. You can therefore
create a new Cue List, open a Cue List, open a Cue List and attach it to the existing Cue List,

and save a Cue List.

It is also possible to save a Cue List in *.csv file format. This feature allows you to edit Cue

Lists with your preferred text editor very easily.

The right side of the Cue List window contains 5 buttons. You may add and remove
entries to/from the Cue List ("+" and "-"), add all Storage Places that are in use to the Cue
List ("Cue All"), and for moving entries upwards or downwards in the list ("Up" and "Down"

arrows).
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Selecting And Modifying Multiple Entries
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You can select and modify more than one entry at a
time. Simply select several entries (by using "Shift" or "Ctrl" plus "the left mouse button" or "the

arrow keys") and right-click into the column of the value you wish to change. That could be the
duration of the effects, for example.

Controlling The Cue List - Play, Pause, ...

At the bottom of the Cue List window you have controls for "Go",
"Back", "GoTo" and a "Play/Pause" button. Press "Go" to skip to the next Cue List entry.
Press "Back™" to select and play the previous Cue List entry. By typing in a number into the input
field and clicking the "GoTo" button the next Cue List entry will be the number you chose.
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Time Code

Overview

Time Code
T
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Next to the general controls
the "Time Code" section is shown. MADRIX is able to work with Time Code. There are options:

If you activate "System Time", your internal computer clock generates the Time Code. If the
time of your computer systemis 10:00 a.m., the generated Time Code will be 10:00:00:00, for

example.

If you activate "External”, MADRIX is able to receive Time Code from an external source (a
console, another software solution, etc.). MADRIX can receive external MIDI Time Code (MTC) or
Art-Net Time Code. If those are running in the network, they will be received by MADRIX if the

option is enabled here.

Last but not least, you can select the mode for the Time Code. You can choose from "24 FPS",
"25 FPS", "30 Drop", and "30 FPS".

The Time Code is displayed in the following format: HH:MM:SS:FF (00:00:00:00), meaning

hours:minutes:seconds:frames.

Receiving Time Code ("External") is only possible with MADRIX professional and
MADRIX ultimate.
Using Time Code in combination with the System Time is available in all MADRIX

versions.
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Important Notes

When you are using date, Time Code, and/or duration a logical routine is implemented in MADRIX
to determine, which cue should be active. For more information, on how to use Time Code

correctly, please read the following two chapters!

File Watcher - Automatic Cue List Reloading

S |
Izer Interface | Performance

MADRIX can automatically reload a Cue List within a predefined refresh time. For more information,

please read the chapter File Watcher.

6.1 Standard Setup, Duration, And Date

Introduction

Please make sure to read the previous chapter and to familiarize with the interface of the Cue List.

Using The Standard Setup
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Step 1 - Adding New Entries

First, add a new entry by clicking at the "+" button. To change the name of this entry, click
inside the "Description"” field and type in your text. To change the "Storage" (A or B), "Place"
(1 - 60), "Fade" (XF, WF, BF, or CF), or "F-Time" (fade time in seconds), click inside the
respective fields and change the values. If you have activated CF (for color fade), you can modify

the values for red ("R"), green ("G"), blue ("B") and white ("W") to select a color for the fade.

After adding your first entry, repeat these steps to add more entries to the list. Please do

not forget to save your created Cue List if you want to use it later.

Step 2 - Starting The Cue List

Use the "Play/Pause" button to start your newly created Cue List.
The Cue List will then run automatically. Press "Go" to skip to the next Cue List entry. Press
"Back" to select and play the previous entry. By typing in a number into the input field and
clicking the "GoTo" button the next Cue List entry will be the number you chose. The MADRIX

main interface includes those control buttons as well (except for "GoTo").

Using Duration
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red daily

Step 1 - Adding New Entries

First, add a new entry by clicking at the "+" button. To change the name of this entry, click
inside the "Description" field and type in your text. To change the "Storage" (A or B), "Place"
(1 - 60), "Fade" (XF, WF, BF, or CF), or "F-Time" (fade time in seconds), click inside the
respective fields and change the values. If you have activated CF (for color fade), you can modify
the values for red ("R"), green ("G"), blue ("B") and white ("W") to select a color for the fade.

After adding your first entry, repeat these steps to add more entries to the list. Please do

not forget to save your created Cue List if you want to use it later.

Step 2- Setting Up Duration

The next step is to set a specific duration for a single Cue List entry. The duration is displayed in
the following format: HH:MM:SS:FF, meaning hours:minutes:seconds:frames (see picture

above).

You can type in the following values for the duration:

For an input of one hour you can use 01000000, 01:00:00:00, 01,00,00,00, 01.00.00.00
,01/00/00/00, 1h, or 01hOOMO0O0sO0Of.

For an input of ten minutes you can use 00100000, 00:10:00:00, 00,10,00,00,
00.10.00.00, 00/10/00/00, 10m, or 00h10mO00s0Of.

For an input of ten seconds you can use 00001000, 00:00:10:00, 00,00,10,00,
00.00.10.00, 00/00/10/00, 10s, or 00h0O0OM10s00f.
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For an input of ten frames you can use 00000010, 00:00:00:10, 00,00,00,10,
00.00.00.10, 00/00/00/10, 10f, or 00hOOMOO0s10f.

Of course, other values are possible as well.

A value of 0 or the usage of the space bar resets the parameter to the default value.

Repeat these steps for every entry you want to assign a pre-defined duration.

Step 3 - Starting The Cue List

The Cue List will then run automatically. Press "Go" to skip to the next Cue List entry. Press

Use the "Play/Pause" button to start your newly created Cue List.

"Back" to select and play the previous entry. By typing in a number into the input field and
clicking the "GoTo" button the next Cue List entry will be the number you chose. The MADRIX

main interface includes those control buttons as well (except for "GoTo").
Loop function:

If all entries inside your Cue List have been assigned a duration, the Cue List will repeat
automatically from the beginning after the last entry.

If any entry inside the Cue List does not have a pre-defined duration, the Cue List will stop
at this entry.

But maybe you want to stop the Cue List with the last entry. In this case, you only have to

remove the duration for the last entry in your Cue List.
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Using Date

Drarstion FCue

Step 1 - Adding New Entries

First, add a new entry by clicking at the "+" button. To change the name of this entry, click
inside the "Description"” field and type in your text. To change the "Storage" (A or B), "Place"
(1 - 60), "Fade" (XF, WF, BF, or CF), or "F-Time" (fade time in seconds), click inside the
respective fields and change the values. If you have activated CF (for color fade), you can modify

the values for red ("R"), green ("G"), blue ("B") and white ("W") to select a color for the fade.

After adding your first entry, repeat these steps to add more entries to the list. Please do
not forget to save your created Cue List if you want to use it later. Or load a Cue List that

you have set up before.

Step 2 - Setting The Date

The next step is to set the date for a single Cue List entry. The following input formats can be

used for the date:

Daily:
d or Dor 0 ... daily
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Monday - Sunday:

m or M ... Monday

t... Tuesday

w or W ... Wednesday
T... Thursday
forF ... Friday

S ... Saturday

S ... Sunday

Date:

2009/03/01 ... 2009/03/31
2009:03:01 ... 2009:03:31
2009;03;01 ... 2009;03;31
2009-03-01 ... 2009-03-31

or use the short version:
09-03-01 ... 09-03-31

01 ... fist day of actual month and year

02 ... second day of actual month and year

01-01 ... first day and first month of the actual year

01-02 ... second day and first month of the actual year

MADRIX always starts with the year 2000.

A value of -1 and using the space bar resets the field to the default value "daily".

Repeat these steps for every entry you want to assign a pre-defined date.

© 2011 inoage GmbH



299 MADRIX Help and Manual

Step 3 - Using System Time And Starting The Cue List

Please enable "System Time" now.

- =1
tetn Time = External

Use the "Play/Pause" button to start your newly created Cue List. The Cue List will then run
automatically. Press "Go" to skip to the next Cue List entry. Press "Back" to select and play the
previous entry. By typing in a number into the input field and clicking the "GoTo" button the next
Cue List entry will be the number you chose. The MADRIX main interface includes those control

buttons as well (except for "GoTo").

Important Notes

When you are using date, Time Code, and/or duration a logical routine is implemented in MADRIX

to determine, which cue should be active. This routine is explained in more detail here:

Date

If you are setting a date, 3 options are available: daily, a weekday, or an
explicit date. If you are using a mixture of those three options, a cue will be favored and activated

according to the following hierarchy if applicable:

An explicit date overrides a weekday entry. And a weekday entry overrides a daily entry.
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For example, daily will activate a cue every single day. But on Mondays, another cue should be
activated and it will be. But 2010/04/19 is also a Monday and this cue will be activated this day

instead of the daily cue and instead of the Monday cue.

Time Code Without Duration

If you are using the column Time Code without the column Duration, a cue will only be activated if
the Time Code (system time or external time) passes this predefined time. If the Time Code

(system time or external time) has already passed that deadline, the cue will not be activated.

Time Code With Duration

If you are using the column Time Code and the column Duration, a cue will be activated when the
current Time Code (system time or external time) falls into this time window.

In addition, the logical routine will check if the date needs to be considered according to the
information above (Date).

For example, if your daily cue should start at 8 o'clock for 8 hours and the current Time Code says

10 o'clock, the cue will be activated.

6.2 Time Code, Duration, And Follow Cue

Introduction

Please make sure to read the chapter MADRIX Cue List and familiarize with the interface of the
Cue List.

Receiving MIDI Time Code is only possible with MADRIX professional and MADRIX
ultimate.
Using the Time Code in combination with the system time is available in all MADRIX

versions.

More information on MIDI Time Code can be found in the chapter MIDI Time Code (MTC).
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Using Time Code, Duration, and Follow Cue

F-Time
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Step 1 - Adding New Entries

First, add a new entry by clicking at the "+" button. To change the name of this entry, click
inside the "Description" field and type in your text. To change the "Storage" (A or B), "Place"
(1 - 60), "Fade" (XF, WF, BF, or CF), or "F-Time" (fade time in seconds), click inside the
respective fields and change the values. If you have activated CF (for color fade), you can modify

the values for red ("R"), green ("G"), blue ("B") and white ("W") to select a color for the fade.

After adding your first entry, repeat these steps to add more entries to the list. Please do

not forget to save your created Cue List if you want to use it later.

Step 2- Setting Up Time Code And Duration

The next step is to set a specific Time Code and duration for a single Cue List entry. Both are
displayed in the following format: HH:MM:SS:FF, meaning hours:minutes:seconds:frames (see

picture above).

You can use the following values for the Time Code and duration:

For an input of one hour you can use 01000000, 01:00:00:00, 01,00,00,00, 01.00.00.00
, 01/00/00/00, 1h, or 01hOOMOO0sO0Of.

For an input of ten minutes you can use 00100000, 00:10:00:00, 00,10,00,00,
00.10.00.00, 00/10/00/00, 10m, or 00h10mO00s0Of.
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For an input of ten seconds you can use 00001000, 00:00:10:00, 00,00,10,00,
00.00.10.00, 00/00/10/00, 10s, or 00hOOmM 10s00f.

For an input of ten frames you can use 00000010, 00:00:00:10, 00,00,00,10,
00.00.00.10, 00/00/00/10, 10f, or 00hOOMO0O0s10f.

Of course, other values are possible as well.

A value of 0 or the usage of the space bar resets the parameter to the default value.

Add or edit more entries according to your requirements.

Step 3 - Setting Up Follow Cues

The next step is to set "F.Cue" (follow cues). A follow cue allows you to define a certain order in

which cues are going to be played. You can assign a certain cue to be played after another.

To configure a follow cue, double-click the F.Cue-column of the entry you want to edit. Simply

type in the number of the next entry, i.e. the next cue that should be played after this one.

Ce=cription ime Code Cue™ "Storage face ate F-Time

red daily 03:00:00:00 0O:00:04:00 0 Ed 2.00

green
blue 09:00:00:00

e | low

In our example above Cue List entry #2 will be followed by Cue List entry #1. Cue List entry #4

has Cue List entry #3 as its follow cue.

You can type in numerical values or use the following keys for F.Cue:
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Step 4 - Starting The Cue List

| - | Back 1

a0

GoTo 1
Use the "Play/Pause" button to start your newly created Cue List.
The Cue List will then run automatically. Press "Go" to skip to the next Cue List entry. Press
"Back" to select and play the previous entry. By typing in a number into the input field and
clicking the "GoTo" button the next Cue List entry will be the number you chose. The MADRIX

main interface includes those control buttons as well (except for "GoTo").

Important Notes

When you are using date, Time Code, and/or duration a logical routine is implemented in MADRIX

to determine, which cue should be active. This routine is explained in more detail here:

Date
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If you are setting a date, 3 options are available: daily, a weekday, or an
explicit date. If you are using a mixture of those three options, a cue will be favored and activated

according to the following hierarchy if applicable:

An explicit date overrides a weekday entry. And a weekday entry overrides a daily entry.

For example, daily will activate a cue every single day. But on Mondays, another cue should be
activated and it will be. But 2010/04/19 is also a Monday and this cue will be activated this day

instead of the daily cue and instead of the Monday cue.

Time Code Without Duration

If you are using the column Time Code without the column Duration, a cue will only be activated if
the Time Code (system time or external time) passes this predefined time. If the Time Code

(system time or external time) has already passed that deadline, the cue will not be activated.

Time Code With Duration

If you are using the column Time Code and the column Duration, a cue will be activated when the
current Time Code (system time or external time) falls into this time window.

In addition, the logical routine will check if the date needs to be considered according to the
information above (Date).

For example, if your daily cue should start at 8 o'clock for 8 hours and the current Time Code says

10 o'clock, the cue will be activated.

6.3 Keyboard Layouts

You can use the following keys for:
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Description

L] CELLJELEL]EELE

Time Code And Duration

L] CLELIEELTICLELL

F. Cue

L] CELLJELEL]EELE

Storage
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MADRIX Cue List
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7 OUTPUT

Overview

MADRIX supports a lot of well-known industry standards, such as DMX512, Art-Net II, DVI, as well
as the protocols from Philips Color Kinetics, Insta/Robe, EurolLite T9, and ColourSmart Link.
Streaming ACN by ESTA was added as well.

In the following chapters each output method will be described in more detail.

e DMX512

o Art-Net

e DVI

e e:net From e:cue

e ROBE StageQube 324

e Insta Light 2022 - LED-Panel RGB 324
e Philips Color Kinetics (KiNet)

e ESTA - Streaming ACN

e Proprietary DVI Devices (EuroLite T9 and ColourSmart Link)
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7.1  Art-Net

Introduction

ETHERNET

Before you start and in order to be able to use Art-Net, please set up your network card in

Windows using the following address area:

2.0.0.1 ... 2,.255.255.254 or

10.0.0.1 ... 10.255.255.254

Artistic Licence (the creators of Art-Net) recommends to use 2.x.x.x (10.x.x.Xx is
regarded to be an alternative). The subnet mask should be 255.0.0.0 You must use this

address area. Otherwise Art-Net might not work.
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Network Switches - Gigabit Ethernet

We recommend using only Gigabit Ethernet network
switches. Gigabit Ethernet (GbE or 1 GigE) is a term describing various technologies for
transmitting Ethernet frames at a rate of a gigabit per second, as defined by the IEEE 802.3-
2008 standard. You might encounter problems if you try to use slower network

switches.
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Configuration

Open the "Device Manager" ("F4" or go to "Preferences") and select the tab "Art-Net".

The menu will allow you to configure Art-Net interfaces and other Art-Net settings.
If you want to use Art-Net with MADRIX you have to enable it here first. Check the box next

to "Art-Net" in the upper left corner.

If you have Art-Net enabled, you will see an "Art-Net Remote" device shown in the list. This
device is solely for controlling MADRIX remotely. Please read the information about Remote Control

for further information.
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Using ArtPollReply - First Option

Frame

Optimiz:

I
Fincl Auto

If your Art-Net interface supports the ArtPollReply function, you can press the "Find Auto" button

to scan the network for your Art-Net interface. Click "Refresh" to update the list.

If you want to see details of your Art-Net interface, click on the interface entry in the list and use
the "Edit" button. A new dialog will open.

Because of the ArtPollReply function and due to the fact that your device was assigned in this
way, you will not be able to modify your Art-Net device. Instead, you will have to use a tool from

your Art-Net interface manufacturer.
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Creating Manually - Second Option

Fincl Auto

Dielete

Hely

If your Art-Net interface is not equipped with an ArtPollReply function you can manually create a

new interface by clicking "New". A new dialog will open.

Direct IP Mode Faor The Dewvi

= Full Frames

Please select the number of devices you wish to create. And please enter the number of ports

of each device.

Select "Use Direct IP Mode For the Devices" if you wish to use Direct IP mode. See below for

more details.
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Select "Device Sends Full Frames" if you wish to always send a single frame including all 512

DMX channels. If this option is disabled, MADRIX will automatically send optimized frames that

reduce network traffic. If problems occur with your Art-Net node, please enable this option and

send full frames.

Please note: In order to create an 8-port node, set up 2 devices with 4 ports each. In most

cases the same IP address should be entered then for both devices.

Now, select the newly created entry and click on the "Edit" button. A new dialog will open.

fanufacturar:
Froduct :

Es=ta :

Short Name :

Long Hame :

Manuall
fanuallewi 11
inoage trade - Hertel, Pinzer,

Arrlet 0001

Port Count: 2 (0

Universe Port OUT @ [

Uniwerse Port IN :

Lo :

Send Broadeast :

Send Direct :

IP :

Subnet:

Fort :

Frame :

ok

zmann bR

Uniwerse

= Send Full Frames

=01

APy

hdanual I : 1
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Use the settings to modify your Art-Net device. For instance, a short name and a long name can
be entered. Set up how many ports you have on this device, which universe should be used to
send data. And you can specify the IP address ("Send Direct" and "IP") if you do not want to
activate the network-wide broadcast option ("Send Broadcast"). See below for more details. You

can also enable optimized or full frames. See below for more details.

Broadcast Or Direct IP Mode?

Using the Art-Net protocol in broadcast mode means that every packet sent from a single
(MADRIX) transmitter will be received by all recipients in the network. This can be very useful, e.g.
if you wish universes 1 and 2 to be available on several points of the set-up. The disadvantage is

that through broadcasting a potentially huge number of packages will be sent over the network.

2 Modes: "Send Broadcast" and "Send Direct"

If "Send Broadcast" is activated, MADRIX will send data to the whole Art-Net network.
(Broadcast Mode)

If "Send Direct" is activated, MADRIX forwards data directly to the listed IP address. (Direct
IP Mode)

To reduce network traffic, we suggest using Direct IP mode.

Full Frames Or Optimized Frames?

In order reduce network traffic, MADRIX is able to send optimized Art-Net data. For example, if
you are only using 240 DMX channels, MADRIX can send data for 240 DMX channels. When using
full frames, MADRIX will send frames including all 512 DMX channels every time - even if you are
only using 240 DMX channels. Older Art-Net nodes might not support optimized frames. This is why

full frames are recommended if problems occur.

To reduce network traffic, we suggest using optimized frames.
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Subswitch

If your Art-Net device is equipped with a subswitch, MADRIX is able to recognize this feature. This
is for your information. In the configuration dialog (Art-Net Configure Device) you will see if your
Art-Net device is equipped with a subswitch or not. Then, the dialog will include several
informative elements. In this way, you will be able to see the configuration of your interface within
MADRIX.

Subswitch available:

Part Count : 1 01 Sub Switeh ;15 0xF

State : part 1: dizable

subawitch £ universe

Univarse Port OUT : LF fOxF "

Subswitch not available:

Faort Count - 1 Ox1 W

e |

State : part 1: dizable

universe

Activating Your Art-Net Interfaces

If you have finished setting up your devices, they will still be disabled.
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Manufacturer : Manuall
Product : Manualbew
Esta : inoage trade - Hertel, Pinze mann bR

ort Hame : WJet 0001 Manual 1D : 1
_— e

Lang Mamey Arilet device nr 0001

Fort Count: 2
State : : Di 0 rled
U Universe
Universe Pot OUT : (0 000 Wl 01
Un e Port [N :
b :
ode : node
Send Broadcast :
Send Direct :
IF :
Subnet :
Fart

Frame :

To activate them, please close the window and open the tab "DMX Devices" tab, select the
device(s), and click "Enable" and "Output". You can select several interfaces in the list and click

"Enable" once in order to enable multiple devices.

Please also set up the individual DMX universe for every device.
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Frame Ti

T |
Cancel Hedy

Please check if the DMX universes are assigned correctly!

After you have set up your output and input devices, please press the button "Ok".

Sync Mode

An automatic sync mode for Art-Net devices is implemented in MADRIX. In this

way you can activate or deactivate the usage of sync packages.

This Sync Mode is not conform to Art-Net. To work properly it needs to be implemented by
the manufacturer. Please check the manual of your Art-Net node if this option is available to

you.

Before activating sync, make sure that all activated Art-Net devices are available in
your network! Else, the frame rate of Art-Net might drop. If you are not sure, do not
enable any sync mode.
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Even if your Art-Net hardware does not support Pre Sync or Post Sync mode, it might
be advisable to activate it in MADRIX. In this way, data packages will be sent one
after another and will not get mixed up. The data will be sent more precisely. But

please make sure that all of your interfaces are available in the network.

Click "Sync" and a new dialog will open. Now, choose if you want to activate sync packages to
be sent before data is sent ("Pre Sync"). Or you can send sync packages after Art-Net data has

been sent ("Post Sync"). Then, press "OK".

If you want to disable sync mode, click "Sync" again and uncheck the mode that is selected.

Then, press "OK".

Detailed information is described in the chapter Technical Information For Developers.

Config By Web

Contig By ek

The button "Config By Web" allows you to configure your Art-Net device
remotely with the help of a web browser if this feature is supported by your device. If this feature
is available, a new browser window will be opened using the specified IP address. This offers you
access to the configuration dialog of your Art-Net device. If this is not possible, a message box
will be displayed in MADRIX.
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Resizing The Window

If wish to resize the window of the Device Manager to see more devices in the list, simply move
your mouse pointer to the bottom of this window. Then, select the border and hold the left mouse

button, while moving your mouse downwards.

Further Configuration

Please remember to configure your light matrix in the Matrix Generator or Patch.

Please make sure to save your MADRIX Setup after the configuration process.

There are more chapters that belong to the topic Art-Net:

e Using EUROLITE Node 8 With MADRIX

Using ENTTEC Datagate With MADRIX
e Using X-NET 8 With MADRIX

Technical Information For Developers

Important Notes

Please keep in mind that network devices, if activated, cause network traffic!
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7.1.1 Using EUROLITE Node 8 With MADRIX

Introduction

The EUROLITE Node 8 fully supports the Art-Net protocol. It can be configured to output anything

between 1 and 8 DMX universes.

How Do I Configure The EUROLITE Node 87

IP Address in Windows

You have to set up your computer's IP address to 2.0.0.1 and the subnet mask to
255.0.0.0.

DMX Port Settings
To configure the EUROLITE Node 8 to output 8 universes of DMX, follow the next steps.
Push the control wheel at your EUROLITE Node 8 once and select "DMX port 1".

- the option Port must be set to "output”
- the option Universe must be set to "Art-Net 0.0"
- the option Rate must be set to "Sync"

- the option Hold must be set to "Always"
Now, select the option "Save" to save your settings.

Repeat the steps above for "DMX port 2", "DMX port 3", "DMX port 4", "DMX port 5", "DMX
port 6", "DMX port 7" and "DMX port 8" according to the following table:

DMX Port Universe Rate Hold

DMX port 1 output Art-Net 0.0 Sync Always
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DMX port 2 output Art-Net 0.1 Sync Always
DMX port 3 output Art-Net 0.2 Sync Always
DMX port 4 output Art-Net 0.3 Sync Always
DMX port 5 output Art-Net 0.4 Sync Always
DMX port 6 output Art-Net 0.5 Sync Always
DMX port 7 output Art-Net 0.6 Sync Always

DMX port 8 output Art-Net 0.7 Sync Always

Network Settings

In the next step, push the control wheel on your EUROLITE Node 8 and select "Network Opt.".
Now, change the "Address" to 2.0.0.2. Please check if the option "Netmask" is set to
255.0.0.0.

Select the option "Save" to save your settings. Repeat these steps for your second, third, etc.
EUROLITE Node 8 according to the following table:

1st EUROLITE Node 8 IP address: 2.0.0.2 Netmask: 255.0.0.0
2nd EUROLITE Node 8 IP address: 2.0.0.3 Netmask: 255.0.0.0
3rd EUROLITE Node 8 IP address: 2.0.0.4 Netmask: 255.0.0.0
etc.

If you want to use more than one EUROLITE Node 8, please make sure that you use
different IP adresses for each connected EUROLITE Node 8.

How Do I Configure MADRIX?
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In order to configure MADRIX, go to the MADRIX menu "Preferences -> Device Manager".
Select the "Art-Net" tab.

You can enable Art-Net by activating the checkbox next to the label "Art-Net" in the upper left

corner. The small box will light up green.

Next, press the button "Find Auto". After a few seconds your EUROLITE Node 8 is configured

automatically and will be shown in the list.

If you have connected one EUROLITE Node 8, you will see two entries. Each entry has 4 ports

(universes).

Ok T — =l
ok bl Cancel Help

In the next step open the tab called "DMX Devices". Here, you have to enable each device.
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If you have connected one EUROLITE Node 8, you will see 8 entries called "EUROLITE Node

8" (please ignore the entry "ArtNet Remote" for this configuration).

Device

ubld?
d1

Universe:

| EE— |

Frame Time (ms)

Rezcan For

= = ok il Cancel Helr

Now, do the following steps for each entry in the list to configure MADRIX like shown in the

screenshot above:
1) Select an entry from the list.

2) Activate "Enable" in the "Settings" section to the right. Make sure that "Output” is

activated, too.

3) Set the "Universe" according to the following table:

DMX DMX Universe
EUROLITE Node 8 Port 0 1
EUROLITE Node 8 Port 1 2
EUROLITE Node 8 Port 2 3
EUROLITE Node 8 Port 3 4
EUROLITE Node 8 Port 0 SubId1 5
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EUROLITE Node 8 Port 1 Subldl 6
EUROLITE Node 8 Port 2 Subldl 7
EUROLITE Node 8 Port 3 Subldl 8

4) Press the "Apply" button.

Please remember to do these 4 steps for every entry.

Important Notes

For more information, please consult the chapter Art-Net.
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7.1.2 Using ENTTEC Datagate With MADRIX

Introduction

The Datagate fully supports the Art-Net protocol. It can be configured to output anything

between 1 and 8 DMX universes.

How Do I Configure The ENTTEC Datagate?

You can use the software "Node Management Utility (NMU)" from ENTTEC to easily configure
the Datagate with your computer. Please check with ENTTEC if this tool is available.

4-Port DMX

To set the Datagate to output 4 universes of DMX, press the "Menu" button next to the LCD
display on the front panel until it reads "1-Activate Profile". Hit "Enter", then "Scroll" until the
"Art-Net" profile is displayed. Hit "Enter" to select and the Datagate will display "Profile
Activate". The Art-Net profile configures ports 1-4 as outputs for DMX universe 1-4, and ports 5-
8 as DMX inputs.

8-Port DMX

To set the Datagate to output 8 universes of DMX, follow the initial instructions above to access
the "1-Activate Profile"” menu on the Datagate. Afterwards, select the "Enet -> DMX" profile,
then change the protocol type on each of the 8 channels to Art-Net instead of the default ESP.
This will enable 8 output ports.

To change the protocol type, hit the "Menu" button until it displays "2-Edit Profile", hit "Enter"
then "Scroll" until the display reads "2-3 EthernetConfig". Hit "Enter" again, then "Scroll" until
"2-3-2 Protocol" is displayed. Hit "Enter", then "Scroll" until the display reads "Art-Net", then

hit "Enter" once more. This will set the Datagate to output DMX universes 1-8 on ports 1-8.
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Broadcast Or Direct IP Mode?

Using the Art-Net protocol in broadcast mode means that every packet sent from a single
(MADRIX) transmitter will be received by all recipients in the network. This can be a very useful
feature, e.g. if you wish universes 1 and 2 to be available on several points of the set-up. The
disadvantage is that through broadcasting a potentially huge number of packages will be sent over

the network.

To reduce network traffic, we suggest using Direct IP mode ("Send Direct").

Please note: In the following example we will configure a Datagate with ports 1-8 to use

DMX universes 1-8 in broadcast mode.

How Do I Configure MADRIX?

In order to configure MADRIX, please go to the MADRIX menu "Preferences -> Device Manager"

. Activate the "Art-Net" tab and enable Art-Net. Press the "New" button to add new Art-Net

device(s).

I
Fincl ALt
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Inside this dialog you can set the number of devices and number of ports for each new device.
Now you will see your new Art-Net 0001 device (Art-Net 0002, ...) included in the list with x
ports.

Select a device and press "edit" to configure this Art-Net device.

Manufacturer: ManualD
Froduet . Manuall 1
e trade - Hertel, Pin GhR

Manual 1D : 1

Fort % Dizabled
Un

Subnet:

e |
—_—_——

Fort: G454

Frame : B Send Full Frames

ok

Here you can set up your Art-Net device. First, please click on "Port Count" and select the port
count to be "4 0x4".
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Up to this point we have used the broadcast option.

Please note: You can also use Direct IP mode by activating the switch "Send Direct". In

that case you will have to type in the IP address of your Datagate.

Accordingly, you will see your newly created Art-Net 0001 (Art-Net 0002, ...) device listed with 4

ports. Repeat this step and create a new Art-Net device by clicking the "New" button.

I
Finc ALt

If you did repeat the step, you will now see two Art-Net devices (Art-Net 0001 and Art-Net
0002) in the list. You can modify these Art-Net devices by selecting the Art-Net device first
and then clicking the "Edit" button.
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Manufacturer: Manual

Produst : Manual 1
Esta :

ot Name :

As shown above, we have changed the short name from Art-Net 0001 to Datagate #1A in this

example.
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Manufacturer: Manual

Produst : Manual 1

Esta : inoage trade - Hertel, Pinzer,

ot Name : [ #18

This modification is repeated for the Art-Net 0002 device changing the short name from Art-Net

0002 to Datagate #1B.
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name; Bob-Baum

Now you will see the two Art-Net devices, Datagate #1A and Datagate #1B, in the list.

Result:
Datagate #1A with the first 4 DMX universes and
Datagate #1B with the next 4 DMX universes.

BEEBERENED

Frame Tim

uze OUT:
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In the next step open the tab called "DMX Devices". Here, you have to enable each Art-Net

device by activating the "Enable" switch. You will also have to assign the DMX universe.

In this example we have used all 8 ports of the Datagate and activated them for
output.

Datagate #1A Port:0 is the DMX universe 1
Datagate #1A Port:1 is the DMX universe 2

Datagate #1B Port:3 is the last DMX universe 8

DATAGATE .

Datagate #1A Datagate #1B

Important Notes

For more information please consult the chapter Art-Net.
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7.1.3 Using X-NET 8 With MADRIX

Introduction

The X-NET 8 fully supports the Art-Net protocol. It can be configured to output anything between

1 and 8 DMX universes.

How Do I Configure The X-NET 8 Using Art-Net?

1) You have to set up your computer's IP address to 2.0.0.1 and the subnet mask to
255.0.0.0.

2) X-NET 8 Back Panel View:
Set up the IP address of your X-NET 8 from 2.39.2.1 to 2.39.2.255 using the SW1, SW2,
and SW3 switches.

Back Panel Switches:
SW1: x100

SW2: x10

SW3: x1

Set up an IP address other than your computer's network card.
Examples:

2.39.2.10: you have to set the SW1 to 0, SW2 to 1, and SW3 to O
2.39.2.127: you have to set the SW1 to 1, SW2 to 2, and SW3 to 7
2.39.2.231: you have to set the SW1 to 2, SW2 to 3, and SW3 to 1

Each X-NET 8 must have its own, unique IP address.
Example:

1st X-NET 8 ... 2.39.2.1

2nd X-NET 8 ... 2.39.2.2

3rd X-NET 8 ... 2.39.2.3
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3) X-NET 8 Front Panel View:
To activate Art-Net, set the two dip-switches on the front side of the X-NET 8 to the OFF
position (upper position). As a result, you will disable the CL100M protocol and enable the

Art-Net protocol at the same time.

Please also adjust the two rotary dip switches Art-Net Sub-Net and Art-Net Universe.
With the help of these two HEX rotary dip switches you define the start (first) universe for
each X-NET 8.

Example for the Front Panel HEX rotary dip switches Sub-Net and Universe:
Universe 0 ... Sub-Net value 0 , Universe value 0

Universe 8 ... Sub-Net value 0 , Universe value 8

Universe 16 ... Sub-Net value 1, Universe value O

Universe 24 ... Sub-Net value 1, Universe value 8

Universe 32 ... Sub-Net value 2, Universe value O

Universe 40 ... Sub-Net value 2, Universe value 8

Universe 122 ... Sub-Net to value 7 , Universe to value A

Universe 255 ... Sub-Net to value F , Universe to value F

4) You must restart your X-NET 8 if you make changes on the front or back panel switches!

Broadcast Or Direct IP Mode?

Using the Art-Net protocol in broadcast mode means that every packet sent from a single
(MADRIX) transmitter will be received by all recipients in the network. This can be a very useful
feature, e.g. if you wish universes 1 and 2 to be available on several points of the set-up. The
disadvantage is that through broadcasting a potentially huge number of packages will be sent over

the network.

To reduce network traffic, we suggest usin Direct IP mode.
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Please note: In the following example we will configure a X-NET 8 with ports 1-8 to use

DMX universes 1-8 in broadcast mode.
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How Do I Configure MADRIX?

In order to configure MADRIX, please go to the MADRIX menu "Preferences -> Device Manager"
. Activate the "Art-Net" tab and enable Art-Net.

e
I Countmiet Onrverse Frame s
] 1 %00 20011 anly from 2.0.0.13

Coo
Fircl ALt

1 2| Number Of New

1 = Mumber Of P

'E' Uze Direct IP Mode For The Devices
e

iz Full Frames

Please select the number of devices you wish to create. And please enter the number of ports
of each device.
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Select "Use Direct IP Mode For the Devices" if you wish to use Direct IP mode. For more

information see the chapter Art-Net.

Select "Device Sends Full Frames" if you wish to always send a single frame including all 512
DMX channels. If this option is disabled, MADRIX will automatically send optimized frames that
reduce network traffic. If problems occur with your Art-Net node, please enable this option and

send full frames.

Select a device and press "Edit" to configure this Art-Net device.

Manufacturer: Manuall
Product : b
Esta :
Short Nam
Long Mame :
Fort Count :

State :

Port OUT : 0
Fort [N :

LD

' Send Full Frames

Here you can set up your Art-Net device. First, please click on "Port Count" and select the Port
Count to be "4 0x4".

Up to this point we have used the broadcast option.
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Please note: You can also use Direct IP mode by activating the switch "Send Direct". In

that case you will have to type in the IP address of your X-NET 8.

Accordingly, you will see your newly created Art-Net 0001 (Art-Net 0002, ...) device listed with 4

ports. Repeat this step and create a new Art-Net device by clicking the "New" button.

If you did repeat the step, you will now see two Art-Net devices (Art-Net 0001 and Art-Net
0002) in the list. You can modify these Art-Net devices by selecting the Art-Net device first

and then clicking the "Edit" button.
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Manufacturer: M
Froduct : b

E=ta

Fort & Disablad

Uniy

Subnet:
Fort

Frame : B Send Full Frames

ok

As shown above, we have changed the "Short Name" from Art-Net 0001 to X-Net 8 #1A in this

example.

Select the next Art-Net device and click edit.

For the second 4 ports of your first X-Net 8 select also port count 4 0x4 and set up
the universe port out to 4 0x04, 5 0x05, 6 0x06, 7 0x07.
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Manufacturer: b

zablad Fort & Disabled

Send Direct:

P :

Subnet :

342

This modification is repeated for the Art-Net 0002 device changing the "Short name" from Art-

Net 0002 to X-Net 8 #1B. Close this dialog with OK.
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Now you will see the two Art-Net devices, X-Net 8 #1A and X-Net 8 #1B, in the list.

X-Net 8 #1A with the first 4 DMX universes and
X-Net 8 #1B with the next 4 DMX universes.

(5

-1 ™

Frame Tim

Fiighlight
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In the next step open the tab called "DMX Devices". Here, you have to enable each Art-Net
device by activating the "Enable" switch. You will also have to assign the DMX universe for

each port.

In this example we have used all 8 ports of the X-NET 8 and activated them for

output.

First X-Net 8:
X-NET 8 #1A Port:0 is the DMX universe 1
X-NET 8 #1A Port:1 is the DMX universe 2

X-NET 8 #1B Port:3 is the last DMX universe 8.

If you have more than one X-NET 8, configure the subsequent X-NET 8 devices in the same

way.

Manufacturer : ManualD

Froduct :

Short Mame Manual D : 4

Lang Mame & Arthlet dey

Fort2: Dizabled Fort 3: Disabled Fort 4: Dizabled
Un =) Un Un

0x09

end Data To "Directed

Send Full Frames
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Manufacturer: Manual

ot © Manuallevi 1

e trade - Hertel, Pinze

Short Name 0 Manual ID : 5

Lang Hame = Arthet o e nrao0s

isabled g zabled Fort &

LI

Subnet:
Fort

Frame : "B Send Full Fran

In this example you can see a correct Art-Net configuration for two X-NET 8 sending in broadcast

mode.
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X-NET 8 #1A X-NET 8 #1B

X-NET 8 #1A Port:0 is the DMX universe 1
X-NET 8 #1A Port:1 is the DMX universe 2
X-NET 8 #1A Port:2 is the DMX universe 3
X-NET 8 #1A Port:3 is the DMX universe 4

X-NET 8 #1B Port:0 is the DMX universe 5
X-NET 8 #1B Port:1 is the DMX universe 6
X-NET 8 #1B Port:2 is the DMX universe 7
X-NET 8 #1B Port:3 is the DMX universe 8

Important Notes

For more information please consult the chapter Art-Net.

The "Auto Find" option of MADRIX may find only one node with 4 universes (with older X-NET 8
firmwares). If this is the case, please add your X-NET 8 devices manually by using the "New"

button.

Please always "Enable" all Art-Net ports when using the X-NET 8. Please enable all
ports in MADRIX even if you do not need all ports in your LED installation. Otherwise
problems might occur caused by the firmware of the X-NET 8. Please do not disable
any ports in MADRIX.
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7.1.4 Technical Information For Developers

Regarding Art-Net Sync Mode

This is not a standard of Art-Net and not officially supported by the Art-Net protocol.
As you can see below, our OpCode for the broadcast package is either 0x5101 or 0x5202:

1) #defi ne MADRI X NET_OP_OUTPUT_SYNC POST 0x5101 /* Qutput Post Sync*/

The package we are sending looks like this:

typedef struct S_SyncMadrix
{
uchar 1D[8]; // protocol ID = "MdrixN 0"
ushort OpCode; // == OpSyncMadri x == 0x5101
uchar VersionH, // O
uchar Version; // protocol version, set to Protocol Version // 14
uchar Sequenz; // 0= sequence disable // 1..... 255 sequence running
} T_SyncMadri x;

2) #define MADRI X_NET_OP_OUTPUT_SYNC PRE 0x5202 /* Qutput Pre Sync*/

The package we are sending looks like this:

typedef struct S _SyncMadri x

{
uchar 1D[8]; // protocol ID = "Madri xN 0"

ushort OpCode; // == OpSyncMadri x == 0x5202

uchar VersionH; // O

uchar Version; // protocol version, set to Protocol Version // 14

uchar Sequenz; // 0= sequence disable // 1..... 255 sequence runni ng
} T_SyncMadri x;

In addition, we have implemented a sequence number, called frame id. This number runs in a loop
from 1 to 255 if a sync mode is activated in MADRIX. This sequence number is synchronized with
the sequence number of the normal Art-Net data packages. If sync mode is not used, this

sequence number will be zero in the normal Art-Net data packages.
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After installing MADRIX on your PC and using the Art-Net sync mode for the first time, you will get
the following registry key:

HKEY_CURRENT _USER\ Sof t war e\ i noage\ MADRI X\ Net Art - Net \ SyncNane

By default, this key set to: MadrixN. It was chosen because of its 7 characters, just like "Art-
Net". MADRIX limits the length of this key to 7 characters.

7.2 DVI

Overview

MADRIX can output DVI.

Usage

The DVI window is particularly useful when using a video beamer (VGA or DVI, for example), a DVI

wall, the software LED Studio, on-screen capturing, or in similar fields of application.
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Activating DVI Output

DVI output is only available with MADRIX dvi start, MADRIX dvi, MADRIX professional, and MADRIX

ultimate.

Any other version, including the demo, will render a rotating cross over the actual output. Only
after purchasing MADRIX dvi start, MADRIX dvi, MADRIX professional, or MADRIX ultimate, and the

MADRIX KEY (software protection dongle) that comes with it, the cross will disappear.

e MADRIX KEY dvi start supports up to 512 native DVI pixels, for example 32x16 pixels.

e MADRIX KEY dvi supports up to 307,200 native DVI pixels, for example 640x480 pixels.

e MADRIX KEY professional supports up to 786,432 native DVI pixels, for example 1024x768
pixels.

¢ MADRIX KEY ultimate supports up to 1,310,720 native DVI pixels, for example 1280x1024
pixels.

e Stretching and scaling to higher resolutions is possible with all these DVI versions.

e Please pay attention to other restricting factors, such as hardware limitations.

To activate DVI output, navigate to the menu "Previews" -> "Preview DVI" and then click on

"DVI", "Window", or "Fullscreen".
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Click DVI if you want a borderless DVI window, which is the most important one.
Click Window to open a window with a frame.
Click Fullscreen to enable output in fullscreen mode.

For more information, please have a look at the specific chapter.

You may activate two separate DVI windows (Preview DVI 1 and Preview DVI 2).

Further Configuration

Please remember to configure your light matrix in the Matrix Generator or Patch.

Please make sure to save your MADRIX Setup after the configuration process.

7.2.1 DVIWindow (Borderless)

Introduction

You can activate a DVI window without a frame. Go the menu "Previews" -
> "Preview DVI" -> and click "DVI". This borderless DVI window is particularly useful for on-

screen capturing.

You can also simply drag & drop a DVI window to change its position. Move this window around by

clicking and holding it using the left mouse button.
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Settings - Context Menu

Overview
The context menu makes various options and settings available to the user.

To open the context menu, perform a right mouse-click inside the DVI window. In addition, you

can navigate to the menu "Previews" -> "Preview DVI", where the same context menu appears.

v DVIMap Mode

v | Grid
Stretch Pixels
Show Status Information
Show Clock
DVI Window Settings...
Lock Position

v Always On Top
Use Background Image...

v DMV
Window

Fullscreen

Flip Vertically
Flip Horizontally

Close

DVI Map Mode

Activate "DVI Map Mode" if you configured an individual DVI Patch including DVI Maps. Learn
more in the chapter DVI Patch.

Grid
You can activate and deactivate a "Grid" by choosing this option inside the context menu.

Stretch Pixels
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The function "Stretch Pixels" activates scaling of your preview to the maximum size of your

preview window.

Show Status Information

"Show Status Information"” can be used to display some extra information regarding this preview

window, such as the size of the matrix or the frame rate.

Show Clock

"Show Clock" inserts the time into the window.
DVI Window Settings

"DVI Window Settings" calls up a new dialog.

B Full i

Bottom:

L
e

v Rotation

Friin

i dth: Height:
| Eal—

5] 15 Ay s

Use "Window Position" to define the exact position of the DVI window. The coordinate system
used for this starts with 0,0 at the top left of the entire screen/monitor. In this way, "Left:"

defines the X coordinate and "Top:" represents the Y coordinate. Valid values range from -10,000

to 10,000.
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"Display Area" specifies what is shown in the DVI window. Activate "Full Size" and your full
matrix will be displayed. Or you can select a certain cut-out and specify which details of your
matrix will be shown. You can choose the start coordinates and the end coordinates of this area.
"Left:" and "Top:" define the start coordinates in a coordinate system that starts with 0,0 in the
top left corner. "Right:" and "Bottom:" define the end coordinates. The end coordinates cannot
be higher than the full size of the matrix. For example, for a matrix with 50x50 pixels, the maximum
value of "Right:" and "Bottom:" is 50.

"Display Rotation" allows you to rotate the DVI preview window by 90 degrees, 180 degrees, or

270 degrees clock-wise. This rotation applies to the "Display Area".

"Window Size" determines the actual size of the DVI window. Activate "Display Area Size" to
set the size of the window to the pixel count of the display area, which determines what is shown
of your matrix. Using different values than the size of the display area will stretch or compress the
content.

Please press "Apply" to activate the changes you have made.

The standard configuration of these "DVI Window Settings" includes an activated "Display

Area Size" and activated "Full Size". These settings represent a standard 1:1 DVI window.

Lock Position

You can lock this window at a particular position. Right-click and choose "Lock Position" from the

context menu.
Always On Top

If you want the window to be in the front of all windows at all times, activate the entry "Always

On Top".

Use Background Image...

Only applies to "Window" and "Fullscreen" mode.
DVI, Window, Fullscreen

"DVI" activates the borderless DVI Window. "Window" activates the framed DVI window.

"Fullscreen" activates DVI output in fullscreen mode.
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Flip Vertically & Flip Horizontally
"Flip Vertically" and "Flip Horizontally" will flip the output accordingly. It turns over the image.
Close

Click "Close" to close this Window.

Further Configuration

Further settings can be accessed in the MADRIX Options -> Performance.
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7.2.2 DVIWindow (With Frame)

Introduction

E Preview window

A DVI window with a frame will appear if you have activated this option via the menu "Previews"
-> "Preview DVI" -> "Window".

You can easily move this window around by clicking and holding the title bar with the left mouse
button. In this way, you can also simply drag & drop a DVI window to change its position. Drag
the borders of this window in order to resize it.

Settings - Context Menu

Overview
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The context menu makes various options and settings available to the user.

To open the context menu, perform a right mouse-click inside the DVI window. In addition, you

can navigate to the menu "Previews" -> "Preview DVI", where the same context menu appears.

DVI Map Mode

Grid

Stretch Pixels

Show Status Information
Show Clock

DVI Window Settings...
Lock Position

v Always On Top
Use Background Image...

DV
¥ Window

Fullscreen

Flip Vertically
Flip Horizontally

Close

DVI Map Mode

Activate "DVI Map Mode" if you configured an individual DVI Patch including DVI Maps.

Grid

You can activate and deactivate a "Grid" by choosing this option inside the context menu.

Stretch Pixels

The function "Stretch Pixels" activates scaling of your preview to the maximum size of your

preview window.

Show Status Information
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"Show Status Information" can be used to display some extra information regarding this preview

window, such as the size of the matrix or the frame rate.
Show Clock

"Show Clock" inserts the time into the window.

DVI Window Settings

"DVI Window Settings" calls up a new dialog.

T '“1 s Se

B Full Size (3

Lett: Top:

I
F:i!;l ht: Baottom:
 EE—

e
y Ratation

gqp Ta0e 2

"Window Position", "Display Rotation"”, and "Window Size" only apply to the borderless DVI

window.
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"Display Area" specifies what is shown in the DVI window. Activate "Full Size" and your full
matrix will be displayed. Or you can select a certain cut-out and specify which details of your
matrix will be shown. You can choose the start coordinates and the end coordinates of this area.
"Left:" and "Top:" define the start coordinates in a coordinate system that starts with 0,0 in the
top left corner. "Right:" and "Bottom:" define the end coordinates. The end coordinates cannot
be higher than the full size of the matrix. For example, for a matrix with 50x50 pixels, the maximum
value of "Right:" and "Bottom:" is 50.

The standard configuration includes an activated "full size". These settings represent a standard
1:1 DVI window.

Please press "Apply" to activate the changes you have made.
Lock Position

You can lock this window at a particular position. Right-click and choose "Lock Position" from the

context menu.
Always On Top

If you want the window to be in the front of all windows at all times, activate the entry "Always

On Top".

Use Background Image...

Allows you to use a picture in "Window" and "Fullscreen" mode instead of the grey background.
DVI, Window, Fullscreen

"DVI" activates the borderless DVI Window. "Window" activates the framed DVI window.

"Fullscreen" activates DVI output in fullscreen mode.

Flip Vertically & Flip Horizontally

"Flip Vertically" and "Flip Horizontally" will flip the output accordingly. It turns over the image.
Close

Click "Close" to close this Window.
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Further Configuration

Further settings can be accessed in the MADRIX Options -> Performance.

7.2.3 DVIWindow (Fullscreen)

Introduction

360

If you navigate to the menu and activate "Previews" -> "Preview DVI" -> "Fullscreen", the

DVI window appears in fullscreen mode.

This fullscreen window is particularly useful for beamers, for example.

Settings - Context Menu

Overview
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The context menu makes various options and settings available to the user.

To open the context menu, perform a right mouse-click inside the DVI window. In addition, you

can navigate to the menu "Previews" -> "Preview DVI", where the same context menu appears.

DVI Map Mode

Grid

Stretch Pixels

Show Status Information
Show Clock

DVI Window Settings...
Lock Position

v Always On Top
Use Background Image...

DV
Window

v Fullscreen

Flip Vertically
Flip Horizontally

Close

DVI Map Mode

Activate "DVI Map Mode" if you configured an individual DVI Patch including DVI Maps.

Grid

You can activate and deactivate a "Grid" by choosing this option inside the context menu.

Stretch Pixels

The function "Stretch Pixels" activates scaling of your preview to the maximum size of your

preview window.

Show Status Information
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"Show Status Information" can be used to display some extra information regarding this preview

window, such as the size of the matrix or the frame rate.
Show Clock

"Show Clock" inserts the time into the window.

DVI Window Settings

"DVI Window Settings" calls up a new dialog.

T '“1 s Se

B Full Size (3

Lett: Top:

I
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"Window Position", "Display Rotation"”, and "Window Size" only apply to the borderless DVI

window.
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"Display Area" specifies what is shown in the DVI window. Activate "Full Size" and your full
matrix will be displayed. Or you can select a certain cut-out and specify which details of your
matrix will be shown. You can choose the start coordinates and the end coordinates of this area.
"Left:" and "Top:" define the start coordinates in a coordinate system that starts with 0,0 in the
top left corner. "Right:" and "Bottom:" define the end coordinates. The end coordinates cannot
be higher than the full size of the matrix. For example, for a matrix with 50x50 pixels, the maximum
value of "Right:" and "Bottom:" is 50.

The standard configuration includes an activated "Full Size".

Please press "Apply" to activate the changes you have made.

You can use "Display Rotation" in the following way: Select "DVI" first, change the settings,

and then switch back to "Fullscreen".
Lock Position

You can lock this window at a particular position. Right-click and choose "Lock Position" from the

context menu.
Always On Top

If you want the window to be in the front of all windows at all times, activate the entry "Always
On Top".

Use Background Image...

If you want to replace the grey background color, you can replace it with an image. Click "Use

Background Image..." and open the file.
DVI, Window, Fullscreen

"DVI" activates the borderless DVI Window. "Window" activates the framed DVI window.

"Fullscreen" activates DVI output in fullscreen mode.
Flip Vertically & Flip Horizontally
"Flip Vertically" and "Flip Horizontally" will flip the output accordingly. It turns over the image.

Close
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Click "Close" to close this Window.

Switching Windows, Monitors, Or Output Devices

One Monitor:

Use "AlIt+Tab" to switch to the MADRIX GUI and back to the fullscreen window.

Several Monitors:

i
If you have installed a second monitor or beamer (or more), you can easily

move this window to the first, second, third, ... output device by pressing the Tabulator

key.

In this way you can use the fullscreen mode to visualize effects on your second monitor in DVI

fullscreen mode, while you are working with MADRIX on your first screen.
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.' Q S « All Control Panelltems » Display » Screen Resolution v Search Control Panel Fel

Change the appearance of your displays

Display: 1. Ben(Q FP91G+ ~

Resolution: [1280 # 1024 (recommended) v]

Multiple displays: [Extend these displays v]

[] Make this my main display Advanced settings

Make text and other items larger or smaller

What display settings should I choose?

0K ] [ Cancel

Note: You must install and configure your graphics card and monitors correctly to use this

special feature!

Further Configuration

Further settings can be accessed in the MADRIX Options -> Performance.
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7.3 DMX512 (DMX-OUT)

Overview

Above all, for administrating DMX512 or other network devices, please make sure that you enabled
the appropriate network drivers first. To access these options, press "Ctrl+Alt+0" or go to the
menu "Preferences" -> "Options". Enable all network and USB devices your are going to need by
using the "Devices (USB/PCI)" and "Devices (Network)" tab. For more info please read the
chapter MADRIX Options.

Next, open the "Device Manager" (can be found in the menu "Preferences" or press "F4").

Preferences

Matrix Generator... F2
Patch... F3
Device Manager... F4
Audio Performance.., Ctri+Alt+4
Remote Control L

Backup System...

Options... Ctrl+Alt+0

The first tab "DMX Devices" shows a list of registered devices which were found in the network.

You can see which ones are defined to be input or output devices.
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HED #NEDDD0454
an; 0511

wmber: NEODOO454

Output B

gt ' =

HiciAlickit 3 Unive ze OUT: 1455 IN:O

First, please choose your DMX output device. If you click "Enable" and "Output” the DMX data

will be sent using this DMX device.

In the next step, set up the DMX "Universe". Press "Apply" afterwards.

You can also define the "Frame Time" in ms for each device as well. Setting up the frame time
can help in different cases. For example, if you have different DMX512 devices attached. When
each device uses different DMX512 output frames, you might want to sync all to a specific frame
rate. Or your attached LED fixtures could have problems with a faster frame rate. Then, you can

slow down the frame time by typing in larger values in ms.

Moreover, you can enable "Input" to use DMX-IN in this dialog. Click on "Enable" and then

"Input".

Always press "Apply" to activate any changes you made.
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. NEO #NECOO0954

1511
Serialnumber: NEOOOD954

B Erable Cutput B

Input "2
1=

1

F

Corfigure Te

Al Cancel el

You can also see a "Configure Device" button. By clicking this button you can edit the settings
of the DMX device.

Press "Ok" when you are finished setting up all devices.

Rescan For Devices

Fezcan For Devices

If you click the "Rescan For Devices" button, MADRIX disconnects all
DMX512, Art-Net, and other network devices and starts to search for new devices.
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Highlight Mode

The "Highlight Device" button activates/deactivates the highlight mode

for the selected interface and universe.

Select one ore more interfaces and press the button. The corresponding fixtures at the selected
interface(s) will flash for a better identification. This makes it easier to see them on stage. It

considerably speeds up the procedure of programming the selected DMX512/Art-Net interfaces.

Resizing The Window

If wish to resize the window of the Device Manager to see more devices in the list, simply move
your mouse pointer to the bottom of this window. Then, select the border and hold the left mouse

button, while moving your mouse downwards.

Further Configuration

Please remember to configure your light matrix in the Matrix Generator or Patch.

Please make sure to save your MADRIX Setup after the configuration process.

Important Notes

Please keep in mind that network devices, if activated, cause network traffic!
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7.4 e:net From e:cue

Enable e:net

For the administration of e:net in MADRIX, please enable the network driver first. Go to the menu
"Preferences" -> "Options" or the press the keys "Ctrl-Alt-0". Select the tab "Devices
(Network)".

" MADRIX O

Mlax. Count Of e:net Un

Here you can enable and disable the e:net network driver.

Use the drop-down list to select the correct network.

Please always make sure that you have selected the correct network. Otherwise, the

network device might still be found. But no data can be sent.

Please note: The standard butler interface has a predefined IP address (192.168.123.x) and
subnet mask (255.255.255.0).

Use the edit field "Time To Detect Devices (s)" to define how long MADRIX searches the

network for e:cue devices (type in a value in seconds).

We recommend to utilize at least a value of 3 to allow for a sufficient search.

Higher values are recommended for larger installations.
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Use "Max. Count Of e:net Universes Used" to specify how many DMX universes you wish to use

in total.

Please keep the standard settings of you do not have any specific requirements.
Change the universe count only if your requirements exceed the standard value of
256.

Further Configuration

For more information about the configuration of your DMX devices, please see the chapter DMX512
(DMX-0UT).

© 2011 inoage GmbH



OUTPUT 372

7.5 ROBE StageQube 324

Overview

StageQube 324

To use the ROBE StageQube 324™, a separate DHCP server is required. This can be a software or
hardware DHCP server, which handles the IP addresses of the ROBE StageQube 324™ and the

MADRIX computer. A good idea and option is to activate that the DHCP server binds MAC
addresses to IP addresses.

StageQube 324 StageQube 324 StageQube 324 StageQube 324
e.g. 10.0.0.20 e.g. 10.0.0.21 e.g. 10.0.0.22 e.g. 10.0.0.23

) e.g. 10.0.0.1
M‘t"i' . g

&

DHCP Server

MADRIX
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ROBe€.

StageQube 324

BACKSIDE

Fuirireire
|

S| R | R | LR
&) SRS SRS S0 .
) S ST S .

Ethernet

e.g. 10.0.0.1

Switch

DHCP Server

MADRIX

Configuration

We recommend to use an IP address range of 10.0.0.x for MADRIX and ROBE StageQube
324™. The subnet mask should be 255.0.0.0

For the use of ROBE StageQube 324™, we suggest to only use 1000Mbit network
components. That means 1000Mbit network cards in your computer, 1000Mbit switches and
a DHCP server with support of 10/100/1000Mbit if your setup looks like the configuration

shown above.

For the administration of the ROBE StageQube 324™ driver, please enable the network driver first.
Go to the menu "Preferences" -> "Options" or the press the keys "Ctrl-Alt-O". Select the tab

"Devices (Network)".
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Here you can enable and disable the ROBE/Insta network driver. Use the edit field "Time To
Detect Fixtures (s)" to define how long MADRIX searches the network for ROBE StageQube

324™ network devices (type in a value in seconds).

We recommend to utilize at least a value of 10 to allow for a sufficient search.

Higher values are recommended for larger installations.

Please always make sure that you have selected the correct network. Otherwise, the

network device might still be found. But no data can be sent.

In the next step, open the "Device Manager" (press "F4" or open the menu "Preferences” ->

"Device Manager").

I Preferences

Matrix Generator... F2
Patch... F3
Device Manager... F4
Audio Performance... Ctrl+Alt+ A
Remote Control »
Backup System...

Options... Ctrl+Alt+0
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Go to the tab "DMX Devices" and decide which of the listed devices are used as output devices.
If you click on "Enable" and "Output”, the data will be sent to this device. Check also if every

device is assigned a different universe (right hand side of the window).

Please check if the DMX universes are assigned correctly!

Ot ':'

Iripaat =

DD P = -, =
FictRhet U inuse OUT: 1455 IN:0

In the example above you can see 4x ROBE StageQube 324™ starting at universe 1 to 4 with IP
addresses from 10.0.0.20 to 10.0.0.23.
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Left half panel

Brightness
Contrast
luminesce time
Frequenaoy

Red

Green

Blue

' Live preyview

Right half panel

Brightness
Contrast
luminesce time
Frequency

Red

Graen

Blue

cet defadlt

376

Apphy

The option "Configure Device" (use the button or double-click the device) allows you to set up
various parameters of the selected Robe panel. Those include: Brightness, Contrast, Luminesce
Time, Frequency, and the values for Red, Green, and Blue for the left half and the right half of
each ROBE StageQube 324™.

= on

Please note: You can also select multiple ROBE StageQube 324™ and change all the

settings in one step.

Enabling the "Live Preview" switches to receive parameters live from the device. By clicking at

the button "Set Default", you will reset it to factory default values.
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Settings

B Enable Output '

Imput

Univearse:

Frame Time (ms):
FF5:

COnTGore Device .

Setting up the "Frame Time" is particularly useful if you have
connected different devices each rendering different output frame rates and you want to sync
them to a specific frame rate. Or it might be that the LED fixtures you attached have problems
with fast frame rate. You are able to slow down the frame time by typing in larger values in ms

in that case.

Rescan For Devices

Fezcan For Devices

If you click the "Rescan For Devices" button, MADRIX disconnects all

DMX512, Art-Net, and other network devices and starts a new search for devices.

Highlight Mode

Highlight Trevice

The "Highlight Device" button activates/deactivates the highlight mode

for the selected interface and universe.

Select one ore more interfaces and press the button. The corresponding fixtures at the selected
interface(s) will flash for a better identification. This makes it easier to see them on stage. It

considerably speeds up the procedure of programming the selected DMX512/Art-Net interfaces.
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Resizing The Window

If wish to resize the window of the Device Manager to see more devices in the list, simply move
your mouse pointer to the bottom of this window. Then, select the border and hold the left mouse

button, while moving your mouse downwards.

Further Configuration

Please remember to configure your light matrix in the Matrix Generator or Patch.

Please make sure to save your MADRIX Setup after the configuration process.

Important Notes

Please keep in mind that network devices, even if activated but not used, cause

network traffic!

7.6 InstalLight 2022 - LED-Panel RGB 324

Overview

INSTA

To use Insta Light® 2022 LED panels, you need to have a separate DHCP server. This can be a
software or hardware DHCP server, which handles the IP addresses of the Insta LED panels and
the MADRIX computer. A good idea and option is that the DHCP server binds MAC addresses to IP

addresses.
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INSTA Instalight 2022
(18x18 pxl)

e.g. 10.0.0.20

INSTA Instalight 2022 INSTA Instalight 2022 INSTA Instalight 2022
(18x18 pxl) [18x18 pxl) [18x18 pxl)
e.g. 10.0.0.21 e.g. 10.0.0.22 e.g. 10.0.0.23

Ethernet

e.g. 10.0.0.1

Switch

DHCP Server

INSTA Instalight 2022

(backside)

| | e e

) SIS SIS S

i S e

Ethernet

e.g. 10.0.0.1

S
O

DHCP Server

N

MADRIX
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Configuration

We recommend to use an IP address range of 10.0.0.x for MADRIX and InstalLight2022. The
subnet mask should be 255.0.0.0

For the use of Insta products, we suggest to only use 1000Mbit network components. That
means 1000Mbit network cards in your computer, 1000Mbit switches and a DHCP server with

support of 10/100/1000Mbit if your setup looks like the configuration shown above.

For the administration of the Insta network driver, please enable the network driver first. Go to
the menu "Preferences" -> "Options" or the press the keys "Ctrl-Alt-O". Select the tab

"Devices (Network)".

Devices (Metwork) [k

Here you can enable and disable the ROBE/Insta network driver. Use the edit field "Time To
Detect Fixtures (s)" to define how long MADRIX searches the network for InstalLight2022

network devices (type in a value in seconds).

We recommend to utilize at least a value of 10 to allow for a sufficient search.

Higher values are recommended for larger installations.

Furthermore, the option "White Adjustment"” is included for Insta Light panels. MADRIX
automatically performs this automatic calibration with the start-up. Connected panels will adjust
their white value to the maximum value possible in the installation to ensure a similar color
temperature. If the adjustment takes longer than 100 seconds, MADRIX will send data

nevertheless. Uncheck this option if you want to deactivate it.

© 2011 inoage GmbH



381 MADRIX Help and Manual

Please always make sure that you have selected the correct network. Otherwise, the

network device might still be found. But no data can be sent.

In the next step, open the "Device Manager" (press "F4" or open the menu "Preferences" ->

"Device Manager").

Preferences | Window Tools  Previews

Matrix Generator... F2
Patch... F3
Device Manager... F4
Audio Performance... Ctrl+Alt+ A
Remote Control k

Backup - System...

Options... Ctrl+Alt+ 0

Go to the tab "DMX Devices" and decide which of the listed devices are used as output devices.
If you click on "Enable" and "Output”, the data will be sent to this device. Check also if every

device is assigned a different universe (right hand side of the window).

Please check if the DMX universes are assigned correctly!
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COT AN

aut

Ot

Irpouat "

Frame Tim

n use OUT:

In the picture above you can see 4x InstalLight2022 starting at universe 1 to 4 with IP addresses
from 10.0.0.20 to 10.0.0.23.

Left half panel ——————————— Right half panel
Brightn 183 Brightn

Caontrast

= Live pr
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The option "Configure Device" (use the button or double-click the device) allows you to set up
various parameters of the selected Robe panel. Those include: Brightness, Contrast, Luminesce
Time, Frequency, and the values for Red, Green, and Blue for the left half and the right half of
each InstalLight2022 LED Panel.

= an obeS taged ube3: ight2022 - 1P 10.0.0.22

- . igh IP10.0.0.23

Please note: You can also select multiple panels and change all the settings in one step.

Enabling the "Live Preview" switches to receive parameters live from the device. By clicking at
the button "Set Default"”, you will reset it to factory default values.

Settings
B Enakble Output
Imput

Universe:

Frame Time (ms):

FPS:

COntre Crevice

Setting up the "Frame Time" is particularly useful if you have
connected different devices each rendering different output frame rates and you want to sync
them to a specific frame rate. OR it might be that the LED fixtures you attached have problems
with fast frame rate. You are able to slow down the frame time by typing in larger values in ms

in that case.
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Rescan For Devices

Fescan For Devices

If you click the "Rescan For Devices" button, MADRIX disconnects all

DMX512, Art-Net, and other network devices and starts a new search for devices.

Highlight Mode

Highlight Trevice

The "Highlight Device" button activates/deactivates the highlight mode

for the selected interface and universe.

Select one ore more interfaces and press the button. The corresponding fixtures at the selected
interface(s) will flash for a better identification. This makes it easier to see them on stage. It

considerably speeds up the procedure of programming the selected DMX512/Art-Net interfaces.

Resizing The Window

If wish to resize the window of the Device Manager to see more devices in the list, simply move
your mouse pointer to the bottom of this window. Then, select the border and hold the left mouse

button, while moving your mouse downwards.

Further Configuration

Please remember to configure your light matrix in the Matrix Generator or Patch.

Please make sure to save your MADRIX Setup after the configuration process.
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Important Notes

Please keep in mind that network devices, even if activated but not used, cause

network traffic!

7.7  Philips Color Kinetics (KiNet)

Overview

PHILIPS

sense and simplicity

MADRIX natively supports Philips Color Kinetics. The necessary protocol is implemented in the

software, which makes it easy to use Color Kinetics fixtures with MADRIX.

Configuration

For the administration of the Philips Color Kinetics - KiNet network driver, please enable the
network driver first. Go to the menu "Preferences" -> "Options" or the press the keys "Ctrl-Alt-
O". Select the tab "Devices (Network)".

© 2011 inoage GmbH



OUTPUT

386

Time To Deted

Here you can enable and disable the Color Kinetics KiNet network driver.

. Please use these IP addresses!
We recommend to begin with 10.0.0.1 for MADRIX. The subnet mask should be
255.0.0.0

The factory settings for the power supplies start with a default IP address range of 10.0.0.x

You will have to set these settings in Windows. Please open the properties of your network

connection and adjust the values. It should look like this:
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Internet Protocol Version 4 (TCP/APvd) Properties EE

General

You can get IP settings assigned automatically if your netwark supports
this capability, Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(7 Obtain an IP address automatically
i@ Use the following IP address:

IF address:
Subnet mask:

Default gateway:

Obtain DNS server address automatically
i@ Use the follawing DMS server addresses:

Preferred DMS server:

Alternate DMS server:

[ validate settings upon exit

To send data using all network cards of your computer, simply enter 255.255.255.255
(IP address) and 0.0.0.0 (subnet mask).

Please always make sure that you have selected the correct network. Otherwise, the
network device might still be found. But no data can be sent.

Use the edit field "Time To Detect Devices (s)" to define how long MADRIX searches the

network for KiNet network devices/power supplies (type in a value in seconds).
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We recommend to utilize at least a value of 10 to allow for a sufficient search.

Higher values are recommended for larger installations.

In the next step, open the "Device Manager" (press "F4" or open the menu "Preferences" ->

"Device Manager").

Preferences | Window Tools  Previews

Matrix Generator... F2
Patch... F3
Device Manager... F4
Audio Performance... Ctrl+Alt+ A
Remote Control k

Backup - System...

Options... Ctrl+Alt+ 0

Go to the tab "DMX Devices" and decide which of the listed devices are used as output devices.
If you click on "Enable" and "Output”, the data will be sent to this device. Check also if every

device is assigned a different universe (right hand side of the window).

Please check if the DMX universes are assigned correctly!

There is a difference between KiNet V1 and V2. KiNet V2 makes sure that the panels will receive
the data at the same time. This is particularly useful for large installations. Please see the Color

Kinetics documentation to see which protocol is supported by your power supply.

A green dot indicates that all devices are enabled and working.
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Dl Devices s St | MID! Input T Audio Input 1

it

Output B

Input '

Highlight Device

Cancel Applhs Help

In the exemplary picture above, you can see 2x KiNet V1 and 1x KiNet V2 power supplies assigned
to universe 1 to 3 with the IP addresses 10.0.159.189, 10.0.68.54, and 10.0.65.4.

Seftings
B Enakle Output '
Impt

Uniwverse:

Frame Time (ms):

FPS:

COrTGure

Setting up the "Frame Time" is particularly useful if you have
connected different devices each rendering different output frame rates and you want to sync
them to a specific frame rate. OR it might be that the LED fixtures you attached have problems
with fast frame rate. You are able to slow down the frame time by typing in larger values in ms
in that case.
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Rescan For Devices

Fescan For Devices

If you click the "Rescan For Devices" button, MADRIX disconnects all

DMX512, Art-Net, and other network devices and starts a new search for devices.

Highlight Mode

Highlight Trevice

The "Highlight Device" button activates/deactivates the highlight mode

for the selected interface and universe.

Select one ore more interfaces and press the button. The corresponding fixtures at the selected
interface(s) will flash for a better identification. This makes it easier to see them on stage. It

considerably speeds up the procedure of programming the selected DMX512/Art-Net interfaces.

Resizing The Window

If wish to resize the window of the Device Manager to see more devices in the list, simply move
your mouse pointer to the bottom of this window. Then, select the border and hold the left mouse

button, while moving your mouse downwards.
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Further Configuration

LED Fixtures Comments
Color Kinetics eW Flex SLX If your are using a PDS-60ca with one or two strings per
Color Kinetics iColor Flex SLX controller, a PDS-150, or sPDS-480ca, please select the

correct fixture in the Matrix Generator.

Please remember to configure your light matrix in the Matrix Generator or Patch.

Please make sure to save your MADRIX Setup after the configuration process.

Important Notes

Please keep in mind that network devices, if activated, cause network traffic!

Checklist To Solve Problems

If you are encountering problems, please work through the following checklist:
e Please check if all network cables are connected and if Gigabit network components are used.

e Please check if your light matrix is configured correctly in the "Matrix Generator" or "Patch".
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e Have all devices been found in the "Device Manager" under "DMX Devices"?
If not,
1) please check if the IP address and Subnet mask are configured correctly in Windows and your
devices.
2) please go to the menu "Preferences" -> "Options" -> "Devices (Network)". Select "Enable
KiNet".
3) please go to the menu "Preferences" -> "Options" -> "Devices (Network)". Select the correct
network card in the section "Philips Color Kinetics - KiNet".
4) please go to the menu "Preferences" -> "Options" -> "Devices (Network)". Increase the value
for "Time To Detect Devices (s)" in the section "Philips Color Kinetics - KiNet".
5) please press "Rescan For Devices" in the "Device Manager" under "DMX Devices".

6) please try and deactivate your Firewall in Windows.

e Are all devices activated in the "Device Manager"?

Please check if "Enable" and "Output" are activated under the tab "DMX Devices".

e Please check if all ports you are using on your device are configured correctly in the "Device
Manager" under "DMX Devices". Please check if ports, that are not used, are deactivated in
MADRIX.

e Please check if the DMX addressing and DMX universes are assigned correctly in the "Device

Manager" under "DMX Devices" and in the "Patch".

e Please test if MADRIX is connected to the devices. Use the button "Highlight Device" for each of

your devices in the "Device Manager" under "DMX Devices".
e Please go to the menu "Tools" -> "Task Watcher". Check if the devices are sending data.

e Please go to the menu "Tools" -> "Lodfile". Check if any error or warnings occur regarding the

network or KiNet.

Additional Information

Addressing And Configuration
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Regarding the configuration and addressing of Philips Color Kinetics lighting fixtures and power
supplies, the company offers extensive information on the following website: http://www.

colorkinetics.com/support/addressing/

In addition, there is a software tool called QuickPlay Pro for configuration and multiple addressing.

Here is an excerpt from the website:
"With QuickPlay Pro, you can:

Use serial numbers to program fixtures with light numbers or DMX addresses

Assign base light numbers to power / data supplies, allowing automatic fixture configuration
Test light numbers and DMX channels

Demonstrate a lighting system using four built-in light shows: fixed color, color wash, rainbow,
and streak"

For example, the tool can be used to change the IP addresses of Color Kinetics lighting fixtures.

Please note: Working with such a tool is only recommended for advanced users because settings

can easily be adjusted wrong!

You can download the tool on the website mentioned above or at http://www.colorkinetics.com/

support/downloads/

The download archive for older products can be found at http://www.colorkinetics.com/support/

downloads/archive/

Information About PDS-60ca Power Supplies

The PDS-60ca is a well-known and often used power/data supply from Philips Color Kinetics. Three

different versions are offered:

e PDS-60ca PREPROGRAMMED
e PDS-60ca DMX
e PDS-60ca ETHERNET

You can identify your version of the device using the following item numbers written on the case
of the PDS-60ca:

e 109-000016-00 (Pre-programmed)
e 109-000016-01 (DMX)
e 109-000016-02 (Ethernet)
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The PDS-60ca DMX supports DMX512 via an extra interface (controlled by MADRIX) or Color
Kinetics DMX controllers.

The PDS-60ca ETHERNET uses KiNet and can be controlled via MADRIX without an extra
interface.

And the PDS-60ca PREPROGRAMMED does not support external data input.

Information Update

The official website now only lists two PDS-60ca. The second power supply how automatically

switches between DMX and Ethernet mode.

e 109-000020-00 PDS-60ca 12V (Pre-programmed)
e 109-000020-03 PDS-60ca 12V (DMX / Ethernet)

7.8 ESTA - Streaming ACN

Introduction

ESTA
=

|
Streaming ACN (sACN) is a protocol that transfers DMX data over Ethernet.

Hence, it is another network-based DMX protocol. It is a standard created by ESTA

(Entertainment Services and Technology Association - www.esta.org).
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Configuration

Enable Streaming ACN

In order to use Streaming ACN, please enable the network driver first. Go to the menu
"Preferences" -> "Options" or the press the keys "Ctrl-Alt-0". Select the tab "Devices
(Network)".

Select "Enable ACN E1.31" in order to activate Streaming ACN.

In the next step, you will have to define how many ACN devices you are going to use in your

installation. This is the total amount of OUT and IN devices. Enter the number in the field after
"Count Of ACN Devices Used". Please set the exact number of devices you are using. (If the
count is higher, this increases unnecessary network traffic.) If your are using 10 ACN devices,

please enter "10", for example. Press "Apply" to save the settings.
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ACN CID : T3c844fb-1dar-4b4f-95

Being a network protocol, Streaming
ACN sends a so-called CID (Component Identifier). Every single ACN device has such a unique ID.
When using Streaming ACN, your MADRIX software is one of those devices. When you start
MADRIX for the first time, this ID will be generated automatically for you. From this point onwards
it will be used on your PC.
With this ID your MADRIX software can be easily identified in the network. Interfaces can detect
this unique ID and can be configured to receive data from this particular device. Please note that

the ACN interface must support this feature.

Do not change the ACN CID, unless you are an experienced user!

Configuration of DMX Devices

In the next step, please open the "Device Manager" in the menu "Preferences". Or press "F4"

on your keyboard. A new window will open.

Output B

o bbb e[l )

Irpoet "B

Highlight Tevice E ] 10 1N O

cancel el
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As you can see, MADRIX automatically creates the number of interfaces defined in the

Options dialog. In the our example, 10 devices were created.

Next, please select one device in the list and click "Configure Device...". In addition, you can

perform a double-click on this device. A new dialog will open.

ACH Source Mame :
ALCH Universes :
ALCH Priarity :

ACH Frotocal :

I 53

"ACN Source Name" allows you to define a specific name for the device. This name is send via
network as well. Therefore, interfaces may be able to retrieve this name and can be configured to
receive data from this source. If you are using the default name "MADRIX U:X", the universe will

automatically be displayed in the name (represented by X: 1, 2, 3, etc.).

"ACN Universe" is to define the DMX universe of your ACN interface. You can manually adjust the

settings.

"ACN Priority" was implemented for backup solutions. Valid values range from 0 to 200, which is
the highest priority. For example, you may have set up two MADRIX PCs. One gets a priority of
100. The second PC gets a priority of 50. If the first PC fails and only if it malfunctions, data will
be automatically received from PC #2. Data will always be received from the device with the

highest priority. Please note that the ACN interface must support this feature.

"ACN Protocol” allows you to choose the protocol version. The official version is called "Release
r3". This option is selected by default. If you installed an older interface with the Draft version,

you may select "Draft r2". Please do not change the protocol unless you are sure.

Press "Apply" to save your changes.
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In addition, you can configure several interfaces at the same time. Select multiple devices and

press "Configure Device...". A new dialog will open.

ACH Source Mame :

ALCHN Uniy

ALH Priarity : 100 OxGd4  (Defaul)

ACH Pro : e 3 (Default)

ik

You will be able to define a "ACN Source Name" and the "ACN Universe".

Leave this button deactivated and every device will get the same universe.
T

Activate the button and MADRIX will automatically number the devices starting

with the ACN Universe you defined.

Press "Apply" to save your changes.
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Enable DMX-OUT

Output '

Imput

Please make sure that your DMX devices are enabled. Select the interface or multiple interfaces
and click "Enable" and "Apply".

"State" is "off", please click "Enable" in the "Settings" section.

A green dot in the list indicates that all devices are enabled and working. If the

Setting up the "Frame Time" is particularly useful if you have connected different devices each
rendering different output frame rates and you want to sync them to a specific frame rate. OR it
might be that the LED fixtures you attached have problems with fast frame rate. You are able to

slow down the frame time by typing in larger values in ms in that case.

Please note: If you are loading a MADRIX Setup, please check if the number of ACN devices in
your setup corresponds with the number that is activated. The Setup stores the number of
devices. But if you changed the amount and then loaded the Setup, the newly defined number will

be activated.
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Enable DMX-IN

B Enakle Outpt '

Irpoat m

Uniwverse:

Frame Time (ms):

Contigore Device .

If you wish to use an ACN interface for DMX-IN, activate "Input" and "Enable" in the "Settings"

section. Press "Apply" afterwards.

Please note that in DMX-IN mode, you will not be able to select the ACN protocol. MADRIX will

automatically select the correct protocol version.

ACH Source Mame :

ACH Universes :

ALH Priarity :

For further configuration, please read the chapter DMX-IN & Art-Net Remote.
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Rescan For Devices

Fezcan For Devices

If you click the "Rescan For Devices" button, MADRIX disconnects all

DMX512, Art-Net, and other network devices and starts a new search for devices.

Highlight Mode

Highlight Crevice

The "Highlight Device" button activates/deactivates the highlight mode

for the selected interface and universe.

Select one ore more interfaces and press the button. The corresponding fixtures at the selected
interface(s) will flash for a better identification. This makes it easier to see them on stage. It

considerably speeds up the procedure of programming the selected DMX512/Art-Net interfaces.

Resizing The Window

If wish to resize the window of the Device Manager, simply move your mouse pointer to the
bottom of this window. Then, select the border and hold the left mouse button, while moving your

mouse downwards.
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Important Notes

Please switch off your Firewall under Windows Vista and Windows 7 or configure your

Firewall accordingly. sACN might not work with a Firewall!

sACN streams data to all network cards of the computer in broadcast mode. You

cannot select a single, specific network card.

It is recommended to run sACN in a separate network without internet access. Else,

the internet connection may not work properly.

Please keep in mind that network devices, if activated, cause network traffic!

Further Configuration

Please remember to configure your light matrix in the or

Please make sure to save your MADRIX Setup after the configuration process.

7.9 Proprietary DVI Devices

Overview

Certain DVI hardware is equipped with proprietary protocols. MADRIX has implemented a range of
products that are natively supported because of this.

MADRIX currently supports the following DVI device types:
e EuroLite T9

e ColourSmart Link
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Before you can use MADRIX, please make sure that you have configured your LED

fixture and hardware correctly.

Gigabit Network Card

Please only use a GIGABIT network card ("1GBit/s"). 100Mbit network cards will not

work!

Configuration

Navigate to the menu "Preferences" -> "Device Manager" (or press "F4"). Now, select the tab

"DVI Devices".

P T . -
State Mame SIzE Type T mE TEPS

Righlight Trevice

Click "Add New Device".
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Eurolite T9

ColourSmart Link

Add Mewe Device |

A small selection list will be opened above the button.

Simply select your DVI device type and a new configuration dialog will open.

twok card and the WinPcap driver installed

If the drop-down list at the top end does not contain an entry,

there is either no network card available or the WinPcap driver is not installed properly.

If you are receiving this error message, please correct these issues and run the MADRIX

installer again to install the drivers ("WinPcap Driver").
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== MADRIX 2.10 Sety

Choose Components
Choose which features of MADRIX 2,10 you want to install,

MADRIX

Chedk the components you want to install and uncheck the components you don't want to
install. Click Mext to continue.

. Description
Select components to install:
MADRIX Installs the WinPcap

Desktop shorteut driver and enables
Examples Eurclite T9 ar
MADRIX KEY Driver ColourSmart Link

[ ] interface Driver hardware support.
[ ] visualizer Driver

Space reguired: 95.0MB

If everything is installed properly, select the network device that communicates with your DVI

fixture in the drop-down list.

Do not change any other settings here (Color Master) unless you are an experienced user.

Advanced users may adjust the color settings if the DVI device renders colors incorrectly. Press

Ilokll.
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Now, the new DVI device will appear in the list:

There are different "Settings" available for further configuration. Always press "Apply" to accept

the changes you have made.

"Enable" activates or deactivates the currently selected DVI device. This is activated by default.

It should be activated in order to work correctly.

Activate "Enable Full Size" and your full matrix will be displayed. This is activated by default.

Or you can select a certain cut-out and specify which details of your matrix will be shown. You
can choose the start coordinates and the end coordinates of this area. "Left" and "Top" define
the start coordinates in a coordinate system that starts with 0,0 in the top left corner. "Right"

and "Bottom" define the end coordinates.

Scaling is not available.

Your matrix will not be stretched or compressed in order to fit the DVI device or vice versa.
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Use "Set Frame Time (ms)" in order to set a different frame time. By default, the DVI device is
set to be an "event" type with a frame rate of 50 FPS. If you manually set a new frame time, the
output might judder. We do not recommend to set a higher frame rate than 50 FPS. But if your
hardware controller requires a frame rate that is lower than 50 FPS, adjust the value to these

requirements. Then, the type of your device will be set to "frame" in the list.

"Remove Device" will delete the currently selected DVI device.

"Highlight Device" will make your device flash and will set all pixels instantly to white for testing

purposes.

"Configure Device..." will call up the configuration dialog, again.

Further Configuration

Please remember to configure your light matrix in the Matrix Generator or Patch.

Please make sure to save your MADRIX Setup after the configuration process.

Important Notes

Device Type Comments

All DVI device types 1) Please do not use a network hub or switch. Please only use a
direct network connection.

2) Please note that the hardware controller needs to be
configured correctly, before MADRIX can be used.

3) The configuration cannot be rotated. If you have rotated
fixtures in your installation, please use the rotation features
provided by each MADRIX effect.

EuroLite T9 1) Before using MADRIX, please make sure that you have
configured your EUROLITE LED fixture and hardware correctly.
The configuration is described in the EUROLITE user manual.
Repeat the steps if necessary.
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2) You can only create and use one single DVI device in MADRIX
per network card. This means that a maximum of 56 controllers
connected in series can be used per one network card with a
maximum of 128x128 pixels for each controller.

3) Please note: Configure only one hardware controller at a
time with the software EUROLITE LED Show T9. Please do not
connect several controllers while setting the parameters.

4) See www.eurolite.de for the latest documentation.

Checklist To Solve Problems

If you are encountering problems, please work through the following checklist:

e Please check if all network cables are connected correctly. Please do not use a network hub or

switch.
e Please check if your hardware is working without MADRIX.
e Please check if you have installed the "WinPcap" Driver during the installation of MADRIX.
e Please check if your light matrix is configured correctly in the "Matrix Generator" or "Patch".

e Please go to the menu "Preferences" -> "Device Manager". Check if you have added a new DVI

device under "DVI Devices".

e Please check if "Enable" and "Enable Full Size" are activated for your device in the "Device

Manager" under "DVI Devices".
e Please configure your hardware controller again if this seems to be necessary.

¢ Please always configure only one hardware controller. Do not connect two or more controllers

while setting the parameters.
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e When using LED Show T9,
1) please repeat the steps described in the manual.
2) please make sure to press "Send" two times in order to make the "parameter set" on your PC
and on your controller.
3) please download the configuration file again (for example, "Presets T9.DAT") and use this
default configuration file to configure your controller again.

4) please deinstall the software and then install it again. Reconfigure all settings.
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8 INPUT & Remote Control
Overview

MADRIX supports Art-Net Remote, DMX-IN, MIDI-IN, Remote HTTP, and MIDI Time Code to control

the software remotely.

e Art-Net Remote

The Art-Net protocol includes Art-Net Remote. This function is built right into the software.

Several standard protocols are implemented to easily address every LED installation.
e DMX-IN

To access any hardware that is ready for DMX-IN, six protocols are natively implemented into

MADRIX. Any DMX console or desk can easily be used to gain full control.

e MIDI-IN

Learn how to configure your MIDI device. In a lot of cases MIDI consoles are used to control
MADRIX.

e MIDI Time Code (MTC)
MIDI Time Code (MTC) can be received with MADRIX professional and MADRIX ultimate.
e Remote HTTP

MADRIX offers remote control with every internet browser. An internal web server is implemented

in the software and can be started if required.

© 2011 inoage GmbH



INPUT & Remote Control 412

8.1 DMX-IN & Art-Net Remote

Introduction

MADRIX can be controlled remotely via DMX-IN or Art-Net Remote. This chapter will explain how to
activate these options. For DMX-IN with Streaming ACN, please also refer to the section 'DMX-IN'

below.
Contents of this chapter:

e DMX-IN

e Art-Net Remote

e Protocols (Overview)

e How To Assign DMX Freely - DMX-IN Remote Editor

DMX-IN

1. Activating Your DMX Device

For administration of DMX-IN devices, please open the "Device Manager" (press "F4" or go to

the menu "Preferences").

Preferences | Window Tools  Previews

Matrix Generator... F2
Patch... F3
Device Manager... F4
Audio Performance... Ctrl+Alt+ A
Remote Control k

Backup - System...

Options... Ctrl+Alt+ 0

A new window will be displayed.
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Frame Time [m:

se OUT: 0455 IN: O

Please press "Rescan For Devices" in order to detect your connected devices. Now, select your

DMX device in the list. Then, activate "Enable" and "Input” in the section "Settings". Press

"Apply" afterwards.

Advanced users may reconfigure further settings if needed.

Output ')

It B

Highiight O
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2. Enabling DMX-IN

Now, please select the tab "DMX Input" of the Device Manager.

" audio Input

Femote

o L

-

e Contral

v Ecit...

annels From : = Ta:
| I |

To Un : = Start At Channel :
L ———]

= Use HTP
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Select an (empty) entry in the list according to your preferred DMX universe. By default, universe
1 to 8 are listed. If you wish to increase the number of DMX-IN universes, please change the
setting in the "MADRIX Options" -> Performance.

After the selection, choose your "DMX-IN Device" in the section "Device". This could also be a
Streaming ACN device. Activate "Remote" (in the upper right corner) in the next step. Finally,
select one of the built-in protocols in the section "Remote Control" or create your own remote

configuration as explained below (How To Assign DMX-IN Freely).

B Remote

Ecit...

Ta -

it Channel :
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Remote Control

Use this button to open an existing MADRIX DMX Remote Configuration file (*.mdrc)

from your hard disk.

The protocols (configurations) you can choose from

will be explained in more detail in the following chapters.

5] Edt...
Click "Edit" if you wish to change a configuration or create a new one. More

information is given below with

Start Address :

A protocol can start at a particular DMX channel. Define this "Start

Address" here. The whole protocol will be mapped to this new area then.

Dt vatcher.

Open the DMX Watcher to monitor your DMX output or input. Learn more in

the chapter
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Mapping

Activate "Mapping"” (in the upper right corner) if you would like to route incoming DMX signals
through MADRIX for output (DMX through). This feature maps incoming data to the specified DMX

universe and channels.

Define which minimum DMX channel and which maximum DMX channel should be mapped to
which DMX universe ("Map Channels From ... To ... To Universe ..."). You can also define a
start channel ("Start At Channel™), which defines the first channel to start with.

The option "Use HTP" can be activated if MADRIX should only use the highest values it receives

on a particular channel (Highest Takes Precedence principle).

Press "Apply" after the configuration process.

happing

Map Channels Fram :
To Universe :

= Uze HTP

Art-Net Remote

Overview

An Art-Net device can be used for DMX-IN as well. In general, this feature is called Art-Net

Remote.
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1. Art-Net Configuration
Please set up your network card using the following Art-Net address area:

2.0.0.1 ... 2,.255.,255.254 or

10.0.0.1 ... 10.255.255.254

Artistic Licence, the creators of Art-Net, recommends to primarily use the first address range. The
second is regarded to be an alternative.

Please use the following Subnet mask:

255.0.0.0

You must use this address area. Otherwise Art-Net may not work.

2. Activating Art-Net
Go to the menu "Preferences", select "Device Manager" and then select the tab "Art-Net".

Enable Art-Net here by activating the check-box in the upper left corner.

If you have enabled Art-Net inside this dialog, you will see at least one entry. The "Art-Net
Remote" entry is automatically provided by MADRIX and you can use it for controlling MADRIX
remotely within the Art-Net network (Art-Net Remote).
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TH' Art-Net

arme

Arthlet Remate

Click "Edit" and you will be allowed to modify the universe and other options.
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Manufacturer : inoage
Froduct : his 1
Esta : inoage trade - Hertel, Pinzer, Wissmann bR
Short Hame : Manual IC: 0

Long Hame :
L ——————————

Fort Count: 1 0x1 w
e

State : Fort 1: Enabled
Universe
Fort OUT : 0O
sa Port [N :
hac:
Style Code :

ve Broadcast

Subnet:

Port :

If you activate "Receive Broadcast", any light desk in the network can send data to MADRIX. If
this option is not enabled, only a lighting desk with the IP defined in the "IP" input field can
control MADRIX.

Press "Apply" after the configuration process.
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3. Activating Your Art-Net Device

Now, go to the tab "DMX Devices" in the "Device Manager".

Frame Time (ms)

Please press "Rescan For Devices". Now, select your DMX device in the list. Then, activate

"Enable" and "Input” in the section "Settings". Press "Apply" afterwards.

I 0
ArNet Remote (b2

L e -
Hicklict Ty 1 n use QU
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4. Enabling DMX-IN

Now, go to the tab "DMX Input"” in the "Device Manager".

" audio Input

Femote

o L

-

e Contral

v Ecit...

annels From : = Ta:
| I |

To Un : = Start At Channel :
L ———]

= Use HTP
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Select an (empty) entry in the list according to your preferred DMX universe. By default, universe
1 to 8 are listed. If you wish to increase the number of DMX-IN universes, please change the
setting in the "MADRIX Options" -> Performance.

Then, choose your "DMX-IN Device" in the section "Device" (your Art-Net Remote device).
Activate "Remote" (in the upper right corner) in the next step. Finally, select one of the built-in
protocols in the section "Remote Control" or create your own remote configuration as explained
below (How To Assign DMX-IN Freely).

B Remote

Ecit...
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Remote Control

Use this button to open an existing MADRIX DMX Remote Configuration file (*.mdrc)

from your hard disk.

The protocols (configurations) you can choose from

will be explained in more detail in the following chapters.

5] Edt...
Click "Edit" if you wish to change a configuration or create a new one. More

information is given below with

Start Address :

A protocol can start at a particular DMX channel. Define this "Start

Address" here. The whole protocol will be mapped to this new area then.

Dt vatcher.

Open the DMX Watcher to monitor your DMX output or input. Learn more in

the chapter
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Mapping

Activate "Mapping"” (in the upper right corner) if you would like to route incoming DMX signals
through MADRIX for output (DMX through). This feature maps incoming data to the specified DMX

universe and channels.

Define which minimum DMX channel and which maximum DMX channel should be mapped to
which DMX universe ("Map Channels From ... To ... To Universe ..."). You can also define a

start channel ("Start At Channel™), which defines the first channel to start with.

The option "Use HTP" can be activated if MADRIX should only use the highest values it receives

on a particular channel (Highest Takes Precedence principle).

Press "Apply" after the configuration process.

happing

Map Channels Fram :
To Universe :

= Uze HTP
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Protocols (Overview)

Six different protocols are already implemented. Here is an overview:
e DMX-IN (Micro Protocol)

e DMX-IN (Mini Protocol)

e DMX-IN (Small Protocol)

e DMX-IN (Large Protocol)

e DMX-IN (Universal Protocol)

e DMX-IN (Universal Protocol 2)

426
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How To Assign DMX Freely - DMX-IN Remote Editor

Overview

Once you clicked "Edit", a new window with the DMX-IN Remote Editor will open.

If you are creating a new configuration, this window will be empty.

walue
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Add a new entry or remove an entry. Scroll and navigate through the list of entries with

the help of the two arrow keys.

Duplicate/copy an entry. Select one entry or several entries in the list, press the button

and the selected entries will be duplicated. The entries will be added to the list right after each

selected entry. You can change the settings of each entry afterwards.

You may create a completely new configuration,
open an existing MADRIX DMX Remote Configuration file (*.mdrc) from your hard disk, or save

your remote configuration.

Use this button to automatically assign a control of your device to a function in
MADRIX. Activate "Assign", select an entry you created and move the control of your input
device. MADRIX will automatically identify the "DMX Channel" and "Control Type".

After assigning a function to a control of your input device, you can press "Test"
and move the control on your input device. You can see if the control works as expected on the
MADRIX GUI, when "Test" is activated. If "Test" is activated, MADRIX will receive the signal
directly and not the DMX-IN Remote Editor.

"Test" is also useful for testing modifiers. Read more on this topic: Modifiers.
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Config HMame :  Large
R R RERERESEEBmmmmm

When editing or creating a

configuration, make sure to type in an individual name for your remote configuration in the field

labeled "Config Name". It will be created as "USER 'Config Name" in the list.

Keyboard Shortcuts

Ctrl + A

Select all entries in the list.

Ctrl + E (hold)

Activates "Assign", while holding this shortcut.

Ctrl + N Create a new configuration.
Ctd + 0 Open a configuration.
Ctrl + S Save a configuration.

Ctrl + T (hold)

Activates "Test", while holding this shortcut.

Entf

Delete selected entries in the list.

Arrow Up

Navigate upwards in the list.

Arrow Down

Navigate downwards in the list.

Double-click on an entry

Calls up the context menu for the column.

Double-click on a head row of the list

Sorts the list alphabetically according to the column
(ascending or descending).
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Configuration Of The DMX-IN Remote Editor

Function:

Select an entry and perform a double-click with your mouse on the column "Function" or create a
new entry with "+". First, select the general topic ("Storage A", for example). Second, select the

exact function of MADRIX you wish to configure ("Place", for example) and click with your mouse.

T Caulh Cortror Type Irterschor Irvert o e Lt DrE=criptior

walue

L
| —
L
| —
| —
| I—
| —
—_

DMX Channel:

Option A) Use the button "Assign", select an entry and move the control of your input device. In

most cases, MADRIX will automatically recognize the DMX Channel and the Control Type.

Option B) Select an entry and perform a double-click with your mouse on the column "DMX
Channel". First, select the channel ("Channel 01", for example). Second, select "Control Change".

Third, select the value ("053", for example) and click with your mouse.
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Value
| —
L
| —
| —
L
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Small

v Control Change

Channel 08
Channel 09
Channel 10
Channel 11
Channel 12
Channel 13

Control Type:

Option A) Use the button "Assign”, select an entry and move the control of your input device. In

most cases, MADRIX will automatically recognize the DMX Channel and the Control Type.

Option B) Select an entry and perform a double-click with your mouse on the column "Control

Type". Select the type of the control of your input device ("Fader/Knob", for example).
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| —
L
| —
| —
| B—
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—_
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Interaction:

Select between "Toogle" or "Absolute". "Toogle" is suitable for On/Off-Functions: A value of 0 to
127 represents "Off", while a value of 128 to 255 represents "On". "Absolute" uses the exact

value.
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Value
| —
L
| —
| —
L
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—_
| —

Invert:

Select an entry and perform a double-click with your mouse on the column "Invert". The entry will
change between "No" and "Yes". If "Yes" is selected, all values of this control will be inverted.

That means for example that 0 becomes 255 and 255 becomes 0.
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State
o

EEREREN]

Condition (Cond.):

Select an entry and perform a double-click with your mouse on the column "Cond.". Select the
condition ("None", for example). If you select a "State", click "Yes" or "No". If you select a "Value",

select and click the according number for it. Read more on this topic:
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o T . |

Small
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Min, Max, Description:

Select an entry and perform a double-click with your mouse on the column "Min", "Max", "Factor",
or "Description". Enter the desired value or text.

"Min" requires a minimum value for this control. The default value is 0.

"Max" requires a maximum value for this control. For example, the Master Fader has a maximum
value of 255, or you may want to set the maximum Fade Time to 10 seconds.

"Description" requires a text (By default, the name of the function will automatically be entered).
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State
o

AlRERRER

Modifiers:

The DMX-IN Remote Editor allows you to create advanced configurations. Modifiers allow to set
certain conditions.

In general, these are the steps to follow:

1) Select an entry and perform a double-click with your mouse on the column "Function". Or you
can create a new entry with "+".

First, select "Modifier". Second, select a "State" or "Value" and click with your mouse.
2) Afterwards create a function.

3) Assign the condition to this function ( ).

"State" creates a requirement/condition that is required before the function will work.

Example: We have set up a fader on the console that controls the Master Fader of MADRIX.
Because of the condition the Master Fader can only be used, when the button is pressed at the

same time:
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Hame

At
Irrert Conc

If no condition is assigned, the fader can be moved and the Master Fader of MADRIX will always

respond accordingly:

"Value" allows you to add several functions to one or more controls of your input device.

Test your modifiers. Activate the button (it changes to a green color). Now, move
or use a control of your input device (a button or fader, for example). The DMX-IN Remote Editor

will show at the left side of the window which modifier is assigned to this control.

Important Notes

Please make sure to save your MADRIX Setup after the configuration process.
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8.1.1 DMX-IN (Micro Protocol)

438

Overview
DMX Value Function
Channel
1 0-120 Storages A 1 - 60
121 - 240 Storages B 1 - 60
2 0 - 100% (0-10 sec. default value) Set up the Fade time in percent
3 0 - 255 Set up the Master Fader

Other Protocols

There are other preprogrammed DMX protocols, despite the Micro Protocol:

o DMX-IN (Micro Protocol)

e DMX-IN (Mini Protocol)

DMX-IN (Small Protocol)

e DMX-IN (Large Protocol)

DMX-IN (Universal Protocol)

e DMX-IN (Universal Protocol 2)
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8.1.2 DMX-IN (Mini Protocol)

Overview
DMX Value Function
Channel
1 0-120 Storages A 1 - 60
121 - 240 Storages B 1 - 60
2 0-63 XF - Cross-fade
64 - 127 WF - White-fade
128 - 192 BF - Black-fade
192 - 255 CF - Color-fade
3 0 -100% Set up the Fade time in percent
(0-10 sec. default value)
Set up the color for Color-fade
4 0 - 255 Red
5 0 - 255 Green
6 0 - 255 Blue
7 0 - 255 White
8 0 - 255 Set up the Master Fader

Other Protocols

There are other preprogrammed DMX protocols, despite the Mini Protocol:

DMX-IN (Micro Protocol)

o DMX-IN (Mini Protocol)

e DMX-IN (Small Protocol)

e DMX-IN (Universal Protocol)

DMX-IN (Large Protocol)

DMX-IN (Universal Protocol 2)
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8.1.3 DMX-IN (Small Protocol)

Overview
DMX Value Function
Channel
1 0 - 240 Storage A Place 1 - 60 (in steps of 4)
2 0 - 240 Storage B Place 1 - 60 (in steps of 4)
3 0-63 XF - Cross-fade
64 - 127 WF - White-fade
128 - 191 BF - Black-fade
192 - 255 CF - Color-fade
4 0 - 255 Fade Value (Position of the Fade Slider)
5 0 - 255 Fade Time in seconds
6 0 - 255 Fade Time in 1/100 seconds
7 0/255 Auto Fade
8 0 - 255 CF Fade Color R
9 0 - 255 CF Fade Color G
10 0 - 255 CF Fade Color B
11 0 - 255 CF Fade Color W
12 0 - 255 Set up the Master Fader

Other Protocols

There are other preprogrammed DMX protocols, despite the Small Protocol:

DMX-IN (Micro Protocol)

o DMX-IN (Mini Protocol)

e DMX-IN (Small Protocol)

DMX-IN (Large Protocol)

e DMX-IN (Universal Protocol)

DMX-IN (Universal Protocol 2)
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8.1.4 DMX-IN (Large Protocol)

Overview
DMX Value Function
Channel

1 0-5 No Function
6 - 30 Storage A Place 1
31-55 Storage A Place 2
56 - 80 Storage A Place 3
81- 105 Storage A Place 4
106 - 130 Storage A Place 5
131 -155 Storage A Place 6
156 - 180 Storage A Place 7
181 - 205 Storage A Place 8
206 - 230 Storage A Place 9
231 - 255 Storage A Place 10

2 0-5 No Function
6 - 30 Storage A Place 11
31 -55 Storage A Place 12
56 - 80 Storage A Place 13
81- 105 Storage A Place 14
106 - 130 Storage A Place 15
131 -155 Storage A Place 16
156 - 180 Storage A Place 17
181 - 205 Storage A Place 18
206 - 230 Storage A Place 19
231 - 255 Storage A Place 20

3 0-5 No Function
6 -30 Storage A Place 21
31-55 Storage A Place 22
56 - 80 Storage A Place 23
81- 105 Storage A Place 24
106 - 130 Storage A Place 25
131 -155 Storage A Place 26
156 - 180 Storage A Place 27
181 - 205 Storage A Place 28
206 - 230 Storage A Place 29
231 - 255 Storage A Place 30

4 0-5 No Function
6 - 30 Storage A Place 31
31-55 Storage A Place 32
56 - 80 Storage A Place 33
81- 105 Storage A Place 34
106 - 130 Storage A Place 35
131 -155 Storage A Place 36
156 - 180 Storage A Place 37
181 - 205 Storage A Place 38
206 - 230 Storage A Place 39
231 - 255 Storage A Place 40

5 0-5 No Function
6 - 30 Storage A Place 41
31-55 Storage A Place 42
56 - 80 Storage A Place 43
81- 105 Storage A Place 44
106 - 130 Storage A Place 45
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131 -155 Storage A Place 46
156 - 180 Storage A Place 47
181 - 205 Storage A Place 48
206 - 230 Storage A Place 49
231 - 255 Storage A Place 50
6 0-5 No Function
6 -30 Storage A Place 51
31 -55 Storage A Place 52
56 - 80 Storage A Place 53
81- 105 Storage A Place 54
106 - 130 Storage A Place 55
131 -155 Storage A Place 56
156 - 180 Storage A Place 57
181 - 205 Storage A Place 58
206 - 230 Storage A Place 59
231 - 255 Storage A Place 60
7 0-5 No Function
6 -30 Storage B Place 1
31-55 Storage B Place 2
56 - 80 Storage B Place 3
81- 105 Storage B Place 4
106 - 130 Storage B Place 5
131 -155 Storage B Place 6
156 - 180 Storage B Place 7
181 - 205 Storage B Place 8
206 - 230 Storage B Place 9
231 - 255 Storage B Place 10
8 0-5 No Function
6 - 30 Storage B Place 11
31-55 Storage B Place 12
56 - 80 Storage B Place 13
81- 105 Storage B Place 14
106 - 130 Storage B Place 15
131 -155 Storage B Place 16
156 - 180 Storage B Place 17
181 - 205 Storage B Place 18
206 - 230 Storage B Place 19
231 - 255 Storage B Place 20
9 0-5 No Function
6 - 30 Storage B Place 21
31 -55 Storage B Place 22
56 - 80 Storage B Place 23
81- 105 Storage B Place 24
106 - 130 Storage B Place 25
131 -155 Storage B Place 26
156 - 180 Storage B Place 27
181 - 205 Storage B Place 28
206 - 230 Storage B Place 29
231 - 255 Storage B Place 30
10 0-5 No Function
6 -30 Storage B Place 31
31 -55 Storage B Place 32
56 - 80 Storage B Place 33
81- 105 Storage B Place 34
106 - 130 Storage B Place 35
131 -155 Storage B Place 36
156 - 180 Storage B Place 37
181 - 205 Storage B Place 38
206 - 230 Storage B Place 39
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231 - 255 Storage B Place 40
11 0-5 No Function
6 - 30 Storage B Place 41
31-55 Storage B Place 42
56 - 80 Storage B Place 43
81- 105 Storage B Place 44
106 - 130 Storage B Place 45
131 -155 Storage B Place 46
156 - 180 Storage B Place 47
181 - 205 Storage B Place 48
206 - 230 Storage B Place 49
231 - 255 Storage B Place 50
12 0-5 No Function
6 - 30 Storage B Place 51
31-55 Storage B Place 52
56 - 80 Storage B Place 53
81- 105 Storage B Place 54
106 - 130 Storage B Place 55
131 -155 Storage B Place 56
156 - 180 Storage B Place 57
181 - 205 Storage B Place 58
206 - 230 Storage B Place 59
231 - 255 Storage B Place 60
13 0-63 XF - Cross-Fade
64 - 127 WF - White-Fade
128 - 191 BF - Black-Fade
192 - 255 CF - Color-Fade
14 0 - 255 Fade Value (Position of the Fade Slider)
15 0 - 255 Fade Time in seconds
16 0 - 255 Fade Time in 1/100 seconds
17 0/255 Auto Fade
18 0 - 255 CF Fade Color R
19 0 - 255 CF Fade Color G
20 0 - 255 CF Fade Color B
21 0 - 255 CF Fade Color W
22 0 - 255 Set up the Master Fader

Please Note regarding DMX Channels 1-6 & 7-12:

DMX channels 1-6 and 7-12 control the Storage Areas A and B. Please send signals only on one of

the six DMX channels 1-6 to switch Storage Places. The same applies to DMX channels 7-12.

Example 1

You want to request Storage Place 17 from Storage A:

DMX-Channel

Value
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56-180

Ul A WN -
O OO o+ o

Example 2

You want to request Storage Place 43 from Storage B:

DMX-Channel Value
7 0
8 0
9 0
10 0
11 56-80
12 0

In practice:
After setting up the first Storage with a fader, you can select a new Storage with a second

fader on the mixer. This one will only be applied if the first fader is set to O.

Other Protocols
There are other preprogrammed DMX protocols, despite the Large Protocol:
e DMX-IN (Micro Protocol)

o DMX-IN (Mini Protocol)

DMX-IN (Small Protocol)

e DMX-IN (Large Protocol)

DMX-IN (Universal Protocol)

e DMX-IN (Universal Protocol 2)
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8.1.5 DMX-IN (Universal Protocol)
Overview
DMX Value Function
Channel
1 0-120 Storages A 1 - 60 with Autofade
121 - 240 Storages B 1 - 60 with Autofade
2 0 - 240 Storage A Place 1-60 (Steps of 4)
without Autofade
3 0 - 240 Storage B Place 1-60 (Steps of 4)
without Autofade
4 0 - 255 (0 - 100%) Set up the Fade time in percent
(Set up inside the MADRIX Device Manager -
DMX-IN Tab the value for the fade time. This
time
complies the value 255 or 100%)
5 255 Auto Fade
6 255 Skip A
7 255 Skip B
8 0 - 255 Fade Value (Position of the Crossfader)
0 = left (A)
255 = right (B)
9 0-63 (0 - 24%) XF - Cross-fade
64 - 127 (25 - 49%) WF - White-fade
128 - 191 (50 - 74%) BF - Black-fade
192 - 255 (75 - 100%) CF - Color-fade
10 0 - 255 Red (color for Color-fade)
11 0 - 255 Green (color for Color-fade)
12 0 - 255 Blue (color for Color-fade)
13 0 - 255 White (color for Color-fade)
14 0 - 255 Master Fader
15 0 - 255 Audio Input
16 255 Audio Start/Stop Toggle
17 0 - 255 Speed Master A, factor -10 till +10
18 0 - 255 Speed Master B, factor -10 till +10
19 0/ 255 Pause Storage A (0O=play,255=pause)
20 0/ 255 Pause Storage B (0O=play,255=pause)
21 0/ 255 Freeze Output (O=unfreeze/255=freeze)
22 255 Cue List GO
23 255 Cue List BACK
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24 0 - 255 Cue List GOTO 1 - 256

25 255 Cue List Play/Pause

26 0 - 255 Submaster Storage A

27 0 - 255 Submaster Storage B

28 0 - 255 Select Layer A, 1 - 256 (O=Layerl, 1=Layer2,
2=Layer3 ... 255=Layer256)

29 0 - 255 Select Layer B, 1 - 256 (O=Layerl, 1=Layer2,
2=Layer3 ... 255=Layer256)

30 0 - 255 Submaster selected Layer A

31 0 - 255 Submaster selected Layer B

32 0 - 255 Opacity selected Layer A

33 0 - 255 Opacity selected Layer B

34 0-24 0=NONE function / Mix mode selected Layer A

35 0-24 0=NONE function / Mix mode selected Layer B

Other Protocols

There are other preprogrammed DMX protocols, despite the Universal Protocol:

e DMX-IN (Micro Protocol)

e DMX-IN (Mini Protocol)

e DMX-IN (Small Protocol)

e DMX-IN (Large Protocol)

e DMX-IN (Universal Protocol)

e DMX-IN (Universal Protocol 2)
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8.1.6 DMX-IN (Universal Protocol 2)
Overview
DMX Value Function
Channel
1 0-120 Storages A 1 - 60 with Autofade
121 - 240 Storages B 1 - 60 with Autofade
2 0 - 240 Storage A Place 1-60 (Steps of 4)
without Autofade
3 0 - 240 Storage B Place 1-60 (Steps of 4)
without Autofade
4 0 - 255 (0 - 100%) Set up the Fade time in percent
(Set up inside the MADRIX Device Manager -
DMX-IN Tab the value for the fade time. This
time
complies the value 255 or 100%)
5 255 Auto Fade
6 255 Skip A
7 255 Skip B
8 0 - 255 Fade Value (Position of the Crossfader)
0 = left (A)
255 = right (B)
9 0-63 (0 - 24%) XF - Cross-fade
64 - 127 (25 - 49%) WF - White-fade
128 - 191 (50 - 74%) BF - Black-fade
192 - 255 (75 - 100%) CF - Color-fade
10 0 - 255 Red (color for Color-fade)
11 0 - 255 Green (color for Color-fade)
12 0 - 255 Blue (color for Color-fade)
13 0 - 255 White (color for Color-fade)
14 0 - 255 Master Fader
15 0 - 255 Audio Input
16 255 Audio Start/Stop Toggle
17 0 - 255 Speed Master A, factor -10 till +10
18 0 - 255 Speed Master B, factor -10 till +10
19 0/ 255 Pause Storage A (0O=play,255=pause)
20 0/ 255 Pause Storage B (0O=play,255=pause)
21 0/ 255 Freeze Output (O=unfreeze/255=freeze)
22 255 Cue List GO
23 255 Cue List BACK
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24 0 - 255 Cue List GOTO 1 - 256

25 255 Cue List Play/Pause

26 0 - 255 Submaster Storage A

27 0 - 255 Submaster Storage B

28 0 - 255 Select Layer A, 1 - 256 (O=Layerl, 1=Layer2,
2=Layer3 ... 255=Layer256)

29 0 - 255 Select Layer B, 1 - 256 (O=Layerl, 1=Layer2,
2=Layer3 ... 255=Layer256)

30 0 - 255 Submaster selected Layer A

31 0 - 255 Submaster selected Layer B

32 0 - 255 Opacity selected Layer A

33 0 - 255 Opacity selected Layer B

34 0-24 0=NONE function / Mix mode selected Layer A

35 0-24 0=NONE function / Mix mode selected Layer B

36 0 - 255 Red (color for Color Filter)

37 0 - 255 Green (color for Color Filter)

38 0 - 255 Blue (color for Color Filter)

39 0 - 255 White (color for Color Filter)

40 - Reserved - Please do not use otherwise!
Reserved for future features.

- Reserved - Please do not use otherwise!

Reserved for future features.

140 - Reserved - Please do not use otherwise!
Reserved for future features.

Other Protocols

There are other preprogrammed DMX protocols, despite the Universal Protocol 2:

e DMX-IN (Micro Protocol)

e DMX-IN (Mini Protocol)

DMX-IN (Small Protocol)

e DMX-IN (Large Protocol)

DMX-IN (Universal Protocol)
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e DMX-IN (Universal Protocol 2)
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8.1.7 DMX-IN (User)

Overview

This type of protocol describes configurations users can create themselves. In order to learn how
to assign DMX-IN freely and how to program your own configuration, please read the chapter
DMX-IN & Art-Net Remote.

Other Protocols

There are other preprogrammed DMX protocols you can choose from:
e DMX-IN (Micro Protocol)

e DMX-IN (Mini Protocol)

e DMX-IN (Small Protocol)

e DMX-IN (Large Protocol)

e DMX-IN (Universal Protocol)

e DMX-IN (Universal Protocol 2)

8.2 MIDI-IN

Introduction

can use MIDI devices to play sounds that are used for the sound effects built into MADRIX.

MIDI Time Code will be explained in the next chapter MIDI Time Code (MTC).

MIDI consoles can be used to control MADRIX remotely. Or you
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Important Notes

Before using a MIDI device, please make sure that all necessary drivers are installed and that

your MIDI console is connected to your computer.

Please also make sure to save your MADRIX Setup after the following configuration process.

Configuration - Activating Your MIDI Device

Open the menu "Preferences" -> "Remote Control” -> "MIDI". A new dialog will open, like
shown below.

Or you can go to the menu "Preferences" -> "Device Manager" -> "MIDI".

[ Channel Fitter

= =2

When your MIDI console is connected to your computer, it will appear in the list.

If you cannot see your MIDI device in the list, please press "Scan".
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To activate your MIDI console,

1) select the device in the list and

2) click "Enable" in the upper right hand corner.

452

Please note that the "State" in the list will change from "Off" (red light) to "On" (green light).
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Ao Femote T

Off

Ecitable v Ecit...

W b

Now, several options are available to you:

e Audio - You may activate your MIDI device (a MIDI keyboard, for example) to be used as audio

source: Audio
e Remote - You can use your MIDI V]/D] console to control MADRIX remotely: Remote Control
e MTC - You can use MADRIX to receive external MIDI Time Code: Time Code

e Watch - Activate this switch if you are encountering any problems: MIDI Watcher

You may activate several MIDI devices. And you may use all options (Audio, Remote, MTC, Watch)

at the same time.
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Configuration - Audio

Please make sure that your MIDI device is activated as described above.

Select your MIDI device in the list, and click "Audio".

This activates incoming MIDI signals for sound effects. Now, the "Audio" section becomes

available:

Audio

B Uze For 521 [ Channel Fiter

B U=e For W20

"Use For S2L" and "Use For M2L" activates the audio analysis of MIDI signals for Sound2Light
and Music2Light effects, respectively. They are activated by default.

The section "Channel Filter" allows you to select which MIDI channel will be scanned by MADRIX.
In general, MIDI offers 16 channels. You can configure each MIDI device to send on a particular
channel. Make sure that this channel is also selected in this section here. If you wish to filter a
channel, deselect the according number. As a result, the channel will not be used for MIDI-IN in
combination with MADRIX. By default, all 16 channels are activated and will be scanned by
MADRIX.
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Configuration - Remote Control

Please make sure that your MIDI device is activated as described above.

Select your MIDI device in the list, and click "Remote".

B’ Remote

This activates incoming MIDI signals for remote control. Please always make sure to select the
MIDI device in the list. After that, several options are available to you in the section named

"Remote Control":

Remote Control

B0 Mumark W) . Edit...

Use this button to open an existing MADRIX MIDI Remote Configuration file (*.mmrc)

from your hard disk.
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Ecdiitakile

Ecdiitakile

E] Edt..

Use this list to select the MIDI configuration you wish to
use. The MIDI maps are listed alphabetically according to

the manufacturer.

MADRIX already includes a number of pre-programmed MIDI
maps as shown in the list. You can get an overview over

all existing MIDI maps

If you wish to create a new MIDI map, choose "USER
User". If a MIDI map is labeled "Editable", you can edit

this configuration. More information is given below with

Click "Edit", if you wish to change a MIDI map. More information is given below

with

Overview

You can find these preprogrammed MIDI maps in the following chapters.
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Livid Instruments Ohm64
M-AUDIO Oxygen 8 v2
M-AUDIO Torg Xponent
MIDI Keyboards

MIDI Universal
Novation Launchpad
Numark NuVJ

Numark Omni Control
Numark Stealth Control
Numark Total Control
Omnitronic MMC-1
Stanton SCS.3d

USER User

Vestax VCI-100
Vestax VCM-100
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How To Assign MIDI Freely - MIDI Remote Editor

Overview

Once you clicked "Edit", a new window with the MIDI Remote Editor will open. If

you are creating a new MIDI configuration, this window will be empty.

Buttan
Buttan
Button
Button
Button
Bui

Buttan
Buttan
Button
Button
Button

Button
Button
Button

Buttan
Buttan
Button
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Add a new entry or remove an entry with "+" or "-". Scroll and navigate through the

list of entries with the help of the two arrow keys.

Duplicate/copy an entry with the help of this button. Select one entry or several

entries in the list, press the button and the selected entries will be duplicated. The entries will be

added to the list right after each selected entry. You can change the settings afterwards.

You may create a completely new MIDI map, open
an existing MADRIX MIDI Remote Configuration file (*.mmrc) from your hard disk, or save your

MIDI remote configuration.

Use this button to automatically assign a control of your MIDI console to a function
in MADRIX. Activate "Assign", select an entry you created and move the control of your MIDI
console. In most cases, MADRIX will automatically recognize the MIDI Command, Control Type, and

Interaction as described below.

After assigning a function to a control of your MIDI console, you can press "Test"
and move the control on your MIDI console. You can see if the control works as expected on the
MADRIX GUI, when "Test" is activated. If "Test" is activated, MADRIX will receive the signal
directly and not the MIDI Remote Editor.

"Test" is also useful for testing modifiers. Read more on this topic: Modifiers.
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Config Bamesy -]

When editing or creating a MIDI map, make

sure to type in an individual name for your MIDI remote configuration in the field labeled "Config
Name". It will be created as "USER 'Config Name" in the list of the Device Manager - MIDI tab. If

you wish to edit a "fixed config", MADRIX will not overwrite the existing configuration. It will create

a new USER configuration when saving it.

Keyboard Shortcuts

Ctrl + A

Select all entries in the list.

Ctrl + E (hold)

Activates "Assign", while holding this shortcut.

Ctrl + N Create a new MIDI map.
Ctrl + O Open a MIDI map.
Ctrl + S Save a MIDI map.

Ctrl + T (hold)

Activates "Test", while holding this shortcut.

Entf

Delete selected entries in the list.

Arrow Up

Navigate upwards in the list.

Arrow Down

Navigate downwards in the list.

Double-click on an entry

Calls up the context menu for the column.

Double-click on a head row of the list

Sorts the list alphabetically according to the column
(ascending or descending).
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Configuration Of The MIDI Remote Editor
Function:

Select an entry and perform a double-click with your mouse on the column "Function" or create a
new entry with "+". First, select the general topic ("Storage A", for example). Second, select the

exact function you wish to configure ("Place", for example) and click with your mouse.

s e ———

T T e e e e T e
TACrCommant arteor Type Irterschor Irvert o e Fartor

i

Frameld Up

AlRRRRER

MIDI Command:

Option A) Use the button "Assign", select an entry and move the control of your MIDI console. In
most cases, MADRIX will automatically recognize the MIDI Command, Control Type, and

Interaction.

Option B) Select an entry and perform a double-click with your mouse on the column "MIDI
Command". First, select the MIDI channel ("Channel 01", for example). Second, select the MIDI
type ("Note", for example). Third, select the value ("053", for example) and click with your mouse.
In general, MIDI offers 16 channels. You can configure each MIDI device to send on a particular

channel. Make sure that this channel is also selected in this section here.
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Channel 08
Channel 09
Channel 10
Channel 11
Channel 12
Channel 13

walue

L
| —
L
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Control Type:

Option A) Use the button "Assign”, select an entry and move the control of your MIDI console. In
most cases, MADRIX will automatically recognize the MIDI Command, Control Type, and

Interaction.

Option B) Select an entry and perform a double-click with your mouse on the column "Control

Type". Select the type of the control of your MIDI console ("Button"”, for example).
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State
gl

IRERENRR

Interaction:

Option A) Use the button "Assign”, select an entry and move the control of your MIDI console. In
most cases, MADRIX will automatically recognize the MIDI Command, Control Type, and

Interaction.

Option B) Select an entry and perform a double-click with your mouse on the column

"Interaction". Select the mode ("Toggle", for example).
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i

IRERENRR

Invert:

Select an entry and perform a double-click with your mouse on the column "Invert". The entry will
change between "No" and "Yes". If "Yes" is selected, all values of this control will be inverted.

That means for example that 0 becomes 255 and 255 becomes 0.
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CEEEEEECE

Condition (Cond.):

Select an entry and perform a double-click with your mouse on the column "Cond.". Select the
condition ("None", for example). If you select a "State", click "Yes" or "No". If you select a "Value",

select and click the according number for it. Read more on this topic:
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State
gl
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Min, Max, Factor, Description:

Select an entry and perform a double-click with your mouse on the column "Min", "Max", "Factor",
or "Description". Enter the desired value or text.

"Min" requires a minimum value for this control. The default value is 0.

"Max" requires a maximum value for this control. For example, the Master Fader has a maximum
value of 255, or you may want to set the maximum Fade Time to 10 seconds.

"Factor" requires a certain value between -127 and +127. 0 is the default value. Use this factor to
slow down (-127 to -1) or speed up (+1 to +127) controls of your MIDI console. For example, a
jog wheel might be to fast to select mix modes of MADRIX. Slow it down by entering a negative
value.

"Description" requires a text (By default, the name of the function will automatically be entered).
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Invert
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State
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Modifiers:

The MIDI Remote Editor allows you to create advanced MIDI configurations. Modifiers allow to set
certain conditions.
In general, these are the steps to follow:

1) Select an entry and perform a double-click with your mouse on the column "Function". Or you
can create a new entry with "+".

First, select "Modifier". Second, select a "State" or "Value" and click with your mouse.
2) Afterwards create a function.

3) Assign the condition to this function ( ).

"State" creates a requirement/condition that is required before the function will work. Here is an

example for a state:
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We have set up a fader on the console that controls the Master Fader of MADRIX. Because of the

condition the Master Fader can only be used, when the button is pressed at the same time:

e Example

If no condition is assigned, the fader can be moved and the Master Fader of MADRIX will always

respond accordingly:

"Value" allows to add several functions to one or more controls of the MIDI console. Here is an

example for a value:

Let's say your MIDI console has only one fader. But you would want to control the Master Fader,
the Speed Master A, and the Speed Master B with this one fader. In this example we have
configured 3 buttons that activate three different configurations for the fader. If button 1 is
pressed one time, the fader will act as the Master Fader. If button 2 is pressed one time, the
fader will act as Speed Master A. If button 3 is pressed one time, the fader will act as Speed

Master B.
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Please note: Always assign the correct values to modifier and function. For example if your
modifier is assigned to Value 1 and Max value 2, the function needs to have Value 1=002. In this

case, Value 2=002 will not work!

You can use the button "Test". Activate the button (green color) and press a control of your
MIDI console (a button, for example). The MIDI Remote Editor will show at the left side of the

window which modifier is assigned to this control.
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Here is an example: The first button has State 5 assigned. In the left column "05" is shown. The

second button has Value 1 with Max 7 assigned to it. In the left column "7" is shown.

walue
—_
L
—
| B
—
—_
1
—

Configuration - Time Code

B T

Please see the chapter for more information on how to

configure and use MIDI Time Code.
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Configuration - Watch (MIDI Watcher)

B Wistch

If you activated the switch "Watch, click "MIDI Watcher..." afterwards. A new
window will open. Then, check the MIDI Watcher for errors. You can learn more about the MIDI

Watcher in the chapter Tools.
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[26] Mode 1:

[45] Cue — Add Storage Place A to Cue List

[46] Cue List Open

[47] Cue List Close

[48] Cue — Add Storage Place B to Cue List

[1] - [16] Storage Place A1 - A16 / B1 -
B16

[30] Audio level

[41] Speed Master A PAUSE

[17] Storage Place A/B DOWN

[31] Master Fader

[42] Blackout

[18] Storage Place A/B UP

[32] Color Filter color RED

[43] Freeze Main Output

[19] A Layer A/B DOWN

[33] Color Filter color GREEN

[44] Speed Master B PAUSE

[20] Layer A/B UP

[34] Color Filter color BLUE

[49] Cue List BACK

[21] + [27] Submaster Storage A/B

[35] Color Filter color WHITE

[50] Cue List Play/Pause
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[22] + [27] Frame ID A/B

[36] Fade type UP

[51] Cue List GO

[23] + [27] Layer Submaster A/B

[37] Color-fade color RED

[52] Crossfader

[24] + [27] Layer Opacity A/B

[38] Color-fade color GREEN

[25] Audio ON/OFF

[39] Color-fade color BLUE

[28] Speed Master Storage A

[40] Color-fade color WHITE

[29] Speed Master Storage B

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.2 Behringer BCD3000 & BCD2000
Also known as BCD 3000 / BCD-3000 or BCD 2000 / BCD-2000.
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[29]
[1] No MIDI function [13] FREE [25] Layer Mix Mode UP
[2] FREE [14] FREE [26] Layer Mix Mode DOWN

[3] No MIDI function

[15] No MIDI function

[27] Crossfader Skip A / Skip B

[4] Cue List open / close

[16] FREE

[28] Master Fader or Audio Level

[5] Color RED for Color Filter or Color-fade
(see [11] & [12])

[17] Autofade

[29] Audio or Cue List Play/ Stop

[6] Color GREEN for Color Filter or Color-
fade
(see [11] & [12])

[18] No MIDI function

[30] Add Storage Place to Cue List

[7] Color BLUE for Color Filter or Color-
fade
(see [11] & [12])

[19] POWER LED / NO MIDI function

[31] Layer UP / DOWN
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[8] Color WHITE for Color Filter or Color-
fade
(see [11] & [12])

[20] Crossfader

[32] Storage speed (Speed Master)

[9] Fade type DOWN

[21] Fade time

[33] Storage Place UP/ DOWN

[10] Fade type UP

[22] FREE

[34] + [35] Submaster Storage

[11] Switch to Color Filter mode (Default
mode)

[23] GO / Back Cue List

[34] + [35] Submaster Layer

[12] Switch to Color-fade mode

[24] Play / Stop Cue List

[34] + [35] Opacity Layer

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.3 Behringer BCF2000

Also known as BCF 2000 or BCF-2000.
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[1] Color RED for Color Filter or Color-fade (see [9])

[24] Pause Storage speed B

[2] Color GREEN for Color Filter or Color-fade (see [9])

[29] Crossfader position

[3] Color BLUE for Color Filter or Color-fade (see [9])

[30] Storage Place A UP/ DOWN

[4] Color WHITE for Color Filter or Color-fade (see [9])

[31] Storage speed A (Speed Master)

[8] Fade time

[32] Master Fader

[9] Switch between Color Filter mode (default) and Color-fade
mode

[33] Audio level

[11] Reset Storage speed A

[34] Storage speed B (Speed Master)

[14] Reset Storage speed B

[35] Storage Place B UP/ DOWN
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[21] Pause Storage speed A

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.4 Behringer BCR2000

Also known as BCR 2000 or BCR-2000.

B-COUTROL
»ROTARY

BCAX000

478

[1] Color RED for Color Filter or Color-fade (see [9])

[24] Pause Storage speed B

[2] Color GREEN for Color Filter or Color-fade (see [9])

[29] Crossfader position

[3] Color BLUE for Color Filter or Color-fade (see [9])

[30] Storage Place A UP/ DOWN

[4] Color WHITE for Color Filter or Color-fade (see [9])

[31] Storage speed A (Speed Master)

[8] Fade time

[32] Master Fader

[9] Switch between Color Filter mode (default) and Color-fade
mode

[33] Audio level

[11] Reset Storage speed A

[34] Storage speed B (Speed Master)

[14] Reset Storage speed B

[35] Storage Place B UP/ DOWN
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[21] Pause Storage speed A

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.5 Creative Prodikeys PC-MIDI

32 34 36 37

480

[1] Cue List Back (MIDI note #53)

[8...17] Storage Place A 1...10

[2] Cue List Play/Stop

[18] + [8...17] Storage Place A 11...20

[3] Cue List GO

[19] + [8...17] Storage Place A 21...30

[18]+ [19] + [8...17] Storage Place A 31...40

[4] Storage Place ADOWN

[5] Storage Place A UP

[20...29] Storage Place B 1...10

[6] Storage Place B DOWN

[30] + [20...29] Storage Place B 11...20

[7] Storage Place B UP

[31] + [20...29] Storage Place B 21...30

[30] + [31] + [20...29] Storage Place B 31...40

[32] Skip A

[33] Autofade

[35] Fade type DOWN

[34] Skip B

[36] Fade type UP

[37] Cue List Back ... see [1] (MIDI note #89)

[38] Audio ON/OFF (Sustain on MIDI-Keyboards)

You can get an overview over all preprogrammed MIDI maps in the chapter MIDI-IN.
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8.2.6
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[3] Cue — Add Storage Place A to Cue List

[48] Cue List GO

[8] Cue — Add Storage Place B to Cue List

[49] Cue List BACK

[11] Layer ADOWN

[52] Speed Master B PAUSE

[12] Layer A UP

[56] Cue List Dialog Open/Close

[13] Color-fade color RED (ON/OFF)

[57] Cue List PLAY/PAUSE

[14] Color-fade color GREEN (ON/OFF)

[62] Storage Place A Cursor UP

[15] Color-fade color BLUE (ON/OFF)

[67] Storage Place B Cursor UP

[16] Color-fade color WHITE (ON/OFF)

[69] Storage Place A Cursor LEFT

[17] Layer B DOWN

[70] Storage Place A Cursor DOWN

[18] Layer B UP

[71] Storage Place A Cursor RIGHT

[19] Layer A Solo mode

[74] Storage Place B Cursor LEFT

[20] Layer A Mix mode UP

[75] Storage Place A Cursor DOWN

[25] Layer B Mix mode UP

[76] Storage Place A Cursor RIGHT

[26] Layer B Solo mode

[77] Speed Master A UP/DOWN

[27] Layer A Blind mode

[77 Push] Reset Speed Master A

[28] Layer A Mix mode DOWN

[78] Crossfader

[33] Layer B Mix mode DOWN

[78] + [89] Fade Time UP/DOWN

[34] Layer B Blind mode

[78] + [91] Audio Level UP/DOWN

[35] Blackout

[78 Push] Autofade
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[36] Layer A Opacity

[79] Speed Master B UP/DOWN

[37] Layer A Submaster

[79 Push] Reset Speed Master B

[38] Color Filter color RED

[80] Speed Master A PAUSE (Hold)

[39] Color Filter color GREEN

[82] Skip to A

[40] Color Filter color BLUE

[83] Skipto B

[41] Color Filter color WHITE

[85] Speed Master B PAUSE (Hold)

[42] Layer B Submaster

[86] Freeze Main Output (Hold)

[43] Layer B Opacity

[87] Freeze Main Output (Permanently)

[44] Master Fader

[88] Fade Type DOWN

[45] Speed Master A PAUSE

[90] Audio ON/OFF

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.7

Hercules DJ Console Rmx

[1] Cue List Open / Close

[21 hold + 51] Storage Submaster B

[41] Storage Place ADOWN

[2] Switch to Color Filter mode (default
mode)

[22] FREE

[42] Storage Place A UP

[3] Storage Place A UP/ DOWN

[23] Reset Speed Master B to default
value

[43] Back in Cue List

[4] Mix mode Storage A UP

[24 + HOLD] Pause Speed Master B

[44] Skip Crossfader to A

[5] Color RED for Color Filter or Color-fade
(see [2] & [10])

[25] Speed Master A/B

[45] Fade type DOWN

[6] Fade time

[26 hold + 51] Layer Submaster A

[46] Skip Crossfader to B

[7] Color WHITE for Color Filter or Color-
fade (see [2] & [10])

[27] FREE

[47] GO in Cue List

[8] Mix mode Storage B UP

[28] Fade type UP

[48] Storage Place B DOWN

[9] Storage Place B UP/ DOWN

[29 hold + 51] Layer Submaster B

[49] Storage Place B UP

[10] Switch to Color-fade mode

[30] FREE

[50 hold + 51] Fast Forward / Rewind A/B

[11] FREE

[31 hold + 51] Opacity Layer A

[51] See [14] [21] [26] [29] [31] [39]

[12] Reset Speed Master A to default
value

[32] FREE

[52] FREE
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[13 + HOLD] Pause Speed Master A

[33] FREE

[53] Master Fader

[14 hold + 51] Storage Submaster A

[34] Color BLUE for Color Filter or Color-
fade (see [2] & [10])

[54] Audio level

[15] FREE

[35] Fade type DOWN

[55] Add Storage Place A to Cue List

[16] Mix mode Storage A DOWN

[36] Fade type UP

[56] Cue List Stop

[17] Color GREEN for Color Filter or Color- | [37] FREE [57] Cue List Play/Stop
fade (see [2] & [10])
[18] Autofade [38] FREE [58] Add Storage Place B to Cue List

[19] FREE

[39 hold + 51] Opacity Layer B

[59] Stop Audio Capture

[20] Mix mode Storage B DOWN

[40] FREE

[60] Start/Stop Audio Capture

[61] Crossfader

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.8 Hercules DJ Control MP3 & DJ Console MK2
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[1] + [40] Submaster Storage A

[16] Audio Play / Stop

[31] Autofade

[2] + [40] Submaster Layer A

[17] Add Storage Place B to Cue List

[32] Color-fade color WHITE

[3] + [40] Opacity Layer A

[18] Layer ADOWN

[33] Audio level

[4] + [41] Submaster Storage B

[19] Layer A UP

[34] Fade time

[5] + [41] Submaster Layer B

[20] Layer B DOWN

[35] Storage Place A UP/ DOWN

[6] + [41] Opacity Layer B

[21] Layer B UP

[36] Color-fade color BLUE

[7] Fade type DOWN

[22] Mix mode Layer ADOWN

[37] Color-fade color GREEN

[8] Fade type UP

[23] Mix mode Layer A UP

[38] Color-fade color RED

[9] Back in Cue List

[24] Mix mode Layer B DOWN

[39] Storage Place B UP/ DOWN

[10] GO in Cue List

[25] Mix mode Layer B UP

[40] See [1], [2], [3]

[11] + [40] Fast Forward / Rewind A

[26] Left Mouse button

[41] See [4], [5], [6]

[12] + [41] Fast Forward / Rewind B

[27] Right Mouse button

[42] Mouse control

[13] Crossfader

[28] Speed Master A

[14] Cue List Play / Stop

[29] Speed Master B
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[15] Add Storage Place A to Cue List

[30 + 40] Master Fader

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.9

Hercules DJ Control MP3 e2

[1] Freeze main output (hold)

Storage mode

Layer mode

[30] Switch to Layer or Storage
mode A

[2] Freeze main output
permanently

[20] Pause A

[20] Select Layer mix mode - A

[31] Switch to Layer or Storage
mode B

[3] Cue List Back

[21] Pause B

[21] Select Layer mix mode - B

[4] Cue List Open/Close

[22] Speed Master A

[22] Layer Opacity - A

[46 ] Add Storage Place A to
Cue List

[5] Cue List Play/Stop

[23] Speed Master B

[23] Layer Opacity - B

[47 ] Add Storage Place B to
Cue List

[6] GO in Cue List

[24] Storage Submaster A
(decrease)

[24] Layer Submaster - A
(decrease)

[48 + 44] Fast Forward /
Rewind A
(Storage mode)

[7] Color-fade color RED

[25] Storage Submaster B
(decrease)

[25] Layer Submaster - B
(decrease)

[49 + 45] Fast Forward /
Rewind B
(Storage mode)

[8] Color-fade color GREEN

[26] Storage Submaster A
(increase)

[26] Layer Submaster - A
(increase)

[48 + 44] Layer Fast Forward /
Rewind A (Layer mode)
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[9] Color-fade color BLUE

[27] Storage Submaster B
(increase)

[27] Layer Submaster - B
(increase)

[49 + 45] Layer Fast Forward /
Rewind B (Layer mode)

[10] Color-fade color WHITE

[28] Reset Submaster A

[28] Reset Layer Submaster,
Mix Mode, and Opacity - A

[11] FREE

[29] Reset Submaster B

[29] Reset Layer Submaster,
Mix Mode, and Opacity - B

[12] Fade time

[32] Storage Place Al

[32] Layer1- A

[13] Blackout function

[33] Storage Place B1

[33] Layer1-B

[14] Autofade

[34] Storage Place A2

[34] Layer2 - A

[15] Fade type

[35] Storage Place B2

[35] Layer2-B

[16] Audio analysis On/Off

[36] Storage Place A3

[36] Layer3 - A

[17] Master Fader

[37] Storage Place B3

[37] Layer3-B

[18] Audio input level

[38] Storage Place A4

[38] Layer4 - A

[19] Crossfader

[39] Storage Place B4

[39] Layer4-B

[40] Storage Place ADOWN

[40] Layer ADOWN

[41] Storage Place B DOWN

[41] Layer B DOWN

[42] Storage Place A UP

[42] Layer A UP

[43] Storage Place B UP

[43] Layer B UP

You can get an overview over all preprogrammed

MIDI maps in the chapter
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Please always select Scene "1".

490

[1] Color-fade color RED

[10] Skip A/B

[18] Storage Place A/B

[2] Color-fade color GREEN

[11] Cue A/B

[19] Submaster Storage A/B

[3] Color-fade color BLUE

[12] Speed Master Reset A/B

[20] Speed Master Storage A/B

[4] Color-fade color WHITE

[13] Speed Master Pause A/B

[21] Master Fader

[5] Fade Time

[14] Fade Type DOWN

[22] Crossfader

[6] Color Filter color RED

[15] Autofade

[23] Audio Level

[7] Color Filter color GREEN

[16] Blackout

[24] Cue List BACK

[8] Color Filter color BLUE

[17] Audio ON/OFF

[25] Cue List PLAY

[9] Color Filter color WHITE

[26] Cue List GO

[27] Cue List Stop

[28] Cue List Open/Close

You can get an overview over all preprogrammed MIDI maps in the chapter MIDI-IN.
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8.2.11 Livid Instruments Ohm64
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[92] Storage A Mode

[94] Storage B Mode

[1] - [60] Storage Place Al — A60

[1] - [60] Storage Place B1 — B60

[95] Skip Layer UP in Effect A

[95] Skip Layer UP in Effect B

[96] Speed Master A PAUSE permanently

[96] Speed Master B PAUSE permanently

[97] Storage Place A DOWN

[97] Storage Place B DOWN

[98] Storage Place A UP

[98] Storage Place B UP

[61] Fade Type UP/DOWN

[73] Freeze Main Output On/Off [84] Opacity Layer 1 (A/B)

[62] Fade Time

[74] Autofade [85] Opacity Layer 2 (A/B)

[63] Master Fader

[75] Cue List Go [86] Opacity Layer 3 (A/B)

[64] Audio Level

[76] Cue List Back [87] Opacity Layer 4 (A/B)

[65] Color-fade color RED

[77] Cue List Open/Close

[88] Blind Mode Layer 1 (A/B)

[66] Color-fade color GREEN

[78] Cue List Play/Stop

[89] Blind Mode Layer 2 (A/B)

[67] Color-fade color BLUE

[79] Blackout

[90] Blind Mode Layer 3 (A/B)

[68] Color-fade color WHITE

[80] Submaster Storage A

[91] Blind Mode Layer 4 (A/B)

[69] Color Filter color RED

[81] Speed Master Storage A

[93] Crossfader

[70] Color Filter color GREEN

[82] Speed Master Storage B

[71] Color Filter color BLUE

[83] Submaster Storage B

© 2011 inoage GmbH




INPUT & Remote Control

492

[72] Color Filter color WHITE

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.12 M-AUDIO Oxygen 8 v2

VRO @

£

Please pay attention that you activate Preset 1 (General MIDI) and c 01 with button [6].

[1] UP: Autofade enabled (default),
DOWN: disabled

[23] Storage Place A1l (If Octave -4)

[35] Storage Place B1 (If Octave -4)

[2] Master Fader

[24] Storage Place A2 (If Octave -4)

[36] Storage Place B2 (If Octave -4)

[3] Switch Storage Place Area (Octaves)

[25] Storage Place A3 (If Octave -4)

[37] Storage Place B3 (If Octave -4)

[4] No MIDI function

[26] Storage Place A4 (If Octave -4)

[38] Storage Place B4 (If Octave -4)

[5] No MIDI function

[27] Storage Place A5 (If Octave -4)

[39] Storage Place B5 (If Octave -4)

[6] No MIDI function

[28] Storage Place A6 (If Octave -4)

[40] Storage Place B6 (If Octave -4)

[7] FREE

[29] Storage Place A7 (If Octave -4)

[41] Storage Place B7 (If Octave -4)

[8] FREE

[30] Storage Place A8 (If Octave -4)

[42] Storage Place B8 (If Octave -4)

[9] CF Color-fade color RED

[31] Storage Place A9 (If Octave -4)

[43] Storage Place B9 (If Octave -4)

[10] CF Color-fade color GREEN

[32] Storage Place A10 (If Octave -4)

[44] Storage Place B10 (If Octave -4)

[11] CF Color-fade color BLUE

[33] Storage Place A11 (If Octave -4)

[45] Storage Place B11 (If Octave -4)

[12] Audio level fader

[34] Storage Place A12 (If Octave -4)

[46] Storage Place B12 (If Octave -4)

[13] Crossfader

[14] Speed Master A

[23] Storage Place A13 (If Octave -2)

[35] Storage Place B13 (If Octave -2)

[15] Speed Master B

[16] Fade time

[34] Storage Place A24 (If Octave -2)

[46] Storage Place B24 (If Octave -2)
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[17] Freeze Output

[18] Cue List Back

... Select the Octave with [3]

... Select the Octave with [3]

[19] Cue List GO

[20] Cue List Stop

[47] Autofade (If Octave 5)

[21] Fade type toggle

[22] Skip A / Skip B

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.13 M-AUDIO Torq Xponent
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[3] Skip A

[27] Autofade

[61] Play/Stop Cue List

[4] Skip B

[28] Autofade

[62] Add Storage Place A to Cue List

[5] Color-fade color WHITE

[29] Freeze Output

[63] Storage Place ADOWN

[6] Color-fade color BLUE

[30] Audio ON/OFF

[64] Storage Place A UP

[7] Color-fade color GREEN

[31] See [33], [34], [35], [36]

[65] Play/Stop Cue List

[8] Color-fade color RED

[32] See [37], [37], [39], [40]

[66] Add Storage Place B to Cue List

[9] Color Filter color WHITE

[33] + [31] Storage Submaster A

[67] Storage Place B DOWN

[10] Color Filter color BLUE

[34] + [31] Layer Opacity A

[68] Storage Place B UP

[11] Color Filter color GREEN

[35] + [31] Layer Mix mode A

[69] Speed Master A

[12] Color Filter color RED

[36] + [31] Layer Submaster A

[70] Speed Master B

[13] Fade time

[37] + [32] Storage Submaster B

[71] Cue List GO

[19] Fade type Color-fade

[38] + [32] Layer Opacity B

[72] Cue List Back

[20] Fade type Black-fade

[39] + [32] Layer Mix mode B

[73] Cue List Open/Close

[21] Fade type White-fade

[40] + [32] Layer Submaster B

[74] Cue List Go

[22] Fade type Cross-fade

[41] Layer A DOWN

[75] Cue List Back

[23] Switch USB or MIDI

[42] Layer AUP

[76] Cue List Open/Close

[24] Master Fader

[43] Layer B DOWN

[25] Audio level

[44] Layer B UP
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[26] Crossfader

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.14 MIDIKeyboards

MIDI Note Value MIDI Note Value

#48 skip A #84 skip A

#49 Autofade #85 Autofade

#50 Skip B #86 Skip B

#51 Fade type DOWN #87 Fade type DOWN

#52 Fade type UP #88 Fade type UP

#53 Cue List Back #89 Cue List Back

#54 Cue List Play/Stop #90 Cue List Play/Stop

#55 Cue List GO #91 Cue List GO

#56 Storage Place ADOWN #92 Storage Place ADOWN

#57 Storage Place A UP #93 Storage Place A UP

#58 Storage Place B DOWN #94 Storage Place B DOWN

#59 Storage Place B UP #95 Storage Place B UP

#60...#69 Storage Place A 1...10

#60...#69 + #70 Storage Place A 11...20

#60...#69 + #71 Storage Place A 21...30

#60...#69 + #70 + #71 Storage Place A 31...40

#72...#81 Storage Place B 1...10

#72...4#81 + #82 Storage Place B 11...20

#72...4#81 + #83 Storage Place B 21...30

#72...4#81 + #82 + #83 Storage Place B 31...40 Control Change 0x40 Audio ON/OFF
(0xB0 0x40 0x00)
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Octave # Note Numbers

C CH D D# E F F# G G# A A# B
-1 0 1 2 3 4 5 6 7 8 9 10 11
0 12 13 14 15 16 17 18 19 20 21 22 23
1 24 25 26 27 28 29 30 31 32 33 34 35
2 36 37 38 39 40 41 42 43 a4 45 46 47
3 48 49 50 51 52 53 54 55 56 57 58 59
4 60 61 62 63 64 65 66 67 68 69 70 71
5 72 73 74 75 76 77 78 79 80 81 82 83
6 84 85 86 87 88 89 90 91 92 93 94 95
7 96 97 98 99 100 101 102 103 104 105 106 107
8 108 109 110 111 112 113 114 115 116 117 118 119
9 120 121 122 123 124 125 126 127

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.15 MIDI Universal

These entries are reserved for future features.

Please note: Do not use MIDI channels/controllers that are currently not assigned.

MIDI Message Type 0xb0 (Controller 0xb, Channel 1)

Controller Value

#00 Storage Place A

#01 Storage Place B

#02 Storage Place A and Autofade

#03 Storage Place B and Autofade

#04 Storage Place A UP

#05 Storage Place ADOWN

#06 Storage Place B UP

#07 Storage Place B DOWN

#08 Storage Place A UP and Autofade
#09 Storage Place A DOWN and Autofade
#OA Storage Place B UP and Autofade
#0B Storage Place B DOWN and Autofade
#10 Submaster Storage Place A

#11 Submaster Storage Place B

#12 Submaster Storage Place A UP
#13 Submaster Storage Place ADOWN
#14 Submaster Storage Place B UP
#15 Submaster Storage Place B DOWN
#20 Storage Speed A

#21 Storage Speed A UP

#22 Storage Speed A DOWN

#23 Storage Speed A RESET

#24 Storage Speed A PAUSE

#25 Storage Speed A PAUSE HOLD

#26 Storage Speed A PLAY

#28 Storage Speed B

#29 Storage Speed B UP

© 2011 inoage GmbH



INPUT & Remote Control

500

Controller Value

#2A Storage Speed B Down
#2B Storage Speed B RESET
#2C Storage Speed B PAUSE
#2D Storage Speed B PAUSE HOLD
#2E Storage Speed B PLAY

#30 Storage A FRAME ID UP
#31 Storage A FRAME ID DOWN
#32 Storage B FRAME ID UP
#33 Storage B FRAME ID DOWN
#3A Output FREEZE

#3B Output UNFREEZE

#3C Output FREEZE HOLD

#40 Layer A

#41 Layer B

#42 Layer A UP

#43 Layer ADOWN

#44 Layer B UP

#45 Layer B DOWN

#50 Layer Opacity A

#51 Layer Opacity B

#52 Layer Opacity A UP

#53 Layer Opacity ADOWN
#54 Layer Opacity B UP

#55 Layer Opacity B DOWN
#60 Layer Submaster A

#61 Layer Submaster B

#62 Layer Submaster A UP
#63 Layer Submaster A DOWN
#o64 Layer Submaster B UP
#65 Layer Submaster B DOWN
#70 Layer Mixmode A

#71 Layer Mix mode B

#72 Layer Mix mode A UP

#73 Layer Mix mode A DOWN
#74 Layer Mix mode B UP

#75 Layer Mix mode B DOWN
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MIDI Message Type O0xb1l (Controller Oxb, Channel 2)

Controller Value

#00 Layer A FRAME ID UP
#01 Layer A FRAME ID DOWN
#02 Layer B FRAME ID UP
#03 Layer B FRAME ID DOWN
#10 Fade time

#12 Autofade

#13 Fade Value

#14 Fade Value Step A

#15 Fade Value Step B

#16 Fade Value Skip A

#17 Fade Value Skip B

#1A Master Fader

#1B Master Fader UP

#1C Master Fader Down

#20 Fadetype UP

#21 Fadetype DOWN

#22 Fadetype Crossfade

#23 Fadetype Whitefade

#24 Fadetype Blackfade

#25 Fadetype Color-fade

#40 Fadecolor RED

#41 Fadecolor RED UP

#42 Fadecolor RED DOWN
#43 Fadecolor GREEN

#Ha4 Fadecolor GREEN UP

#45 Fadecolor GREEN DOWN
#46 Fadecolor BLUE

#47 Fadecolor BLUE UP

#48 Fadecolor BLUE DOWN
#49 Fadecolor WHITE

HAA Fadecolor WHITE UP

#48B Fadecolor WHITE DOWN
#50 Add Storage Place A to Cue List
#51 Add Storage Place B to Cue List
#52 Delete Cue List entry VALUE
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#53 Delete CURRENT Cue List entry
#54 Cue List Start (Play)

#55 Cue List Stop

#56 Cue List Start (Play)/Stop
#57 Cue List GO

#58 Cue List BACK

#59 Cue List NEXT

#5A Cue List GOTO

#5C Cue List Dialog Show

#5D Cue List Dialog Hide

#5E Cue List Dialog Show / Cue List Dialog Hide
#60 Audio Start

#61 Audio Stop

#62 Audio Start / Audio Stop
#63 Audio Mute

#oe4 Audio UnMute

#65 Audio Mute / Audio UnMute
#66 Audio Volume

#67 Audio Volume UP

#68 Audio Volume DOWN

#70 Color Filter RED

#71 Color Filter RED UP

#72 Color Filter RED DOWN
#73 Color Filter GREEN

#74 Color Filter GREEN UP
#75 Color Filter GREEN DOWN
#76 Color Filter BLUE

#77 Color Filter BLUE UP

#78 Color Filter BLUE DOWN
#79 Color Filter WHITE

H7A Color Filter WHITE UP
#7B Color Filter WHITE DOWN

MIDI Message Type 0x80 (Note OFF)

#0 | Storage Place Al with Autofade

#60

Storage Place B1 with Autofade
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#59 | Storage Place A60 with Autofade #11 | Storage Place B60 with Autofade
9
#124 | Storage Place A with Autofade DOWN #12 | Storage Place B with Autofade DOWN
6
#125 | Storage Place A with Autofade UP #12 | Storage Place B with Autofade UP
7
MIDI Message Type 0x90 (Note ON)
#60 | Storage Place B1 without Autofade
#59 | Storage Place A60 without Autofade #119 | Storage Place B60 without Autofade
#124 | Storage Place A DOWN without Autofade #126 | Storage Place B DOWN without Autofade
#125 | Storage Place A UP without Autofade #127 | Storage Place B UP without Autofade

You can get an overview over all preprogrammed MIDI maps in the chapter MIDI-IN.
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[70] Storage Mode A

[71] Storage Mode B

[1] - [60] Storage Place 1 - 60 (A/B)

[72] Autofade

[61] Layer UP (A/B)

[73] Cue List GO

[62] Layer Mix mode UP (A/B)

[74] Cue List BACK

[63] Layer Blind mode (A/B)

[75] Cue List PLAY/STOP

[64] Layer Solo mode (A/B)

[76] Cue List Open/Close

[65] Fade Time UP

[77] Audio Level UP

[66] Fade Time DOWN

[78] Audio Level DOWN

[67] Skip A

[79] Speed Master UP (A/B)

© 2011 inoage GmbH




505 MADRIX Help and Manual

[68] Skip B

[80] Speed Master DOWN (A/B)

[69] Fade Type DOWN

You can get an overview over all preprogrammed MIDI maps in the chapter
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[9] Switch to Layer mode / Storage mode

LAYER MODE

STORAGE MODE

[1] Direct access for Layer1-9

[1] Direct access for Storage Place 1-9

[2] + [4] Skip Layer UP/DOWN

[2 + 4 hold] Fast forward / fast rewind

[4] Pause ON/OFF

[6] Mix mode Layer UP/DOWN

[6] Storage Place UP/ DOWN

[6] + [Pressed] Set Mix mode Layer to normal

[6] + [Pressed] Add Storage Place to Cue List

[7] Submaster Layer

[7] Submaster Storage Place

[8] Opacity Layer

[8] Storage speed (Speed Master)

[10] Reset Submaster Layer

[10] Reset Submaster of Storage Place

[11] Reset Opacity Layer

[11] Reset Storage speed (Speed Master)

GLOBAL
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[3] Master Fader or Audio level

[5] Cue List GO/Back

[12] NuVJ Dot Matrix Display

[13] Fade type UP/DOWN

[14] Cue List open/close

[15] Color Filter color RED

[17] Cue List Play/Stop

[18] Color Filter color GREEN

[19] Color Filter color WHITE

[20] Autofade

[21] Color Filter color BLUE

[22] Crossfader

[24] Fade time

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.18 Numark Omni Control

To use the Numark Omni Control, please refer to the MIDI MAP of the Numark Total Control.

You can get an overview over all preprogrammed MIDI maps in the chapter MIDI-IN.
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8.2.19 Numark Stealth Control

To use the Numark Stealth Control, please refer to the MIDI MAP of the Numark Total Control.

You can get an overview over all preprogrammed MIDI maps in the chapter MIDI-IN.
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[1] GO/Back Cue List

[20] Reset Speed Master

[1 - PRESSED] Cue List Play/Stop

[21] Submaster Storage Place

[2] Fade type DOWN/UP

[22] Reset Submaster Storage Place

[3] Cue List or Audio Play/Stop

[23] Layer Mix mode UP/DOWN

[4] Cue List open/close and Audio ON/OFF

[24] Reset Layer Mix mode to default

[5] Add Storage Place to Cue List

[25] Submaster Layer

[6] Master Fader or Audio level

[26] Reset Submaster Layer

[7] Speed Master

[27] Opacity Layer

[8] Pause Speed Master

[28] Reset Opacity Layer

[10] Autofade

[29] Color-fade color RED

[11] Storage Place UP/DOWN

[30] Color-fade color GREEN
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[12] Layer UP/DOWN

[31] Color-fade color BLUE

[15] Crossfader

[32] Color-fade color WHITE

[16] Fade time

[33] Color Filter color RED

[17] FREE

[34] Color Filter color GREEN

[18] FREE

[35] Color Filter color BLUE

[19] + [9] Fast Forward and Rewind

[36] Color Filter color WHITE

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.21 Omnitronic MMC-1

Please power on the console with every new start!

[21 B Hold] + [37] Color Filter mode (Default)

[21 A Hold] + [36] Color-fade mode

[39] Color RED for Color Filter or Color-fade

[40] Color GREEN for Color Filter or Color-fade

[41] Color BLUE for Color Filter or Color-fade

[42] Color WHITE for Color Filter or Color-fade

[22] [22 Push]
[2] Mode 1 Opacity Layer Reset Opacity
[3] Mode 2 Submaster Layer Reset Submaster
[4] Mode 3 Mix mode UP/DOWN Reset Mix mode
[5] Mode 4 - -

[1] Power On

[20] Cue List GO

[30] Reset Speed Master

[10] Layer 1

[21 Hold] + [20] Cue List BACK

[31] Speed Master Pause permanently

[11] Layer 2

[23] Storage Submaster

[32 Hold] Speed Master Pause hold

[12] Layer 3

[23 Push] Reset Submaster

[35] Speed Master

[13] Layer 4

[24] Storage Place UP/DOWN

[36] Skip A

[14] Layer DOWN (Previous Layer)

[21 Hold] + [24] Five Storage Places UP/

DOWN

[37] Skip B
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[15] Layer UP (Next Layer)

[24 Push] Return to Storage Place 1

[38] Fade type

[16] Solo mode

[25] Cue List Stop/Play

[43] Fade time

[17] Blind mode

[26] Cue List GO

[45] Master Fader

[18] Deactivate Solo and/or Blind mode

[27] Cue List Open/Close

[46] Audio level

[19] Cue - Add Storage Place to Cue List

[28] Cue List BACK

[47] Crossfader

[21 Hold] + [19] Cue List Open/Close

[29] Frame ID

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.22 Stanton SCS.3d
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[4] Main Mode

[5] Storage A Mode

[6] Storage B Mode

Main Mode

Storage A/B Mode

[1] Master Fader

[1] Speed Master

[2] Blackout

[2] Reset Speed Master to default value

[3] Fade type

[3] Storage Place DOWN

[7] FREE

[7] FREE

[8] FREE

[8] FREE
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[9] Freeze On/Off [9] FREE

[10] Audio Level [10] Submaster Storage

[11] Audio On/Off [11] Reset Submaster to default value
[12] Autofade [12] Storage Place up

[13] Cue List Open/Close [13] Speed Master Pause On/Off

[14] Cue List Back [14] Add to Cue List

[15] Cue List Stop [15] Layer Mix mode NEXT

[16] Cue List Go [16] Layer NEXT

[17] Fade time [17] Layer Submaster

[18] Crossfader [18] Layer Opacity

You can get an overview over all preprogrammed MIDI maps in the chapter
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In order to learn how to assign MIDI freely and how to program your own MIDI map, please read

the chapter MIDI-IN.

You can get an overview over all preprogrammed MIDI maps in the chapter MIDI-IN.
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8.2.24 Vestax VCI-100

W Vestax

() @

@O G ®

Qié'@)@!‘

DJ MIDi
CONTROLLER

[27] Switch to Layer mode / Storage mode
(Storage mode = light on)

LAYER MODE

STORAGE MODE

[25] + [42] Submaster

[25] + [42] Submaster

[26] + [42] Opacity

[42] Switch Layers

[42] Frame ID

[49] + [42] Layer UP/DOWN

[49] + [42] Storage Places 1 -60

[1] Speed Master A/B

[19] Color Filter color WHITE

[47] Speed Master PAUSE OFF

[5] Cue List Stop

[22] Autofade

[48] Speed Master Pause Hold

[6] Cue List Back

[23] Freeze Main Output

[50] Fade type XF Cross-fade

[7] Cue List Open/Close

[24] Add to Cue List A/B

[51] Fade type WF White-fade

[8] Cue List GO

[28] Crossfader Skip A/B

[52] Fade type BF Black-fade

[9] Cue List GO + Start

[29] Must be value “mas.”! If “A” or “B” is
selected, select “mas.”, then disconnect
and reconnect the VCI100.

[53] Fade type CF Color-fade

[14] Fade time

[43] Master Fader

[16] Color Filter color RED

[44] Audio level

[17] Color Filter color GREEN

[45] Crossfader
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[18] Color Filter color BLUE

[46] Speed Master PAUSE permanently

You can get an overview over all preprogrammed MIDI maps in the chapter
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8.2.25 Vestax VCM-100

L ‘iﬁ'Vestax

cue

@)@fﬁ@

< =

Byne

& review ¢
SonE ooioet

@ voner e cewrrouse VCIVI-T00 @

[==1"

®®®

[1] Speed Master A/B

[12] Color Filter color RED

[24] Speed Master Pause permanently A/B

[2] Storage Place A1-A15 / B1-B15

[13] Color Filter color GREEN

[25] Speed Master Pause OFF A/B

[3] Storage Place A16-A30 / B16-B30

[14] Color Filter color BLUE

[26] Speed Master Pause Hold A/B

[4] Storage Place A31-A45 / B31-B45

[15] Skip A

[27] Cue Storage Place A/B

[5] Storage Place A46-A60 / B46-B60

[16] Skip B

[28] Storage Place A/B DOWN

[6] Fade time

[17] Master Fader

[29] Storage Place A/B UP

[7] FREE

[18] Audio level

[30] Crossfader

[8] FREE

[19] Cue List Stop

[31] Autofade

[9] Blackout

[20] Cue List Back

[32] Fade modes

[10] Audio ON/OFF

[21] Cue List Start + GO

[33] FREE

[11] FREE

[22] Cue List GO

[34] Output Freeze permanently

[23] Cue List Open/Close

You can get an overview over all preprogrammed MIDI maps in the chapter MIDI-IN.
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8.3 MIDI Time Code (MTC)

Introduction

MIDI Time Code (MTC) includes timing information in the same way as standard SMPTE time

code, that is, as a series of small 'quarter-frame' MIDI messages.

MTC synchronization can be used to match MADRIX with an audio or video signal. It allows you to

synchronize your MADRIX show with other lighting panels or a laser show for instance.
MADRIX professional and MADRIX ultimate support receiving MIDI Time Code (MTC):

e 24 FPS (Standard frame rate for films)

25 FPS (Standard frame rate for PAL video)

30 Drop (30/1.001 FPS drop-frame time code for color NTSC video)

e 30 FPS (Monochrome NTSC video)

Important Notes

Before using a MIDI console, please make sure that all necessary drivers (e.g. USB) are

installed and that your MIDI console is connected to your computer.

Please also make sure to save your MADRIX Setup after the following configuration process.
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How to Set Up MTC

If you want to activate MTC, please go to the menu "Preferences"

select the tab "MIDI".

-> "Device Manager" and

When your MIDI device is connected to your computer, it will appear in the list:

If you cannot see your MIDI device in the list, please press "Scan".
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B Use For M2L

To activate your MIDI device,

1) select the device in the list and

2) click "Enable" in the upper right hand corner.

' EnEkle

522

Please note that the "State" in the list will change from "Off" (red light) to "On" (green light).
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O Enable

v 52 [ Channel Fiter

B Use For M2L

Now, select your MIDI device again in the list and activate "MTC".
BT

If you are encountering any other problems, please activate the switch "Watch" after selecting

the MIDI device in the list. This will add the device to the MIDI Watcher.

Now press "OKk™". You can close this window now.
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Setting Up the Cue List to Receive MTC

In the second step, set up your Cue List. (Learn more about the Cue List.)

First, activate the switch "External” and select a frame rate. In this example we have used 25

FPS (standard rate for PAL video).

W External

Now, add an entry to the Cue List. The next step is to set the "Time Code" for a Cue List entry.
The format for the Time Code is HH:MM:SS:FF, meaning hours:minutes:seconds:frames.

You can use the following values for the Time Code:

For an input of one hour you can use 01000000, 01:00:00:00, 01,00,00,00, 01.00.00.00
,01/00/00/00, 1h, or 01h0O0OMOO0OsO0Of.

For an input of ten minutes you can use 00100000, 00:10:00:00, 00,10,00,00,
00.10.00.00, 00/10/00/00, 10m, or 00h10mO0O0sO0Of.

For an input of ten seconds you can use 00001000, 00:00:10:00, 00,00,10,00,
00.00.10.00, 00/00/10/00, 10s, or 00hOOM10s00f.

For an input of ten frames you can use 00000010, 00:00:00:10, 00,00,00,10,
00.00.00.10, 00/00/00/10, 10f, or 00hOOMO0O0s10f.

A value of -1 or using the space bar resets the fields to their default value.

Add or edit more entries according to your requirements.
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8.4 Remote HTTP
Usage
Connect MADRIX to any TCP/IP network and you can control MADRIX from all over the world using

an internet browser or your mobile phone with internet communications via the Remote HTTP
function.

Configuration

1) Please open the menu "Preferences" -> "Remote Control” -> "HTTP". A new dialog will
open.

 Enakle

Fart : 80 IP: Hostname:
I

Fathy CProgram Files 1AL ublic_remuote_html

Cretaut

ok

2) Click "Enable" to activate the internal web server implemented in MADRIX.

3) "Port" defines the protocol port on which the web server will be running. Please note that
other software (for example, SKYPE or similar clients with the same principle) might block the port
you have selected. To solve the problem, please use the alternative ports suggested below or
close other software. Press "Apply" if you have made any changes.
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Recommended Ports: Alternative Ports:

80 If you are encountering problems, please
3128 enter any port higher than 1024.

8080

8081

4) "Path" defines the location of the HTML start pages. Select the folder "public_remote_html" in
your MADRIX installation folder. In WIndows 7 the path often is C:\Program Files (x86)
\MADRIX\public_remote_html. Press "Apply" if you have made any changes.

5) Now, press the button "Call". Your internet browser will be opened and you will see a website

you can use to control MADRIX remotely. You can access this website using the internet.

Your Remote Control should be working now. If the internet browser is opening and closing with no
visible result, please change the port. You can also open the "Logfile" ("F6" or "Window" ->

"Lodfile") and check the file for errors.

Create Your Individual HTML Page

The HTML examples do work. But it is also a demonstration to show you the possibilities.
You can modify or create your own html files to integrate them in your own applications, e.g.
using the DJ Software ULTRAMIXER.

Please note: You should name your individually created HTML start page 'index.html'.

Commands and Help File
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Madrix V2.10
RemoteHttp

micro

preview thumbs

Madrix
Remote
Members

2010/10/07 03:14 PM

MADRIX offers several interfaces that can be used with Remote HTTP. Use the one that is the

best for your needs.

If you would like to create a custom layout, please have a look at "Madrix Remote Members"
for the overview and documentation of remote commands (remote members). This is the user

guide for the remote commands.
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9 Tutorials & Examples
Overview

In this section you can find several tutorials to make your start with the software easier.

Moreover, examples demonstrate the possibilities of the software.

e How To Create Your First Matrix/Patch
e Creating And Playing An Effect

e Using The Fader To Switch Effects

Examples

9.1 How To Create Your First Matrix/Patch

In this tutorial we are going to set up a matrix with 25 CHAUVET COLORpalette LED fixtures. The
aim is get a typical rectangle matrix by positioning 5 units next to each other and 5 units on top of
each other. The CHAUVET COLORpalette fixture features 4 pixels in x and 2 pixels in y. This

means, as a result we will be able to use 20 pixels in x and 10 pixels in y for light effects.
Please follow the steps described below.

1. Open the "Matrix Generator" by pressing the "F2" key or go to the menu tab "Preferences".
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‘ET COLORpalette 27 Ch
Fotation | Criginal
Count . :
Start Carner:
lain Orientation | “vertica
Snake Mode : "B

tart Channel :

1
|
tart Universe : 1 =
e —

Ay

2. Select the fixture "CHAUVET COLORpalette 27 Ch".

3. Leave the orientation as it is. The orientiation of a fixture describes how it is mounted. So for
example, it would be possible to mount this fixture in an angle of 90 degrees. This means that if

we face the the fixture directly, we would see a usage of 2 pixels in x but 4 pixels in y.
4. Enter '5' for "Count X" and '5' for "Count Y".

5. Next, we will set up the "DMX Start Corner". This function describes the point where the first
fixture will ge its DMX signal. For our example we decide to start at the bottom left corner. After
changing the DMX start corner, the little graphic on the right side changes and the small rectangle

which marks the start point appears in the bottom left.

6. Now, we are going to set up the "Main Orientation". It describes in which direction the next

fixture will get the next DMX address. In our example we decide to use the vertical direction.

7. Because of the more simple connection of fixtures, often they are patched in a snake mode,
which means after reaching the top end of the first column, the next fixture will be the top most

of the next column. To use this mode we select the "Snake Mode" checkbox.
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8. Sometimes fixtures have to be rotated about 180 degree to be able to use the snake mode
connection. In the case of the CHAUVET COLORpalette this is not necessary. Therefore, we will

leave the "With Fixture Rotation" checkbox as it is.

9. Because we want to start the first DMX channel in the first DMX universe, we will leave number

one to be our "DMX Start Channel” as well as "DMX Start Universe".

10. Click the "OK" button to apply all changes and to close the "Matrix Generator". Now you

should be able to see a 40x10 pixel matrix in the preview windows.

11. Last but not least, open the "Patch" dialog with the "F3" key or go to the menu tab
"Preferences". Here you can check how the MADRIX patched the fixtures for us.

i e ooo
) | B H-H
Patch Size Adc ect All Deselect All Invert

ighlight Cwverlap = Link i ut Focus All

Fixture
uoo1 uoo1
cio09 136 Care

uot1
uoo1
cisn

uoo1
c217

uoo1 uoo1
coo1 Cza4

[ DVIMapping —— |

Flippi
Rotation :
Postion X :

Postion ¥ :

[ Fodure Description ———————————————
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9.2 Creating And Playing An Effect

Start MADRIX. Now call up the "Matrix Generator" via the menu "Preferences" or press "F2". A

new window will be opened, in which you can find all the settings for your Matrix.

| Preferences

Matrix Generator... F2
Patch... F3
Device Manager... F4
Audio Performance... Ctrl+Alt+ A
Remote Control »
Backup System...

Options... Ctrl+Alt+0

Please set up all necessary parameters. The previous tutorial might help you with that. Or you can

find more information in the chapter Matrix Generator.

ATTENTION:
At this point, it is expected that all necessary settings for the light matrix and LED hardware

have been already configured and tested. Therefore, this part will be skipped in this tutorial.

S T = i ey e o

CLE Calor

Now, select a free Storage Place
from the Storage Areas A or B. In this example we are going to use Storage Place 1 in Storage A.

Then, it is time to select an effect from the effect list.

Pick the SCE Color Ramp effect and configure it.
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=CE  Color Ramp

Lk “hapn Mormal ik

u
)

B Fade

The effect offers to modify a lot of settings. In our example we are using a color ramp from red to

pink.

A more detailed description can be found here: Static Color Effects — SCE Color Ramp.

e B ik - ik

|||||I|| | ||I||||| B
—l—|-|—|—|—|—|—|—

1 FADE

Now set the output fader to the side in use. If you
work in Storage A, pull the crossfader to the left. Set it to the right for Storage B. You will be able

to see the effect in the preview output as a result.

9.3 Using The Crossfader To Switch Effects

First, select an effect you have already programmed from Storage Area A. Next, choose an effect

placed in Storage Area B.
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For example, you have set and selected the first effect in Storage A-1 and the second effect in

Storage B-1. Now, you can simply cross-fade between both Storage Places.

B

|

NN B

In the example below we moved the fader to the middle using a white-fade. You will see a mix of

both effects in the output preview.

references  Window Tools  Previews

=MAD

= MUSIC MAKES THE LIGHT

ki
o B S| R

r T | vt 1 g
T ST

e 1
FADE

Cuetist
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R AR RRRINIT]
=
- 1 ‘ L rrrnnm
L—1 T
| ‘ I Errnnm
(I,

| | L B AT
—] T.'.

4 Calor Ramp 4 Metaballs

9.4 Examples

If you would like to see some examples, various

e setups,

I fep= L LD EEEErm
= L T
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o effects,

e scripts,

e and color tables

are already installed on your PC if you have enabled this option during the installation process:

MADRIX

Choose Components
Choose which features of MADRIX vyou want to install.

Chedk the components you want to install and unchedk the components you don't want to

install. Clicdk Next to continue.

Select components to install:

Space reguired: 91. 7MB

MADRIX
Desktop shortout
MADRIX KEY Driver
Interface Driver
Visualizer Driver
WinPcap Driver

Description

Installs several
exemplary setups,
effects, soripts, and
color tables.

< Back ][ Mext = ] [ Cancel

You can find the examples e.g. on your hard disk:

e C:\Program Files\MADRIX\setups

e C:\Program Files\MADRIX\effects

e C:\Program Files\MADRIX\scripts or
C:\Program Files\MADRIX\scripts\learning_examples

e C:\Program Files\MADRIX\colortables

Explanation:
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'C:\' being your hard disk where you installed the software.
And the equivalent 'program folder' (...Program Files..., ...Program Files (x86)..., or...

Programme... , etc.) containing your applications.

More Information

Learn more about the file types used in MADRIX: File Types.

536
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10 Recording
Introduction

The Recording dialog is able to create MADRIX Record Files (*.mrec). This file type has two areas

of application:
e * mrec files can be converted to create Stand-alone Shows for the MADRIX PLEXUS

e * mrec files can be played just like a video using the SCE Video effect

The following chapter describes how to create records for the SCE Video effect.
(Learn more about the SCE Video effect.)

You can learn more about how to create Stand-alone Shows in the chapter MADRIX PLEXUS.

Overview

To call up the Recording dialog, please go to the menu "Window" -> "Recording" (or
"Ctrl+Alt+R").

Cue List... F7
Recording... Ctrl+Alt+R
Touch... F&
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The following dialog will open.

Path

"Path" specifies a directory on your hard disk. All record files will be saved in this folder. By
default, a useful folder is already chosen for your (For example, C:

\Users\USERNAME\Documents\MADRIX\records).

=

You can change the folder. Use this button to browse for a different folder on your hard

disk.
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Managing Files

Delete the selected file or files from your hard disk.

Show MADRIX Record File (*.mrec) in the list. Disable the option to hide all Record

Files.

s

Show MADRIX PLEXUS Scene Files (*.dxd) in the list. Disable the option to hide all

Scene Files.

Use this button to refresh the list of records. Please make sure to select your preferred

records folder first.

File Information

Select the Tab "File Information" to receive detailed information about the files you have

created. Please select a file in the list first.

A== Recaording I Edit Record I PLEXUS Co
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Recording
Select the Tab "Recording" to create a new record.

Preparation

Please configure your virtual matrix with the help of the Matrix Generator or Patch to define

the correct pixel resolution for your record.

Important Note

Please note: Only the Main Output will be recorded. Make sure that your content is

displayed on Preview Window Output before you record.

Options

Please configure the following options before recording.

Options
Synchronize With Cue List ' T

Start wiith Cue :

=

Frame Time {ms): 1
L ———

"Synchronize With Cue List" will create a record according to your preprogrammed Cue List. If
this option is activated, the Cue List will automatically start to play when the Recording is started

(by pressing the button "Start").

"Start With Cue" allows you to specify which Cue List entry should be used first, when you wish

to use the function "Synchronize With Cue List".
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"Frame Time (ms)" defines the frame rate of the record. Please adjust the setting to the
requirements of your LED fixtures! A frame rate (FPS) that is too high might cause visual

problems.

Creating A Record File

Please make sure to configure all available options before recording (see above).

Step 1)

Begin recording by pressing "Start". MADRIX will start to record the Main Output.
Please note: During your record you can change Storage Places, use the cross-fader, use the

Master Fader, etc. in order to customize your record.

Step 2)

Key Frames

Buffer :

Various information will be displayed.

The Time is displayed in HH:MM:SS:FF (Hours:Minutes:Seconds:Frames).
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Simply press "Stop" to halt the process. Please wait a few seconds to let MADRIX

process the data. Afterwards you will need to enter a hame for the new record.

Step 4)

Afterwards, you will see your record in the list.

Recording
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Edit Record

After creating your record, you can edit your record.

First, please select your Record File in the list. Second, change to the tab "Edit Record" in the

"Recording" dialog.

1.0 || g R e ‘N Eralenl
\IIIIIIIIIHIIIIIIIIIHIHI | LLLLLELELLEEL LT ELrEL

In Frame Out Frame

= | | .
i] = Find Coos = 178
| — |

Blend

A small preview window is provided in the lower left to inspect the record.

Use the provided controls to edit your record. That means you can preview, trim, and loop your

record. First, select a list entry.

_ Use the slider to select a specific frame.
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[T
Fire Coog

This field displays the current frame that is also
shown in the small preview window. Enter a number

to jump directly to this frame.

Start or stop the preview playback.

Rewind or forward one frame per click.

Skip directly to the In Frame or the Out Frame.

Skip to the beginning or the end of the record.

Enter a number or use the slide to select a specific
frame. Then, use the "S" button to set the In Frame

(start frame).

Enter a number or use the slide to select a specific
frame. Then, use the "S" button to set the Out Frame

(end frame).

MADRIX will search the Record File in order to find a
segment that is loopable. It will automatically set the
In Frame and Out Frame afterwards. Use the button
"Export" to export your loop. Before that, you can

also insert "Blend Frames".
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Blend Frames :

Export

Insert "Blend Frames" into your record. First, enter
the number of frames you wish to use. This defines
the length. Second, choose the fade mode (XF:
Cross-fade, WF: White-fade, BF: Black-fade, >>more
info). Third, press "Blend". Fourth, use PlayPause to
preview the edited record. Fifth, use the button
"Export" to export your loop.

Please note: The beginning of your record will be cut
by the defined frame number. This is indicated by a
red line below the slider.

Example: If you enter "100" frames, MADRIX will
create the fade using the first 100 frames and the
last 100 frames. Those frames will blend into each
other. To have a smooth fade, the record is then cut

by 100 frames and starts at frame 101.

Use this button to export the edited record. Choose a

name in the second step.
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PLEXUS Conversion

.| PLEXUS Conwersion

Use this tab to convert MADRIX Record Files (*.mrec) into MADRIX PLEXUS Scene Files (*.dxd).
Learn more about how to create Stand-alone Shows in the chapter MADRIX PLEXUS.
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How To Play A Record File Using SCE Video

1. Select the effect SCE Video.

E
E
E
E
E
E
E
E
E
E
E
E
E
E
E
E

2. The controls of the SCE Video effect become available as a result.

548
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3. Load your MADRIX Record File (*.mrec) using the "Open" button.

2" Cpen

Use the "Open" button and select the file you wish to play.

4. The SCE Video effect will play your Record File.
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11  MADRIX NEO

Overview

The MADRIX NEO is a USB 2.0 DMX512 interface.

Loading The Drivers

Please make sure to select the "MADRIX USBone / NEO interfaces" driver in the options. To access
options of MADRIX, first go to the menu "Preferences" -> "Options" (or "Ctrl+Alt+0"). Second,
select the tab "Devices (USB/PCI)".
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Select the "MADRIX USBone / NEO interfaces" driver and press "Apply". Close the the dialog
with "Ok".

Please restart MADRIX if the driver was not enabled before.

Using DMX Output or DMX Input

The NEO allows you to send or receive data via MADRIX using 512 DMX channels. A male to male

3-pin or 5-pin gender changer is required for DMX-IN.

Learn more about using DMX-OUT in the chapter DMX512.
Learn more about using DMX-IN and Remote Control in the chapter DMX-IN & Art-Net Remote.

© 2011 inoage GmbH



553 MADRIX Help and Manual

Upgrading From MADRIX NEO To A Higher MADRIX Version

The NEO Quick Start Guide describes which elements should be installed when you wish to use the
MADRIX NEO interface. If you want to upgrade to higher version of MADRIX (e.g. MADRIX basic),
please re-install the software and choose the necessary components. Please see the chapter
Installation Of MADRIX for more details.

Important Notes

Regarding the MADRIX NEO, the MADRIX software license for 512 DMX channels is already
included.The MADRIX KEY is not necessary for the MADRIX NEO.

Up to 60 NEOs can be connected to a USB host controller without having any frame rate
problems. Please connect every NEO to an active USB 2.0 port or use a USB 2.0 hub

with a power supply.
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12 MADRIX PLEXUS

Overview

The MADRIX PLEXUS is a USB 2.0 DMX512 interface. The device can be used as a live controller

(Live Mode) or stand-alone interface (Stand-Alone Mode).
Contents of this chapter:

e Important Notes

Loading Drivers

e Live Mode

Stand-Alone Mode

e Managing Your MADRIX PLEXUS Devices

o Tips

Important Notes

Regarding the MADRIX PLEXUS, the MADRIX software license for 1024 DMX channels is already

included.

The MADRIX KEY is not necessary for the MADRIX PLEXUS.
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Loading And Enabling Drivers

USB Drivers

Please make sure to activate the driver for the USB connection in the MADRIX Options. To access
the Options of MADRIX, first go to the menu "Preferences" -> "Options" (or "Ctrl+Alt+O").
Second, select the tab "Devices (USB/PCI)".

Enable the "MADRIX USB PLEXUS interfaces" driver and press "Apply". Close the dialog with
llokll.
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Network Drivers

Please make sure to activate the driver for the Ethernet (network) connection in the MADRIX
Options. To access the Options of MADRIX, please press "Ctrl+Alt+0" or go to the menu

"Preferences" -> "Options". Now go to the tab "Devices (Network)".

Select "Enable PLEXUS Networking"” and press "Apply". Close the dialog with "Ok".

Live Mode

The PLEXUS allows you to send or receive data via MADRIX using 1024 DMX channels per device.

A gender changer with 5-pin male to 3-pin or 5-pin male is required for DMX-IN.

Learn more about DMX-OUT in the chapter DMX512.
Learn more about DMX-IN and Remote Control in the chapter DMX-IN & Art-Net Remote.
Learn more about Art-Net in the chapter Art-Net.
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Stand-Alone Mode

Introduction

Normally, a computer runs the MADRIX software live and thereby controls the LED installation. In
contrast, the Stand-Alone Mode of the MADRIX PLEXUS can be used to control LED installations

without the need for a computer during the show.

The PLEXUS can use a SD card (SD or SDHC) on which a Stand-Alone Show can be saved. But

first, it is necessary to create such a Stand-Alone Show.

Please read the following chapter carefully in order to learn how to create a MADRIX
PLEXUS Stand-Alone Show.

Basic Workflow (Step By Step)
In order to create a show file, please follow these steps:

Step 1) Configure your virtual matrix according to your LED installation.
(Use the Matrix Generator or the Patch for this task.)

Step 2) Create the MADRIX effects you wish to use.

(Learn more about Effects.)

Step 3) Create a Cue List, if you wish to use it during the recording.
If not, simply skip this step and you will create a live record.

(Learn more about the Cue List.)

Step 4) Record your effects by creating a MADRIX Record File (*.mrec).
(Use the Recording dialog for this task.)

Step 5) Convert the Record File (*.mrec) into a PLEXUS Scene File (*.dxd).
(Use the Recording dialog for this task.)

Step 6) Create a PLEXUS Configuration. This will be your Stand-Alone Show!
(Use the PLEXUS Configuration dialog for this task.)

© 2011 inoage GmbH



559 MADRIX Help and Manual

Step 7) Upload your Stand-Alone Show onto the SD card.
(Use the PLEXUS Configuration dialog for this task.)

Step 8) Activate Stand-Alone Mode for the MADRIX PLEXUS.

(Use the PLEXUS Configuration dialog for this task.)

Step 1), Step 2), And Step 3)
Please use the Matrix Generator or the Patch for Step 1).
Please read the chapter Effects for Step 2).

Please read the chapter Cue List if you wish to do Step 3).

Step 4) Recording Your Effects

Overview

To call up the Recording dialog, please go to the menu "Window" -> "Recording" (or

"Ctri+Alt+R").
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Patch =iTe Time KF FP= Q

Path

"Path" specifies a directory on your hard disk. All record files will be saved in this folder. By
default, a useful folder is already chosen for your (For example, C:

\Users\USERNAME\Documents\MADRIX\records).

=

You can change the folder. Use this button to browse for a different folder on your hard

disk.
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Managing Files

Deletes the selected file or files from your hard disk.

Shows MADRIX Record File (*.mrec) in the list. Disable the option to hide all Record

Files.

s

Shows MADRIX PLEXUS Scene Files (*.dxd) in the list. Disable the option to hide all

Scene Files.

Refreshes the list of records. Please make sure to select your preferred records folder

first.

File Information

Select the Tab "File Information" to receive detailed information about the files you have

created. Please select a file in the list first.

File Information et
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Recording
Select the Tab "Recording" to create a new record.

Preparation

Please make sure to do Step 1), 2), and 3) before recording.

Important Note

Please note: Only the Main Output will be recorded. Make sure that your content is

displayed on Preview Window Output before you record.

Options

Please configure the following options before recording.

] Fl‘til'l n=
Synchronize With Cue List =
Start Wiith Cue : 1

Frame Time {msz) : 20 FFPS : 500
L

"Synchronize With Cue List" will create a record according to your preprogrammed Cue List. If
this option is activated, the Cue List will automatically start to play when the Recording is started
(by pressing the button "Start").

"Start With Cue" allows you to specify which Cue List entry should be used first, when you wish

to use the function "Synchronize With Cue List".

"Frame Time (ms)" defines the frame rate of the record. Please adjust the setting to the
requirements of your LED fixtures! A frame rate (FPS) that is too high might cause visual

problems.
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Creating A Record File

Please make sure to configure all available options before recording (see above).

Step 1)

Begin recording by pressing "Start". MADRIX will start to record the Main Output.
Please note: During your record you can change Storage Places, use the cross-fader, use the

Master Fader, etc. in order to customize your record.

Step 2)

Key Frames

Buffer :

Various information will be displayed.

The Time is displayed in HH:MM:SS:FF (Hours:Minutes:Seconds:Frames).
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Step 3)

Simply press "Stop" to halt the process. Please wait a few seconds to let MADRIX

process the data. Afterwards you will need to enter a name for the new record.

Step 4)

Afterwards, you will see your record in the list.

Recording |2

Frame Time

Buffer :
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Edit Record

After creating your record, you can edit your record.

First, please select your Record File in the list. Second, change to the tab "Edit Record" in the

"Recording" dialog.

L]

e

Edit Record

O L L VT L L
| |

IIIIIIIIIIIIIIIIIIIIIIIIIIIII|”IIIIIIIIIIIIIIIIIIIIII

In Frame Clut Frame

=
Brtenc

A small preview window is provided in the lower left to inspect the record.

Use the provided controls to edit your record. That means you can preview, trim, and loop your

record. First, select a list entry.
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Use the slider to select a specific frame.

This field displays the current frame that is also shown
in the small preview window. Enter a number to jump

directly to this frame.

Starts or stops the preview playback.

Rewinds or forwards one frame per click.

Skips directly to the In Frame or the Out Frame.

Skips to the beginning or the end of the record.

Enter a number or use the slide to select a specific
frame. Then, use the "S" button to set the In Frame

(start frame).

Enter a number or use the slide to select a specific
frame. Then, use the "S" button to set the Out Frame

(end frame).

MADRIX will search the Record File in order to find a
segment that is loopable. It will automatically set the In
Frame and Out Frame afterwards. Use the button
"Export" to export your loop. Before that, you can also

insert "Blend Frames".
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Blend Frames: 0= Blend! Insert "Blend Frames" into your record. First, enter the

number of frames you wish to use. This defines the

length. Second, choose the fade mode (XF: Cross-fade,
WF: White-fade, BF: Black-fade, >>more info). Third,
press "Blend". Fourth, use PlayPause to preview the
edited record. Fifth, use the button "Export" to export
your loop.

Please note: The beginning of your record will be cut by
the defined frame number. This is indicated by a red line
below the slider.

Example: If you enter "100" frames, MADRIX will create
the fade using the first 100 frames and the last 100
frames. Those frames will blend into each other. To
have a smooth fade, the record is then cut by 100

frames and starts at frame 101.

T Export Exports the edited record. Choose a name in the second

step.

Step 5) Converting Files

Overview

Call up the Recording dialog again. Please go to the menu "Window" -> "Recording" (or
"Ctrl+AIt+R").

First, select your MADRIX Record File (*.mrec) in the list. Second, switch to the tab "PLEXUS

Conversion".
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The tab "PLEXUS Conversion" allows you to prepare the conversion. You can edit and configure
how a MADRIX Record File (*.mrec) is converted into a MADRIX PLEXUS Scene File (*.dxd).

Preparing The Conversion

Please make sure that your virtual matrix (Patch) is configured correctly before generating

Scene Files (*.dxd).

1. Select a list entry.

2. Edit the information for the soon converted file according to your requirements ("Author",
"Scene Name", "File Name"). You are defining how the new Scene File will be named after the
conversion. Double-click on the particular column and enter the values or characters using the
keyboard. Use Enter to apply your change. Please make sure that your "File Name" has the

ending "*.dxd".

3. Define which DMX universe of your virtual matrix (Patch) will be used for the first output port of
your PLEXUS ("DMX 1"). Perform a double-click and simply enter the number of the universe. Use

Enter to apply the changes. Select "No" if the output port should be deactivated.

4. Define which DMX universe of your virtual matrix (Patch) will be used for the second output port
of your PLEXUS ("DMX 2"). Perform a double-click and simply enter the number of the universe.
Use Enter to apply the changes. Select "No" if the output port should be deactivated.
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5. Activate "Use Master Values" if you have used the Master Fader during recording. Then, your
converted record will include the brightness levels set by the Master Fader during the recording.

Leave the option unchanged if your did not use the Master Fader during recording.

Please note: If your are using more than 2 DMX universes and more than 2 MADRIX PLEXUS

at the same time, please create a new list entry for each PLEXUS.

Adds a list entry. Then, change the information for each entry. Do not forget to adjust
the entry "DMX 1" and "DMX 2" as well as "Author", "Scene Name", "File Name" for each list entry.

Removes an entry from the list.
Example:

We have created a Patch for 6 DMX universes and we are using 3 MADRIX PLEXUS. PLEXUS
number 1 should play DMX universe 1 and 2, PLEXUS number 2 should play DMX universe 3 and 4,

PLEXUS number 3 should play DMX universe 5 and 6. Then, we need to create 3 list entries.

;) PLEXUS Conwersion

We will also have to generate 3 MADRIX PLEXUS Scene Files (*.dxd) in the next step.
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Generating MADRIX PLEXUS Scene Files (*.dxd)

Please make sure that your virtual matrix (Patch) is configured correctly before generating

Scene Files (*.dxd).

1. Select the edited list entry.

2. Press the button "Generate" to convert the MADRIX Record File (*.mrec) into a MADRIX
PLEXUS Scene File (*.dxd).

3. The newly create MADRIX PLEXUS Scene File (*.dxd) will be added to the list.

Please note:

e You can create multiple MADRIX PLEXUS Scene Files (*.dxd) from one MADRIX Record File (*.

mrec).

e Your MADRIX Record File (*.mrec) will not be deleted when a new MADRIX PLEXUS Scene Files

(*.dxd) is generated.

e When using multiple devices at the same time, you will have to create multiple Scene Files (*.
dxd). Please create a Scene File for every PLEXUS. Do not forget to adjust the entry "DMX 1"

and "DMX 2" as well as "Author", "Scene Name", "File Name" for each list entry.

Step 6) Creating PLEXUS Configurations (Show Files)
Overview

To call up the PLEXUS Configuration dialog, please go to the menu "Tools" -> "PLEXUS
Configuration " (or "Ctrl+Alt+P").

It is highly recommended to maximize the size of the PLEXUS Configuration dialog.
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The upper section of the PLEXUS Configuration dialog is called "Devices". It can be used to

manage your PLEXUS devices (see below).

The lower section of the PLEXUS Configuration dialog has two parts. The left part is used to
manage your PLEXUS Configurations (create a new Configuration, import/export a Configuration,
etc). The right part is used to edit each PLEXUS Configuration individually (add scenes, add
events etc).

Basically, when you create and configure a MADRIX PLEXUS Configuration, you create a
Show for the PLEXUS Stand-Alone Mode.
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How To Create And Manage PLEXUS Configurations

In order to manage your PLEXUS Configurations, please use the lower left part of the PLEXUS

Configuration dialog.

Please note: A MADRIX PLEXUS Configuration is not one single file. A Configuration is a

folder containing several files.

I |_r|_|
ar

Creates a new PLEXUS Configuration. Enter a name for the new PLEXUS

Configuration in the second step.

Removes an existing PLEXUS Configuration. Select the particular PLEXUS

Configuration first.

-
Duplicates an existing PLEXUS Configuration. Select one PLEXUS Configuration first.

Enter a new name for the copy in the second step.

I Irmport

Imports a PLEXUS Configuration. Select the particular PLEXUS Configuration first. In
the second step, please select the directory or the source on which the Configuration can be
found. Importing a PLEXUS Configuration is useful when receiving Configurations from someone

else.

I Export

Exports a PLEXUS Configuration. Select the particular PLEXUS Configuration first. In
the second step, please select the directory or the source on which the PLEXUS Configuration
should be saved. Exporting a Configuration is useful for exchanging PLEXUS Configurations with
each other (on USB sticks, for example) and for uploading a Stand-Alone Show directly onto a SD

card.
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Shows the content of a PLEXUS Configuration (View Directory). Remember that a
MADRIX PLEXUS Configuration is not one, single file, but a folder containing several files. You will

hence view the whole directory that includes all files of the PLEXUS Configuration.

Uploads a PLEXUS Configuration onto a SD card that is inserted into a MADRIX
PLEXUS. Learn more below.

Please configure the column "AutoPlay" for each of your PLEXUS Configurations.
This setting specifies what to do when a new Stand-Alone Show is uploaded to a MADRIX PLEXUS
or when a newly recorded SD card is inserted into a MADRIX PLEXUS. Select "No" and nothing will
be played automatically. Select "Last" and the PLEXUS will continue where it last stopped. Or you
can select a specific Scene after you have created Scenes (Number "1", "2", "3", etc). Perform a
double-click to change the entry.

You may also change the name of your PLEXUS Configurations after you
have created them. Simply perform a double-click on the column "Name" and enter the new

description via the keyboard. Press Enter to apply the changes.

© 2011 inoage GmbH



MADRIX PLEXUS 574

How To Edit PLEXUS Configurations

In order to edit your PLEXUS Configurations individually, use the lower right part of the PLEXUS

Configuration dialog.

First create a new PLEXUS Configuration as described above.

'R Perform Con zistency Checks

MADRIX can automatically control if your editing is logical and
consistent within one Configuration. Enable this function in order to receive warnings if your

editing may be false. Disable this function to hide such messages.

You will automatically receive small warning symbols if your editing is inconsistent
and illogical. MADRIX then indicates that you have created conflicts. You will receive these

warnings even if you disable "Perform Consistency Checks".

Scenes:

Scenes are based on a MADRIX PLEXUS Scene File (*.dxd). Scenes are smaller parts of a whole

show. All Scenes together create your Stand-Alone Show.

First, please select one PLEXUS Configuration you wish to edit.

Creates a new Scene.

When creating a new Scene, a new window will open and you will be asked to select a MADRIX
PLEXUS Scene File (*.dxd).
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["Select Data File
-

Select a file from the list of . Or you can simply

"Import" a *.dxd file from your hard disk. If the list is empty, please import a file.

Removes a Scene. Select the particular Scene first.

Duplicates a Scene. Select the particular Scene first. Enter a new name for the copied

Scene in the second step.

In addition, please edit the following columns according to your requirements.

(Perform a double-click to change their values. Use Enter to apply your changes. Use Escape to

cancel.)
"Name" defines the description of the Scene. Simply enter a name.
"File" defines the source of the Scene. Simply select another source, if you wish to

change it.

"Direction” defines which way the Scene is played. Applicable values are: "Forward", "Ping
Pong", "Backward".
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"Repeat”

"Soft Loop"

"Follow"

"Master"

"Speed"

"Port7"

"Port8"

"Port9"

"Port10"

Timers:

defines how often the Scene is repeated. Simply enter a number. A value of 0 will

be shown in the list as "Endless", that means it will be repeated endlessly.

creates an automatic loop by the software. First, enter a number of frames.
MADRIX will add these frames to the end of the Scene and therefore loops towards
the first frame of your Scene. A cross-fade is created. For example, if your record
was set to a frame rate of 33 FPS and you enter 66 here, the last two seconds of

the Scene will be used for a loop towards the first frame.

defines which Scene will be played after the currently selected Scene. Applicable

values are: "No", "Next", and a specific Scene ("1", "2", "3", etc).

defines the Master Fader for the Scene in percent, that means the master

brightness. Applicable values are: 0 - 100.
defines the tempo in percent. Applicable values are: 0 - 1000.

defines if Port 7 of the Extension Port will be triggered when the Scene begins to
play. Applicable values are: "NO", "0" (OFF), or "1" (ON).

defines if Port 8 of the Extension Port will be triggered when the Scene begins to
play. Applicable values are: "NO", "0" (OFF), or "1" (ON).

defines if Port 9 of the Extension Port will be triggered when the Scene begins to
play. Applicable values are: "NO", "0" (OFF), or "1" (ON).

defines if Port 10 of the Extension Port will be triggered when the Scene begins to
play. Applicable values are: "NO", "0" (OFF), or "1" (ON).

The tab "Timers" allows you to add specific events to your Stand-Alone Show.

First, please select one PLEXUS Configuration you wish to edit.
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Creates a new Timer.

Removes a Timer. Select the particular Timer first.

Duplicates a Timer. Select the particular list entry first.

In addition, please edit the following columns according to your requirements.

(Perform a double-click to change their values. Use Enter to apply your changes. Use Escape to

cancel.)

"Action"

"Value"

llType L1

"Start"

defines the type of Timer. Applicable values are: "Scene", "Master", "Speed,
"Port7", "Port8", "Port9", "Port10". "Scene" will trigger a specific Scene to be
played. "Master" will trigger the master brightness to change. "Speed" will trigger a

change of tempo. "Port" will trigger a port of the Extension Port.

is a field that depends on the "Action". Enter a number to specify a certain
"Scene". Enter a value from 0 to 100 for "Master". Enter a value from 0 to 1000 for
"Speed". Select 0 (Off) or 1 (On) for "Port".

defines the how often the "Action" is triggered. Applicable values are: "Once",
"Cycle", "Daily", "Weekly", "Monthly", "Yearly". "Once" will trigger the event
only one time. "Cycle" will trigger the event according to the "Cycle Interval”, for

example every 10 minutes.

defines the date and time, that means when the event will be triggered.

"Valid From" defines together with "Valid Thru" a time interval in which the event will be

triggered. "Valid From" sets the starting point.

© 2011 inoage GmbH



MADRIX PLEXUS 578

"Valid Thru" defines together with "Valid From" a time interval in which the event will be

triggered. "Valid Thru" sets the end point.

"Cycle defines a time period for the "Type" "Cycle" in HH:MM:SS (Hours:Minutes:Seconds).

Interval”

Extension Ports:

The tab "Extension Ports" allows you to configure the individual pins of the Extension Port.

First, please select one PLEXUS Configuration you wish to edit.

Resets all settings to their default value. This will discard any changes you have made.

Please edit the following columns according to your requirements.

(Perform a double-click to change their values. Use Enter to apply your changes. Use Escape to

cancel.)

"Type" defines the character for each Port. On the one hand, "Ports 1 - 6" can be either
"Digital Input” or "Analog Input". Therefore, only input is allowed for Ports 1 to 6.
On the other hand, "Ports 7 - 10" are only digital ports, but can be switched from
"Digital Input” to "Digital Output” and vice versa.

"Invert" defines if the status of the Port (1 = On, 0 = Off) will be reversedto 0 =0n, 1 =
Off.

"Action" defines the type of event that will be triggered when a Port is triggered. Applicable
values are: "No", "Scene", "Master", "Speed", "PlayPause", "Freeze".
"PlayPause" will start or stop the playback. "Freeze" will halt the output.

"Value" defines the "Action" in more detail. Enter a number to specify a certain Scene.

Enter a value from 0 to 100 for "Master". Enter a value from 0 to 1000 for "Speed".
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"Threshold can be entered when using "Analog Input". Specify the limit an analog input must be

High" moved up to before the event is triggered.

"Threshold can be entered when using "Analog Input”. Specify the limit an analog input must be

Low moved back before the event is triggered.

Data Files:

The tab "Data Files" shows all MADRIX PLEXUS Scene Files (*.dxd) that are used in the selected
PLEXUS Configuration. It represents a database of your Scene Files within one PLEXUS
Configuration. (Remember that you need MADRIX PLEXUS Scene Files (*.dxd) in order to create

Scenes.)

First, please select one PLEXUS Configuration you wish to edit.

Adds a new Scene File (*.dxd).

Removes an existing Scene File from the PLEXUS Configuration.
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Step 7) Uploading A Stand-Alone Show Onto The SD Card

(Press "Scan" to find your connected PLEXUS. Learn more on how to manage your PLEXUS

devices below.)
You can either

A) directly save your Stand-Alone Show on a SD card

I Export

In order to save a Stand-Alone Show on a SD card directly, please use the "Export"
button. First, select your Configuration. Second, press "Export". In the third step, choose your

target source.

B) or you can save your Stand-Alone Show on the SD card that is inserted into your
MADRIX PLEXUS.

Your PLEXUS must be connected via USB or via Ethernet (network).

" Uploac
Heload

First, select your MADRIX PLEXUS. Second, select your PLEXUS Configuration.
Third, press "Upload" and the PLEXUS Show will be saved on the SD card of your device.

Step 8) Activating Stand-Alone Mode
Last but not least, you will have to activate Stand-Alone Mode on your MADRIX PLEXUS.

A) Activate Stand-Alone Mode manually on the device using the menu (LCD graphics display) and

the 5 control buttons.

B) "Call" your device and activate Stand-Alone Mode remotely. Learn more below.
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Managing Your MADRIX PLEXUS Devices

To call up the PLEXUS Configuration dialog, please go to the menu "Tools" -> "PLEXUS
Configuration " (or "Ctrl+Alt+P").

It is highly recommended to maximize the size of the PLEXUS Configuration dialog.

The lower section of the PLEXUS Configuration dialog consists of two parts to for the Stand-Alone
Mode. The upper section of the PLEXUS Configuration dialog is labeled "Devices". The upper

section can be used to manage your PLEXUS devices.

Scans the USB ports of your computer and the network (Ethernet) for
connected PLEXUS devices. If devices are found, they will be shown in the list.
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Re-scans already connected devices and brings the information in the list up to
date.

Enables remote access. You can easily connect to your devices using a web
browser. In the browser you will be able to control your device remotely via a graphical interface

that represents the menu of your PLEXUS. First, select your PLEXUS in the list. Then, press "Call"

=TT TImE

Synchronizes the internal clock of the PLEXUS with the clock of your computer.
The computer clock will define the time that is used. First, select your PLEXUS devices in the list.

The, press "Sync Time".

[ Ermemre |
F

P are

Upgrades the firmware of your MADRIX PLEXUS. Firmware upgrades are
implemented directly into the MADRIX Software. To upgrade, please connect the PLEXUS via
USB to your computer. Then, select your interface in the list and press "Firmware". It is

recommend to always use the latest firmware.

Drorerloadd

Downloads a saved PLEXUS Configuration directly from a connected PLEXUS to

your hard disk. You can use this feature to create backups, for example.

In addition, please edit the following columns according to your requirements.
(Perform a double-click to change their values. Use Enter to apply your changes. Use Escape to

cancel.)
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"Master" defines the Master Fader of your device in percent, that means the master

brightness. Applicable values are: 0 - 100.
"Speed” defines the tempo in percent. Applicable values are: 0 - 1000.

"Sync" defines if your interfaces use the implemented Master-Slave Synchronization.
Applicable values are: "Master"”, "Slave", "No". "Master" will set the interface to
work as central clock. "Slave" will set the interface to synchronize with the

"Master". "No" will deactivate any synchronization.

Tips
e You can create a Stand-Alone Show without having connected the PLEXUS to the computer.

e In order to upload a Stand-Alone Show onto a SD card, the SD card or the device with the SD
card must be connected. You can upload a show onto the SD card of a device via USB or via

Ethernet (network).

e You can export a Stand-Alone Show directly to the SD card using the "Export" button in the
"PLEXUS Configuration"” dialog.
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13 WYSIWYG Visualizer

wysiwyg

Introduction

Since R23 MADRIX has been officially implemented into WYSIWYG.

Installing The WYSIWYG Driver

To use WYSIWYG with MADRIX, you have to install the MADRIX WYSIWYG driver first. Therefore,

please make sure to select the check box "Visualizer Driver" in the MADRIX setup wizard.

Choose Components
Choose which features of MADRIX vyou want to install.

MADRIX

Chedk the components vou want to install and unchedk the components you don't want to
install. Click Next to continue,

Description

Installs the MADRIX -
Desktop shortcut WYSIWYG driver for

Examples supported Visualizer
MADRIY KEY Driver software (WYSIWYG).
Interface Driver

WinPcap Driver

Select components to install: MADRIX

Space reguired: 91. 7MB

|[ mext> | | cancel
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More information on the complete installation process is given in the chapter Installing The MADRIX

Software.

In the next step, a second setup wizard will be launched for the MADRIX WYSIWYG driver:

Welcome to the MADRIX WYSIWYG
Driver 1.0 Setup Wizard

This wizard will guide you through the installation of MADRIX
WYSIWYG Driver 1.0,

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Mext to continue,

License Agreement
Flease review the license terms before installing MADRIX
WYSIWYG Driver 1.0,

MADRIX

Press Page Down to see the rest of the agreement.

END-USER LICENSE AGREEMENT FOR INOAGE SOFTWARE
Licence agreement

IMPORTANT NOTE

Flease read this license agreement before using this software. By continuing the
installation and by using this software you commit yourself respecting all the terms and
conditions of the license agreement without reservation. If you do not accept these
terms and conditions, please stop the installation process.

RIGHTS OF THE LICENSE AGREEMENT

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install MADRIX WYSIWYG Driver 1.0.

< Badk ][ I Agree ] [ Cancel

Step 1)

You can always quit the setup by choosing

"Cancel".

Click "Back" in order to return to a previous

step during the setup process.

Now, please click "Next" to start the

installation of the driver.

Step 2)

The "License Agreement” will appear. It
outlines the terms you are agreeing to by
installing the driver. You must accept these

terms in order to continue.

Please click "I Agree".
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Step 3)
= Choose Components
M&Pnlx Choose which features of MADRIX WYSIWYG Driver 1.0 you . . )
want o instal. This window offers the chance to select which
Ez;ﬁ?laﬂzﬁrgnsni%t:antminsiall and unchedk the components you don't want to Components and Whlch drlvers yoU Want tO

. install. A description is given for every item.
Select components to install: De=orine
—c ) Install MADRIX -
visualizer documentation | ywysTWYG driver for
Start Menu Shortcuts supported Visualizer

software (WYSIWIYG) It is always required to install the "Visualizer

Driver".

Space required: 1.2MB

Select "Visualizer Documentation" if you

wish to install this user guide as a separate

document.

Select "Start Menu Shortcuts” if you wish to

install short cuts in the Windows start menu.

Click "Next" after choosing the components.

Step 4)

Choose driver install location
Choose the folder in which to install MADRIX WYSIWYG Driver 1.0

MADRIX

Afterwards, please choose an installation
directory on your hard disk to install the
driver. A standard destination folder will

automatically be provided by the setup.

Destination Folder

Fog am Fies (@5 WVSIWTG DrversMADREC WYsivG e TR .
SRS — Click "Browse" to change the folder.

Space required: 1.2MB
Space available: 28.7GB

Then, click "Next".

< Back ][ Mext > ] I Cancel ]
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Choose d ion install locati
Choose the folder in which to install MADRIX WYSIWYG Driver 1.0
documentation and uninstaller

=MADRIX

Destination Folder

:\Program Files (x86)\MADRIX WYSIWYG Driver|

Browse...

Space required: 1.2MB
Space avaizble: 28.7GB

Installation Complete

= -
—_— \M&F!F“.,x Setup was completed successfully.

Completed
=== ————=—.,

Created uninstaller: C:¥Program Files (x85)\MADRIX WYSIWYG Driver \MADRIX WYSL...
Qutput folder: C:\Program Files (x&6) WYYSIWYG Drivers MADRIX WYSIWYG Driver
Extract: MadrisWya.dll... 100%:

Output folder: C:\Program Files {x86) MADRIX WYSIWYG Driver

Extract: MADRIX WYSIWYG Driver Manual.pdf... 100%:

Create folder: C:\ProgramData\MicrosoftiWindows\Start Menu'Programs\MADRIX W. ..
Output folder: C:\ProgramData\Microsoft\Windows\Start Menu\Programs\MADRIX W...
Create shortcut: C:ProgramDataWMicrosoft\Windows\Start Menu'\Programs \MADRIX ...
Create shortcut: C:\ProgramData\Microsoft\Windows\Start Menu\Programs\MADRIX ...
Completed

Completing the MADRIX WYSIWYG
Driver 1.0 Setup Wizard

MADRIX WYSIWYG Driver 1.0 has been installed on your
computer.

Click Finish to dose this wizard,

Step 5)

Now, please choose an installation directory
on your hard disk to install the documentation
and the uninstaller. A standard destination
folder will automatically be provided by the

setup.
Click "Browse" to change the folder.

Then, click "Install".

Step 6)

If this window is shown, the driver installation

was completed successfully.

Click "Next".

Step 6)

In order to quit the WYSIWYG setup wizard,

please click "Finish".
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Activating WYSIWYG In MADRIX

To activate the Visualizer, please open the menu "Preferences" -> "Device Manager" (or simply

press the key "F4"). Go to the tab "Visualizer" and click "Enable Visualizer".

r-

Device Manage

¥ Input | Artoiet | MID!input | Audio Input SRUETEIE

& Mame

Fired Acto

Use the "Find Auto" button to automatically find all running WYSIWYG devices
on your local computer or in the network. Make sure that the port number in the dialog matches
the port number in your WYSIWYG - Driver configuration page.

To open the WYSIWYG - Driver configuration page you have to double-click the tray icon in the
Windows system tray of the computer that WYSIWYG is running on.
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@ MADRIX - WYSIWYG Driver =
PADRIX - WYSIWYG Driver loaded

590

Your WYSIWYG device should appear now in the list

displaying "State: online". To configure the device, just double-click it.

Device Manager

"D vices | DM Input | artNet | WD nout | Audio ot ey
B Enat

—tate Crotpat™ = vstahzer Name Unrrerses
= online on  WYSWYG  WYSIWYG auto #1 [x07 - x07] count: 1

;1.0.0.0 protocol version : 1.0
Enable :

Device Hame :

Start Universe :

IF :

Note that you can also manually create the WYSIWYG device by clicking on the "New" button. In

this case you have to change the IP address and the port number of the new WYSIWYG device as

described below.
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In the WYSIWYG device configuration page you can enable or disable the DMX-Output, rename
the device using a custom name, and set the start and the end universe for the DMX data that
will be send to WYSIWYG. The "IP" and "Port" fields represent the IP address and the port

number of the target computer, on which WYSIWYG is running. So, if the device was detected

automatically, you do not need to change it.

Please note: You can only enable DMX output if the WYSIWYG Driver "State" is "online" .
In other words, the WYSIWYG driver must be up and running on the same computer or in the

network.

Now if the connection is established, a message will be display that reads "xx MADRIX device(s)

connected" in the status area of the WYSIWYG device configuration page.

MADRIX - WYSIWYG Driver Configuration ;=’

onnected

port: 3454 =
| E———— |

Please note that WYSIWYG can connect up to 20 computers running MADRIX and vice

versa.

You can save your device settings in *.vdf file format to retrieve it later. To save your current
configurations, click on the save button in the lower left corner of the Visualizer dialog and

choose a name and path.
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592

You can easily load your settings by using the open button in the lower left corner of the

Visualizer dialog. Navigate in the directory to the desired file.

open existing device settings

Connecting To MADRIX In WYSIWYG

After starting WYSIWYG, switch to "LIVE" mode. Open the "Live" menu and choose "Device

Manager". The dialog box will be displayed afterwards.
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Edit  Library

rE B S

Zoom  Options Help
%F  Intensity Tool

Focus Tool

Iris Tool

o b
R

Zoom Tool
CalorTool

Gobo Tool

® B h b

Prism Tool

Update Intensity Label

Device Manager...

AutoPatch

DMX Camera Patch

Render...

Video Manager

Device Manager

Mame Connect on load

Bind AutoFocus

Properties

Delete

Connect

Connect on load
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Click "New" -> "Consoles" and navigate through the console library until you find "MADRIX".

Highlight it and then click "Insert".

[ -

Library Selection

|

] o P = o e o e e o St e ) /e

= Manufacturer

AVAB
Avelites

Cast Software
ChamSys
Color Kinetics

- Colortran/MSI

- Compulite

- ECue

- Entertainment Technol

ETC

- Fisher Technical Servic

- Flying Pig System
~HOL - Guangzhou Hed
- High End

- Horizon Control Inc

ne

Appearance | Version | Data |

3D

Now the MADRIX console should appear in the Device Manager. Select it and click on

"Properties". In the Property dialog box fill in the IP address of the computer that runs MADRIX
(for instance 192.168.33.5) into the "Address:" field.
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Console

Manufacturer

Open
Protocal [Dl'u'l}(
Model

Bind
Mame : MADIR

|UnBind
Address :  192.168.2.33

OK | | Abbrechen | | Ubemehmen

If MADRIX and WYSIWYG run on the same computer, please enter 127.0.0.1 in the "Address:"

field. Then, apply the changes with "OK" and click "Connect" in the Device Manager dialog box.

For more information on how to create and edit patches, please refer to the WYSIWYG
documentation.
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14  Supported DMX512 & Art-Net Interfaces
Supported DMX512 Interfaces

MADRIX relies on existing standards: the DMX512 protocol and DMX512 devices. For any data

output various interfaces are supported.
MADRIX
USBone - USB 2.0 interface, 512x DMX-OUT or 512x DMX-IN
NEO - USB 2.0 interface, 512x DMX-OUT or 512x DMX-IN
PLEXUS - USB 2.0 interface, 1024x DMX-OUT, or 1024x DMX-IN, or 512x DMX-IN and 512x
DMX-OUT
Daslight
DVC2 512 - USB 2.0 interface, 512x DMX-OUT and 512x DMX-IN
DVC2 ECO 512 - USB 2.0 interface, 512x DMX-OUT and 512x DMX-IN
DVC2 Gold - USB 2.0 interface, 1024x DMX-OUT

DVS 3D - USB 2.0 interface, 512x DMX-IN

Digital Enlightenment

USB-DMX Interface

e:cue

butler - Ethernet-to-DMX gateway, 2x 512x DMX-OUT

Elation Professional

Compu 1024EC - USB 2.0 interface, 512x DMX-OUT or 512x DMX-IN
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Compu 2048FC - USB 2.0 interface, 512x DMX-OUT or 512x DMX-IN
Compu 2048FC+ - USB 2.0 interface, 512x DMX-OUT or 512x DMX-IN

Compu Live - USB 2.0 interface, 512x DMX-OUT or 512x DMX-IN

ENTTEC
Open DMX USB Interface - (Output only)

DMX USB Pro - 512x DMX-OUT or 512x DMX-IN

EUROLITE

USB-DMX512 Interface - 512x DMX-0OUT

GLP Light Produktion GmbH
ion.control.one - USB 2.0 interface, 1024x DMX-OUT with standalone mode

LSC 3002 - USB 2.0 interface, 512x DMX-OUT

LTS KOREA co., Itd.

DMX Tranceiver 2.0 - USB DMX512 interface

MONACOR
img Stage Line DMX-1 USB - 512x DMX-OUT or 512x DMX-IN

img Stage Line DMX-510 USB - 512x DMX-OUT or 512x DMX-IN

Nicolaudie - Sunlite
SLESA - USB interface, 512x DMX-0OUT

SLESA-IP1 - Ethernet interface, 512x DMX-OUT

598
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SLMEV - USB interface, 512x DMX-IN

peperoni-light
Rodinl - USB 2.0 interface, 512x DMX-IN or 512x DMX-OUT
Rodin2 - USB 2.0 interface, 512x DMX-OUT or 512x DMX-IN

RodinT - USB 2.0 interface, 512x DMX-OUT or 512x DMX-IN

Soundlight - The DMX company
1514PCI - PCI Card, 1024x DMX-IN/OUT (DMXCRD32.dll)
2514PCI - PCI Card, 2048x DMX-IN/OUT (DMXCRD32.dll)
2512A - PCMCIA Card, 1024x DMX-IN/OUT (DMXCRD32.dll)
USBDMX2 - USB interface, 512x DMX-OUT (dashard.dll)
USBDMX1-LC - USB interface, 512x DMX-OUT (dashard.dll)
USBDMX-IN - USB interface, 512x DMX-IN (dashard.dll)
SLESA-IP - Ethernet interface, 512x DMX-OUT (via Art-Net)
SUIDI-5A - (dashard2006.dll)

USBDMX-ONE - (susbdmx.dll)

USBDMX.com

Interface - USB interface, 512x DMX-OUT and 512x DMX-IN
(Requires: FTDI driver version 1.6 and higher; Suggested for use: ENTTEC drivers included in
MADRIX; original USBDMX.com driver is not recommended)
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Supported Art-Net Interfaces

ETHERNET

MADRIX supports all available Art-Net nodes. You can use these
nodes either as output or input devices. Art-Net is a communication system that allows DMX512
to be sent over Ethernet. It was invented by Artistic Licence and has now been published for the

public domain.
Acclaim Lighting

X-NET 8

ENTTEC
DMXEtherGate MK2

Datagate

EUROLITE

Node 8

Luminex
Ethernet-DMX2 Wall
Ethernet-DMX2 Box
Ethernet-DMX2 Wifi

Ethernet-DMX8
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Ethernet-DMX8 Wifi

Ethernet-DMX8 Truss

MADRIX

PLEXUS
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15 Keyboard Shortcuts (Hotkeys)

Overview

File - New Ctrl+N

File - Open Setup Ctrl+O
File - Save Setup Ctrl+S

File - Save Setup as Ctri+Alt+S
Matrix Generator F2

Patch (open and close) F3

Device Manager (open and close) F4

Audio Performance Ctrl+Alt+A
Options Ctri+Alt+O
Cue List (open and close) F7
Recording Ctrl+Alt+R
Touch Screen (open and close) F8

Task Watcher (open and close) F5

Logfile (open and close) F6

DMX Watcher Ctrl+Alt+D
MIDI Watcher Ctr+Alt+M
DMX Fader Tool Ctrl+AIt+F
PLEXUS Configuration Ctrl+Alt+P
MADRIX Help F1l

Moving the DVI fullscreen or Touch Screen TAB
Window to a different monitor

If the selected control is a button, SPACEBAR

the button will be clicked.

If the selected control is a check box,
this toggles the check box.

If the current control is an option,
this selects the option.
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If an edit field (Color Edits) is selected,
you can switch between the values 0 and 255.

(Cue List, FaderBox, Macro Editor, ..

)

Confirm your selection ENTER
The equivalent to clicking the 'Cancel' button ESC
Quit MADRIX or close a window Alt+F4
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16 Imprint & Copyright
MADRIX

MADRIX is a trademark of inoage GmbH.

All other company names and/or product names are trademarks and/or entered trademarks of their
respective holders. The product might not always be conforming to the presentation, features,
and performances. Technical data can differ slightly, depending on the operating system and the

chosen hardware.

We withhold the option of changes without notification. inoage GmbH does not give any guaranty
for function capability for a certain purpose, the marked ability or other features of the product.

No other guaranty claims, on legal or other terms, can be enforced.

Under no circumstances does inoage GmbH take on the responsibility for liabilities for faults for
loses in sales volume or profits, that occur through the usage of the product, through the
serviceability, through abuse, happenings, circumstances or actions, that we have no influence

on. No matter if the damages were caused by the holder of the product or a third person.

Copyright (c) 2001 - 2011 inoage GmbH. All rights reserved.

Address

inoage GmbH

Fetscherplatz 5

D-01307 Dresden - Germany
Phone: +49 351 482 056 30
Fax: +49 351 482 056 31

E-mail: info@madrix.com

Credits
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e Microsoft, Windows are U.S. registered trademarks of Microsoft Corporation.
e Art-Net™ - Designed by and Copyright Artistic Licence (UK) Ltd.

e ASIO is a trademark and software of Steinberg Media Technologies GmbH.

This product includes software by NetGroup, Politecnico di Torino and CACE Technologies, Davis.

e Other product and company names, terms, or marks are the property of their respective holders.

WinPcap

Copyright (c) 1999 - 2005 NetGroup, Politecnico di Torino (Italy).
Copyright (c) 2005 - 2009 CACE Technologies, Davis (California).

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. Neither the name of the Politecnico di Torino, CACE Technologies nor the names of its
contributors may be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.
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This product includes software developed by the University of California, Lawrence Berkeley
Laboratory and its contributors.

This product includes software developed by the Kungliga Tekniska Hégskolan and its
contributors.

This product includes software developed by Yen Yen Lim and North Dakota State University.

Portions Copyright (c) 1990, 1991, 1992, 1993, 1994, 1995, 1996, 1997 The Regents of the
University of California. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes software developed by the University of California,
Berkeley and its contributors."

4. Neither the name of the University nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE INSTITUTE AND CONTRIBUTORS " "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Portions Copyright (c) 1983 Regents of the University of California. All rights reserved.

© 2011 inoage GmbH



609 MADRIX Help and Manual

Redistribution and use in source and binary forms are permitted provided that the above copyright
notice and this paragraph are duplicated in all such forms and that any documentation, advertising
materials, and other materials related to such distribution and use acknowledge that the software
was developed by the University of California, Berkeley. The name of the University may not be
used to endorse or promote products derived from this software without specific prior written
permission. THIS SOFTWARE IS PROVIDED " *AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF
MERCHANTIBILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Portions Copyright (c) 1995, 1996, 1997 Kungliga Tekniska Hégskolan (Royal Institute of

Technology, Stockholm, Sweden). All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes software developed by the Kungliga Tekniska Hégskolan
and its contributors."

4. Neither the name of the University nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE INSTITUTE AND CONTRIBUTORS " "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE INSTITUTE OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.
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Portions Copyright (c) 1997 Yen Yen Lim and North Dakota State University. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes software developed by Yen Yen Lim and North Dakota
State University"

4. The name of the author may not be used to endorse or promote products derived from this
software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR " “AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Portions Copyright (c) 1993 by Digital Equipment Corporation.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is
hereby granted, provided that the above copyright notice and this permission notice appear in all
copies, and that the name of Digital Equipment Corporation not be used in advertising or publicity

pertaining to distribution of the document or software without specific, written prior permission.
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THE SOFTWARE IS PROVIDED "AS IS" AND DIGITAL EQUIPMENT CORP. DISCLAIMS ALL
WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL DIGITAL EQUIPMENT CORPORATION BE
LIABLE FOR ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Portions Copyright (C) 1995, 1996, 1997, 1998, and 1999 WIDE Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. Neither the name of the project nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE PROJECT AND CONTRIBUTORS " "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE

ARE DISCLAIMED. IN NO EVENT SHALL THE PROJECT OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS

OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY

OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Portions Copyright (c) 1996 Juniper Networks, Inc. All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are permitted
provided that: (1) source code distributions retain the above copyright notice and this paragraph
in its entirety, (2) distributions including binary code include the above copyright notice and this
paragraph in its entirety in the documentation or other materials provided with the distribution.
The name of Juniper Networks may not be used to endorse or promote products derived from this
software without specific prior written permission.

THIS SOFTWARE IS PROVIDED " "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. Portions Copyright (c) 2001 Daniel Hartmeier All rights
reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

- Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTOR "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Portions Copyright 1989 by Carnegie Mellon.
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Permission to use, copy, modify, and distribute this program for any purpose and without fee is
hereby granted, provided that this copyright and permission notice appear on all copies and
supporting documentation, the name of Carnegie Mellon not be used in advertising or publicity
pertaining to distribution of the program without specific prior permission, and notice be given in
supporting documentation that copying and distribution is by permission of Carnegie Mellon and
Stanford University. Carnegie Mellon makes no representations about the suitability of this

software for any purpose. It is provided "as is" without express or implied warranty.
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A 59

Acclaim Lighting 335
ACNCID 190, 394
ACNE1.31 190

Activate "Audio"-Button 183
Activate Audio Button 29
Advantages of LEDs 9

Akai Professional 472
Always On Top 351, 356, 360
APC40 472

Apple 238

Artnet 310

Art-Net 310, 322, 327, 335, 348, 597
Art-Net interfaces 597
Arnt-Net Remote 412

ASIO 22

Aspect Ratio 192

Audio 77, 450

Audio Analysis 29

Audio Controls 22

Audio Device 22

Audio Input 20

Audio Input Configuration 22
Audio Level 37, 77

Audio Performance 29, 40
Automatic Fade 192

Av 238
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B 59

Back 75, 289

Backup 171

Backup System 40, 171
BCD2000 474
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BCR2000 478
Behringer 474, 476, 478
BF 59
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Bitmap 200

Black 77
Black-fade 59
Blackout 77

Blend 238
Blending 150

Blind Mode 69, 150
Bmp 200

Bob 238

Bob Linear 238
bottom: 402
Broadcast 310, 322, 327, 335

_C-

CF 59

Channel Filter 450
Check for BETA Update 183
Check for Update 183
Circle of Fifths 270
Clear 67

Clear All Storages 40
Clear All Storages A 40
Clear All Storages B 40
Clear Message 49
Clock 49

Close 351, 356, 360
Color Control 160
Color Depth 89
Color FaderBox 160
Color Filter 59

Color Kinetics 190
Color Picker 160
Color Ramp 160
Color Table 160
Color-fade 59
ColorKinetics 385
ColourSmart Link 402
Commands 525
Config By Web 310
Configure device... 402
Console 450

Control Panel 33
Conwersion 555
Copy 67,150

Copy Storage Places 40
Count Of ACN Devices Used 394
Create a new layer 150

Creative 480

Cross-fade 59

Crossfader 59, 533

Cue 67, 137, 289

Cue All 289

Cue All Occupied Storage Places 40
Cue List 40, 75, 186, 289, 304

Cue List Section 37

Cue List With Duration and Date 293

Cue List With Time Code, Duration, And Follow Cue
300

Cut 67

D -

Darker Areas 49
DaScratch 514

Daslight 597

Data Files 555

Datagate 327

Date 289

Deinterlace 238

Delete 150

Demo mode 11, 349
Description Field 67
Device Driver 188

Device Manager 40, 310, 348
Devices (Network) 190
Devices (USB/PCI) 188

DI 238

Digital Multiplex 7

Digital Visual Interface 349
Direct IP mode 310, 322, 327, 335
Direct3D 195

DirectX 32
Disable Preview 49
Discard 238

Display Area 351, 356, 360
Display Rotation 351, 356, 360
DivXx 238

DJ Console MK2 485

DJ Console Rmx 483

DJ Control MP3 485

DJ Control MP3 e2 488
DJ/VJ console 450

DMX 7

DMX Addressing 180

DMX Devices 366
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DMX Fader Tool 40, 125
DMXInput 412

DMX output device 310, 348

DMX Start Channel 83

DMX Start Corner 83
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DMXWatcher 40, 125

DMX512 7, 366, 551, 555

DMX-IN 412

DMX-IN - Large Protocol 441
DMX-IN - Micro Protocol 438
DMX-IN - Mini Protocol 439
DMX-IN - Small Protocol 440
DMX-IN - Universal Protocol 445
DMX-IN - Universal Protocol 2 447
DMX-IN Device 412

DMX-OUT 310, 348, 366

Dongle 11

DPI 200

drag & drop 137

Duplicate 150

Duration 289

DVI 349

DVI configuration 349

DVI devices 402

DVI Fixture 110

DVI Fullscreen 360

DVIMap 110

DVI Map Mode 110, 351, 356, 360
DVI Mapping 110

DVI output 49, 349

DVI Patch 110

DVIiwall 349

DVI Window 356

DVI Window (Borderless) 351

DVI Window Settings 351, 356, 360
DVI, Window, Fullscreen 351, 356, 360
dxd 538, 555

" E -

e:cue 190, 370, 597
emnet 190, 370

Edit 40

Edit Record 538
Effect Area A 37, 69
Effect AreaB 37, 69
Effect Pipelines 49

Effects 69, 149, 532
Effects - Oveniew 199
Elation Professional 481, 597
Enable 366, 402

Enable ACNE1.31 394
Enable full size 402

Enable manual frame time 402
Energy Sawer 33

ENTTEC 327, 597

ENTTEC Datagate 327

EQ 248

ESTA 190

EUROLITE 322

EuroLite T9 402

event 402

Examples 529, 534

Exit 40

Extension Ports 555
External 289

_F -

F.Cue 289

FADE 59

Fade Area 37

Fade Time 59

Fader 59

File 40

File Watcher 186

Files 177

Filter 59

Fixture 89, 529

Fixture Editor 83, 180
Fixture rotation 83
Fixtures 180

Flash device 385

Flip Horizontally 351, 356, 360
Flip Vertically =~ 351, 356, 360
Flipping 89, 110

FLV 238
FPS 195
frame 402

Frame Fade 69

Frame time 372, 378, 385
Free MIDI Assignment 450
Freeze 59

F-Time 289

Full Frames 310
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Full Size 351, 356, 360
Fullscreen 349

-G -

Gif 200

GLP 597

GLP Light Productions GmbH 597
Go 75, 289

GoTo 289

Graphical User Interface 37

Grid 49, 351, 356, 360

GUI 37

“H -

Help 6, 40

Hercules 483, 485, 488
Highlight device 402
Hotkeys 603

HowTo 6
HTP 180
HTTP 525

Image Resolution 200
Images 177, 200

Initialize QuickTime At Startup 183
Input 366

Input Protocol 412

Insert 150

Insta Light2022 190

Insta network driver 378
Installing the Software 15, 585
Insta-Net 378

Interface 551, 555

Interlace 238

Internet Browser 525

Internval 269

IP address range 385

_ ] -

Jpg 200

“K -

Key 269

Keyboard Layouts 304
Keyboard shortcuts 603
Keyboards 497

KiNet 190, 385

KiNet network driver 385
KORG 490

L -

Large Protocol 441
Launchpad 504

Layer A 40

LayerB 40

Layer Button 69

Layer mixing 150

Layer mixing modes 150
Layer Opacity 69, 150

Layer Tab 69

Layers 150

LED Fixtures 83, 180

LED Matrix 83

LED Screen 83

LED Studio 349

LED Wall 83

LEDs 9

left: 402

Light Matrix 83

Lighting fixtures 89, 180

Link 150

Link Mode 69

Linking layers 150

Live Mode 555

Livid Instruments 491

Load A Special Fixture Library 183
Load Audio Settings 177
Load DMX Device Settings 177
Load DVI Device Settings 177
Load Patch 177

Load Setup 177

Load This Setup On Start 183
Lock Position 351, 356, 360
Logfile 40, 125

Logo 37
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M2L Color Rings 274
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Macros 286

MADRIXGUI 192
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MADRIXNEO 551
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Main Orientation 83
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Major 268, 270

Map 167

Map Channels 412
Mapping 69, 412

MAS Script Effect 199, 284

Mask Mode 49

Master / Slave 171
Master Fader 37, 77
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Matrix 529

Matrix Generator
Matrix size 49
M-AUDIO 493, 495

Max. count of e:net universes used

Micro Protocol 438
MIDI 450, 497, 520
MIDI Map

512, 514, 516, 517, 519
MIDI Remote Control
MIDI Remote Editor
MIDI Time Code 520
MIDI Universal 499
MIDI Watcher
MIDICON 481
MIDI-IN 450

Mini Protocol 439

40, 83

450
450

370

472, 474, 476, 478, 480, 483, 485, 488,
490, 491, 493, 495, 497, 499, 504, 506, 508, 509, 510,

40, 125, 450

Minor 268, 270
Mix mode 150
Mix Modes 69
MMC-1 512
Monitoring 125
Mpg 238

mrec 538, 555
MTC 450, 520
Multiple fixtures 89
Music Theory 267
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Name 89
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NEO 551
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NuvJ 506

-0 -

Ohm64 491
Omni Control 508
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On-screen capturing
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Open 67

Open Options 177
Open Setup 40
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Operating System 10

Options 40, 183

Orientation 83

Output 366
Oweniew 37
Oxygen 8 V2

_P-

Paste 67, 150

Patch 40, 83, 89, 529
Patch size 89

Pause 67

490

349

493
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PC Configuration 10
PC-MIDI 480
peperoni 597
Performance 195
Philips 190, 385
Picture Resolution 200
Pictures 200

Pin Layout 7
Play/Pause 75
Playback 555
PLEXUS 555
PLEXUS Conwersion 538
Position 89

Post Sync 310, 348
Power Management 33
Power Options 33

Pre Sync 310, 348
Preferences 40
Preview A 37, 40, 49
Preview B 37, 40, 49

Preview DVI1 40

Preview DVI2 40

Preview Output 37, 40, 49
Previews 40, 49

Problems 125

Processor 10

Prodikeys 480

Projector 349

Proprietary DVI Devices 402

_Q_

Quicktime 238
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RAM 10

Record 538

Recording 40, 538
Remote 450

Remote Control 40, 412, 450
Remote HTTP 525
Remote members 525
Remowe device 402
Remowe/ delete a layer 150
Rename 150

Rescan for devices 385

Reset 69

Reset Previews 195
right: 402

Robe 372

Robe StageQube234 190
Rotation 89, 110, 167
RTC file 11

Run MADRIX, when Windows Starts
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183

199, 247
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SCE Explosions 221
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SCE Shapes 232
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SCE Video 238

SCE Wawe 245
Scenes 555

Screen Resolution 10

199

229

236
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286
514
555

Scripts
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286

Selecting an Effect 69
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Send Direct

Setup 15, 177
Show 555
Show Clock

Show Status Information

Small Protocol

310

310
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Set Timeout To Start Software

183
183

49, 351, 356, 360

49, 351, 356, 360
440

Snake Mode 83
Software Protection Dongle 11

Solo Mode 69,
Sound Card
Soundlight
Spacing 110
Speed 148
Speed Master
Stand-Alone Mod

Stand-Alone Show

Stanton 514
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Start Cue List Aft

Start Touch At Startup

State 366
Stealth Control
Stereo Mix 22
Storage 137
Storage A 67
Storage Area A
Storage Area B
Storage B 67

Storage Button Count

Storage Place
Storage Place A
Storage Place B

Storage Place Macro

Storages 137
Streaming ACN
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Sub 67

150

20, 32
597

67, 148
e 555
555

412
er Loading The Start Setup
183

509

37
37

78, 192
67

40

40
67, 69, 137

190, 394
49, 351, 356, 360

183

Submaster 67, 69, 137
Subswitch 310

Sunlite 597

Support 125

Sync Mode 310, 348
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System Time 289
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T9 402

Task Watcher 40, 125
TCP/IP network 525

Tile 167

Time Code 289, 520
Time to detect devices in sec. 370
Timers 555

Tonality 268

Tone Theoretical Parameters 266
Tones 268

Tools 40

Top Field First 238

top: 402

Torq 495

Total Control 510

Touch 40, 78, 192
Touch Screen 78, 192
Tutorial 529, 532, 533

- U -

Unicast 322, 327
Universal 499

Universal Protocol 445, 447
Universe 372, 378
Update MADRIXKEY 11
Upgrade 11, 15

USB 2.0 551, 555

USB Software Protection 11
Use Automatic Fade 78
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USER 516

User Interface 192
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49, 351, 356, 360
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VCI-100 517
VCM-100 519
Version Upgrade 11
Vestax 517, 519
Video 238

Video beamer 349
Videos 177

View Dir 555

Virtual DMX Universes 195
Virtual Matrix 89, 110
Visualizer 585

V-Sync 195
Watch 450

Watch This Cue List File And Reload If Changed
186

WDM 22

WF 59

White Adjustment 190
White-fade 59

Window 40, 349

Window Position 351, 356, 360
Window Size 351, 356, 360
Windows 33

WMV 238

WYSIWYG 585
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XF 59
XNET8 335
Xponent 495
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